User Non-Disclosure and License Agreement

IMPORTANT-READ CAREFULLY: This Honeywell End-User License Agreement (this “Agreement”) is a legal agreement between you (either an individual or a single entity) and Honeywell International Inc. (including its subsidiaries) for the Honeywell software product identified above, which includes computer software and may include associated media, printed materials, and “online” or electronic documentation, and any future versions, releases, updates, patches, error fixes and bug fixes of the above identified Honeywell software product that is provided by Honeywell to you (“HONEYWELL SOFTWARE”).

By installing, copying, or otherwise using the HONEYWELL SOFTWARE, you agree to be bound by the terms and conditions in this Agreement. If you do not agree to the terms and conditions in this Agreement, do not install or use the HONEYWELL SOFTWARE; you may, however, return it to your place of purchase for a full refund.

Unregistered use of the HONEYWELL SOFTWARE is not authorized or permitted by Honeywell, and is in violation of U.S. and international copyright laws. Unauthorized reproduction, distribution or use is subject to civil and criminal penalties.

LICENSE: The HONEYWELL SOFTWARE includes software owned by Honeywell and software licensed to Honeywell, and is protected by United States’ and international copyright laws and treaties, as well as other intellectual property laws and treaties. The HONEYWELL SOFTWARE is licensed to you, not sold.
Subject to the terms below, Honeywell grants you, under this Agreement, a limited, non-exclusive, non-transferable license (without the right to sublicense) to use one copy of the HONEYWELL SOFTWARE, on one computer or workstation, for your internal personal or commercial purposes, and not for re-sale or re-distribution.

You are specifically prohibited from making any additional copies of the HONEYWELL SOFTWARE, for charging for any copies, however made, and from distributing such copies with other products of any kind, commercial or otherwise, without prior written signed permission from Honeywell.

All rights of any kind in HONEYWELL SOFTWARE and all other rights of Honeywell, which are not expressly granted in this Agreement, are entirely and exclusively reserved to and by Honeywell. You may not rent, lease, copy, modify or translate HONEYWELL SOFTWARE, or create derivative works based on HONEYWELL SOFTWARE. You may not alter or remove any of Honeywell's or its licensor's copyright or proprietary rights notices or legends appearing on or in the HONEYWELL SOFTWARE. You may not reverse engineer, decompile or disassemble HONEYWELL SOFTWARE. You may not make access to HONEYWELL SOFTWARE available to any third party outside of your organization, nor are you authorized to make the output generated by HONEYWELL SOFTWARE available to others in connection with a service bureau, application service provider, or similar business. The HONEYWELL SOFTWARE is licensed as a single product. Its component parts may not be separated for use on more than one computer.

The HONEYWELL SOFTWARE may contain or be derived from materials of third party licensors. Such third party materials maybe subject to restrictions in addition to those listed in this Agreement, which restrictions, if any, are included in the documents accompanying such third party software. You agree that any third party supplier shall have the right to enforce this Agreement with respect to such third party's software.

Nothing in this Agreement shall restrict, limit or otherwise affect any rights or obligations you may have, or conditions to which you may be subject, under any applicable open source licenses to any open source code contained in the HONEYWELL SOFTWARE.

KEYS AND ACCESS: Honeywell shall provide you with any Software keys necessary to permit you to gain access to the HONEYWELL SOFTWARE contained on the media shipped or copy provided to you. You shall not disclose the Software keys to any other person or entity. You shall not circumvent, or attempt to circumvent, any license management, security devices, access logs, or other measures provided in connec-
tion with the HONEYWELL SOFTWARE, or permit or assist any other person or entity to do the same. You shall not attempt to modify, tamper with, reverse engineer, reverse compile or disassemble the keys. Upon your use of a new key for the HONEYWELL SOFTWARE, you represent and warrant that you will not use the superseded key to access the HONEYWELL SOFTWARE.

SUPPORT SERVICES: You may separately contract with Honeywell to receive support services related to the HONEYWELL SOFTWARE ("Support Services"), subject to and governed by the terms of a separate Support Services Agreement. Any supplemental software code provided to you as part of the Support Services shall be considered part of the HONEYWELL SOFTWARE and subject to the terms and conditions of this Agreement. With respect to technical information you provide to Honeywell as part of the Support Services, Honeywell may use such information for its business purposes, including for product support and development. Honeywell will not utilize such technical information in a form that personally identifies you.

In any event, you shall promptly report to Honeywell any errors or bugs with respect to your evaluation and use of the HONEYWELL SOFTWARE. In any such report, you agree to designate no more than two contacts who shall be responsible for communicating with Honeywell.

WARRANTY DISCLAIMERS AND LIABILITY LIMITATIONS: HONEYWELL SOFTWARE, AND ANY AND ALL ACCOMPANYING SOFTWARE, FILES, DATA AND MATERIALS, ARE DISTRIBUTED AND PROVIDED AS IS AND WITH NO WARRANTIES OR REPRESENTATIONS OF ANY KIND, WHETHER EXPRESS OR IMPLIED. HONEYWELL EXPRESSLY DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. The entire risk arising out of use or performance of HONEYWELL SOFTWARE remains with you.

THE MAXIMUM AGGREGATE CUMULATIVE LIABILITY OF HONEYWELL ARISING OUT OF OR RELATING TO YOUR USE OF HONEYWELL SOFTWARE OR OTHERWISE ARISING OUT OF OR RELATING TO THE TRANSACTIONS CONTEMPLATED BY THIS AGREEMENT (REGARDLESS OF LEGAL THEORY, WHETHER IN TORT, CONTRACT, OR OTHERWISE) WILL BE THE AMOUNT THAT YOU PAID FOR THE HONEYWELL SOFTWARE. IN ADDITION, IN NO EVENT SHALL HONEYWELL, OR ITS PRINCIPALS, SHAREHOLDERS, OFFICERS, EMPLOYEES, AFFILIATES, CONTRACTORS, SUBSIDIARIES, OR PARENT ORGANIZATIONS, BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE DAMAGES WHATSOEVER RELATING TO THE USE OF HONEYWELL SOFTWARE, OR TO YOUR RELATIONSHIP
WITH HONEYWELL, EVEN IF HONEYWELL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TERMINATION: The license granted in this Agreement becomes effective on the date you legally acquire the HONEYWELL SOFTWARE and will automatically terminate if you breach any of its terms or conditions, without prejudice to any other rights or remedies available to Honeywell. If the HONEYWELL SOFTWARE is provided to you on a subscription basis, then your right to posses or use the HONEYWELL SOFTWARE will terminate at the end of the applicable subscription period. Immediately upon termination or expiration of the license granted in this Agreement, you must destroy all copies of the HONEYWELL SOFTWARE and all of its component parts from your systems, and either return to Honeywell or destroy the original and any stand-alone copies of the HONEYWELL SOFTWARE and all of its component parts.

MISCELLANEOUS: You may not assign or transfer the license granted hereunder or the HONEYWELL SOFTWARE without Honeywell's prior written consent. Any assignment or transfer in contravention to the foregoing shall be null and void.

This Agreement is governed by the laws of the State of New York. Each of the parties hereto irrevocably consents to the jurisdiction of the Federal and state courts in New York, New York, to the exclusion of all other courts. If this product was acquired outside the United States, then local law may apply.

Honeywell has the right to audit your compliance with the terms and conditions of this Agreement, including without limitation, ensuring that you are not using more than one copy of the HONEYWELL SOFTWARE, or bypassing the software keys to engage in unauthorized, unlicensed use of the HONEYWELL SOFTWARE, and to immediately terminate your license in this Agreement if an audit shows that you are in breach with any of the terms and conditions of this Agreement, as well as to enforce all other rights and remedies available under this Agreement or otherwise under law or at equity.

The failure of Honeywell to enforce at any time any of the provisions of this Agreement shall not be construed to be a continuing waiver of any provisions hereunder nor shall any such failure prejudice the right of Honeywell to take any action in the future to enforce any provisions hereunder.

It is understood and agreed that, notwithstanding any other provisions of this Agreement, breach of any provision of this Agreement by you may cause Honeywell irreparable damage for which recovery of money damages would be inadequate, and that Honeywell shall therefore be entitled to obtain timely injunctive relief to protect Honeywell's rights under this
Agreement in addition to any and all remedies available at law.

Nothing contained herein shall be construed as creating any agency, employment, relationship, partnership, principal-agent or other form of joint enterprise between the parties.

The section headings appearing in this Agreement are inserted only as a matter of convenience and in no way define, limit, construe, or describe the scope or extent of such section or in any way affect this Agreement.

Whenever possible, each provision of this Agreement shall be interpreted in such manner as to be effective and valid under applicable law. But, if any provision of this Agreement is held to be invalid, illegal or unenforceable in any respect under any applicable law or rule in any jurisdiction, such invalidity, illegality or unenforceability shall not affect any other provision in that jurisdiction, but this Agreement shall be reformed, construed and enforced in such jurisdiction as if such invalid, illegal or unenforceable provision had never been contained herein. Further, such invalidity, illegality or unenforceability shall not affect any of the provisions in this Agreement in any other jurisdiction.

This Agreement constitutes the entire agreement between you and Honeywell and supersedes in their entirety any and all oral or written agreements previously existing between you and Honeywell with respect to the subject matter hereof. This Agreement may only be amended or supplemented by a writing that refers explicitly to this Agreement and that is signed by duly authorized representatives of you and Honeywell. The preprinted terms and conditions of any Purchase Order issued by you in connection with this Agreement shall not be binding to Honeywell and shall not be deemed to modify this Agreement.

Software and technical information delivered under this Agreement is subject to U.S. export control laws and may be subject to export or import regulations in other countries. You agree to strictly comply with all such laws and regulations, and you shall be solely responsible for obtaining any import, export, re-export approvals and licenses required for such software any technical information, and retaining documentation to support compliance with those laws and regulations.
CONTENTS

About this Guide 1
Scope .................................................................................................................. iii-1
Intended Audience ......................................................................................... iii-1
Prerequisite Skills ......................................................................................... iii-1
Structure of the Guide ..................................................................................... iii-1
Symbol Definitions ........................................................................................ iii-2
Contacts ............................................................................................................ iii-3

Chapter 1 Introduction
Overview of WIN-PAK .................................................................................... 1-2
WIN-PAK Components .................................................................................... 1-2
WIN-PAK Servers ............................................................................................ 1-2
WIN-PAK Client ............................................................................................... 1-2
WIN-PAK Features .......................................................................................... 1-3
Software Concepts .......................................................................................... 1-4
Abstract Devices .............................................................................................. 1-4
Floor Plan View ............................................................................................... 1-4
Badge ............................................................................................................... 1-4
Card and Card Holder ....................................................................................... 1-4
Intrusion Panels ............................................................................................... 1-4
Video Management Server ............................................................................... 1-4

Chapter 2 Installation
Introduction ....................................................................................................... 2-2
Overview ........................................................................................................ 2-2
WIN-PAK Architecture .................................................................................. 2-2
System Requirements .................................................................................... 2-3
Hardware Requirements ................................................................................ 2-3
Video Capture Card ........................................................................................ 2-3
Modems and Communication Ports .............................................................. 2-4
Badging Printers ............................................................................................. 2-4
Report Printers ............................................................................................... 2-4
Panel Firmware ................................................................................................ 2-4
DVR/NVR Firmware ....................................................................................... 2-4
Software Requirements ................................................................................ 2-4
System Prerequisites ..................................................................................... 2-5
Stand-alone Systems ..................................................................................... 2-5
Networked Systems ....................................................................................... 2-5
Installation and Upgrades ............................................................................ 2-6
Overview ........................................................................................................ 2-6
Installing WIN-PAK ....................................................................................... 2-6
Installing SQL Express 2008 R2 .................................................................. 2-9
Installing Complete WIN-PAK ...................................................................... 2-11
Installing Video Management Server ........................................................... 2-14
Chapter 3 User Interface

Introduction ................................................................................................................. 3-2
WIN-PAK User Interface Elements ............................................................................. 3-2
Logging on to WIN-PAK .............................................................................................. 3-2
Knowing more about the User Interface ..................................................................... 3-3
WIN-PAK Windows ....................................................................................................... 3-3
The Main Window ......................................................................................................... 3-3
Tree Window ................................................................................................................... 3-11
WIN-PAK Help .............................................................................................................. 3-11
Accessing the Online Help ............................................................................................ 3-12
Accessing Help on Web .................................................................................................. 3-12
Knowing more about WIN-PAK .................................................................................. 3-12

Chapter 4 Getting Started

Introduction .................................................................................................................... 4-2
Remote Client Server Configuration ............................................................................. 4-2
Domain Environment ..................................................................................................... 4-2
Adding Domain Users ................................................................................................... 4-2
Configuring the Log On Property of WIN-PAK Servers ............................................... 4-3
Setting the Domain Environment ............................................................................... 4-3
Firewall Exception Settings .......................................................................................... 4-5
Unblocking WIN-PAK Services on Windows XP SP2 .................................................... 4-6
Disabling Firewall in Windows 2003 Server/Windows 2008 Server/Windows 7 ........ 4-9
Enabling Ports in Windows XP ..................................................................................... 4-9
Video Management Server Services and Ports ............................................................. 4-10
WorkGroup Environment ............................................................................................ 4-11
Comparison between Domain and Workgroup Environment ..................................... 4-11
System Manager .......................................................................................................... 4-12
Setting RPC Endpoints ............................................................................................... 4-12
Setting the User Interface Workstation ...................................................................... 4-13
Service Manager ........................................................................................................... 4-14
User Interface ............................................................................................................... 4-14
Logging On .................................................................................................................... 4-15
Logging Off ..................................................................................................................... 4-15
Quitting WIN-PAK .......................................................................................................... 4-16
## Chapter 5  System Settings

**Overview** ................................................................. 5-2

**Accounts** ........................................................................... 5-2
- Adding an Account.......................................................... 5-2
- Selecting an Account....................................................... 5-4
- Editing an Account.......................................................... 5-5
- Deleting an Account......................................................... 5-5

**Administrators** ............................................................... 5-5

**Operators** ........................................................................ 5-7
- **Operator Levels** .......................................................... 5-7
  - Adding an Operator Level............................................. 5-8
  - Configuring Operator Levels........................................ 5-8
  - Copying an Operator Level............................................ 5-12
  - Editing an Operator Level............................................. 5-13
  - Isolating and Deleting an Operator Level..................... 5-13
- **Defining Operators** ..................................................... 5-14
  - Adding an Operator..................................................... 5-14
  - Tips on Password......................................................... 5-16
  - Editing an Operator..................................................... 5-17
  - Searching and Sorting Operators............................... 5-17
  - Deleting an Operator.................................................. 5-18
- **Default Settings** ......................................................... 5-19
  - Setting Workstation Defaults..................................... 5-19
  - Setting System Defaults.............................................. 5-25

## Chapter 6  Quick Configuration

**Quick Start Wizard** ........................................................... 6-2
- **Overview** ....................................................................... 6-2
  - Configuration Options.................................................. 6-2
  - Launching the Quick Start Wizard................................. 6-2
- **Creating an Account** .................................................... 6-2
- **Associating Time Zones to Accounts** .......................... 6-3
- **Adding a New Site** ....................................................... 6-4
- **Adding a Loop to a Site** .............................................. 6-5
- **Adding a Panel** ............................................................ 6-8
- **Adding Readers to a P-Series Panel** ............................ 6-9
- **Saving the Configuration** ............................................ 6-10

## Chapter 7  Badge Layout

**Introduction** ..................................................................... 7-2

**Configuring a Badge Layout** ........................................... 7-2
- Selecting the Account...................................................... 7-2
- Adding a New Badge Layout.......................................... 7-2
- Searching and Sorting Badge Layouts............................ 7-4
- Copying a Badge Layout.................................................. 7-5
- Editing a Badge Layout.................................................... 7-5
- Viewing a Badge Layout.................................................. 7-5
- Isolating and deleting a Badge Layout............................ 7-5

**Creating Badge Designs** .................................................. 7-6
- **Overview** ...................................................................... 7-6
- Know more about the Badge Definition window.............. 7-6
- Changing the Ruler Measurement..................................... 7-7
- Setting the printable size of the badge........................... 7-7
- Adjusting the Zoom factor.............................................. 7-8
- Specifying Grid Settings.................................................. 7-9
- Setting Blockouts............................................................. 7-9
- Setting a Badge Background.......................................... 7-10
Chapter 8  Card Holders

Overview .................................................................................................................. 8-2
Configuring Additional Information ........................................................................ 8-2
Selecting an Account ................................................................................................. 8-3
Configuring Note Field Template .............................................................................. 8-3
Adding a Note Field Template .................................................................................. 8-3
Searching and Sorting Note Field Templates ......................................................... 8-4
Isolating and Deleting a Note Field Template ........................................................ 8-5
Configuring Card Holder Tab Layout ........................................................................ 8-7
Adding a Card Holder Tab Layout .......................................................................... 8-7
Rearranging the Card Holder Tab Layouts ............................................................... 8-8
Configuring Autocard Lookup .................................................................................. 8-8
Configuring Access Levels ....................................................................................... 8-9
Adding a New Access Level ..................................................................................... 8-9
Configuring Access Area ......................................................................................... 8-10
Configuring Card and Card Holder Information .................................................... 8-13
Adding a Card and Card Holder Information .......................................................... 8-13
Adding a Card Holder .............................................................................................. 8-13
Editing Card Holder Information .............................................................................. 8-23
Deleting a Card Holder ............................................................................................ 8-24
Adding a Card ........................................................................................................... 8-24
Editing a Card ........................................................................................................... 8-30
Deleting a Card .......................................................................................................... 8-30
Adding Bulk Cards .................................................................................................. 8-30
Deleting Cards in Bulk ............................................................................................ 8-31
Assigning a Card to a Card Holder .......................................................................... 8-32
Importing Card and Card Holder Information ....................................................... 8-32
Logging on to Import Utility .................................................................................... 8-32
Defining Order of Fields ........................................................................................... 8-33
Entering Card and Card Holder Information in an Excel Sheet ......................... 8-33
Assigning Default Values ....................................................................................... 8-34
Importing from Excel Sheet .................................................................................... 8-35
Correcting Errors in Excel Sheet ............................................................................. 8-36
Visitor Management ............................................................................................... 8-38
Integrating LobbyWorks .......................................................................................... 8-38
Setting Key Values .................................................................................................. 8-38

Chapter 9  Time Management

Introduction ............................................................................................................... 9-2
Time Zone ................................................................................................................ 9-3
Adding a Time Zone ................................................................................................. 9-3
Editing a Time Zone ................................................................................................. 9-5
Isolating and Deleting a Time Zone ......................................................................... 9-5
Isolating a Time Zone .............................................................................................. 9-5
Deleting a Time Zone .............................................................................................. 9-7
Schedule .................................................................................................................. 9-8
Scheduling a Task ..................................................................................................... 9-8
Task Type .................................................................................................................. 9-10
Editing a Schedule ................................................................................................. 9-19
Chapter 10 Device Map

Introduction .................................................................................................................. 10-2
  Device Map Structure .................................................................................................. 10-2
  Physical Devices and Abstract Devices ....................................................................... 10-2
  Servers and Devices ..................................................................................................... 10-2
  Interacting with Intrusion Panels ............................................................................... 10-3
  Interacting with Cameras ............................................................................................. 10-4
Server Configuration ..................................................................................................... 10-4
  Communication Server ............................................................................................... 10-4
    Adding a Communication Server .............................................................................. 10-4
    Editing a Communication Server ............................................................................ 10-6
    Isolating and deleting a Communication Server ....................................................... 10-6
  Command File Server ................................................................................................. 10-8
    Adding a Command File Server ............................................................................... 10-8
    Editing a Command File Server .............................................................................. 10-9
    Isolating and Deleting a Command File Server ....................................................... 10-10
Guard Tour Server ....................................................................................................... 10-11
  Adding a Guard Tour Server ..................................................................................... 10-11
  Editing a Guard Tour Server ..................................................................................... 10-12
  Isolating and deleting a Guard Tour Server ............................................................... 10-13
Schedule Server .......................................................................................................... 10-14
  Adding a Schedule Server ......................................................................................... 10-14
  Editing a Schedule Server ......................................................................................... 10-15
  Isolating and deleting a Schedule Server ................................................................... 10-16
Tracking and Muster Server ......................................................................................... 10-17
  Adding a Tracking and Muster Server ...................................................................... 10-17
  Editing a Tracking and Muster Server ...................................................................... 10-18
  Isolating and Deleting a Tracking and Muster Server ............................................... 10-19
Communication Loops .................................................................................................. 10-20
  C-100 Panel Loop ....................................................................................................... 10-20
    Adding a C-100 Panel Loop ..................................................................................... 10-20
    Editing a C-100 Panel Loop ..................................................................................... 10-22
    Isolating and Deleting a C-100 Panel Loop ............................................................. 10-23
  485/PCI Panel Loop ...................................................................................................... 10-25
    Adding a 485/PCI Panel Loop .................................................................................. 10-25
    Editing a 485/PCI Panel Loop .................................................................................. 10-27
    Isolating and deleting a 485/PCI Panel Loop ............................................................ 10-27
  RS-232 Panel Loop ...................................................................................................... 10-29
    Adding an RS-232 Panel Loop .................................................................................. 10-29
    Editing an RS-232 Panel Loop .................................................................................. 10-31
    Isolating and deleting an RS-232 Panel Loop ............................................................ 10-32
  P-Series Panel Loop .................................................................................................... 10-33
    Adding a P-Series Panel Loop .................................................................................. 10-33
    Editing a P-Series Panel Loop .................................................................................. 10-34
    Isolating and deleting a P-Series Panel Loop ............................................................ 10-35
Video Management System .......................................................................................... 10-37
  Add or Edit a Video Management Server ................................................................... 10-37
  Connect ....................................................................................................................... 10-38
  Synchronize Event Types ............................................................................................ 10-38
Adding a Recorder ........................................................................................................ 10-39
   Recorder Configuration .................................................................................. 10-39
   Editing a Recorder ..................................................................................... 10-45
   Deleting a Recorder .................................................................................... 10-45
   Camera Configuration ................................................................................... 10-45
   Associate a recorder to a video input device ........................................... 10-47
   Input Configuration ....................................................................................... 10-50
   Output Configuration ...................................................................................... 10-52
Deleting a Video Management Server ................................................................. 10-53
Modem Pools ....................................................................................................... 10-53
   Adding a Modem Pool ................................................................................... 10-54
   Editing a Modem Pool ................................................................................... 10-56
   Isolating and deleting a Modem Pool ............................................................ 10-56
   Isolating a Modem Pool ................................................................................. 10-56
   Deleting a Modem Pool ............................................................................... 10-57
C-100 or 485 (non-ACK/NAK) Remote Communication Loop ................................... 10-57
   Adding a C-100 or 485 (non-ACK/NAK) Remote Communication Loop .......... 10-57
   Editing a C-100 or 485 (non-ACK/NAK) Remote Communication Loop ........... 10-59
   Isolating and deleting a non-ACK/NAK Remote Communication Loop .......... 10-59
485 ACK-NAK Remote Communication Loop .......................................................... 10-60
   Adding a 485 ACK-NAK Remote Communication Loop ................................... 10-60
   Editing a 485 ACK/NAK Remote Communication Loop .................................. 10-62
   Isolating and deleting a 485 ACK/NAK Remote Communication Loop ............ 10-63
CCTV Switcher ...................................................................................................... 10-64
   Adding a CCTV Switcher .................................................................................. 10-64
   Editing a CCTV Switcher ............................................................................... 10-67
   Isolating and deleting a CCTV Switcher .......................................................... 10-67
   Isolating a CCTV switcher ............................................................................. 10-67
   Deleting a CCTV switcher ............................................................................. 10-68
RS-232 Connection .............................................................................................. 10-69
   Adding an RS-232 Connection ...................................................................... 10-69
   Editing an RS-232 Connection ...................................................................... 10-70
   Isolating and deleting an RS-232 Connection ................................................. 10-70
   Isolating an RS-232 connection .................................................................... 10-70
   Deleting an RS-232 Connection .................................................................... 10-71
Ethernet Module (Galaxy Panel) .......................................................................... 10-71
   Adding a Galaxy Ethernet Module .................................................................. 10-71
Vista Panel Port (Home Automation Mode) .............................................................. 10-73
   Adding a Vista Panel Port .............................................................................. 10-74
Panel Configuration ............................................................................................. 10-75
   Adding an N-1000/PW-2000 Panel ............................................................... 10-76
   Adding a NS2+ Panel .................................................................................... 10-89
      Interlocking ............................................................................................... 10-101
      Interlocking Examples .............................................................................. 10-102
   Adding a P-Series Panel .............................................................................. 10-102
      Setting Up a Direct Connection ................................................................. 10-102
      Interlocking Points on SIO Board ............................................................. 10-117
      Door Interlocks .......................................................................................... 10-118
   Adding P-Series Panel in Modem Pool ............................................................ 10-125
   Adding a NetAXS Panel .................................................................................. 10-128
      Setting the Card Formats ........................................................................... 10-131
      Assigning Time zones and Holiday groups to the NetAXS panel ................ 10-133
      Setting the NetAXS Panel Options .............................................................. 10-134
      Configuring Inputs Points to the NetAXS panel ......................................... 10-137
      Configuring the Output Points to the NetAXS panel ................................... 10-139
      Configuring Groups to the NetAXS panel ............................................... 10-142
      Configuring Readers to the NetAXS panel ................................................. 10-144
      Adding Downstream Devices .................................................................... 10-148
   Adding a Galaxy Panel .................................................................................... 10-151
   Right-Click Menu Options ............................................................................. 10-158
      Synchronizing with Galaxy Panel ............................................................. 10-158
Contents

Viewing Panel Configuration Details ................................................................. 10-159
Downloading Log Data .......................................................................................... 10-160
Uploading User Code .......................................................................................... 10-160
Uploading Date and Time ..................................................................................... 10-161
Working on Virtual Keypad .................................................................................. 10-161
Isolating and deleting a Vista Panel ...................................................................... 10-164
Editing a Vista Panel ............................................................................................ 10-168
Isolating and deleting a Galaxy Panel ................................................................... 10-168
Abstract Device ................................................................................................. 10-170
Configuring an Abstract Device ........................................................................... 10-170
Adding an Abstract Device .................................................................................. 10-170
Editing an Abstract Device ................................................................................. 10-175
Deleting an ADV ................................................................................................... 10-175
Action Group ........................................................................................................ 10-176
Viewing Action Group Details ............................................................................ 10-176
Editing an Action Group ...................................................................................... 10-177
Copying an Action Group ................................................................................... 10-179
Deleting an Action Group ................................................................................... 10-179
ADV Action Groups ............................................................................................ 10-179
Moving Loops and Panels ................................................................................... 10-207
Copying Loops and Panels .................................................................................. 10-210
Initializing Panels ............................................................................................... 10-211

Chapter 11 Defining Areas

Introduction ........................................................................................................... 11-2
Defining Access Areas .......................................................................................... 11-3
Adding a Branch .................................................................................................. 11-3
Adding an Entrance ............................................................................................ 11-4
Moving an Entrance ............................................................................................ 11-5
Renaming a Branch ............................................................................................. 11-5
Removing a Branch or Entrance ....................................................................... 11-5
Defining Tracking and Mustering Areas .............................................................. 11-7
Configuring Tracking Areas ............................................................................... 11-9
Adding a Tracking Area Branch ......................................................................... 11-9
Adding an Entrance to the Tracking Area ......................................................... 11-10
Moving an Entrance ........................................................................................... 11-11
Renaming a Branch or an Entrance .................................................................. 11-11
Removing a Branch or an Entrance .................................................................. 11-12
Finding an Item in the tree .................................................................................. 11-12
Configuring Mustering Areas ............................................................................. 11-12
Adding a Mustering Area Branch ...................................................................... 11-12
Adding an Entrance to the Mustering Area ....................................................... 11-13
Moving an Entrance ........................................................................................... 11-14
Renaming a Branch or an Entrance .................................................................. 11-15
Removing a Branch or an Entrance .................................................................. 11-15
Finding an Item in the tree .................................................................................. 11-15
Tracking and Muster View .................................................................................. 11-15
Viewing the Tracking and Mustering details ..................................................... 11-16
Deleting a Card holder from the Tracking and Muster View .............................. 11-17
Printing Tracking and Mustering details ............................................................ 11-17
Defining Control Areas ....................................................................................... 11-20
Adding a Site ........................................................................................................ 11-20
Adding a Branch to a Site ................................................................................... 11-21
Renaming a Site or a Branch .............................................................................. 11-21
Adding a Device .................................................................................................. 11-22
Moving a Device .................................................................................................. 11-22
Removing a Site, Branch or Device ................................................................... 11-23
Chapter 12 Floor Plan

Introduction ........................................................................................................ 12-2
Floor Plan Definition .......................................................................................... 12-3
Adding a Floor Plan ............................................................................................ 12-3
Creating Floor Plan Design .................................................................................. 12-4
    Adding an ADV to the Floor Plan ...................................................................... 12-5
    Adding Links to other Floor Plans .................................................................... 12-10
    Adding Alarm View and Event View links to the Floor Plan ......................... 12-11
    Adding a Text Box to the Floor Plan ............................................................... 12-12
Adjusting the Size of the Floor Plan .................................................................. 12-13
Previewing the Floor Plan .................................................................................... 12-14
Working with Floor Plan Controls ...................................................................... 12-14
    Copying and Pasting a Control ....................................................................... 12-14
    Removing a Control from the Floor Plan ....................................................... 12-14
    Resizing, Rotating, and Re-arranging Objects .............................................. 12-14
Editing a Floor Plan ............................................................................................ 12-15
Deleting a Floor Plan ........................................................................................... 12-15
Floor Plan Operations ........................................................................................ 12-16
Working with Floor Plan Views ......................................................................... 12-16
    Opening a Floor Plan View ............................................................................ 12-16
    Resizing and Previewing Floor Plan Views ................................................... 12-17
Controlling System Devices from the Floor Plan .............................................. 12-18
Initializing Panels from Floor Plan ................................................................... 12-21
    Panel Initialization Options ........................................................................... 12-23
    Initializing Status ............................................................................................ 12-23

Chapter 13 Command File

Command File Configuration ............................................................................... 13-2
Adding a Command File ....................................................................................... 13-2
    Adding Commands to the Command File ..................................................... 13-3
    Adding a Custom Command .......................................................................... 13-4
    Editing a Command in the Command File .................................................... 13-4
Editing a Command File ..................................................................................... 13-4
List of Commands ............................................................................................... 13-6
Running a Command File .................................................................................... 13-10

Chapter 14 Guard Tour

Introduction ......................................................................................................... 14-2
Configuring Guard Tours ................................................................................... 14-3
Adding a Guard Tour ......................................................................................... 14-3
Adding Check Points ......................................................................................... 14-4
    Adding Sequenced Check Points ................................................................. 14-4
    Adding Unsequenced Check Points ............................................................ 14-6
Setting Check Point Alarms .............................................................................. 14-7
Running Guard Tours ....................................................................................... 14-9
Starting a Guard Tour ....................................................................................... 14-9
## Chapter 15 Monitoring Actions

**Introduction** ................................................................. 15-2

**Locate Card Holder** .......................................................... 15-2

**System Events** ............................................................... 15-3

  - Viewing System Events ...................................................... 15-3

**Event View** ................................................................. 15-4

  - Opening an Event View window ............................................. 15-4

  - Filtering Event Views ......................................................... 15-5

**Alarm View** ................................................................. 15-7

  - Opening an Alarm View Window ........................................... 15-7

  - Handling Alarms using the right-click menu options ................. 15-8

  - Handling Alarms using the Command buttons ............................... 15-9

  - Filtering Alarm Views ......................................................... 15-10

  - Viewing Alarm Details ....................................................... 15-11

**Autocard Lookup** ............................................................ 15-12

  - Activating Autocard Lookup ............................................... 15-13

**Live Monitor View** .......................................................... 15-14

  - Opening a Live Monitor View .............................................. 15-14

  - Capturing a Frame from the Live Monitor View ....................... 15-15

  - Controlling the Camera ..................................................... 15-15

  - Setting Pan and Tilt Limits .................................................. 15-16

  - Clearing Limits .................................................................... 15-16

  - Setting Home Position ....................................................... 15-16

**Digital Video** .............................................................. 15-17

  - Opening the Digital Video Display ....................................... 15-17

  - Video control options in panel toolbars ................................. 15-20

  - Context menu options ....................................................... 15-23

  - Filtering Events ............................................................... 15-24

**System Viewer Real Time** ................................................ 15-28

  - Opening the System Viewer Real Time window ......................... 15-28

## Chapter 16 Translation

**Introduction** ................................................................. 16-2

**Language Configuration** .................................................. 16-3

  - Adding or Editing Language Information ................................... 16-4

    - Adding a new Language .................................................. 16-4

    - Editing a Language .......................................................... 16-5

    - Deleting a Language ......................................................... 16-5

  - Selecting a language for translation ....................................... 16-7

    - Adding or editing entries for translating Dialogs, Menus, and Other Text ........................................................................ 16-7

      - Adding or Editing entries for dialog boxes ......................... 16-7

      - Adding or editing entries for menus .................................. 16-10

      - Adding or Entering Entries for other Text ............................. 16-11

## Chapter 17 Reports

**Introduction** ................................................................. 17-2

**Report Templates** ........................................................ 17-2

  - Defining Card Holder Report Templates .................................. 17-2

    - Adding a Card Holder Report Template ................................. 17-2

    - Editing a Card Holder Report Template ................................ 17-4

    - Searching a Card Holder Report Template ............................ 17-4

    - Deleting a Card Holder Report Template ............................... 17-4

  - Defining History Report Templates ........................................ 17-5

    - Adding a History Report Template .................................... 17-5

    - Editing a History Report Template .................................... 17-6

    - Searching a History Report Template .................................. 17-7
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting a History Report Template</td>
<td>17-7</td>
</tr>
<tr>
<td>Generating and Printing a Report</td>
<td>17-7</td>
</tr>
<tr>
<td>Access Area Report</td>
<td>17-13</td>
</tr>
<tr>
<td>Access Level Report</td>
<td>17-14</td>
</tr>
<tr>
<td>Account Report</td>
<td>17-15</td>
</tr>
<tr>
<td>ADV Actions</td>
<td>17-17</td>
</tr>
<tr>
<td>Attendance Report</td>
<td>17-19</td>
</tr>
<tr>
<td>Card Report</td>
<td>17-21</td>
</tr>
<tr>
<td>Card Frequency Report</td>
<td>17-23</td>
</tr>
<tr>
<td>Card History Report</td>
<td>17-26</td>
</tr>
<tr>
<td>Card Holder Report</td>
<td>17-29</td>
</tr>
<tr>
<td>Card Holder Tab Layout Report</td>
<td>17-33</td>
</tr>
<tr>
<td>Command File Report</td>
<td>17-34</td>
</tr>
<tr>
<td>Control Area Report</td>
<td>17-35</td>
</tr>
<tr>
<td>Device Map Report</td>
<td>17-36</td>
</tr>
<tr>
<td>Floor Plan Report</td>
<td>17-42</td>
</tr>
<tr>
<td>Galaxy Panel Log Report</td>
<td>17-44</td>
</tr>
<tr>
<td>Guard Tour Report</td>
<td>17-45</td>
</tr>
<tr>
<td>History Report</td>
<td>17-46</td>
</tr>
<tr>
<td>Holiday Group Report</td>
<td>17-50</td>
</tr>
<tr>
<td>Note Field Template Report</td>
<td>17-51</td>
</tr>
<tr>
<td>Operator Report</td>
<td>17-52</td>
</tr>
<tr>
<td>Operator Actions Report</td>
<td>17-53</td>
</tr>
<tr>
<td>Operator Level Report</td>
<td>17-56</td>
</tr>
<tr>
<td>Schedule Report</td>
<td>17-57</td>
</tr>
<tr>
<td>Time Zone Report</td>
<td>17-58</td>
</tr>
<tr>
<td>Tracking and Mustering Area Report</td>
<td>17-60</td>
</tr>
</tbody>
</table>

### Chapter 18 Import Utility

- Introduction                                                            18-2
- Defining Note Fields and Card Holder Tabs                              18-2
- Defining Sequence of Fields                                            18-2
- Creating the Excel Sheet                                               18-3
- Tips on entering card and card holder details in the excel sheet       18-3
- Assigning Default Values                                               18-4
- Importing Card and Card Holder Information                             18-4
- Correcting Errors in Excel Sheet                                       18-5

### Chapter 19 Appendix

- Cold Restart on Power-surge                                             A-1

### Chapter 20 Index
List of Tables

Chapter 1  Introduction

Chapter 2  Installation

Chapter 3  User Interface
  Toolbar Buttons ................................................................. 3-4
  Menu names and Shortcut Keys ......................................... 3-5
  Search and Sort Options and Actions ............................... 3-8
  Buttons and Descriptions ............................................... 3-9

Chapter 4  Getting Started
  Comparing the configuration between Domain Environment and Workgroup Environment ................................................. 4-11

Chapter 5  System Settings
  Describing options for setting defaults ............................ 5-20
  Describing instances for activating a sound file ............... 5-22
  Describing options for setting wallpaper ......................... 5-24
  Describing restore options for operators ....................... 5-25
  Describing the options for setting the defaults ................. 5-26
  Describing options for alarm settings ............................ 5-27

Chapter 6  Quick Configuration

Chapter 7  Badge Layout
  Live Screen Video Image Settings ...................................... 7-12
  Live Screen Grab Settings ............................................... 7-13
  Live Screen Photo Settings ............................................. 7-13
  Color Settings .................................................................. 7-15
  Characters printed using Datacard IC III printer ............... 7-16
  Style for Bar Codes ....................................................... 7-23

Chapter 8  Card Holders
  Describing mask properties with examples ...................... 8-4
  Live Screen Video Image Settings ...................................... 8-20
  Live Screen Grab Settings ............................................... 8-20
  Live Screen Photo Settings ............................................. 8-21
  Error types and Corrective Actions .................................. 8-37
Chapter 9   Time Management
Describing Dial Remote Area commands................................................. 9-14

Chapter 10   Device Map
Explaining Shunt Time and Debounce Time........................................... 10-83
Describing the anti-passback options .................................................. 10-98
Describing the available actions for points........................................... 10-100
Describing the modes of input point.................................................... 10-111
Describing Input Circuit Types.............................................................. 10-111
Describing the Output Inverter settings ............................................... 10-113
Describing Control Flags ................................................................. 10-115
Describing Online Door Mode options ................................................. 10-116
Describing Zone properties ............................................................... 10-153
Describing Output Properties ............................................................. 10-154
Describing 485 ACK/NAK and 485 non-ACK/NAK (loop) Actions............ 10-178
Describing C-100 (loop) Actions......................................................... 10-178
Describing Camera (CCTV camera) Actions ........................................ 10-179
Describing Camera PTZ (CCTV camera) Actions .................................... 10-179
Describing Cards (Entrance Reader) Actions ....................................... 10-179
Describing Command File Server Actions .......................................... 10-180
Describing Communication Server Actions ......................................... 10-180
Describing Door (Entrance) Actions ................................................... 10-180
Describing Door Output Actions .......................................................... 10-181
Describing Group Actions ................................................................. 10-181
Describing Guard Tour Sequenced Group Actions ............................... 10-181
Describing Guard Tour Server Group Actions ...................................... 10-181
Describing Guard Tour Unsequenced Actions ...................................... 10-182
Describing Input Alarm Point (Input Supervised) Actions ....................... 10-182
Describing Modem Pool ACK/NAK Actions ......................................... 10-182
Describing Modem Pool non ACK/NAK Actions .................................... 10-182
Describing Monitor (CCTV Monitor) Actions ....................................... 10-182
Describing NS2+ Panel Actions ............................................................ 10-183
Describing N-1000-II/PW-2000-II Panel Actions .................................. 10-184
Describing N-1000-III/PW-2000-IV Panel Actions ................................. 10-184
Describing P-Series SIO Board Actions ............................................... 10-185
Describing P-Series Dial-Up Actions .................................................. 10-186
Describing P-Series Reader Actions .................................................... 10-187
Describing P-Series Input-Generic (Input P-Series Supervised) Actions .... 10-188
Describing P-Series Output (Output P-Series) Actions ........................... 10-188
Describing Galaxy Panel Action Groups .............................................. 10-189
Describing RS-232 Action Groups ........................................................ 10-190
Describing RS-232 Port (Single Panel) Action Groups ............................ 10-191
Describing Schedule Server Action Groups ......................................... 10-191
Describing Tracking Server Action Groups .......................................... 10-191
Describing Video Switcher (CCTV Switcher) Action Groups .................. 10-191
Describing Galaxy Communication Actions ........................................ 10-191
Describing Galaxy Group Actions ....................................................... 10-192
Describing Galaxy Keypad Actions ..................................................... 10-193
Describing Galaxy Keyprox Actions ..................................................... 10-193
Describing Fusion DVR Action Groups ................................................. 10-194
Describing HRDP DVR Action Groups ................................................ 10-195
Describing NetAXS Entrance Actions .................................................. 10-195
Describing NetAXS Group Actions ..................................................... 10-197
Chapter 17  Reports

Describing the filter options for Access Level report............................... 17-14
Describing the filter options for Account report..................................... 17-16
Describing the card holder filter options for Attendance report............. 17-20
Describing the options for filtering the card number.............................. 17-22
Describing the card options for filtering card events............................. 17-28
Describing the options for filtering card holders .................................. 17-30
Describing the options for filtering note fields ...................................... 17-30
Describing the options for filtering card holders .................................. 17-34
Describing the options for filtering floor plans ...................................... 17-43
Describing the options for filtering guard tours ..................................... 17-46
Describing the transaction types for filtering history details.................... 17-48
Describing the Alarm & Card options for filtering history details .......... 17-48
Describing the options for filtering holiday groups ............................... 17-51
Describing the options for filtering operators ...................................... 17-52
Defining toolbar buttons ....................................................................... 17-55
Describing the options for filtering operator levels ................................ 17-57
Describing the options for filtering schedules ....................................... 17-58
Describing the options for filtering time zones ...................................... 17-59
Describing the time zone options ........................................................... 17-60

Chapter 18  Import Utility

Chapter 19  Appendix

Chapter 20  Index
About this Guide

Scope

The WIN-PAK user’s guide helps you in installing, configuring, and using the WIN-PAK access control software. In addition, this guide includes the Special Applications section, which describes the configuration of the several other applications to use WIN-PAK.

This guide covers the features of all the following editions of WIN-PAK.

- Standard Edition (SE)
- Professional Edition (PE)
- Express Edition (XE)

Intended Audience

This guide is intended for the WIN-PAK Operators and Administrators.

Prerequisite Skills

Knowledge of Access Control System and its terminologies.

Structure of the Guide

The guide is divided into several chapters for better organization. The following table describes the details of what is covered in each chapter:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, Introduction</td>
<td>Gives an overview of WIN-PAK and explains the key software concepts and features.</td>
</tr>
<tr>
<td>Chapter 2, Installation</td>
<td>Covers the system requirements, installation procedures, licensing and registration information.</td>
</tr>
<tr>
<td>Chapter 3, User Interface</td>
<td>Explains the basic convention used in the user interface of the WIN-PAK software. This chapter also includes the procedures to access the Help.</td>
</tr>
<tr>
<td>Chapter 4, Getting Started</td>
<td>Explains the basic configuration details of the client and server. This helps you to get started with the WIN-PAK software. It also includes the configuration details of WIN-PAK services.</td>
</tr>
</tbody>
</table>
# Structure of the Guide

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 5, System Settings</td>
<td>Describes how to configure WIN-PAK users and to set or change the default settings of WIN-PAK.</td>
</tr>
<tr>
<td>Chapter 6, Quick Configuration</td>
<td>Comprises sections for configuring servers, panels, and readers using Quick Start wizard.</td>
</tr>
<tr>
<td>Chapter 7, Badging</td>
<td>Describes how to design a badge, configure the badge DLLs and the badge printer.</td>
</tr>
<tr>
<td>Chapter 8, Card Holders</td>
<td>Includes information on setting up the card holder template, card holders, cards, and assigning card holders to cards and badges. In addition, this chapter describes how to use the WIN-PAK Import Utility to import the card and card holder information to WIN-PAK from an Excel sheet.</td>
</tr>
<tr>
<td>Chapter 9, Time Management</td>
<td>Explains how to set time zones, schedule an event, and define holiday groups and daylight saving groups.</td>
</tr>
<tr>
<td>Chapter 10, Device Map</td>
<td>Comprises sections for configuring servers, panels, readers, and abstract devices and, in addition, includes instructions on how to monitor intrusions using the Galaxy and Vista Panels.</td>
</tr>
<tr>
<td>Chapter 11, Defining Areas</td>
<td>Describes how to define access areas, control areas and tracking and muster areas, control devices through the control map, and monitor card holder movement in the tracking and muster areas through the tracking and muster view.</td>
</tr>
<tr>
<td>Chapter 12, Floor Plan</td>
<td>Explains how to create floor plans and control devices from the floor plan view.</td>
</tr>
<tr>
<td>Chapter 13, Command File</td>
<td>Includes sections on defining commands, command files, and for controlling devices by executing the command files.</td>
</tr>
<tr>
<td>Chapter 14, Guard Tour</td>
<td>Describes how to define and run guard tours.</td>
</tr>
<tr>
<td>Chapter 15, Monitoring Actions</td>
<td>Explains the different ways available for tracking and monitoring events in the access control system.</td>
</tr>
<tr>
<td>Chapter 16, Translation</td>
<td>Describes how to translate the user interface using the language text file and on creating language files.</td>
</tr>
<tr>
<td>Chapter 17, Reports</td>
<td>Assists you in generating the variety of reports that can be exported, viewed, or printed.</td>
</tr>
<tr>
<td>Appendix</td>
<td>Includes a section on performing a cold restart of the access control panel in the event of the power surge.</td>
</tr>
</tbody>
</table>
Symbol Definitions

The following table lists the symbols used in this guide.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="note.png" alt="Note" /></td>
<td><strong>Note:</strong> Identifies information that requires special consideration.</td>
</tr>
<tr>
<td><img src="tip.png" alt="Tip" /></td>
<td><strong>Tip:</strong> Identifies advice or hints for the user, often in terms of performing a task.</td>
</tr>
<tr>
<td><img src="example.png" alt="Example" /></td>
<td><strong>Example:</strong> Identifies an example that complies with the concept.</td>
</tr>
<tr>
<td><img src="warning.png" alt="Warning" /></td>
<td><strong>Warning:</strong> Indicates a potentially hazardous situation, which if not avoided, could result in serious injury or death.</td>
</tr>
<tr>
<td><img src="caution.png" alt="Caution" /></td>
<td><strong>Caution:</strong> Indicates a situation which, if not avoided, may result in equipment or work (data) on the system being damaged or lost, or may result in the inability to properly operate the process.</td>
</tr>
</tbody>
</table>

Contacts

The following table lists the contact details for Honeywell Access Systems

<table>
<thead>
<tr>
<th>Honeywell Access Systems (USA)</th>
<th>Honeywell Access Systems (UK)</th>
</tr>
</thead>
<tbody>
<tr>
<td>135 West Forest Hill Avenue</td>
<td>Charles Avenue, Burgess Hill</td>
</tr>
<tr>
<td>Oak Creek, WI 53154</td>
<td>West Sussex, RH15 9UF</td>
</tr>
<tr>
<td>U.S.A</td>
<td>U.K.</td>
</tr>
</tbody>
</table>

**OFFICE HOURS:** 8 AM to 5 PM (CST)
**PHONE:** 414-766-1700
**FAX:** 414-766-1798
**URL:** http://www.honeywellaccess.com
**Technical Support:** 800-323-4576 (8AM EST – 7PM EST Monday - Friday)

**OFFICE HOURS:** 8 AM to 5 PM (CST)
**PHONE:** +44 (0)844 8000 235
**FAX:** +44 (0)1444 871074
Contacts
Introduction

In this chapter...

Overview of WIN-PAK 1-2
WIN-PAK Features 1-3
Software Concepts 1-4
Overview of WIN-PAK

WIN-PAK is a state-of-the-art access control software that is compatible with Microsoft Windows XP, Microsoft Windows 7 desktop operating systems and Microsoft Windows 2008 server-based operating system.

WIN-PAK uses access control mechanism to authenticate the employee access at security areas. Access is authenticated using access cards or key codes provided to the employees. In addition, the access control tracks the employee access, controls the entry and exit details, and generates reports of all access cards and keycode activities.

WIN-PAK Components

WIN-PAK is divided into three components: Database Server, Communication Server, and User Interface. These components can run either on a single computer or on multiple computers, allowing flexibility in configuring a networked system.

WIN-PAK Servers

Database Server

The database tables can store, organize, and retrieve data using the WIN-PAK Database Server. This data is accessible to Communication Server and User Interface for retrieving and generating the reports. The Database Server can be installed on the client computer or any other computer connected to the network.

Communication Server

The Communication Server sends the user Interface requests and the access transactions to the access control panel. The access control panel processes the transactions and sends the information to the Database Server for storage, and the responses are sent to the User Interface through the Communication Server. When the Communication Server sends information to the Database Server, it can receive a request from the User Interface. In these cases of conflict, the Communication Server considers the user request as a higher priority and temporarily stops the panel-database server communication till the time the user request is processed. The Communication Server can be installed on the client computer or any other computer connected to the network.

WIN-PAK Client

User Interface

The User Interface helps the WIN-PAK operators to communicate with the access control system. The User Interface can be installed on the computer where the Database Server or the Communication Server is installed or any other computer connected to the network.

You can run several client computers and can access the single Database Server simultaneously. The number of client computers depend on the license type that you procure WIN-PAK.
WIN-PAK Features

- **Installation**: Handles large and complex installations including the configuration of the WIN-PAK environment.
- **Secured Environment**: Supports Tracking and Mustering reporting to indicate the location of people for enabling the secured environment. Additionally, intrusions at different areas can be monitored, if you have the license for the Galaxy and/or Vista features in WIN-PAK.
- **WIN-PAK Services**: In addition to the database server and the communication server, WIN-PAK contains five other servers:
  - **Command File Server**: Text files containing device instructions are stored in the Command Files database. The commands in the command files can be sent to the devices automatically on receiving, acknowledging, or clearing an alarm. The command files can also be executed manually.
  - **Guard Tour server**: A Guard Tour is a defined series of check points a guard must activate within a given amount of time. The check points are readers or input points where the guard presents the card or presses the button.
  - **Muster Server**: A Muster Server is enabled in the event of an emergency and allows the card holders to swipe the readers. Muster areas are logical areas that contain readers to be used by the card holders, only if there is a call for muster (in the event of a disaster, for example).
  - **Schedule Server**: The Schedule server schedules the list of events to be performed at predetermined time and intervals such as hourly, daily, or monthly.
  - **Video Management Server**: This Video Management server provides interface to connect to various DVR's/NVR's. In addition, it also provides CCTV control with Live Monitor Display, PTZ control of cameras, Video Playback operations, and so on.

*Note*: The Video Management functionality is NOT applicable to WIN-PAK XE.

*Note*: The WIN-PAK services are installed when you install the Database Server or WIN-PAK with all the components. These services start automatically after successful completion of the installation.
Software Concepts

Abstract Devices
An abstract device is a logical representation of a physical device. The ADVs can be associated with any hardware device, including communication interfaces, panels, alarm points, entrances, and CCTV equipment. The ADVs help in monitoring the device status and controlling the actions of a physical device through the Control Map, Floor Plan, or Alarm View.

Floor Plan View
The Floor Plan provides a graphical representation of a building which includes the placement of the physical devices such as doors, panels, inputs, outputs, and CCTV equipment. The floor plans can also be a loop wiring diagram, a simple grid, or a picture of an area where the device is located. The floor plan views can be tailored to the specific needs of your access control system.

Badge
Badge is a template or a design for creating a card. WIN-PAK includes a full-featured badge layout utility for designing, creating, and printing badges. Badge design includes magnetic stripe encoding, barcoding, signatures, and so on.

Card and Card Holder
A card is an identity proof of a person and a card holder is a person who holds the card. Multiple cards can be assigned to a single card holder to provide different access.

Intrusion Panels
Galaxy and Vista are intrusion panels that enable you to monitor and control intrusions in your organization. To enable this feature in WIN-PAK, procure the license for the Galaxy panel and/or Vista panel from your Honeywell Access Systems representative.

Video Management Server
Note: The Video Management functionality is NOT applicable to WIN-PAK XE
The Video Management System (VMS) is an enterprise-class video management and storage solution. It is a truly hybrid solution which, enables you to operate the traditional analog and the network and IP based video equipment in the same surveillance network. Using the user interface, you can easily add cameras, recorders, and other devices. Monitoring locations is more effective through features like color correction, digital zoom, and others. Events such as failure of camera or loss of video can be logged. You can retrieve and view video pertaining to specific events. In addition, you can configure alarms to notify the operators when events are triggered.
Installation

In this chapter...

- Introduction: 2-2
- System Requirements: 2-3
- Installation and Upgrades: 2-6
- 2-22
Introduction

Overview
This chapter describes the step-by-step procedure for installing, uninstalling, and registering WIN-PAK. In addition, it provides the hardware and software requirements, and prerequisites for installing WIN-PAK.

The WIN-PAK installation setup installs the required components and programs depending on the type of installation. The WIN-PAK software is distributed on an auto-run DVD, with release notes and other technical documents.

WIN-PAK Architecture
WIN-PAK is a multi-tier, client-server distributed application, consisting of three primary modules: the Database Server, Communication Server, and User Interface.

- The WIN-PAK modules installed on different computers are networked and connected through RPC and LPC. This allows extremely flexible WIN-PAK program components to run as full services in Windows XP.
- The WIN-PAK software is shipped with debug versions of the services, which provide a console output window. However, avoid daily usage of these versions, as they are reserved for error isolation.
- WIN-PAK provides the System Manager utility to configure connection information. The System Manager directs the User Interface and other remote servers to the Database Server.
System Requirements

Hardware Requirements

This section provides you the list of hardware requirements for installing WIN-PAK.

- If you want to install WIN-PAK in a stand-alone computer that supports 1 to 10 readers, 250 cards, and 2 communication ports, your computer must fulfill the **minimum** requirements.
- If you want to install WIN-PAK in a computer that supports 1 to 100 readers, 5,000 cards, and 8 communication ports, your computer must fulfill the **recommended** requirements.
- If you want to install WIN-PAK in a computer that supports more than 100 readers, 50,000 cards and 255 communication ports, your computer must fulfill the **performance** requirements.

### Hardware Component

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum</th>
<th>Recommended</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Dual Core Intel® Xeon® W3503</td>
<td>Intel® Xeon® E5600 series</td>
<td>Intel® Xeon® X5600 series</td>
</tr>
<tr>
<td>CPU</td>
<td>2.4 GHz</td>
<td>2.4GHz</td>
<td>2.8GHz</td>
</tr>
<tr>
<td>RAM</td>
<td>2 Gigabytes(GB)</td>
<td>4 Gigabytes (GB)</td>
<td>8 Gigabytes (GB)</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>80 GB SATA with minimum 5 GB free space</td>
<td>250 GB SATA or SCSI</td>
<td>250GB SATA 7200 RPM</td>
</tr>
<tr>
<td>Serial communication ports</td>
<td>2</td>
<td>2</td>
<td>As per the requirement</td>
</tr>
<tr>
<td>Secondary Storage</td>
<td>Tape or DVD burner</td>
<td>Tape or DVD burner</td>
<td>Tape or DVD burner</td>
</tr>
<tr>
<td>Printer port</td>
<td>1 (2 if badging)</td>
<td>1 (2 if badging)</td>
<td>1 (2 if badging)</td>
</tr>
<tr>
<td>Monitor Display</td>
<td><strong>Size</strong>: 15 Inches SVGA</td>
<td><strong>Size</strong>: 17 Inches</td>
<td><strong>Size</strong>: 19 inch</td>
</tr>
<tr>
<td></td>
<td><strong>Resolution</strong>: 1024 x 768</td>
<td><strong>Resolution</strong>: 1024 x 768</td>
<td><strong>Resolution</strong>: 1024 x 768</td>
</tr>
<tr>
<td></td>
<td><strong>Colors</strong>: 256 color</td>
<td><strong>Colors</strong>: True color</td>
<td><strong>Color</strong>: True color</td>
</tr>
<tr>
<td>Graphics Card</td>
<td>NVS 300</td>
<td>NVS 300</td>
<td>NVS 300</td>
</tr>
<tr>
<td>Pointing Device</td>
<td>Mouse (USB preferred)</td>
<td>Mouse (USB preferred)</td>
<td>Mouse (USB)</td>
</tr>
</tbody>
</table>

**Video Capture Card**

A video capture card is required for transmitting the analog signals to digital signals and to send the source of video to a computer where WIN-PAK is installed. The source of video may be a CCTV switcher or any camera used for photo snapping. The video capture card can interact with the CCTV switcher and the video badge attached to the WIN-PAK software. However, a single computer supports only one video capture card.

Therefore, when both the CCTV switcher and video badging is used in a computer, the badging camera signal is routed to the CCTV switcher and back to the WIN-PAK software. Honeywell recommends PBVC17 video capture card.
Modems and Communication Ports

Modems and communication ports are required when the mode of communication between loop and server computer is dial-up. Modems and communication ports are supported by Windows 7 operating system and Win2008 server-based operating system.

Badging Printers

The Windows Operating System supports any type of badge printer. However, for two-sided PVC encoding or magnetic stripe encoding, the 3652-0001 series (Ultra Rio Pro or Rio Pro Duplex) printer is required.

Report Printers

The Windows Operating System supports any type of printer for printing the reports. However, for single-line printing a dot-matrix printer, such as the PB-PRINTER is sufficient.

Panel Firmware

The PW-2000 or N-1000 family of control panels must have firmware of version 8.02 or later. The NS2 and NS2+ must have firmware of version 1 or later (1.05.05 recommended) and the P-Series panels must have firmware version 1.04 or later. The NetAXS-123 and the NetAXS-4 panels must have a firmware of version 3.4 or later.

DVR/NVR Firmware

<table>
<thead>
<tr>
<th>DVR/NVR</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>RapidEye</td>
<td>V9.0.0.32, V10.0.0.24</td>
</tr>
<tr>
<td>MAXPRO NVR</td>
<td>1.0.0 Build 15</td>
</tr>
<tr>
<td>Fusion</td>
<td>4.5.1513</td>
</tr>
<tr>
<td>HRDP H.264</td>
<td>1.0.0.23</td>
</tr>
<tr>
<td>HRDP MPEG4</td>
<td>3.0.0.86_2.5.7.H53</td>
</tr>
</tbody>
</table>

Note: The Video Management functionality is NOT applicable to WIN-PAK XE.

Software Requirements

The following table lists the software requirements to install WIN-PAK on your computer:

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum</th>
<th>Recommended</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Microsoft Windows® 7 SP1</td>
<td>Microsoft Windows® 7 SP1 (64-bit)</td>
<td>Microsoft Windows® Server 2008 R2 SP1</td>
</tr>
</tbody>
</table>

Note: WIN-PAK also supports the following operating systems. Microsoft Windows® 2008 (32 & 64 bit OS), Microsoft Windows® 7 (32 & 64 bit OS) and Microsoft Windows® XP SP3.
### System Prerequisites

#### Stand-alone Systems

Before installing WIN-PAK, ensure that the following prerequisites are met:
- If the configuration is meant for Performance or Maximum, Microsoft SQL Server 2008 R2 is installed on the Database Server computer.
- A video capture card is installed on the badging workstation.
- Printer and printer drivers are installed.
- The energy management from the BIOS and the Operation system is disabled. If not, it may affect the installation and operation of WIN-PAK.
- TCP/IP protocol must be enabled for the proper functioning of the SQL Engine.
- Microsoft Loopback or Dial-up adapter is installed, if network card does not exist.

**Note:** WIN-PAK may not function properly with the earlier versions of Internet Explorer 5.5. Hence, Honeywell recommends you to install Internet Explorer 5.5 or later.

**Before beginning the installation:**
- Make a note of the CD Key, which is provided on the DVD case. This is required while installing WIN-PAK.
- Read the release notes on the WIN-PAK DVD for additional installation information and updates.

#### Networked Systems

Before installing WIN-PAK for the first time in the networked system, ensure that the following prerequisites are met in addition to the stand-alone systems prerequisites:
- Network cards are installed on a networked system. A standard Windows-compatible network card is adequate.
- Ensure that the client computer name is alphanumeric characters without spaces and the first character is always an alphabet (standard UNC connections).
- Ensure that an unrestricted, permanent path is established between the networked computers. Any firewalls, proxies, or routers between workstations must not restrict the communication.

---

**Components** | **Minimum** | **Recommended** | **Performance**
---|---|---|---

**Note:** Microsoft Windows® 2008 R2 SP1 64-bit is recommended for Video Management Server.
Installation and Upgrades

Overview

The WIN-PAK installation setup installs the required components and programs depending on the type of installation. The WIN-PAK software is distributed on an auto-run DVD, with release notes and other technical documents.

Installing WIN-PAK

To install WIN-PAK:

1. Insert the WIN-PAK DVD into the DVD drive. An installation browser opens. If the browser does not open, browse to the DVD folder and run the Setup.exe file.
2. Navigate to the initial installation screens and click Install Software to display the next screen.
3. Click Install/Upgrade WIN-PAK PE. Figure 2-1 appears.

   ![Figure 2-1 Welcome](image)

4. Click Next to continue installation. Figure 2-2 appears.
5. Click **Next** to verify that all the services are stopped. **Figure 2-3** appears followed by **Figure 2-4**.

6. Click **Next**. **Figure 2-5** appears.
Installation
Installation and Upgrades

Figure 2-5  End User License Agreement

7. Read the license agreement details and click Accept to accept the agreement. Figure 2-6 appears.

Figure 2-6  Type of Installation

8. Select the type of setup. The following table lists the available installations in WIN-PAK setup:

<table>
<thead>
<tr>
<th>Type of Setup</th>
<th>Installs...</th>
<th>Suitable when...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are installing WIN-PAK in a stand-alone computer, you can select the setup type as Complete Installation:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete Installation</td>
<td>All the WIN-PAK components such as client, server, support programs and so on.</td>
<td>Setting up in a stand-alone computer. Installing the Database Server for a networked system.</td>
<td>Installing User Interface</td>
</tr>
</tbody>
</table>
### Note:
- To protect the database files from the failure of the operating system, place them on a different drive partition.
- To isolate the database files from the database server, place them on a separate hard drive.
- Install the database file on the database server. This helps in effective usage of the WIN-PAK back up and restore option.
- The Video Management functionality is NOT applicable to WIN-PAK XE.

### Installing SQL Express 2008 R2

The following screen shown in [Figure 2-7](#) appears if you are installing SQL Express 2008 R2 on a fresh computer.
Figure 2-7  SQL Express 2008 R2 Installation

1. The following scenarios arise while installing SQL Express 2008 R2.

   If your computer does not have SQL Express 2008 R2 / earlier versions of SQL Express installed,
   
   • the Use existing SQL Server option is always disabled, and the Install SQL Express 2008 R2 is enabled.
      
      – Click Next. SQL Express 2008 is successfully installed. Figure 2-9 appears.

   If your computer has an existing version of SQL Express installed,
   
   • the Use existing SQL Server option is enabled, and the Install SQL Express 2008 R2 is enabled.
      
      – Select the Use existing SQL Server option, and select the SQL version from the Select SQL Version from the drop-down list.
      
      – Click Next. Figure 2-8 appears. Go to step 2.

Figure 2-8  SQL Server Authentication
2. The Instance Name, User Name, and Password appear by default. 
   **Note:** You can change the Instance Name and Password, but cannot change the User Name.

3. Click **Next**. SQL Express 2008 is successfully installed. **Figure 2-9** appears.

### Installing Complete WIN-PAK

You can install complete WIN-PAK, if you are installing WIN-PAK on a stand-alone computer. To install Complete WIN-PAK on your computer, perform the instructions given in “Installing WIN-PAK” on page 6 and follow these steps:

1. On the **WIN-PAK Setup Type** screen, select **Complete Installation** and click **Next**. The system checks for SQL Service status and displays the screen shown in **Figure 2-9**.

![Figure 2-9 Choose Destination Folder](image)

2. By default the installation path is C:\Program Files\WINPAKPRO. To change the path, click **Browse** and navigate to the destination folder.

3. Click **Next**. **Figure 2-10** appears displaying the WIN-PAK database file paths.
Installation
Installation and Upgrades

Figure 2-10  WIN-PAK Database path

4. To change the path, click Browse and navigate to the destination folder for each database file.
5. Click Next. Figure 2-11 appears.

Figure 2-11  WIN-PAK User Information

6. Type your Name, Company and CD Key details. The CD Key is available on the DVD case.
7. Click Next. The setup verifies the CD key and displays a message of its validity.

Figure 2-12  Validating the CD Key
8. Click OK. Figure 2-13 appears.

![Figure 2-13 Setup Type]

9. Select the Installation Mode as Install Automatically for auto-installation.
10. Click Next. A dialog box appears prompting you to create WIN-PAK shortcuts on your desktop.

![Figure 2-14 Prompt for creating Desktop Icons]

11. Click Yes to place icons on your desktop. Figure 2-15 summarizes the selected information.

![Figure 2-15 Start Copying Files]
12. If you want to change any settings, click **Back**. OR, click **Next** to start the installation.

![Setup Status](image)

**Figure 2-16 Setup Status**

13. After completing the installation, **Figure 2-17** appears.

![WIN-PAK Setup Completed](image)

**Figure 2-17 WIN-PAK Setup Completed**

14. Click **Yes, I want to restart my computer now** to restart your computer after installation.

    OR

    Click **No, I will restart my computer later** to complete the installation without restarting your computer.

15. Click **Finish** to complete the installation.

**Installing Video Management Server**

**Note:** The Video Management functionality is NOT applicable to WIN-PAK XE.
The Complete Installation installs the Video Management Server by default. However, clear the Video Management Server check box if you do not want to install the Video Management Server.

1. On the **WIN-PAK Setup Type** screen, select the **Video Management Server** check box and click **Next**. The system checks for SQL Service status and displays the screen shown in **Figure 2-18**.

![Figure 2-18 Validation of User Credentials](image)

**Figure 2-18 Validation of User Credentials**

2. From the **Domain Name/Host Name** list, select the domain name/host name of the video management server.

3. Type the **User Name** to access the video management server.

4. Type the **Password** to access the video management server.

5. Select the **Enable Auto Logon** check box to enable the system to auto logon each time the system restarts.

   **Note:** The system reboots several times to complete the Video Management Server installation.

6. Click **Next**. **Figure 2-19** appears.
Installation

Installation and Upgrades

Figure 2-19  Selecting the Device Drivers

7. Select the check boxes corresponding to DVRs under **Device Drivers** as applicable.
8. Click **Next**. Follow the steps from step onward in the **Installing Complete WIN-PAK** section to complete the installation.

Installing Database Server

You can install the database server on the computer connected to a network.

To install only the database server, perform the instructions given in the **Installing WIN-PAK** section and then follow these steps:

1. On the **WIN-PAK Setup Type** screen, select **Database Server Only** and click **Next**. The system checks for SQL Service status and displays screen shown in **Figure 2-20**.

![Figure 2-20 Choose Destination Path](image)

2. Click **Browse** to change the destination folder and click **Next** in each screen. The **WIN-PAK User Information** dialog box appears.
3. Type your **Name**, **Company** and **CD Key** details. The CD Key is available on the DVD case.
4. Click **Next**. The setup verifies the CD key and displays the message for validity.
5. Click **OK**. **Figure 2-21** appears.
6. Select the Installation Mode as **Install Automatically** for auto installation.

7. Click **Next**. A dialog box appears prompting you to create icons on the desktop.

8. Click **Yes** to place the icons on your desktop. The summary of the selected information displays as shown in **Figure 2-22**.

9. Click **Back** to change any installation settings, or click **Next**. The WIN-PAK software is installed and then **WIN-PAK Setup Complete** dialog box appears.

10. Click **Finish** to complete the installation.

**Installing User Interface**

The User Interface is installed at each workstation across the Local Area Network (LAN).

To install WIN-PAK User Interface only, perform the instructions given in **“Installing WIN-PAK”**, and follow these steps:
1. On the WIN-PAK Setup Type dialog box, select User Interface Only and click Next. The system checks for SQL Service status and displays the screen shown in Figure 2-23.

![Figure 2-23  Choose Destination Path](image)

2. Click Browse to change the destination folder and click Next in each screen. A dialog box appears prompting you to create icons on the desktop.

3. Click Yes to place the icons on your desktop. The summary of the selected information is displayed.

4. Click Back to change any installation settings, or click Next.

5. After the installation is complete, the WIN-PAK Setup Complete dialog box appears.

6. Click Finish to complete the installation.

### Installing User Interface and Communication Server

To install WIN-PAK User Interface and Communication Server, perform the instructions given in Installing WIN-PAK, and follow these steps:

1. On the WIN-PAK Setup Type dialog box, select User Interface and Comm Server and click Next. The system checks for SQL Service status and displays Figure 2-24.
Figure 2-24  Choose Destination Path

2. Click Browse to change the destination folder and click Next in each screen. A dialog box appears prompting you to create icons on the desktop.

3. Click Yes to place the icons on your desktop. The summary of the selected information is displayed.

4. Click Back to change any installation settings, or click Next.

5. After installation is complete, the WIN-PAK Setup Complete dialog box appears.

6. Click Finish to complete the installation and restart the computer.

Installing Communication Server

WIN-PAK supports installation of multiple communication servers across a network. After installing the Database Server and User Interface, you can install multiple communication servers depending on your licensing limit.

To install WIN-PAK Communication Server, perform the instructions given in Installing WIN-PAK, and follow these steps:

1. On the WIN-PAK Setup Type dialog box, select Communication Server and click Next. The system checks for SQL Service status and displays the WIN-PAK Destination Path dialog box.
Figure 2-25  Choose Destination Path

2. Click **Browse** to change the destination folder and click **Next** in each dialog box. A dialog box appears prompting you to create WIN-PAK icons on the desktop.

3. Click **Yes** to place the icons on your desktop. The summary of the selected information is displayed.

4. Click **Back** to change any installation settings, or click **Next**.

5. After the installation is complete, the **WIN-PAK Setup Complete** dialog box appears.

6. Click **Finish** to complete the installation and restart the computer.

Additional Installation Components

The WIN-PAK installation program installs several utilities during the normal installation process. These are supplied as re-distributable Microsoft packages and are deployed automatically based on the installed options. Each of these components is installed by a separate installation program that runs directly from the WIN-PAK CD.

While working with Windows XP operating systems, WIN-PAK installs the following external components:

External Components

The following is the list of external components that are installed during the WIN-PAK installation:

- Microsoft Data Access Components
- Sentinel Lock Drivers
- Crypkey Drivers
- Active Reports
- Topaz Signature Pad
- Videology drives for Badge print
- Microsoft Dot Net Framework 2.0
Microsoft Data Access Components
System Manager uses Microsoft Data Access Components (MDAC) for the DB server interface to the MDB file. Therefore, MDAC needs to be installed in your computer. However, MDAC is installed by default in all Operating Systems.

Sentinel: The Sentinel Hardware Lock Drivers
- Install the Sentinel Hardware Lock Drivers on the computer, where the Database Server is installed.

CrypKey: The CrypKey Licensing Drivers
- Install the CrypKey Licensing Drivers on the computer, where the Database Server is installed.

Foreign Language Installation
The WIN-PAK installation provides only the English version of these Microsoft modules. This may cause a problem, as the English version are not compatible with other language version of Windows operation system.

Upgrading WIN-PAK

Before upgrading WIN-PAK, take a backup copy of your database files. When prompted by the installation program, do not overwrite your existing database. In addition, make backup copies of your Floor Plan backgrounds, Card Holder photos, and signatures.

Also, before upgrading WIN-PAK, ensure to stop the WIN-PAK services and to quit all the Windows applications.

Migration Utility

Note: Migration is not applicable if you are installing WIN-PAK for the first time or for a site that does not have video devices

Migration tool is installed on the computer that has the WIN-PAK Database when you have opted to Install Video Management server during Installation.

Migration tool is needed when you upgrade from previous SE/PE versions of WIN-PAK, that is, Build 633.2 to 645.3 which has Video Devices to the latest WIN-PAK SE/PE 3.0 Build. This tool helps you to migrate any legacy video devices which were configured from Builds 633.2 onwards to the latest WIN-PAK SE/PE 3.0 Build.

Steps to run the Migration Tool: (Applicable when video devices are configured in legacy builds)

Scenario 1: Directly upgrading from Builds 633.2 onwards to Release 3 builds
1. While upgrading to Release 3 build, choose the Video Management Server option.
2. After the installation is finished, the WIN-PAK Migration Tool icon appears on your desktop.
3. Click the Migration Tool icon, the **Login Information** dialog box appears.

![Login Information]

Figure 2-26  Login Information

4. Type your user **Name** and **Password** (WIN-PAK user credentials) to open the tool. **Figure 2-27** appears listing all the communication servers available in WIN-PAK.

![Video Devices Migration Tool]

Figure 2-27  Video Devices Migration Tool

5. In the **Available comm server** list, select the communication server to which you want to associate all the video devices.

6. In the **Select Time Zone** list, select the time zone in which the recorders are available. By default the local time zone displays.

7. Click **Start Migration**. A progress bar appears displaying the status of migration. The “Migration Completed” message appears after the migration is successfully finished.

8. Close the Migration Tool and restart all WIN-PAK Services using the WIN-PAK Service Manager.

**Scenario 2: Upgrade through Backup & Restore Utility**

1. If you take a backup of the old database then, uninstall the old build and install the Release 3 build.

2. After restoring the old database into the Release 3 build, you must manually run the Migration tool to migrate the legacy video devices.
Scenario 3: Upgrading from Builds older than 633.2

- You must first upgrade the older build to build 633.2, and follow the procedure listed in Scenario 1.

**Licensing and Registration**

The WIN-PAK installation setup installs only the demo version. Though the demo version of WIN-PAK has no expiry date, it has the following limitations:

- Only a 10 card database can be maintained.
- You cannot add cards in bulk.
- You cannot print badges.

However, registering the software enables you to overcome the preceding limitations.

**Registering WIN-PAK**

Before you register the WIN-PAK software, make a note of the CD Key and Site Code. The CD Key number is located on the DVD case.

To view the Site Code:

1. Choose Help > License. Figure 2-28 appears.

![Figure 2-28 License](image)

2. Make a note of the Site Code. This is a unique number that identifies your computer.

**Registering WIN-PAK Online**

You can register your WIN-PAK software online. The registration can be done using the Honeywell Access Systems web site.

To register WIN-PAK online:

1. Open Internet Explorer, type www.honeywellaccess.com in the address bar, and then press Enter.

Or

Installation
Licensing and Registration

2. Choose **Support & Resources > Register Products**. The **Product Registration** page appears.

3. Click **Yes** to accept the License agreement. The **Site Information** page appears.

4. Enter the required details and click **Next**. The **Authorized Dealer Information** page appears.

5. Enter the dealer information and click **Next**. The **Enter the CD Key** page appears.

6. Select **WIN-PAK PRO** from the list of Honeywell products.

7. Type the **CD Key** in the provided box.

8. Click **Submit**. The **Site Key** is displayed.

9. Make a note of the **Site Key**. Close the browser and return to WIN-PAK.

10. In the **License** dialog box, type the **Site key** produced by the online registration.

11. Click **Save License Key**. This activates the license for WIN-PAK.

**Upgrading WIN-PAK License**

You can upgrade your WIN-PAK license to overcome the limitations of the WIN-PAK software.

Example: You may need to upgrade your WIN-PAK license from single-user license to multi-user license.

Before upgrading the license, get the new CD Key from Honeywell Access System Support Service.

To upgrade your WIN-PAK license:

1. Choose **Help > Honeywell Access Systems > License**. The **License** dialog box appears.

2. Type the new **CD Key**.

3. Click **Save CD Key**. This upgrades your license.

**Caution on License Files**

The encryption software writes files to your hard drive as part of licensing. Do NOT move or damage these license files, as it invalidate the license.

**De-fragmenting Disk Drive**

Any sort of moving or damaging license files, may invalidate your license. De-fragmentation is one of the actions that relocates the files.

**Warning:** Do not use Microsoft Disk Defragmenter for de-fragmenting

Norton Speed Disk is used for de-fragmenting a hard drive so that it may be used more efficiently. In doing so, certain disk files may be physically moved. This may invalidate your license. However, if you de-fragment using Speed Disk after enabling the following options, the license file remains valid:

1. Open Norton Speed Disk, select Options/Customize, and select **Unmovable Files** from the **File** menu.

2. Enter the *.ent, *.key, and *.rst files under **Unmovable Files**.

3. Choose **Files > Options > Optimization > Save** to save the new profile.

4. Run the Speed Disk.
User Interface

In this chapter...

Introduction 3-2
WIN-PAK User Interface Elements 3-2
WIN-PAK Help 3-11
Introduction

The WIN-PAK User Interface helps you to configure, monitor, and control the entities in the Access Control System.

The User Interface can be installed on the computer in which the Database Server resides, or on one or more computers connected to the Database Server on a network. Closing or quitting the User Interface does not stop the WIN-PAK operations, the Database Server, Communication server and the other services still continue to run.

This chapter describes how to log on to the WIN-PAK User Interface and its various elements. Elements in the User Interface include windows, menus, toolbars, and status bar. In addition, you can learn how open the WIN-PAK help.

WIN-PAK User Interface Elements

The elements in the WIN-PAK User Interface are:

- Windows
- Menu bar
- Toolbar
- Status bar

Logging on to WIN-PAK

To log on to WIN-PAK:

1. Double-click the WIN-PAK User Interface icon on your desktop. The Connect to Server dialog box appears.
2. Type the User Name and Password.
   
   See the section "Setting the User Interface Workstation" in Chapter 4 for more information on setting the database server.
3. Click Connect.
   
   The WIN-PAK - Account name - [Operator] window appears after you have logged on to the WIN-PAK application.
Knowing more about the User Interface

WIN-PAK User Interface Elements

Figure 3-1   GUI Elements in the WIN-PAK user interface

- Card and Cardholder icons in the toolbar.
- Sub-menu options in the Card menu.
- Options in the Cardholder sub-menu of the Configuration menu.

WIN-PAK Windows

The WIN-PAK user interface includes a single Main window, multiple Maintenance windows, and Tree windows.

The Main window displays as soon as you log on to the WIN-PAK user interface. It has the options for performing various operations in WIN-PAK.

The Maintenance windows help you to perform various operations for WIN-PAK entities.

The Tree windows help you to view the details of devices, ADVs, areas, and operator levels and their relationship in a graphical tree.

The Main Window

The Main Window consists of a Title bar, Menu bar, Toolbar, and the Resize buttons.

The title bar displays the following details.

- WIN-PAK
- Account
- Operator
- Watchdog Timer

The Watchdog Timer is represented by the blinking green sphere icon to the left of the Honeywell Access Systems logo on the toolbar. It sends continual pulses to the computer to verify that the connection to the server(s) is alive.
User Interface
WIN-PAK User Interface Elements

**Toolbar**

The toolbar appears below the menu bar in the Main window. The toolbar comprises the icons for the frequently used WIN-PAK operations.

The toolbar is displayed by default in the Main window. However, you can choose not to display the toolbar by clicking the Tool option in the View menu.

![Toolbar Image]

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Log In Icon]</td>
<td>Log In</td>
<td>Enables you to log on to WIN-PAK and connect to the WIN-PAK database server.</td>
</tr>
<tr>
<td>![Select Account Icon]</td>
<td>Select Account</td>
<td>Displays the Select Account dialog box, allowing an authorized operator to select an account.</td>
</tr>
<tr>
<td>![Dynamic Alarm View and Acknowledge Icon]</td>
<td>Dynamic Alarm View and Acknowledge</td>
<td>Opens the Alarm View window, which allows incoming alarms to be viewed, acknowledged, and cleared.</td>
</tr>
<tr>
<td>![View Events Icon]</td>
<td>View Events</td>
<td>Opens the Event View window, which displays the current system activity in real time.</td>
</tr>
<tr>
<td>![Control Map Icon]</td>
<td>Control Map</td>
<td>Opens the Control Map window, which can be used for controlling the devices and for providing an alternate means of acknowledging and clearing alarms.</td>
</tr>
<tr>
<td>![Run Command File Icon]</td>
<td>Run Command File</td>
<td>Displays the Run a Command File dialog box, enabling you to run command files containing device instructions.</td>
</tr>
<tr>
<td>![Open Floor Plan Icon]</td>
<td>Open Floor Plan</td>
<td>Opens the Open Floor Plan window, enabling you to open floor plans.</td>
</tr>
<tr>
<td>![Locate Last Card/Card Holder Transaction Icon]</td>
<td>Locate Last Card/Card Holder Transaction</td>
<td>Opens the Locate Card Holder dialog box, enabling you to search for a card by card holder name or card number and view the time and place where the card was used.</td>
</tr>
<tr>
<td>![Card Icon]</td>
<td>Card</td>
<td>Opens the Card window, enabling you to search and sort the card list and to add, edit, or delete cards.</td>
</tr>
<tr>
<td>![Card Holder Icon]</td>
<td>Card Holder</td>
<td>Opens the Card Holder window, enabling you to search and sort the cardholder list and to add, edit, or delete card holders.</td>
</tr>
<tr>
<td>![Add Card Holder Icon]</td>
<td>Add Card Holder</td>
<td>Opens the Card Holder window enabling you to add card holders.</td>
</tr>
</tbody>
</table>
Menu Bar
The menu bar appears at the top of the Main window and comprises menus to carry out various WIN-PAK operations.

Table 3-2 Menu names and Shortcut Keys

<table>
<thead>
<tr>
<th>Menu</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Alt + F</td>
<td>Contains options to configure printers, to log on and log off from the application, to quit from WIN-PAK, to view the reports window, and so on.</td>
</tr>
<tr>
<td>View</td>
<td>Alt + V</td>
<td>Enables you to disable or enable the toolbar and the status bar.</td>
</tr>
<tr>
<td>Account</td>
<td>Alt + A</td>
<td>Enables you to work with the accounts.</td>
</tr>
<tr>
<td>Operations</td>
<td>Alt + O</td>
<td>Enables you to perform various operations, such as viewing events, alarms, working with digital video, and so on.</td>
</tr>
<tr>
<td>Card</td>
<td>Alt + C</td>
<td>Contains options for working with access cards and access levels.</td>
</tr>
<tr>
<td>System</td>
<td>Alt + S</td>
<td>Contains options for setting system defaults.</td>
</tr>
<tr>
<td>Reports</td>
<td>Alt + R</td>
<td>Enables you to generate and view reports.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Alt + N</td>
<td>Contains options for setting general hardware configuration before working with WIN-PAK.</td>
</tr>
<tr>
<td>Window</td>
<td>Alt + W</td>
<td>Enables you to toggle between the multiple open windows.</td>
</tr>
<tr>
<td>Help</td>
<td>Alt + H</td>
<td>Contains options to view the online help.</td>
</tr>
</tbody>
</table>

Table 3-1 Toolbar Buttons

<table>
<thead>
<tr>
<th></th>
<th>Run Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Opens the <strong>Reports</strong> window, enabling you to generate, view, and print reports.</td>
</tr>
<tr>
<td></td>
<td>Help Topics</td>
<td>Opens the online help for WIN-PAK.</td>
</tr>
<tr>
<td></td>
<td>Auto-Logout from all servers</td>
<td>Logs the operator out of the user interface and all the servers.</td>
</tr>
</tbody>
</table>
User Interface
WIN-PAK User Interface Elements

2. Click the required option. The corresponding window appears.
   
   Example: To gain access to the Card Holder menu, click Card and then click Card Holder. The Card Holder window appears.

Using the keyboard,

1. Press Alt and the short key for the menu you want to access.
2. Press the underlined alphabet of the option you require.
   
   Example: To gain access to the Floor Plan menu, press <Alt>+O and then press F. The Open Floor Plan window appears.

Status Bar

The Status Bar is displayed at the bottom of the Main window. By default, the status bar is displayed in the window. However, you can choose not to display the status bar by clicking the Tool option in the View menu.

The Status bar displays the following information:

- The message For Help, press F1 at the left corner.
- A description of the option that you have highlighted in the menu or the toolbar.
- The messages for setting permissions and for establishing communication server connections when you log on to WIN-PAK.
- The message for disconnecting from the server when you log off from WIN-PAK.

Sub-menues and Pop-up menus on right-click

When you right-click in certain dialog boxes, a pop-up menu appears displaying a set of options specific to the dialog boxes.

Example:

2. Right-click Devices to display a sub-menu.
3. Move the mouse pointer on Add to display another sub menu.

![Figure 3-2 Sub menus and Pop-up menus](image)

Maintenance Window

The Maintenance window helps you to perform the following operations on various WIN-PAK entities:

- Adding, editing, deleting, and printing data.
- Searching for and sorting data.
- Viewing the details of previously entered data.
Opening the Maintenance Window

To open the Maintenance Window, choose the menu option or click the icon in the toolbar for the operation you want to perform. The corresponding Maintenance window appears.

For example, if you want to configure the Card Holder Tab Layout, choose Configuration > Card Holder > Card Holder Tab Layout. The Card Holder Tab Layout window appears, which enables you to add, edit, delete, view card holders in addition to other card holder operations.

Viewing Information

You can view the details of previously entered information in a Maintenance Window. The information is listed in a table in the window.

The following operations can be performed while viewing the list of records:

- To move through the list, use the scroll bars.
- To sort the list according to a particular column, click the column. The icon appears on the left of the column name and the list is sorted in the ascending order of the column.
  
  Example: If you want to sort the information based on First Name, click First Name. The icon appears on the left of First Name and the list is sorted in the ascending order, based on the column.

- To view the details of a specific record in the list, click the record and then select the Detail View check box. A dialog box displaying the details of the record appears towards the right of the Card dialog box. See Figure 3-4.

- To view the details of a specific record in the list,
  
  a. Click the entry and then select the Detail View check box or double-click the record. The following screen appears towards the right of the Maintenance window.
b. Click Close (X) on the top-right corner of the screen or clear the Detail View check box in the Maintenance Window to close the Detail View Card dialog box.

**Searching and Sorting**

You can search for and sort the details displayed in the list in a specific order using Search and Sort option in the Maintenance window.

![Search and Sort option](Figure 3-5)

**Table 3-3  Search and Sort Options and Actions**

<table>
<thead>
<tr>
<th>Options</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Select the item to be searched.</td>
</tr>
</tbody>
</table>
**Table 3-3  Search and Sort Options and Actions**

<table>
<thead>
<tr>
<th>Options</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Criteria</td>
<td>Select the criteria for search.</td>
</tr>
<tr>
<td>Search For</td>
<td>Type a letter, word, phrase, or numeric expression that you want to search.</td>
</tr>
<tr>
<td>Sort By</td>
<td>Select the field based on which the records in the list must be sorted. In addition, it indicates the order in which the search results are displayed.</td>
</tr>
<tr>
<td>Update List</td>
<td>Click this button to perform the search. In addition, this button updates the list with the sorted information.</td>
</tr>
</tbody>
</table>

**Adding, Editing, and Deleting records**

The action buttons provided under the Operations area of the Maintenance window enables you to add, edit, and delete records.

![Operations Area](image)

**Table 3-4  Buttons and Descriptions**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click this button to open a blank window for adding a new record.</td>
</tr>
<tr>
<td>Edit</td>
<td>Click this button to edit a selected record. An editable view of the selected record appears, where you can modify the details.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click this button to delete a selected record. A message asking for confirmation appears. Click Yes to delete the record.</td>
</tr>
</tbody>
</table>

**Isolating Records**

Before deleting a record, it is essential to isolate it from all its associations.

**Example:** To delete a time zone you must first remove its association from the panels, access levels, cards, operators, ADVs, or action groups where it is used.

1. To isolate a record, select the record in the list and then click Isolate. The Isolate dialog box appears.
User Interface
WIN-PAK User Interface Elements

The tabs in the Isolate dialog box indicate the various associations of the record that is deleted.

**Example:** Time zones can be applied to Cards, Action Groups, ADVs, Operators, and Panels and therefore appear as tabs in the Isolate dialog box.

2. Click each tab and dissociate the record by clicking **Delete** or **Delete All**. A message asking for confirmation appears.

3. Click **Yes** to confirm the deletion.

**Printing Details**

You can print the record list using the **Print Report** option provided in the Maintenance window.

1. In the Maintenance window, click **Print Report**. A dialog box for specifying the print settings appears.

2. Specify the settings for previewing or printing the required information in the report.

3. Click **Print** on the window to print a report.

**Toggle between Maintenance windows**

You can open more than one Maintenance window at the same time.

1. Open two or more Maintenance windows.

2. Choose **Window** in the menu and click the appropriate window to activate it. A tick mark is displayed to the left of the window name in the menu and the corresponding window is activated.

   **Example:**

   a. Open the Card and the Time Zone windows by choosing **Card > Card** and **Configuration > Time Management > Time Zone** from the menu.

   b. Choose **Windows** in the menu. The Card and Time Zone window names are listed in the menu.
c. To activate the **Card** window, click **Card**. Or to activate the **Time Zone** window, click **Time Zone**. A tick mark appears on the left of selected option in the menu indicating that the window is activated.

**Tree Window**

A Tree window enables you to view the details of devices, ADVs, areas, and operator levels and their relationship in a graphical tree. The tree organizes information into logical or geographical groups and is created as you program the access control system.

Six tree structures for Device Map, Control Map, Control Area, Access Area Map, Operator Level and Tracking Area Map are available in WIN-PAK. The tree structure for Device Map is defined, as and when devices are defined. The remaining tree structures define the hierarchy or relationship between the resources.

The status of the resources are indicated by Red and Green in the tree structure.

**Example:** In an access area, you can add entrances such as doors and readers to the tree structure.

- Choose **Configuration > Define > Access Areas**. The **Access Area** window appears.

![Access Area Window](image)

**Figure 3-8  Access Area**

- To expand the tree, click the plus sign (+) to the left of the folder. The branches corresponding to the selected folder are shown.
- To display only the top level information, collapse an opened tree by clicking the minus sign (-) to the left of a folder.
- The following colors indicate the access status of the entrances:

<table>
<thead>
<tr>
<th>Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Entrances having access in a selected access level.</td>
</tr>
<tr>
<td>Red</td>
<td>Entrances not having access.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Entrances having limited access.</td>
</tr>
</tbody>
</table>

**WIN-PAK Help**

This section describes how to open the help topics of WIN-PAK when you are working with the user interface.
Accessing the Online Help

To access the WIN-PAK Online Help, choose Help > Help Topics or press F1 on the keyboard.

Accessing Help on Web

You can access any information related to the Honeywell Access Systems from the web. Through the web site, you can view the Honeywell contact details and in addition, you can register WIN-PAK.

To access the Honeywell Access Systems website:


To view Honeywell contact details:

2. Click Contact Us. The contact details are displayed.
3. To obtain the contact details of a specific team, click the corresponding link.
   Example: If you want to obtain the contact details of technical support, click Tech Support.

Knowing more about WIN-PAK

To know about the copyright, build, and serial number details of WIN-PAK:

1. Choose Help > About WIN-PAK... The WIN-PAK Release 3.2 dialog box appears window appears with the details of the build number, copyright information, serial number, and URL of Honeywell Access Systems.
2. Click OK to close the window.
Getting Started

In this chapter...

- Introduction 4-2
- Remote Client Server Configuration 4-2
- System Manager 4-12
- Service Manager 4-14
- User Interface 4-14
Getting Started

Introduction

This chapter describes how to configure the client and the server, unblock the firewall protections, start and stop the WIN-PAK services, and to log on and log off from WIN-PAK.

Remote Client Server Configuration

WIN-PAK works both in Domain and Workgroup environment. You can set the client-server communication as per the requirement. However, the domain environment is set by default. After changing the settings, restart the servers and client for the changes to take effect.

Domain Environment

To work in a Domain Environment, you must add the domain users to the local System Administrator or Power Users Group and then unblock the WIN-PAK services from Firewall protection.

Adding Domain Users

To add the domain users:

1. Log on to the system as Administrator where WIN-PAK Servers are installed.
3. Choose System Tools > Local Users and Groups > Groups.

![Figure 4-1 Computer Management window](image)

5. Click **Add** to add domain users to the group.
6. Type the network domain name and user name in the DOMAIN\USER NAME format.

7. Click **OK**. The user is added to the Power Users group.
8. Click **OK** to save the Power User Properties.

**Configuring the Log On Property of WIN-PAK Servers**

Before you configure the Log on property of WIN-PAK servers, add the domain user to the local System Administrator or Power Users Group.

To configure the log on property of WIN-PAK Servers:

1. Click **Start > Settings > Control Panel** and open **Administrative Tools > Services**. The **Services** window appears.

   By default, the **Log On As** property is **Local System** for all the WIN-PAK servers.
2. Select and double-click the required WIN-PAK Server from the right pane of the Services window. The WIN-PAK Server Properties window appears.

3. Click the Log On tab.

4. Click This Account. By default, Local System account is selected.

5. Enter the domain user account or click Browse to select the user account. The domain user account is added to the System Administrator or Power User group in the Adding Domain Users section in this chapter.

6. Type your Password and re-enter the password for confirmation in Confirm password.
7. Click **OK** to save the changes.

    Follow the same procedure for setting the **Log On As** property of all the other WIN-PAK Servers.
    - Restart the system to see the changes.
    - Log on to WIN-PAK Server System using any account; local or domain. However, the client system must be logged on with the domain user account.

### Setting the Domain Environment

To set the domain environment:

1. Choose **Start > Programs > Honeywell Access Systems > System Manager**. The **System Manager** window appears.

    ![System Manager](image)

    **Figure 4-7  System Manager**

    2. Click **DOMAIN Environment (Recommended)** and click **OK**. This sets the Domain Environment.

### Firewall Exception Settings

The Windows Firewall protection system blocks the WIN-PAK services in a networked system. Therefore, you must unblock the WIN-PAK services before using WIN-PAK.
Unblocking WIN-PAK Services on Windows XP SP2

WIN-PAK services can be unblocked, only if the Windows Firewall status is set to **On**. Therefore, check the firewall status in the **Windows Firewall** dialog box.

To check Firewall Status and unblock WIN-PAK Services:

1. Click **Start > Settings > Control Panel** and open **Windows Firewall**. The **Windows Firewall** dialog box appears.
2. Check the status of Windows Firewall. If the option **Off (not recommended)** is set, no need of proceeding further.
3. Click the **Exceptions** tab and click **Add Program...** to add the WIN-PAK services as exceptions from Windows Firewall protection. The **Add Program** dialog box appears.

*Figure 4-8  Windows Firewall window*
4. Select the following WIN-PAK services and click **OK**.
   - WIN-PAK User Interface
   - NCIArchive
   - NCICore
   - WP CmdFile Service
   - WP Communications Server
   - WP GuardTour Service
   - WP Muster Service
   - WP Schedule Service
   - Trinity.SystemServices.exe
   - Trinity.Controller.exe

   If you do not find the service in the **Programs** list, click **Browse** to locate the service.
5. Click the NCICore check box to unblock the WIN-PAK Database Server.

6. Click OK to save the exceptions for Windows Firewall.

The procedure for Unblocking the WIN-PAK Services in Window 7 and Windows 2008 Server operating system is similar to that of Windows XP.
Tip: See the following figures and unblock the WIN-PAK Services in Windows 7 and Windows 2008 Server respectively.

Disabling Firewall in Windows 2003 Server/Windows 2008 Server/Windows 7

The Windows Firewall must be disabled to access the services. Therefore, check the firewall status in the Windows Firewall dialog box.

Enabling Ports in Windows XP

Communication ports in a Windows XP operating system are disabled for security reasons by Windows Firewall. These ports must be enabled for remote communication to the Galaxy panel.

To enable ports in the Windows Firewall:

1. Click Start > Settings > Control Panel and open Windows Firewall. The Windows Firewall dialog box appears.
2. Click the Exceptions tab and click Add Port. The Add a Port dialog box appears.
Getting Started
Remote Client Server Configuration

Figure 4-14   Add a Port

3. Type the **Name** of the port and the **Port Number**.
4. Click **TCP** or **UDP** to select the type of port.
5. Click **OK** to open the port.

**Note:**
- Repeat the above procedure for enabling three ports in the system, where one port is used by Galaxy Gold and the remaining two ports are used by the Galaxy panel for reporting alarms and control commands.
- In the same way, the 3001 or 2101 ports must be enabled for the TCP/IP communication of the access panels.

**Video Management Server Services and Ports**

The following services must be excluded in Firewall settings for Video Management Server.
- Trinity.SystemServices.exe
- Trinity.Controller.exe

The following ports must be enabled and opened in Firewall settings for Video Management Server.

<table>
<thead>
<tr>
<th>Name</th>
<th>Port Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trinity Server</td>
<td>20007</td>
</tr>
<tr>
<td>Trinity Controller</td>
<td>26026</td>
</tr>
<tr>
<td>Trinity Scheduler</td>
<td>20010</td>
</tr>
<tr>
<td>RapidEye DVR</td>
<td>10000</td>
</tr>
<tr>
<td>Fusion DVR</td>
<td>4000</td>
</tr>
<tr>
<td>HRDP</td>
<td>4000, 7001</td>
</tr>
<tr>
<td>MAXPRO NVR</td>
<td>20007, 26026</td>
</tr>
</tbody>
</table>
WorkGroup Environment

To work in a Workgroup Environment, you must set the workgroup environment and then unblock the WIN-PAK services from Firewall protection.

To set the workgroup environment:

1. Click Start > Programs > Honeywell Access Systems > System Manager. The System Manager window appears.

2. Click the RPC Security Options tab.


See the Unblocking WIN-PAK Services on Windows XP SP2 or Disabling Firewall in Windows 2003 Server/Windows 2008 Server/Windows 7 sections in this chapter for unblocking firewall.

Comparison between Domain and Workgroup Environment

The following table compares the configuration between Domain Environment and Workgroup Environment:

<table>
<thead>
<tr>
<th>Configuration Type</th>
<th>DOMAIN Environment</th>
<th>WORKGROUP Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication</td>
<td>The Servers and Clients communicate using the secure RPC connection.</td>
<td>The server and client communicate using an anonymous communication protocol.</td>
</tr>
</tbody>
</table>
The System Manager is a utility in WIN-PAK to locate its various software components. The machine name and protocol end point for each program component is displayed in the System Manager. Honeywell recommends you to retain the default settings.

**Setting RPC Endpoints**

To set the database server and database archive server RPC endpoints:

1. Click **Start > Programs > Honeywell Access Systems > WIN-PAK System Manager**. The **System Manager** window appears.

2. Click the **Database Server** tab.

3. Type the **RPC Endpoint** value. This is the same as TCP/IP port address, which is 5555.
4. Click the **Database Archive Server** tab.
5. Type the **RPC Endpoint** value. This is the same as TCP/IP port address, which is 5556.
6. Click **OK** to save the changes.

### Setting the User Interface Workstation

Ensure that you quit the WIN-PAK User Interface, before setting the User Interface workstation.

To set the user interface workstation:

1. Choose **Start > Programs > Honeywell Access Systems > WIN-PAK System Manager**. The **System Manager** window appears.
2. Click the **User Interface** tab.

![System Manager-User Interface tab](image)

3. Click **Add**. The **System Manager - Servers Setup** dialog box appears.

![System Manager - Servers Setup](image)

4. Type a descriptive **Name** to identify the database server from the list.
5. Under **Database Server**, type the **Node Name** (computer name or IP address of the server).

   Ensure that the RPC **Endpoint** is the same as the value you set in **Setting RPC Endpoints** section of this chapter.

6. Under **Database Archive Server**, type the **Node Name** (computer name or IP address of the server).

   Ensure that the RPC **Endpoint** is the same as the value you set in **Setting RPC Endpoints** section in this chapter.

7. Click **OK**. This enables you to start up the User Interface with the new database server.

## Service Manager

The WIN-PAK Service Manager enables you to start and stop the WIN-PAK services.

WIN-PAK Services running on Microsoft Windows® 7 and Microsoft Windows® Server 2008 Operating system are configured to Automatic(Delayed Start). This delayed start is configured to ensure that SQL starts before WIN-PAK connects. In this scenario, if you try to log on to WIN-PAK after a Windows restart(before WIN-PAK Services start up), then the error message “Database Connection Failed” appears. The only workaround is to log on to WIN-PAK after some time (after the services are up and running).

**Note:** Older operating systems like Microsoft Windows XP, Microsoft Windows Server 2003 continue to work as Service Automatic only.

To start or stop the WIN-PAK services:

1. Choose **Start > Programs > Honeywell Access Systems > WIN-PAK Service Manager**. The **WIN-PAK Services** window appears.

![WIN-PAK Services](image)

**Figure 4-19** WIN-PAK Services

2. Select the **Service** to be started or stopped.
3. Click **Start** to start the server or click **Stop** to stop the server.
4. Click **Restart** to stop the service and start again.
5. Click **Refresh** to refresh the services.

**Note:**

## User Interface

The WIN-PAK User Interface enables you to add, monitor and control devices, card holders, operators, and so on.
Logging On

Before logging on to WIN-PAK, ensure that all WIN-PAK services are running.

See the Service Manager section in this chapter to start the services.

To log on to WIN-PAK:

1. Choose Start > Programs > Honeywell Access Systems > WIN-PAK User Interface
   Or
   Double-click the WIN-PAK User Interface icon on your desktop.

   The Connect to Server dialog box is displayed.

2. Type your user Name.

3. Type your Password.

   Note: If the User Interface is not on the same computer as that of the Database Server, configure the details of the database server through the System Manager. See Setting the User Interface Workstation section for more information.

4. Click Connect. The WIN-PAK XE - Account name - [Operator] window appears after you have logged on to WIN-PAK.

   Note: Administrator has privileges to access all Accounts whereas an Operator has privilege to access only certain accounts. The title bar of the WIN-PAK Main window displays the name of the active account.

Logging Off

To log off from WIN-PAK:

1. In the WIN-PAK User Interface main window, choose File > Log Out or click ✗ from the tool bar. The following confirmation message appears.
Getting Started
User Interface

Figure 4-21  Log out confirmation

2. Click **Yes** to log off from WIN-PAK.

**Note:** Logging Off from WIN-PAK does not automatically stop the WIN-PAK services

**Quitting WIN-PAK**

To quit the WIN-PAK application:

1. Choose **File** > **Exit**. A confirmation message appears.
2. Click **Yes** to quit the application.
System Settings

In this chapter...

- Overview 5-2
- Accounts 5-2
- Administrators 5-5
- Operators 5-7
- Default Settings 5-19
Overview

This chapter describes how to configure WIN-PAK users and to set the default settings for WIN-PAK.

Accounts

This section Accounts describes to add, edit and delete an account. The card and card holder information in WIN-PAK are specific to an account. Therefore, you must select an account to enable card and card holder menu options.

WIN-PAK Users

This section WIN-PAK Users describes in detail about configuring the users and assigning privileges to them.

Users of WIN-PAK are of two types, namely, Administrators and Operators. An administrator has full privileges (view, change, and delete) to work in WIN-PAK whereas, an operator has restricted privileges, which are defined by the associated operator levels.

When you install WIN-PAK on your computer, a default user is created for logging on to WIN-PAK with administrator privileges. The default user name is admin with a blank password. However, to ensure security, you can change the user name and password.

Default Settings

This section describes how to change the default settings for WIN-PAK workstation and system settings. Defaults can be changed for alarm printer, sound files, e-mails for reporting alarms, auto log on, and so on.

In the WIN-PAK system, these settings are configured by default and WIN-PAK functions as per these settings. All the client systems of WIN-PAK would be affected by any changes made to the System Defaults settings. Whereas, only the computer where the settings are changed are affected by the Workstation Defaults settings.

Accounts

Using accounts in WIN-PAK, you can group cards and card holders, whose details can be modified by specific operators. An account can be created with an account name and mapped to the operators who can access the account.

Newly added cards and cardholders must be added to the specific account. Therefore, card holder tab menus in the WIN-PAK UI are available only when an account is selected.

Adding an Account

To add an account:

2. Click **Add** to add a new account. The **Account** dialog box appears.

3. In the **Account** tab, type the **Account Name**. The account name may include a maximum of 30 characters and is mandatory.

4. Enter the additional information about the account from **Data 1** to **Data 10**. For example, you can enter the category of the account, site name, and so on.

5. Click the **Email Configuration** tab to enter the e-mail Ids.
System Settings
Accounts

Figure 5-3  Account Record

6. In the To box, type the e-mail ID of the user to whom the account-specific alarms must be reported.
7. Click OK to save the account information.

Selecting an Account

To select an account in WINPAK:

1. Choose Account > Select or press F2. The Select Account window appears.

Figure 5-4  Select Account window

2. In the Account Name list select the required account.
3. Click Select.
Editing an Account

To edit an account in WINPAK:
1. Choose **Account > Edit**. The **Account** window opens.
2. Click the required account to be edited and click the **Edit** button.

See the *Adding an Account* section in this chapter for more information on editing an account.

Deleting an Account

To delete an account that is not in use in WINPAK:
1. Choose **Account > Edit**. The **Account** window opens.
2. Click the account you want to delete and click the **Delete** button.

OR

Administrators

Administrator is created by default on installing the WIN-PAK user interface. The user name is admin with no password. You can change the user name and password to ensure security.

To change the default settings for Administrator:
1. Choose **System > Operator**. The **Operator** window appears.
2. Select the Admin operator and click Edit.

3. In the Operator tab, change the Operator Type, Operator Name and Description, if required.

4. Click the Password tab to set the new password for the Administrator.
   a. Type the New Password for the Administrator to log on. This field is mandatory. Password is case-sensitive and you can enter maximum of 20 characters.
   b. Retype the password in Confirm New Password.
5. Click the **Operator Information** tab to set the operator details such as operator level, time zone during which the operator is provided access to work on WIN-PAK, the relevant accounts, and so on.

![Operator Information tab]

6. If the Administrator is a card holder, select the card holder in the **Card Holder** list or use the ellipsis button to locate the Administrator in the card holders list.

7. Select the **Language** of the Administrator.

8. Click **OK** to save the changes.

**Operators**

Operators are the individuals with a set of privileges to work with the WIN-PAK system. An operator can log on to WIN-PAK using a user name and password. Operators are assigned by operator levels, where the access rights are configured for the WIN-PAK system components.

**Operator Levels**

The operator level defines the privileges of the operator to work with WIN-PAK. When an operator is assigned to an operator level, the operator gains access for the system components that are configured in the operator level.

In an operator level, the rights are configured for the following system components:

- **Command Files** - To run the command files.
- **Control Area** - To control devices in the control area through Control Map.
- **Databases** - To configure Card Holder, Cards, Floor Plan, and so on.
- **Floor Plans** - To open the floor plans.
- **Reports** - To run the reports.
- **User Interfaces** - To configure and operate on the WIN-PAK User Interface.
Adding an Operator Level

To add an operator level:


   ![Operator Level window](image1)

   \textbf{Figure 5-8} Operator Level window

2. Click Add to add a new operator level. The Operator Level dialog box appears.

   ![Operator Level dialog box](image2)

   \textbf{Figure 5-9} Operator Level dialog box

3. Type the Name for the operator level. This field is mandatory.
4. Type the Description for the operator level.
5. Click OK to save and return to the Operator Level window.

Configuring Operator Levels

You can configure the access rights to an operator level for the control area devices, databases, reports, user interface, and so on.
To configure access rights for an operator level:

1. Choose **System > Operator Level**. The **Operator Level** window appears.

2. In the left-pane, select an operator level in the **Operator Level** list.

3. Right-click the control area device, database, or user interface to configure.

4. Configure rights for an entire branch, an individual device, database, report or user interface element.

**Configuring Rights for an entire branch**

To configure access rights for an entire branch:

1. In the **Operator Level** window, right-click the main branch and select **Configure** to configure the rights for all the devices in one branch at once. The **Configure Rights** dialog box is displayed.

2. Select the appropriate rights configuration for the Operator Level and click **OK**.

**Configuring Rights for an individual Device**

To configure access rights at a device level:

1. In the **Operator Level** window, expand the branch and select a device.
2. Right-click the device and select **Configure**. The **Configure Rights** dialog box appears.

![Configure Rights](image)

*Figure 5-12 Configure Rights*

3. Select the appropriate rights configuration and click **OK**.

**Configuring Rights for Databases**

To configure rights for databases:

1. In the **Operator Level** window, expand the **Databases** branch and select a branch database or an individual database.
2. Right-click the database and select **Configure**. The **Configure Rights Database** dialog box appears for a branch database and the **Configure Rights to Database** dialog box appears for an individual database.

![Configure Rights Database](image)

*Figure 5-13 Configuring Rights for the Database*

3. Select the appropriate option to set the rights for the database.

**Configuring Rights for Reports**

To assign rights to an individual report:

1. In the **Operator Level** window, expand the **Reports** branch and select a report.
2. Right-click the report and select **Configure**. The **Configure Rights** dialog box appears.

![Configure Rights](image)

*Figure 5-14 Configuring Rights for the Reports*

3. Click **None** to provide no access or click **Run Report** to provide rights for running the selected report.
4. Click **OK**.

To assign the same rights to all the reports:

1. In the **Operator Level** window, select the **Reports** branch.
2. Right-click **Reports** and click **Configure**. The **Configure Rights** dialog box appears.

![Configure Rights Dialog Box](image)

*Figure 5-15 Configuring Rights to Reports contd...*

3. Select the appropriate option and click **OK**. The selected rights is assigned to all the reports.

- Red indicates no rights
- Yellow indicates view rights
- Green indicates operate rights (view and edit)
- White indicates delete rights
Configuring rights summary chart

<table>
<thead>
<tr>
<th>Branch, Database, Device</th>
<th>Change</th>
<th>Operate</th>
<th>Delete</th>
<th>Max</th>
<th>None</th>
<th>Operate Specific</th>
<th>Same</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator Level Tree</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Command File</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individual Command File</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Area</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device-Control Area</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Database</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individual Database</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Floor Plans</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individual Floor Plans</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individual Reports</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Interface</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individual-User Interface</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Options**

- **Change & Operate**: Grant change rights to all database. Grant operate rights to all controls and user interfaces.
- **Delete**: Grant delete rights for all database as a whole. Grant change rights for all fields.
- **Maximum**: Grant delete rights to all databases. Grant operate rights to all controls and user interfaces.
- **None**: Remove all rights from all items.
- **Operate Specific**: Grant operate rights to all items from branch or specific devices.
- **Same**: Leave all rights as they are.
- **View**: Grant view rights to all items.

### Copying an Operator Level

To create operator levels that are similar to each other, but with a few minor differences, copy an existing operator level, and then make changes to the copy.

1. Choose **System > Operator Level**. The **Operator Level** window appears.
2. Select the operator level to be duplicated.
3. Click **Copy**. The **Operator Level** dialog box appears.

![Figure 5-16 Copying an Operator Level](image)
4. Type a new **Name** for the operator level.
   The default name of the copy is the same as the original with the prefix “Copy of...” and the default description is the same as the original.
5. Type a new **Description** for the operator level, if required.
6. Click **OK** to save a copy and return to the **Operator Level** window.

**Editing an Operator Level**

To edit the name or description of an operator level:
1. Choose **System > Operator Level**. The **Operator Level** window appears.
2. Select the operator level and click **Edit**. The **Operator Level** dialog box appears.
3. Enter the new **Name** and/or **Description**, and click **OK**.

See the **Configuring Operator Levels** section in this chapter for information on configuring access rights to an operator level.

**Isolating and Deleting an Operator Level**

You cannot delete an operator level, if the operator level is already assigned to an operator. Therefore, before deleting an operator level, reassign the operator to a different operator level.

**Isolating an Operator Level**

To reassign operators to a different operator level and to isolate the operator level:
1. Choose **System > Operator Level**. The **Operator Level** window appears.
2. Select the operator level to be isolated and click **Isolate**. The **Isolate** dialog box appears.
3. Select the operator from the list. For multiple selections, press **SHIFT** or **CTRL** key while selecting the operators.
4. Select the different operator level to which the operators must be assigned.

![Isolate dialog box](image)
5. Click **Reassign** to reassign the selected operators. A message asking for confirmation appears.

OR

Click **Reassign All** to reassign all the operators. A message asking for confirmation appears.

6. In the confirmation message, click **OK** to confirm the reassignment. The selected or all the operator levels are reassigned.

7. Click **OK** to return to the **Operator Level** window.

**Deleting an Operator Level**

To delete an operator level:

1. Select an operator level from the database list and click **Delete**. A message asking for confirmation appears.

   ![Delete Confirmation](image)

   **Figure 5-18  Deleting an Operator Level**

2. Click **Yes** to confirm the deletion. The operator level is deleted.

   ![Delete Confirmation](image)

   **Figure 5-19  Delete Confirmation**

**Defining Operators**

The operators can access various functions of WIN-PAK, based on the associated operator level and the rights assigned to that level.

**Adding an Operator**

To add an operator:

1. Choose **System > Operator**. The **Operator** window appears.

2. Click **Add** to display the **Operator Record** dialog box.
3. In the Operator tab, select the Operator Type as Admin or Operator.
4. Type the Operator Name and Description.
5. Click the Password tab to set the password.
   a. Type the New Password for the operator to log on. This field is mandatory.
      Password is case-sensitive and you can enter maximum of 20 characters.
   b. Retype the password in Confirm New Password.
6. Click the Operator Information tab. The field inside this tab varies according to the operator type.
System Settings
Operators

7. Select an operator level in the Operator Level list to assign access rights to the operator.

8. If the operator is also a card holder, select the Card Holder from the list or use the ellipsis button to locate the operator in the card holder list.

9. Select the Time Zone during which the operator has to log on to the system.

10. Select the language of the operator in the Language list.

11. Under Available Account, select the list of accounts to which the operator can have access and then click Add. The accounts are moved to Selected Accounts.

12. If you want to remove an account from Selected Accounts list, select the account and click Remove. The selected account is moved to Available Accounts.

13. Click OK to add the operator.

Tips on Password

A good strategy for choosing a password is, it must be easy to remember, but hard to decode. The following list provides tips on choosing such a password:

- Pick a simple phrase preceded or followed by one or more numbers.
- Use a password without spaces and capitalize each character. Such passwords cannot be easily decoded either by a random number generator or by a dictionary decoder.
• For tight security, use a combination of both letters and numbers. Avoid familiar terms such as your company name, initials, birth dates, and so on.

**Caution:** Passwords are case-sensitive.

**Editing an Operator**

To edit the operator details:

1. Choose **System > Operator**. The **Operator** window appears.
2. Select the operator to be edited and click **Edit**. The **Operator Record** dialog box appears.

![Operator Record Dialog Box](image)

**Figure 5-21  Editing an Operator**

3. Edit the required details of an operator and click **OK**.

Refer to the **Adding an Operator** section in this chapter for details on adding an operator.

**Searching and Sorting Operators**

To search and sort the operator list:

1. Choose **System > Operator**. The **Operator** window appears.
2. Select an item in the **Search Field** list.
3. If you have selected Description, Last Log In, Name or Operator in the Search Field, select the Criteria.
   - Begins With - Searches for an item that begins with the text in the Search For text box.
   - Equals - Searches for an item that exactly matches with the text in the Search For text box.
   - Greater Than - Searches for an item that is alphabetically or numerically greater than the text in the Search For text box.
   - Less Than - Searches for an item that is alphabetically or numerically less than the text in the Search For text box.

4. Type the text to be searched in the Search For text box.

5. Select an item in the Sort By list.
   - None - No sorting required.
   - Other items - Sorts the list in the ascending order of the selected item.

6. Click Update List to list the searched items in the sorted order.

**Tip:**
- To sort the entire list:
  a. Click the column title. The list is sorted in the ascending order of the column.

**Deleting an Operator**

To delete an operator:

2. Select the operator to be deleted and click Delete. The selected operator is deleted.
Default Settings

Defaults can be set for certain system functions in WIN-PAK. However, you can change these default settings. For example, you can set the deletion of a card without asking for a confirmation message.

WIN-PAK menus for configuring workstation and system settings are:
- Workstation Defaults
- System Defaults

Setting Workstation Defaults

Defaults can be set for alarm printer, sound files, paths, wallpapers and restore options.

To set the workstation defaults:


![Workstation Defaults](image)

Figure 5-22 Workstation Defaults

2. Click each tab to configure or change the default settings.
3. Click Apply to save the settings.

Configuring the default workstation settings

To configure the default workstation settings:

1. In the Workstation Defaults dialog box, click the Defaults tab.
2. Set the following settings:

**Table 5-1 Describing options for setting defaults**

<table>
<thead>
<tr>
<th>Defaults Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Records returned from the Database for Selecting List</td>
<td>The maximum number of records to be displayed in the Maintenance window for Selection list. Enter a number between 20 and 200. Default value is 200.</td>
</tr>
<tr>
<td>Maximum Records returned from the Database for Find List</td>
<td>The maximum number of records to be displayed in the Maintenance window for Find list. Enter a number between 1 and 1000. Default value is 20</td>
</tr>
<tr>
<td>Live Monitor</td>
<td>From the defined list of CCTV monitors, the selected monitor output is connected to the video capture card. Therefore, the video signal from that monitor output is displayed in the Live Monitor view. Default is None.</td>
</tr>
<tr>
<td>Confirm Card Deletes</td>
<td>A message asking for confirmation appears, when you attempt to delete a card. By default, this check box appears selected.</td>
</tr>
<tr>
<td>Always Show Record View</td>
<td>When you open the Maintenance window, the Detail window for the selected item is opened simultaneously. By default, this check box appears cleared.</td>
</tr>
<tr>
<td>Freeze Client and Wait</td>
<td>If the operator leaves the WIN-PAK User Interface idle for a certain period, the session expires. Therefore, the operator must log on to the system again. By default, this check box appears cleared. The period for inactivity is set in the Wait box. The period ranges from 1 to 60 minutes. Default value is 10 minutes.</td>
</tr>
</tbody>
</table>

3. Click **Apply** to save the changes.

**Setting defaults for alarm printers**

By default, alarms are displayed only in the alarm view window and are not printed. If required, you can configure the settings in the alarm printer to print all alarms as soon as they are displayed in the alarm view window.

To configure alarm printer settings:

1. In the **Workstation Defaults** dialog box, click the **Alarm Printer** tab.
2. Select the **Print Alarms** check box to print the alarms.

3. To select a local printer:
   a. In the **Printer** list, select a printer from the list of printers installed in Windows.

   OR

   To select a printer in the network:
   a. Under **Print to Port**, select the **Print directly to port** check box.
   b. In the **Port Name** list, select the name of the port connected to a printer.
   c. In the **Lines per page** box, enter the number of lines to be printed in a page. By default, it is 66.

4. Click **Apply** to save the changes.

### Setting defaults sound settings

To activate sound files on certain instances:

1. In the **Workstation Defaults** dialog box, click the **Sounds** tab.
2. Select the **Enable System Sounds** check box.

3. Specify the instances during which sound files must be activated by selecting the following check boxes:

   **Table 5-2 Describing instances for activating a sound file**

<table>
<thead>
<tr>
<th>Instance</th>
<th>Activates a sound file...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Card</td>
<td>During card reads.</td>
</tr>
<tr>
<td>Enable Ack</td>
<td>When alarms are acknowledged.</td>
</tr>
<tr>
<td>Enable Clear</td>
<td>When alarms are cleared.</td>
</tr>
<tr>
<td>Enable Operator Note</td>
<td>When notes are added to alarms.</td>
</tr>
</tbody>
</table>

4. Click **Apply** to save the sound file settings.

**Setting default paths for sound and language files**

To define default paths for the sound files and language files:

1. In the **Workstation Defaults** dialog box, click the **Directories** tab.
2. In **Path to Sound Files** text box, type the path for the sound files or click **Browse** to locate the sound files folder. By default the path is set to **C:\Program Files\WINPAKPRO\Sound Files**.

3. In **Path to Language Files** text box, type the path for the language files or click **Browse** to locate the language files folder. By default the path is set to **C:\Program Files\WINPAKPRO\Language Files**.

4. Click **Apply** to save the changes.

---

**Setting the default wallpaper for WIN-PAK User Interface**

To set the default wallpaper for WIN-PAK:

1. In the **Workstation Defaults** dialog box, click the **Wallpaper** tab.
Figure 5-26  Workstation Defaults-Wallpaper tab

2. Click any of the following options for setting wallpaper defaults:

<table>
<thead>
<tr>
<th>Wallpaper Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Bitmap</td>
<td>Retains the default bitmap set for the User Interface.</td>
</tr>
<tr>
<td>None</td>
<td>No wallpaper is set for the User Interface.</td>
</tr>
<tr>
<td>Colored Background</td>
<td>Sets a wallpaper color for the User Interface. Click <strong>Color</strong> and choose the background color.</td>
</tr>
<tr>
<td>Bitmap</td>
<td>Set a bitmap as a background for the User Interface. When you select this option, type the path of the image file, or click <strong>Browse</strong> to locate the image file.</td>
</tr>
</tbody>
</table>

3. Click **Apply** to save the wallpaper settings.

**Setting defaults for Restore options**

To configure the restore options in the WIN-PAK User Interface:

1. In the **Workstation Defaults** dialog box, click the **Restore** tab.
2. To set the restore option for the main window before logging on to the WIN-PAK system:
   a. Select the **Restore Main Window Position and Size** check box to retain the last size and position of the main window.

3. To set the restore options after logging on to the WIN-PAK system:
   a. Under **Operator**, select the following restore options:

   **Table 5-4 Describing restore options for operators**

<table>
<thead>
<tr>
<th>Restore Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Main Window Position and Size</td>
<td>The position and size of the main window in the previous session are restored.</td>
</tr>
<tr>
<td>Restore Window Position and Size</td>
<td>The position and size of the secondary windows in the previous session are restored.</td>
</tr>
<tr>
<td>Reopen Window</td>
<td>The windows that were kept open in the previous session are re-opened.</td>
</tr>
</tbody>
</table>

4. Click **Apply** to save the restore settings.

5. Click **OK** to save the workstation settings and close the dialog box.

**Setting System Defaults**

Defaults can be set for certain functions in WIN-PAK. For example, you can configure system settings related to ADV access, card number length, alarm handling, e-mail configuration, and type of access levels.

To set the system defaults:

1. Choose **System > System Defaults**. The **System Config** dialog box appears.
Configuring the default settings

To configure the defaults settings:

1. In the System Config dialog box, click the Defaults tab.
2. Set the following defaults options:

Table 5-5 Describing the options for setting the defaults

<table>
<thead>
<tr>
<th>Defaults Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grant all operators access to ADV not in Control Area</td>
<td>Select the check box to grant permission to all operators for accessing ADVs that are not in the Control Area</td>
</tr>
<tr>
<td>Maximum Length of Card Numbers</td>
<td>The maximum length for card numbers.</td>
</tr>
<tr>
<td>Allow only numeric Card Numbers</td>
<td>Card numbers can only be numbers.</td>
</tr>
<tr>
<td>Port Settings</td>
<td></td>
</tr>
<tr>
<td>Port for TCP/IP Connection</td>
<td>The port number of the panels in the TCP/IP connection.</td>
</tr>
<tr>
<td>Port for TCP/IP Encrypted Connection</td>
<td>The port number of the panels in the TCP/IP encrypted connection.</td>
</tr>
</tbody>
</table>
3. Click **Apply** to save the defaults settings.

**Setting defaults for alarm handling**

To set defaults for alarm handling:

1. In the System Config dialog box, click the **Alarm Handling** tab.

![System Config - Alarm Handling tab](image)

**Figure 5-29  System Config-Alarm Handling tab**

2. Set the following alarm settings:

**Table 5-6  Describing options for alarm settings**

<table>
<thead>
<tr>
<th>Alarm Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Popup Alarm View Window(Applicable for Administrators only)</td>
<td>When a new alarm is received, the Alarm View window opens, restores or continues its display. <strong>Note:</strong> This feature works on Alarm popups configured in the Operator Level Tree. See <strong>Alarm Popups</strong> for more information.</td>
</tr>
<tr>
<td>Beep until Alarm Acknowledged</td>
<td>The alarm beeps continuously, until the alarm is acknowledged. By default it is selected.</td>
</tr>
<tr>
<td>Allow Alarm to be Silenced for 60 seconds</td>
<td>The Silence button appears enabled for an operator to stop the beep for 60 seconds even without acknowledging the alarm. By default it is selected.</td>
</tr>
</tbody>
</table>
### System Settings

#### Default Settings

**3. Click Apply to save the alarm handling settings.**

**Alarm Popups**

This option restricts the display of alarm popups and video popups based on the rights configured for an operator in the Operator Level tree. You can define the alarm popup and video popup permissions for the operator. *(Operator Level Tree > User Interfaces > Operations).*

<table>
<thead>
<tr>
<th>Alarm Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Not Close Window Until all Alarms are Acknowledged</td>
<td>The Alarm View window cannot be closed, until all the alarms are acknowledged.</td>
</tr>
<tr>
<td>Reissue Uncleared Alarms</td>
<td>The acknowledged alarms are reissued if those alarms in the lower-pane returns to the alert state.</td>
</tr>
<tr>
<td>Require a Response when Acknowledging Alarms</td>
<td>A note must be provided when alarms are acknowledged. The option is not applicable for admin operators.</td>
</tr>
<tr>
<td>Automatically Clear Acknowledged Alarms</td>
<td>Acknowledged alarms are automatically cleared.</td>
</tr>
<tr>
<td>Clear Alarm on Normal Only</td>
<td>The operator can clear an alarm, only if the device or point on which the alarm is generated retains to the normal state.</td>
</tr>
<tr>
<td>Maximum # of events in event view</td>
<td>The maximum number of events to be displayed in the Event View.</td>
</tr>
<tr>
<td>Auto-clear alarms limit (per point)</td>
<td>The maximum number of recent alarms for a point (input or output) to be displayed in the Alarm View window. By default, the Alarm View window displays the 100 most recent alarms per point. This value can range from 10 through 500.</td>
</tr>
<tr>
<td>Auto-clear card reads limit (per door)</td>
<td>The maximum number of recent events per door to be displayed in the Alarm View window. By default, the Alarm View window displays the 100 most recent events per door. This value can range from 10 through 500.</td>
</tr>
</tbody>
</table>
The Alarm Popup option in the operator level tree includes the following sub items: Auto Alarm Popup, Auto Video Popup. The Configure option for the Auto Alarm/Auto Video Popup has the None/View/Operate options. The Operate option is selected by default for an admin operator. You can choose to configure the permissions for a non-admin operator.

For an admin operator, the selection of Auto Popup Alarm View Window (Applicable for Administrators only) check box in the Alarms Handling tab is considered for enabling/disabling the display of the alarm popup and video popup.

Note:
For a non-admin operator:
- If you have configured None permission for Alarms and View/Operate permission for Auto Alarm Popup, then the operator level does not have any effect and alarm popups do not appear.
- If you have configured None permission for Alarms and View/Operate permission for Auto Video Popup, then there is a change in operator level and video popups appear.

Specifying the default e-mail IDs for reporting alarms
You can configure the e-mail IDs to whom the e-mails for alarms would be sent.

To specify default e-mail IDs for reporting alarms:
1. In the System Config dialog box, click the Email Configuration tab.
System Settings
Default Settings

2. Under **Sender**, select the **Authentication Method** for sending the mail.
   - **AUTH LOGIN** - The password is encrypted while sending to the server. This ensures security.
   - **LOGIN PLAIN** - The password is sent to the server without encryption.
3. Type the **Username** and **Password** for the selected authentication method.
4. Under **Mail Server**, type the **HostName** or IP address of the mail server.
5. Type the **Port Number** of the mail server.
6. Under **Misc**, select the **Encoding** format.
7. Click **Configure E-mail IDs** to configure the e-mail IDs of the users to whom alarm reports must be sent. The **Configuration - Email Ids** dialog box appears.

8. Type the e-mail IDs in the **From**, **To**, **Cc**, and **Bcc** text boxes.
   **Tip:** To enter multiple e-mail IDs, you can use the semicolon as a separator.
9. Click OK to save the e-mail details and return to the System Config dialog box.
10. Click Apply to save the e-mail configuration details.

**Configuring automatic log on and log off settings**

You can set the WIN-PAK system to log on automatically, when you launch WIN-PAK. In addition, you can set to close the WIN-PAK User Interface when you log off from the system.

To configure the log on and log off settings:

1. In the System Config dialog box, click the Login/Logout tab.

2. Select the Login using current Windows user at startup check box, if you want the WIN-PAK system to log on automatically using Windows logon user name when you launch the application.

3. Select the Close WIN-PAK when user logs out check box, if you want to close the WIN-PAK system when you log off from WIN-PAK.

**Configuring access levels for cards**

You can configure the number of access levels that can be assigned to a card.

To configure the access levels for cards:

1. In the System Config dialog box, click the Access Levels tab.
2. Under **Access Levels**, click any of the following options:
   - **Precision**: Only one access level that must be assigned to a card. When this access level is selected, more memory is consumed.
   - **Multiple**: A maximum of 32 access levels can be assigned to a card.

A similar message is displayed when you switch from **Precision** to **Multiple** access level.

3. Click **Yes** to confirm the switching.
4. Click **Apply** to save the access level settings.
5. Click **OK** to save the changes and close the **System Config** dialog box.
Quick Configuration

In this chapter...

Quick Start Wizard 6-2
Quick Start Wizard

Overview

Quick Start Wizard (QSW) is an optional interface to configure the basic functionalities like creating an account, adding a new time zone, and so on with the default settings. However, you can also perform these operations using the menu options available in WIN-PAK.

- If you are new to WIN-PAK, you can quickly get started with WIN-PAK for performing few basic operations using QSW.
- If you are already using WIN-PAK, you can still proceed with QSW for configuring the basic operations.

Configuration Options

QSW helps you to configure the following:

- Creating an Account
- Adding a Time Zone
- Adding a Site
- Adding Loops to a Site
- Adding a Panel
- Adding Readers to a P-Series Panel

Launching the Quick Start Wizard

As QSW requires access to several WIN-PAK databases, you must log on with administrator privileges to use the QSW. When you log on to WIN-PAK, the QSW automatically starts.

- If you do not want QSW to start automatically,
  - Clear the Show the Quick-Start Wizard after each Log-in check box in the Quick Start Wizard Configure dialog box.
- To manually launch the quick start wizard,
  - Choose Configuration > Quick-Start Wizard from the main window of WIN-PAK. The Quick Start Wizard Configure dialog box appears.

Creating an Account

To create a new account using the QSW:

1. In the Quick Start Wizard Welcome dialog box, click Next. The Configure dialog box appears.

   Note: The Create New Account is the default option selected each time you launch the QSW.
Figure 6-1    Quick Start Wizard-Configuration Options

2. Click **Create New Account** and then click **Next**. The **Account** dialog box appears.

![Quick Start Wizard-Configuration Options](image1)

Figure 6-2    Account

3. Type a unique **Account Name** and click **Next**. A confirmation message appears for the account name.

4. Click **Next**. A new account is created and the **Configure** dialog box appears with the **Add Time Zones** option selected.

### Associating Time Zones to Accounts

A time zone is the defined time interval for accessing a particular area. You must associate Time Zones to an account, as they are specific to an account.

To associate time zones to the accounts using QSW:

1. In the **Quick Start Wizard Configure** dialog box, click **Add Time Zones** and click **Next**. The **Time Zones** dialog box appears. The **Time Zone** dialog box displays the available time zones and accounts.
Quick Configuration
Quick Start Wizard

2. Select the time zones to be associated to an account.

3. In the Available Accounts list, click the account. For multiple account selection, use the SHIFT and CTRL keys.

4. Click \( \text{or} \) \( \text{ or } \) \( \text{ or } \) to move the selected accounts or all accounts to the Selected Accounts list and then click Next. The Continue? dialog box appears.

5. Click Back to change the settings or click Next. The time zones are associated to the accounts and the Configure dialog box displays with the Add New Site option selected.

Adding a New Site

Site is a logical representation of the physical location in WIN-PAK.
To add a new site:

1. In the **Quick Start Wizard Configure** dialog box, click to select **Add New Site** and then click **Next**. The **Sites** dialog box appears.

2. Type a unique **Site Name** and click **Next**. The **Continue?** dialog box appears.
3. Click **Back** to change the site name or click **Next**. A new site is created and the **Configure** dialog box displays with the **Add New Loop to existing Site** option selected.

**Figure 6-5 Sites**

Adding a Loop to a Site

Loop refers to the communication method used for communicating between the workstation and the panel.

Adding a Loop to a Site process includes, adding a panel to a loop and adding readers to a panel.

To add a loop to a site

1. In the **Quick Start Wizard Configure** dialog box, click **Add New Loop to existing Site**.
2. Click the **Site** to be associated with the loop and then click **Next**. The **Loop** dialog box appears.
3. Select the **Communication Type**. It determines the type of protocol used for communication.

4. Select the **Loop Type**. The available loop types are “Direct”, “485 ACK-NAK”, “C-100”, “NetAXS-123-Gateway”, and “NetAXS-4-Gateway”.

   **Note:**
   - If you select the **Loop Type** as “485 ACK/NACK”, then the **PCI-3** check box is enabled. Select this check box to allow adding NetAXS panels to 485 loop. For all other loop types, the **PCI-3** check box is disabled.
   - The options in the **Loop Type** list vary based on the **Communication Type** selected. For example, if you select “Local”, the **NetAXS-123-Gateway** is not listed as it supports only TCP/IP communication.

5. Type the **Loop Name**.

   WIN-PAK supports three types of communication protocols namely, Local, TCP/IP, and Dial Up. The loop configuration differs based on the protocol type selected for communication.

6. If you select **Local** as the **Communication Type**, select the **Communication Port** name connected to the panel.

   OR

   If you select **TCP/IP** as the **Communication Type**, type the **Node Name or IP Address** of the loop.

   OR

   If you select **Dial Up** as the **Communication Type**,
   a. Select the **Communication Port** name.
   b. Type the **Modem Pool Name**.
   c. Type the **Modem Name**.
   d. Type the **Local Phone Number**.
   e. Type the **Remote Phone Number**.
   f. Type the **Password**.

7. Click **Next**. The **Panel** dialog box appears.
8. Select the **Panel Type**.

WIN-PAK supports five types of panels such as N1000, PW2000, P-Series, NetAXS, and NS2+ panels to communicate with WIN-PAK.

**Note:** NS2 is also supported when NS2+ is selected.

9. Type the **Panel Name**.

10. Select the **Panel Address**.

    **Note:** Each panel on a communication loop must have a unique address.

11. Click **Next**. The **Readers** dialog box appears to configure the Reader information.

    **Note:** The number of readers in the **Readers** dialog box depends on the panel type selected.

12. Type the **Name** of the reader.

13. Select the **Time Zone** during which the reader needs to be active.

    **Note:** NetAXS panels have additional time zones set with the card rules to make the readers to work. For more information see *Configuring Readers to the NetAXS panel* in Chapter 10 for more information.

14. Set the **Pulse time** for the reader. The Pulse time specifies the duration for which the device assumes abnormal status. For example, it specifies how long a horn blows or a door strike remains released.

When adding the NetAXS-123 panel, there are two sets of readers that can be defined as shown in the following figure.
Quick Configuration
Quick Start Wizard

The first set is Readers 1, 2 and 3 defined as the “a” readers and the second set is Readers 1, 2 and 3 defined as the “b” readers. The “a” readers are active by default, and use a default 10 second pulse time. The “b” set of readers are undefined – no name or pulse time defined.

15. Repeat steps 12 to 14 for each reader and click Next. The Continue? dialog box appears.

16. Click Back, if you want to change the settings or click Next to save and return to the Configure page.

Adding a Panel

A panel is a physical device in which the readers are connected through wires.

To create a new panel:

1. In the Quick Start Wizard Configure dialog box, click Add New Panel and click Next. The Panel dialog box appears.

   ![Figure 6-9 Adding a New Panel](image)

2. Select the Panel Type.
3. Type a unique Panel Name.
4. If you select P-Series (TCP/IP) as the Panel Type,
   a. Type the Node Name / IP Address of the panel.
   b. Select a unique Panel Address.
   c. In the Site Name, select a site to which the panel must be associated.
   d. Click Next to add readers to a panel. The Readers dialog box appears.
   e. Select the Reader Board Type as 1 Reader Board or 2 Reader Board.
   f. Select the Reader Board Address.

If you select any other Panel Type,
   a. In the Loop Name, select a loop to which the panel must be associated. The loops are displayed based on the selected panel type.
   b. Select a unique Panel Address.
   c. Click Next to add readers to a panel. The Readers dialog box appears.

5. Type the Name of the reader.
6. Select the Time Zone during which the reader needs to be active.
7. Specify the Pulse time. The WIN-PAK system sends pulses to the panel at a defined interval for checking the panel status.
8. Repeat steps 2 to 7 for each reader and click Next. The Continue? dialog box appears.
9. Click Back, if you want to change the settings or click Next to add a new panel and return to the Configure page.

Adding Readers to a P-Series Panel

This option is enabled only if a P-Series panel is added.

To add readers to a P-Series panel:

1. In the Quick Start Wizard Configure dialog box, click Add Readers to a P-Series Panel and click Next. The Readers dialog box appears.

   ![Figure 6-10 Adding Readers to P-Series Panel](image)

   **Figure 6-10 Adding Readers to P-Series Panel**

   2. Select the Reader Board Type. Depending on the type, the number of readers is displayed.
Quick Configuration

Quick Start Wizard

3. Select the Reader Board Address.
4. Type the Name of the reader.
5. Select the Time Zone for the reader during which the reader is active.
6. Set the Pulse Time for the reader.
7. Repeat steps 4 to 6 for each of the readers and click Next. The Continue? dialog box appears.
8. Click Back, if you want to change the settings or click Next to save and return to the Configure page.

Saving the Configuration

After completing the required configuration, you must save the configuration details using the I’m Done option. Note that the configuration details are NOT saved permanently, when you click the Next button after each configuration.

To save the configuration details and to generate the summary report:

1. In the Quick Start Wizard Configure dialog box, click I’m Done and click Next. The Saving Configuration dialog box appears.

![Figure 6-11  Saving the Configuration](image)

After saving the configuration details, the Summary Report dialog box appears.
2. In the **Summary Report** dialog box, click **Print** to print the configuration details or click **Finish** to close the QSW dialog box.
Quick Configuration
Quick Start Wizard
Badge Layout

In this chapter...

- Configuring a Badge Layout 7-2
- Creating Badge Designs 7-6
- Configuring Badge DLLs 7-26
- Setting up Badge Printers 7-27
Badge Layout

Introduction

Badge layouts are templates that define the size, placement, and properties of a badge. Properties of a badge are its printable size, its background color, and the magnetic stripes used for encoding cardholder information. In addition, the badge layout is defined with placeholders for cardholder information such as photo, note fields, signatures, and bar codes.

When a badge layout is later associated with a card, the card holder information such as photo, signature, and any other note field information is automatically entered on the badge. This creates individual badges for every cardholder. These cards are used as photo IDs and access cards.

Badges can be displayed on the screen or printed on paper or on cards. Badges are printed on Technology or non-Technology cards. Any Windows-compatible printer, ink jet, laser, or PVC card printer can be used for printing badges. Special PVC card printers enable double-sided printing and magnetic stripe encoding.

Configuring a Badge Layout

Configuring a badge layout involves:

- **Selecting an account** - Select the individual account for which you want to create a badge layout or specify all accounts.
- **Adding a new badge layout** - Create a badge layout with a name and description.
- **Creating badge designs** - Place elements on the badge layout (bitmaps, placeholders for cardholder photo, bar codes and so on) and set various properties for the badge elements.

Selecting the Account

You can create badge layouts for a particular account or for all accounts.

To select an account:

1. Choose **Account > Select**. The **Select Account** dialog box appears.

   ![Select Account](image)

   *Figure 7-1  Select Account*

2. To configure badge layouts for a particular account, select the account in the list.

   OR

3. Click **OK** to save the account information for creating badge layouts and to exit from the **Select Account** dialog box.

Adding a New Badge Layout

1. Choose **Configuration > Badge > Badge Layout Utility**.
The Badge Layouts window appears with a list of existing badges.

2. Click Add to add a new badge layout. The Badge Definition window appears.
Badge Layout

Introduction

3. Type a **Name** and **Description** for the badge layout.

4. Click the icon provided in the toolbar of the window. The new badge layout is saved and listed in the **Badge Layouts** window.

Searching and Sorting Badge Layouts

1. Choose **Configuration > Badge > Badge Layout Utility**. The **Badge Layouts** window appears.

2. Select a search item in the **Search Field** list.
   - All - Lists all the badge layouts.
   - Description - Searches for similar badge layout descriptions.
   - Name - Searches for similar badge layout names.

3. If you have selected **Description** or **Name** in **Search Field**, select the criteria for search in the **Criteria** list.
   - Begins With
   - Equals
   - Greater than
   - Less than

4. Type the text you want to search in the **Search For** box.

5. To sort badge layouts based on badge name or description, select it from the **Sort By** list.
   - None - no sorting required.
   - Name - sorts badge layouts by the ascending order of badge name.
   - Description - sorts badge layouts by the ascending order of badge description.

6. Click **Update List** to update the list of badge layouts based on the search criteria, sorted in the specified order.

![Badge Definition window](image)

*Figure 7-4  Badge Definition window*

3. Type a **Name** and **Description** for the badge layout.

4. Click the icon provided in the toolbar of the window. The new badge layout is saved and listed in the **Badge Layouts** window.

**Searching and Sorting Badge Layouts**

1. Choose **Configuration > Badge > Badge Layout Utility**. The **Badge Layouts** window appears.

2. Select a search item in the **Search Field** list.
   - All - Lists all the badge layouts.
   - Description - Searches for similar badge layout descriptions.
   - Name - Searches for similar badge layout names.

3. If you have selected **Description** or **Name** in **Search Field**, select the criteria for search in the **Criteria** list.
   - Begins With
   - Equals
   - Greater than
   - Less than

4. Type the text you want to search in the **Search For** box.

5. To sort badge layouts based on badge name or description, select it from the **Sort By** list.
   - None - no sorting required.
   - Name - sorts badge layouts by the ascending order of badge name.
   - Description - sorts badge layouts by the ascending order of badge description.

6. Click **Update List** to update the list of badge layouts based on the search criteria, sorted in the specified order.
Copying a Badge Layout

Copying a badge layout enables you to easily create several badges with the same basic layout, but with distinguishing features such as the background color.

2. Select the badge to be copied, and click Copy Badge. The Badge Layout - Copy Badge dialog box appears.
3. Type the name for the badge layout in the New badge name box.
4. Click OK to create a copy of the badge layout.

Editing a Badge Layout

2. Select the badge layout you want to edit and click Edit. The Badge Definition window appears.
3. Edit the Name and Description of the badge layout.
4. Click the icon.

Viewing a Badge Layout

2. Select the badge layout you want to view and select the Detail View check box. The Badge Definition window appears, with the details of the selected badge layout.

Isolating and deleting a Badge Layout

2. Select a badge layout and click Delete. A dialog box appears, prompting you to confirm the deletion.
3. Click **Yes** to confirm the deletion of the badge layout. If cards are associated to the badge layout, the **Badge Layout Delete** dialog box appears with the list of linked cards.

![Badge Layout Delete](image)

**Figure 7-7  Badge Layout Delete**

4. Click **Delete** to remove the link between the badge layout and the linked cards, and to delete the badge layout.

**Caution:** Be cautious while deleting a badge layout as it could be attached to thousands of cards.

### Creating Badge Designs

#### Overview

Designing badges involves:

1. Setting the printable size of the badge.
2. Providing background color, graphics, and image for the badge.
3. Specifying blockout areas on the badge.
4. Placing the following badge elements and setting their properties:
   - Text
   - Bar Codes
   - Bitmap
   - Placeholder for card holder photo
   - Placeholder for signatures

#### Know more about the Badge Definition window

1. Choose **Configuration > Badge > Badge Layout Utility**. The **Badge Layouts** window appears.
2. Select a badge layout and click **Edit**.

   The **Badge Definition** window appears with the details of the selected badge layout.
Changing the Ruler Measurement

You can set the ruler measurement of the badge outline as Inches or Millimeters.

2. Select a badge layout and click Edit. The Badge Definition window appears.
3. Right-click anywhere inside the badge outline and click Inches or Millimeters. A check mark indicates the option in use. To switch from one unit of measure to another, select the desired unit from the menu.

Setting the printable size of the badge

You can set the printable size of the badge by altering the height and width of the badge outline.

2. Select a badge layout and click Edit. The Badge Definition dialog box appears.
3. Right-click anywhere inside the badge outline and click Properties. The Badge Element Layout dialog box appears.
4. Click the Positioning tab.
5. Select the **Horizontal Position** and the **Vertical Position** of the badge outline.

6. Select the degree of **Orientation**.
   - 0° - Places the object upright.
   - 90° - Rotates the object 90° clockwise.
   - 180° - Places the object upside-down.
   - 270° - Rotates the object 90° counterclockwise.

7. Type the **Top and Left** of the badge in millimeters or inches (0 for PVC printers.)

8. Type the **Height and Width** of the badge in millimeters or inches.

9. Click **Apply** to apply the dimensions to the badge outline.

10. Click **OK** to apply the dimensions to the badge outline and to return to the **Badge Definition** window.

### Adjusting the Zoom factor

The Zoom factor decides the view of the badge outline in the **Badge Definition** window.

1. Right-click in the **Badge Definition** window and select **Zoom Factor**. The **Zoom** dialog box is displayed.

2. Select the required zoom factor, or click **Custom** and type the zoom percentage.

3. Click **OK**.
The badge outline in the **Badge Definition** window enlarges or reduces by the selected zoom percentage.

### Specifying Grid Settings

Grids are evenly spaced points on the badge layout area that assist in sizing and aligning items. You can use the grid as a visual aid for placing items on the badge layout. You can also enable the **Snap** setting for the grid, which pulls any item moving close to the grid mark.

1. Right-click in the **Badge Definition** window, and then click **Grid Settings**. The **Badge Layout - Grid Settings** dialog box appears.

   ![Grid Settings](image)

   **Figure 7-11 Grid Settings**

2. Select one of the five spacing options in the **Spacing** list.
3. Select the **Snap to Grid** check box, if you want items to snap to the grid when they are moved or added.
4. Select the **Show Grid** check box, if you want the grid marks to be visible on the screen.
5. Click **OK** to save the settings and return to the **Badge Definition** window.

### Setting Blockouts

You can set blockouts for reserving the non-printing area on a badge. This is useful to prevent instances like printing over a magnetic stripe or hole punch area in the card. Unlike other badge objects, the blockout has no properties and always remains on top in the item layering.

Though the blockout is generally effective in preventing overprinting of the Mag Stripe area, some card printers do print resin black over the blockout. To avoid this, ensure that no blockout is placed over the Mag Stripe area.

To add a new blockout to the badge layout:

1. Right-click within the badge outline, and then click **Blockouts**. The **Badge Element Layout - Blockout Item Definitions** dialog box appears.

   ![Blockout Item Definitions](image)

   **Figure 7-12 Setting Blockouts**
2. Click **Add** (if you are creating a new blockout) or **Edit** (if you are making changes to an existing blockout). The **Badge Element Layout – Add/Edit Block Item** dialog box appears.

![Figure 7-13 Badge Element Layout-Add/Edit Block Item](image)

3. Type a **Name** for the blockout.

4. In the **Millimeters from left edge of the printable area (x)** box, type the distance of the blockout from the left edge of the badge printable area.

5. In the **Millimeters from top edge of the printable area (y)** box, type the distance of the blockout from the top edge of the badge printable area.

6. In the **Millimeter width of blockout item (dx)** box, type the width of the blockout.

7. In the **Millimeter height of blockout item (dy)** box, type the height of the blockout.

8. Click **OK**. The **Badge Layout - Blockout Item Definitions** dialog box appears with the blockout added in the list.

9. Select the blockout in the list and click **Place**. The blockout is placed on the badge layout in the **Badge Definition** window.

To edit a blockout:

1. Right-click on the blockout on the badge layout, and then click **Blockouts**. The **Badge Element Layout - Blockout Item Definitions** dialog box appears.

2. Select the blockout in the list and click **Edit**. The **Badge Element Layout - Add/Edit Blockout Item** dialog box appears.

You can edit the details of the blockout, such as, the Name, the distance of the blockout from the badge printable area, and the height and width of the blockout.

To delete a blockout:

1. To delete the blockout that is placed on the badge layout, right-click on the blockout on the badge layout, and then click **Delete Object**.

   OR

   To delete the blockout and its definition, right-click on the blockout on the badge layout, and then click **Blockouts**. The **Badge Element Layout - Blockout Item Definitions** dialog box appears. Select the blockout in the list and click **Delete**.

### Setting a Badge Background

You can import or capture background images for the badge layouts. You can also set the width, height, aspect ratios, and the tiled appearance of the image.

1. Right-click anywhere on the badge outline and click **Properties**. The **Badge Element Layout** dialog box appears.

2. Click the **Badge** tab.
3. In the **Background Image** list, select the image that must be applied to the badge background.

   See the **Setting a Badge Background** section in this chapter for more on importing and capturing images to the badge background.

4. Select the **Stretch Width** check box to stretch the width of the image.

5. Select the **Stretch Height** check box to stretch the height of the image.

6. Select the **Keep Aspect Ratio** check box to retain the existing aspect ratio of the image while stretching its height and width.

7. Select the **Tile Image** check box to enable a tiled appearance for the image.

8. Click **OK** to save the changes.

To import a background image:

1. On the **Badge** tab of the **Badge Element Layout** dialog box, click **Import**. The **Open** dialog box appears.

2. Locate for the image file or type the image **File Name**.

3. Click **Open**. The selected image file is listed in **Background Image**.

4. Click **Apply** to apply the image to the badge background or click **OK** to apply the image to the badge background and to close the **Badge Element Layout** dialog box.

To capture an image using a camera:

1. On the **Badge** tab of the **Badge Element Layout** dialog box, click **Capture**. The **Capture Image** dialog box opens displaying the live view from your video camera.

   See the **Configuring Badge DLLs** section in this chapter for details on configuring DLLs for Video Capture Cards.
Figure 7-15 Capturing an Image

2. Click **Settings** to expand the window and access the video settings.

Figure 7-16 Video Settings

3. Adjust the **Video**, and **Grab** settings for a satisfactory image.

Table 7-1 Live Screen Video Image Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Lightens or darkens the entire tonal range of the image.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Expands or contracts the entire tonal range of the image. The difference in highlights and shadows is increased or decreased.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Adjusts the vibrancy or the level of color in the image.</td>
</tr>
<tr>
<td>Hue</td>
<td>Adjusts the value of color in the image. This corrects incorrect coloring of images.</td>
</tr>
<tr>
<td>Sharpen</td>
<td>Sharpens blurry images by increasing the contrast of the adjacent pixels.</td>
</tr>
</tbody>
</table>
Table 7-2  Live Screen Grab Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Lightens or darkens the entire tonal range of the image.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Expands or contracts the entire tonal range of the image. These settings are applied to the camera when an image is captured. If you are not using a flash, set the Contrast the same as the Video settings. If a flash is used, reduce the Contrast settings lower than the Video settings. This prevents overexposure of the picture.</td>
</tr>
</tbody>
</table>

Note:

4. Click **Freeze** to capture the image.

5. To crop the captured image, use the cropping frame or enter the image proportion in **Aspect Ratio**, and select the **Lock Aspect Ratio** check box.
   
   **Tip:** If you are using the default badge size, set the aspect ratio to **0.625**, to fill the entire badge outline.

6. Adjust the **Photo** settings of the captured image.

Table 7-3  Live Screen Photo Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Lightens or darkens the entire tonal range of the captured image.</td>
</tr>
<tr>
<td>Compress</td>
<td>The captured image is saved as a jpg file. If required, use the slider to adjust the compression of the saved image. The lower the number, the greater the compression. <strong>Example:</strong> A setting of 100 applies the least amount of compression and provides the best image quality. A setting of 30 applies the most compression, but provides lower image quality.</td>
</tr>
</tbody>
</table>

7. Click **OK** to save the image.

**Setting a background color**

You can set a background color for a badge or for an item on the badge (for example, a bitmap, shape or signature.) The foreground color is not available unless an item is selected.

To select a color from the basic color palette:

1. Right-click on the badge outline and click **Properties**. The **Badge Element Layout** dialog box appears.

2. Click the **Colors** tab.
3. Click the ellipsis provided near the Background Color box. The Color dialog box is displayed.

4. From the Basic colors palette, click the color swatch you want to use for a background.

5. Click Apply to apply the color to the badge background or click OK to apply the color and to exit from the Color dialog box.

To define a custom color:

1. Right-click on the badge outline and click Properties. The Badge Element Layout dialog box appears.

2. Click the Colors tab.

3. Click the ellipsis button provided near the Background Color box. The Color dialog box is displayed.

4. Click Define Custom Colors to expand the Color dialog box.
5. If you know the Red, Green, Blue equivalents for a specific color, enter those values in the **Red**, **Green**, and **Blue** boxes.

OR

If you know the Hue, Saturation, Luminosity equivalents for a specific color, enter those values in the **Hue**, **Sat**, and **Lum** boxes.

OR

Use the color selector to choose the color.

### Table 7-4  Color Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hue</td>
<td>Wave length of light reflected by an object. It is the characteristic commonly called color, and identified by color names such as yellow, green, or orange. Hue values range from 0 (red) through 239 (running through the spectrum and returning to red).</td>
</tr>
<tr>
<td>Saturation</td>
<td>Strength of the color. It indicates the amount of gray in the color. Saturation values range from 0 (gray with no trace of color) through 240 (fully saturated color with no gray).</td>
</tr>
<tr>
<td>Luminosity</td>
<td>Luminosity is the relative brightness or darkness of the color. Luminosity values range from 0 (black) through 240 (white) with the un-tinted color at about 120.</td>
</tr>
<tr>
<td><strong>Red</strong></td>
<td>The RGB model is based on the representation of the visible spectrum by mixing red, green, and blue light. Computer monitors are based on this model, creating colors by emitting light through red, green, and blue phosphors.</td>
</tr>
<tr>
<td><strong>Green</strong></td>
<td>The RGB model assigns a value for each pixel ranging from 0 (black) to 255 (white) for each color component. The red on the Basic color palette has a Red value of 255, a Green value of 0 and a Blue value of 6.</td>
</tr>
<tr>
<td><strong>Blue</strong></td>
<td></td>
</tr>
<tr>
<td>Color Solid</td>
<td>The color swatch shows the color as it appears on the monitor, and also its approximate appearance when printed.</td>
</tr>
</tbody>
</table>
6. Click OK. The new custom color appears in the **Background Color** box of the **Badge Element Layout** dialog box.

7. Click Apply to apply the custom color to the badge background or click OK to apply the background color to thebadge and to exit from the **Badge Element Layout** dialog box.

**Tip:** Solid dark colors may not print evenly on all printers. Honeywell recommends that you use a light colored or a white background for the badge.

---

### Setting Magnetic Stripe Encoding

Magnetic stripe data can be defined for all the three tracks.

For each track, specify the magnetic stripe format: IATA, ABA, or TTS. The industry standard for track/format assignment is Track 1 - IATA, Track 2 - ABA, Track 3 - TTS. (The NR-1-WR, and the NR-5-KP read ABA on Track 2, and the NR-2-WR reads ABA on Track 1.)

Each track can have a number of data items, which is limited by the amount of data that can fit on a given track. Only certain ASCII characters can be used, depending on the format selected for that track.

**IATA** supports alphanumeric characters 0-9, and A-Z, and various punctuation characters (ASCII 32-95). Lower-case letters are converted to upper-case as IATA does not support lowercase letters. Use a “^” character in the place of a field separator.

**ABA** supports only numeric characters 0-9 and various punctuation characters (ASCII 48-63).

**TTS** supports only numeric characters 0-9 and various punctuation characters (ASCII 48-63).

The following is a list of the maximum number of characters that can be printed using the Datacard IC III printer.

**Table 7-5  Characters printed using Datacard IC III printer**

<table>
<thead>
<tr>
<th>Track</th>
<th>Type of character</th>
<th>Maximum Characters</th>
<th>Bits per inch</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alphanumeric</td>
<td>76</td>
<td>210</td>
</tr>
<tr>
<td>2</td>
<td>Numeric</td>
<td>37</td>
<td>75</td>
</tr>
<tr>
<td>3</td>
<td>Numeric</td>
<td>104</td>
<td>210</td>
</tr>
</tbody>
</table>

To Enter Magnetic Stripe Data:

1. Right-click on the badge outline and click **Properties**. The **Badge Element Layout** dialog box appears.

2. Click the **Track X1**, **Track X2**, or the **Track X3** tab.
3. Select Disabled, IATA, ABA, or TTS from the list on the upper-right corner.

4. Click Add or Edit to define items to be added to the track. The Badge Element Layout - Enter Data Item dialog box appears.

5. Enter the following data items:
   - **Expression**: Any combination of text or database fields can be entered. Type the desired text or double-click the appropriate field in the Fields list to enter it in the Expression field. The selected field appears within braces on the list.
   - **Fields**: The list contains all the note fields defined for card and cardholder. Double-click to select a field and to add it to Expression.
   - **Variable Length**: Select the check box if the field length in the bar code must match the number of characters in the data item.
   - **Length**: The data item is truncated or padded so that it precisely matches the number of characters.
   - **Fill**: Enter the character to be used to pad the data to fit a fixed-length field.
   - **Justify**: If a data item is shorter than the number of characters allotted for it, it can be justified left, center, or right, within those characters. All other characters are set to the Fill character.

6. Click OK to save any changes and return to the Badge Element Layout dialog box.
7. To reorder the data items in a track, click **Move Up** and **Move Down**.

8. To remove a data item from the list, select it and click the **Delete** button.

9. On the **Badge Element Layout** dialog box, click **Apply** to save the data items for the tracks or click **OK** to save the data items for the tracks and to return to the **Badge Definition** window.

### Placing Elements in the Badge Outline

After designing the badge outline, you can place items or elements on it to meet your specific needs. The badge holder’s photo, name, card number, and other pertinent information can be included on the badge. A bar code can be added to the badge for system applications ranging from access control and payroll to resource checkout. Bitmaps such as logos can be added and colors can be applied to the items.

The following are the types of items that can be placed on a badge outline and their corresponding toolbar icons:

- Text
- Bitmap
- Photo
- Bar code
- Shape
- Signature

### Placing a Text element

To place a text element on a badge, draw a text box, and then type the text and/or add card holder note fields. When you assign the badge to a card holder, the cardholder’s data is automatically fill in the text.

- To add a text block on the badge outline:
  a. Click **A** on the toolbar.
  b. Click and drag the mouse pointer on the badge outline to place the text. The text box is now placed on the badge outline.

- To add fields to the text area:
  a. Right-click on the text block and click **Properties**.
  b. Click the **Text Block** tab.
c. Double-click the field that must appear in the text box in the **Fields** list. The field is now placed under **Text**.

d. Type the field name within the parenthesis under **Text**.

e. Click **Font** to modify the font and color of the field name.

f. Select the **Size font to box** check box if you want to resize the font to fit the text block.

g. Click **Apply** to add the text box to the badge outline.

---

**Placing a Photo**

You can place a placeholder for the card holder’s photo on the badge design. When the badge is assigned to a card and card holder, the card holder’s photo is placed at the photo placeholder.

- **To add a photo on the badge outline:**
  a. Click ![Photo Icon] on the toolbar.
  b. Click and drag the mouse pointer on the badge outline to place the photo. The photo is now placed on the badge outline.

- **To change the photo properties:**
  a. Right-click on the photo and click **Properties**.
  b. Click the **Photo** tab.

![Photo Tab](image)

**Figure 7-23  Placing a Photo**

- c. Type or select the **Photo Index**.
- d. Select the **Stretch Width** check box to stretch the width of the photo.
- e. Select the **Stretch Height** check box to stretch the height of the photo.
- f. Select the **Keep Aspect Ratio** check box to retain the aspect ratio of the photo while stretching its height and width.
- g. Increase or decrease the **Ghosting** option to set the degree of transparency for the photo.
- h. Click **Apply** to place the photo in the badge outline.
**Badge Layout**

*Introduction*

**Placing a Shape on the Badge outline**

- To add a shape on the badge outline:
  a. Click on the toolbar.
  b. Click and drag the mouse pointer on the badge outline to place the shape. The shape is now placed on the badge outline.

- To change the properties of the shape:
  a. Right-click on the shape and click **Properties**.
  b. Click the **Shape** tab.

  ![Figure 7-24 Placing a Shape on the Badge Outline](image)

- Under **Shape Type**, click to change the type of the shape. If you click **Rounded Rectangle**, set its properties in the options provided under **Rounded Rectangle** frame.
- In the **Line Width** box, type the width for the shape outline.
- Click **Apply** to place the shape in the badge outline.

**Placing a Signature on the Badge outline**

You can place Signature placeholders on the badge where you need the card holder’s signature to appear. When the badge is assigned to a card holder, the card holder’s signature is applied to the badge.

A signature pad (Honeywell Access Systems PB-SIG-CAP or PBSIGCAPLCD) must be connected to the computer to capture signatures. The captured signatures are saved in vector format and placed on the cards, stretching proportionally to fill the signature placeholder. The signature background is made transparent to be placed on top of any other object on the badge.

- To add a signature to the badge outline:
  a. Click on the toolbar.
  b. Click and drag the mouse pointer on the badge outline to place the signature. The signature is now placed on the badge outline.

- To change the signature index:
  a. Right-click on the signature and click **Properties**.
  b. Click the **Signature** tab.
Placing a Signature on the Badge Outline

c. Type or select the **Signature Index**.

d. Click **Apply** to place the signature in the badge outline.

Placing a Bitmap on a Badge

Graphic images such as a logo or symbol can be placed on the badge. You can either create or scan your image and save it as a bitmap graphic file. Windows Bitmap (*.bmp), JPEG (*.jpg), Targa (*.tga), or TIFF (*.tif) files are supported.

- To add a bitmap on the badge outline:
  a. Click ![icon](image.png) on the toolbar.
  b. Click and drag the mouse pointer on the badge outline to place the bitmap.
     The bitmap is now placed on the badge outline.

- To change the bitmap properties:
  a. Right-click on the bitmap and click **Properties**.
  b. Click the **Bitmap** tab.

c. Select an image from the **Bitmap Image** list or click **Import** to import a bitmap.

d. Select the **Stretch Width** check box to stretch the width of the photo.

e. Select the **Stretch Height** check box to stretch the height of the photo.

f. Select the **Keep Aspect Ratio** check box to retain the aspect ratio of the photo while stretching its height and width.
g. Click **Apply** to place the bitmap in the badge outline.

**Placing a Bar Code on the Badge**

- To add a bar code on the badge outline:
  a. Click ![image](image1.png) on the toolbar.
  b. Click and drag the mouse pointer on the badge outline to place the bar code. The bar code is now placed on the badge outline.

- To add bar code data items:
  a. Right-click on the bar code and click **Properties**.
  b. Click the **Barcode Data** tab.

![image](image2.png)

**Figure 7-27** Placing a Bar Code on a Badge

- Click **Add** to add a new barcode data or select an existing bar code and click **Edit**. The **Badge Element Layout - Enter Data Item** dialog box appears.

![image](image3.png)

**Figure 7-28** Badge Element Layout-Enter Data Item
d. In the Expression box, enter the specific data to be contained in the bar code, or select an entry from the Fields list and double-click it to add the field to Expression.

e. If the field length of the bar code must be adjusted according to the number of characters in the data item, select the Variable Length check box.

f. If you want to set a fixed length for the bar code, clear the Variable Length check box and enter the following information:

- **Length** - The number of characters in the bar code. The data item is truncated or padded so that it has precisely the number of characters.
- **Fill** - The character used to pad the data in order to fit a fixed-length field.
- **Justify** - If a data item is shorter than the number of characters allotted for it, you can justify it to the left, center, or right, within those characters. The remaining characters are set to the character entered in the Fill box.

g. Click OK to save the bar code data items and to return to the Badge Element Layout dialog box.

h. To reorder the data items in a track, click Move Up and Move Down.

i. To remove a data item from the list, select it and click the Delete button.

j. On the Badge Element Layout dialog box, click Apply to save the data items for the tracks or click OK to save the data items for the tracks and to return to the Badge Definition window.

- To change the appearance of barcode data:
  a. Right-click on the barcode and click Properties.
  b. Click the Barcode tab.

c. Enter the following barcode options:

- **Text** - Text to be displayed above the bar code.
- **Style** - Style setting for the barcode characters.

**Table 7-6 Style for Bar Codes**

<table>
<thead>
<tr>
<th>Style</th>
<th>Bar Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 of 5</td>
<td>MSI</td>
</tr>
</tbody>
</table>
Table 7-6 Style for Bar Codes

<table>
<thead>
<tr>
<th>Style</th>
<th>Bar Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 of 5 interleaved</td>
<td>ITF</td>
</tr>
<tr>
<td>3 of 9</td>
<td>Code 11</td>
</tr>
<tr>
<td>Codabar</td>
<td>Code B</td>
</tr>
<tr>
<td>Code 39</td>
<td>Telepen</td>
</tr>
<tr>
<td>Code 93</td>
<td>UPC A</td>
</tr>
<tr>
<td>Code 128</td>
<td>UPC E</td>
</tr>
<tr>
<td>EAN 128</td>
<td>Code 128 A</td>
</tr>
<tr>
<td>EAN 13</td>
<td>Code 128 B</td>
</tr>
<tr>
<td>EAN 8</td>
<td>Code 128 C</td>
</tr>
</tbody>
</table>

- **Ratio**: Determines the ratio of thickness of the thin bars to the thick bars in the bar code. For example, a ratio of 2.00 means that thick bars are twice the width of thin bars.
- **Spacer**: Adds space before and after the bar code when Show Text is enabled.
- **Bearer Thickness**: Thickness, in points, of the bearer bars.
- **Font Adj**: Adjusts the font size in relation to the bar code.
- **Show Text**: Displays the bar code data as text underneath the encoded information.
- **W Bearer Bar**: Displays the width bearer bars (top and bottom borders).
- **H Bearer**: Displays the height bearer bars (left and right borders).
- **Check Digit**: For error detection.
- **Show Spacer**: Displays space before and after the bar code data.
- **Switch Text**: Switches the top and bottom text. The bar code data displayed as text is placed above the bar code and the text entered into the Text field is displayed below the bar code.
- **Check Digit 2**: For error detection.
- **Arial**: Arial is the text font.
- **Courier New**: Courier New is the text font.
- **Bold**: Applies bolding to the text.
- **Italic**: Italicizes the text.

**Common properties of elements**

- To set the colors for the elements:
  a. Right-click on the element and click Properties.
  b. Click the Colors tab.
c. Click the ellipsis button provided near the Foreground Color box to select a foreground color for the element.

d. Click the ellipsis button provided near the Background Color box to select a background color for the element.

e. Select the Transparent Background check box to set a transparent background to the element.

f. Click Apply to set the common properties for the element.

• To position the element:
  
a. Right-click on the element and click Properties.
  
b. Click the Positioning tab.

  c. Select the Horizontal Position of the element.
  
d. Select the Vertical Position.
  
e. Select the Orientation.
  
f. Type the Top, Left, Height and the Width of the badge in millimeters.
  
g. Click Apply to apply the badge outline.

**Item layering order**

Badge items are layered as they are placed. When an item is selected, it is brought to the top of the layering order. Layering can also be controlled using the Change Layering icon on the toolbar in the Badge Definition window.

• To change the items in the layering order:
  
a. Click on the toolbar in the Badge Definition window. The Badge Element Layout - Badge Item Layering dialog box appears, displaying the list of elements placed on the badge.
Badge Layout

Introduction

Figure 7-32  Badge Item Layering

b. In the Badge Items list, select the item to be moved.

c. Click Up to move the item up or click Down to move the item down.

d. Click Top to bring the selected item to the upper layer of the badge.

e. Click Properties to open the Badge Element Layout dialog box for the selected item. The item's properties can be edited without changing its layering order.

f. Click OK to save the changes.

- To select an item in the layering order, click the Select Next Item button. Each time you click the button, it moves to the next item. Continue clicking the button until the item you want is selected.

Configuring Badge DLLs

A specific dynamic-link library (dll) file is required for the video capture card, TWAIN device, and signature pad used with the WIN-PAK System. The DLLs for currently supported hardware are included in the WINPAK PRO directory and are installed from within WIN-PAK.

1. Choose Configuration > Badge > Badge DLL’s. The Badge DLL’s dialog box is displayed.

Figure 7-33  Configuring Badge DLLs

2. Select one of the following Capture Driver Type options:

- **Microsoft DirectX** – Click this option if you want to capture the video using DirectX and no specific video capture card driver is required.

- **DLL** – Click this option if you have the access to Video Capture Card DLLs such as FlashBus.dll, FlashPoint.dll, TWAIN.dll and so on.
3. If you have selected Microsoft DirectX, select the video driver from the DirectX Compatible Video Driver list.

4. If you have selected DLL,
   a. Click the ellipsis button next to Video Capture card DLL. An Open dialog box appears with WIN-PAK PRO opened as the default directory.
   b. Select the appropriate .dll file, and click Open. The .dll file path is displayed in the Video Capture Card DLL box of the Badge DLL’s dialog box.

1. Open the Windows Explorer.
2. Choose Tools > Folder Options. The Folder Options dialog box appears.
3. Click the View tab.
4. Under Advanced settings, expand Files and Folders and then Hidden files and folders.
5. Click Show hidden files and folders.
6. Click Apply to apply the changes you have made and click OK to exit from the dialog box.
7. Click the ellipsis button next to Signature Pad DLL. An Open dialog box appears with WIN-PAK PRO opened as the default directory.
8. Select the appropriate .dll file and click Open. The path of the .dll file is displayed in the Signature Pad DLL box of the Badge DLL’s dialog box.
9. Click OK to save the dll details and to close the Badge DLL’s dialog box.

Setting up Badge Printers

Overview
WIN-PAK SE PE is compatible with many printers. Any printer that is supported by the Windows operating system can be used for printing badges. However, for two-sided PVC printing or magnetic stripe encoding, a Datacard or the Ultra Magicard printer is required. In addition, Windows-compatible laser or other color printers can be used to print badges on paper.

Configuring Badge Printers
1. Choose Configuration > Badge > Configure Badge Printer. The Badge Printer Setup dialog box appears with the list of printers configured in your computer.
2. Select the printer required for badge printing in the Printer Name list.

3. Select the Printer Type.

4. Under Magnetic Stripe, select the Encode Mag Stripe check box if you want to encode magnetic stripe information.

5. Select Encode Only if you want to only encode the magnetic stripe information and not print it.

6. Under Orientation, click Portrait or Landscape. The default orientation for the badge is Landscape.

7. Under Page Size, select the page size in inches or millimeters. The default page size for the badge is 53.5 mm x 85 mm.

8. Click OK to save the badge printer settings and close the Badge Printer Setup dialog box.

Figure 7-34 Configuring Badge Printers
# Card Holders

## In this chapter...

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>8-2</td>
</tr>
<tr>
<td>Configuring Additional Information</td>
<td>8-2</td>
</tr>
<tr>
<td>Configuring Card and Card Holder Information</td>
<td>8-13</td>
</tr>
<tr>
<td>Importing Card and Card Holder Information</td>
<td>8-32</td>
</tr>
<tr>
<td>Visitor Management</td>
<td>8-38</td>
</tr>
</tbody>
</table>
Overview

The chapter **Card Holders** describes how to configure card and card holders details and to assign cards to a card holder. In general, cards are added to WIN-PAK in large volume and later, they are assigned to the card holders as per the need.

A card holder can hold more than one valid card at the same time. These cards can be used by the card holder for access to multiple facilities. Multiple cards can also be issued to the family members of the card holder for using company facilities, such as gym, recreational center and so on.

The card and card holder information are defined for a specific account. Therefore, you must select an account to enable the card and card holder menu options.

**Card**

Cards are defined by card number, access level, and the status of the card whether Active or Inactive. Badge designs can be assigned to the cards and cards can be assigned with a PIN number for enabling high security. WIN-PAK enables you to add a single card or a bulk of cards. Later, the cards are associated to the employees, visitors, and so on.

In addition, you can define a card as a privileged card that can be used for setting the Galaxy group or arm the Vista partitions. However, you must procure the license for the Galaxy panel and/or Vista panel to avail this facility in WIN-PAK.

**Card Holders**

A Card Holder is a person who holds a card. Card Holders in WIN-PAK are defined by information such as First Name and Last Name and User-defined fields referred to as note fields. These fields are used for storing the additional information of a card holder such as qualification, passing year, employee number, and so on.

In addition, a card holder can be associated to user codes for accessing the Galaxy panel or Vista panel. However, you must procure the license for the Galaxy panel and/or Vista panel to avail this facility in WIN-PAK.

- Time Zones
- Devices
- Access Areas
- Badge Design

See the "Time Management" in Chapter 9, "Device Map" in Chapter 10, "Defining Areas" in Chapter 11, and "Badge Layout" in Chapter 7 sections for more information on the above-mentioned sections.

Configuring Additional Information

As card holder information is specific to an account, you must select an account before you start working with card holders. If required, you can also configure the following additional information before you configure a card holder:

- Note fields
- Card holder tab layouts
- Access levels

Note field is a user-defined field for adding additional information to the card holder. These note fields are grouped together to form a card holder tab layout. Access level is a level of access provided to the Card Holders for various doors in the WIN-PAK system.

See the Configuring Note Field Template, Configuring Card Holder Tab Layout and Configuring Access Levels sections in this chapter for more information.
Therefore, configuring a Card Holder includes:

- **Selecting an Account** - You must select a specific account to enable the Card Holders menu options.
- **Configuring Note Field Template** - You can configure a note field template and associate it with the card holder tab layout.
- **Configuring Card Holder Tab Layout** - You can configure a card holder tab layout and associate it to card holders.
- **Configuring Access Levels** - You can configure various access levels and set the permissions for the access to doors based on the time zones.

### Selecting an Account

Card holders are defined for a specific account.

To select an account, perform the following steps:

1. Choose **Account > Select**. The Select Account dialog box appears.
2. Select an account in the list.
3. Click **OK**. The account is selected and displayed in the Title bar.

### Configuring Note Field Template

Note field template is a field that is defined for recording card holders’ additional information such as Gender, Date of Birth, College Studied, Passing Year, and so on. You can define a maximum of 40 note fields in WIN-PAK.

### Adding a Note Field Template

To add a note field template

1. Choose **Configuration > Card Holder > Note Field Template**. The Note Field Template window appears.
2. Click **Add** to add a new note field template. The Note Field dialog box appears.

![Note Field dialog box](image)

3. Type the **Name** of the note field. For example, Passing Year.
4. Type the format of the **Template**.
The template defines the character type and the number of characters in the note field. Thus, it creates a mask for the note field for consistent and unambiguous usage. The following table describes the list of mask properties:

**Table 8-1 Describing mask properties with examples**

<table>
<thead>
<tr>
<th>Input character</th>
<th>Mask Description</th>
<th>Example (Name, Template)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nil</td>
<td>No mask is applied.</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Only numbers (0-9) are allowed.</td>
<td>DOB, ###</td>
</tr>
<tr>
<td>?</td>
<td>Only alphabets (a-z or A-Z) are allowed.</td>
<td>Name, ???????????</td>
</tr>
<tr>
<td>A</td>
<td>Only alphanumeric characters (0-9, a-z and A-Z) are allowed.</td>
<td>Time, ##:## UU</td>
</tr>
<tr>
<td>U</td>
<td>Only upper-case alphabets (A-Z) are allowed.</td>
<td>Time, ##:## UU</td>
</tr>
<tr>
<td>L</td>
<td>Only lower-case alphabets (a-z) are allowed.</td>
<td>Time, ##:## UU</td>
</tr>
<tr>
<td>&amp;</td>
<td>Any characters are allowed including special characters.</td>
<td>Time, ##:## UU</td>
</tr>
<tr>
<td>~</td>
<td>Defines the list of items.</td>
<td>Color, <del>Red</del>Green~Blue</td>
</tr>
<tr>
<td>\ (Escape Character)</td>
<td>Defines the character position in the note field.</td>
<td>Time, ##:## UU</td>
</tr>
</tbody>
</table>

5. Click **OK** to create a new note field template.

**Searching and Sorting Note Field Templates**

To search and sort a note field template

1. Choose **Configuration > Card Holder > Note Field Template**. The Note Field Template window appears.
2. Select an item in the Search Field list.
   - **All** - Lists out all the note field templates.
   - **Name** - Searches for similar note field names.
   - **Template** - Searches for similar template names.
3. If you have selected **Name** or **Template** in the **Search Field**, select the **Criteria**.
   - **Begins With** - Searches for the name or template that begins with the text in the **Search For** text box.
   - **Equals** - Searches for the name or template that exactly matches with the text in the **Search For** text box.
   - **Greater Than** - Searches for the name or template that is alphabetically greater than the text in the **Search For** text box.
   - **Less Than** - Searches for the name or template that is alphabetically less than the text in the **Search For** text box.

4. Type the text to be searched in the **Search For** text box.

5. Select an item in the **Sort By** list.
   - **None** - No sorting required.
   - **Name** - Sorts the list in the ascending order of the names.
   - **Template** - Sorts the list in the ascending order of the templates.

6. Click **Update List** to list the searched items in the sorted order.
   - If you want to sort the entire list, you can perform any of the following steps:
     a. Double-click the column title to be sorted out.
     b. Select **All** in the Search Field list, select the **Sort By** item and then click **Update List**.
   - If you want to search without any sorting, you can perform the following steps:
     a. Enter the details to search.
     b. Select **None** in the **Sort By** list and then click **Update List**.

### Isolating and Deleting a Note Field Template

To delete a Note Field, it must be isolated from the card holder tab layouts and/or card holders. To isolate a Note Field:

1. Choose **Configuration > Card Holder > Configure Note Field Template**. The **Note Field Template** window appears.
2. Select the note field to be isolated and/or deleted.
3. Click **Isolate**. The **Isolate** dialog box appears.
4. Click the **Card Holders** tab. It is selected by default.
5. Select the card holder in the **Name** list. You can also select multiple card holders by holding the Shift key or Ctrl key while selecting.

6. Click **Delete** to remove the selected note field from the card holder details or click **Delete All** to remove all the note fields. A message for confirming the deletion appears.

7. Click **Yes** to delete.

8. Click the **Tabs** tab. The list of tabs associated with the note field is displayed.
9. Select the tab in the **Name** list. You can also select multiple tabs by holding the SHIFT key or CTRL key while selecting.

10. Click **Remove** to isolate the selected tabs from the tab note fields or click **Remove All** to isolate all the note fields. A confirmation for isolation appears.

11. Click **Yes** to confirm the isolation.

**To delete a note field:**

1. In the **Note Field Template** window, select the note field from the list.
2. Click **Delete**. A confirmation for deletion appears.
3. Click **Yes** to confirm the deletion.

**Configuring Card Holder Tab Layout**

A card holder tab layout is a collection of user-defined note fields. For example, Educational Info tab may contain the note fields such as College Name, Passing Year, Aggregate, and so on. This card holder tab layout will be displayed in the **Card Holder** window.

![Figure 8-4 Customizing Card Holder information using Card Holder Tab Layout](image)

**Adding a Card Holder Tab Layout**

Before adding a card holder tab layout, ensure that the note field templates are added.

To add a card holder tab layout:

1. Choose **Account > Select** to select the account to which you want to add the card holder tab layout.
2. Choose **Configuration > Card Holder > Card Holder Tab Layout**. The **Card Holder Tab Layout** window appears.
3. Click **Add** to add a new card holder tab layout. The **Card Holder Tab Layout Record** window appears.
Card Holders
Configuring Additional Information

Figure 8-5  Card Holder Tab Layout Record window

4. Type the Tab Name. For example, Educational Info.
5. In the Available Note Fields, select a relevant note field to be added to the card holder tab layout. For example, College Name.
   * In sequence: Hold the SHIFT key and select the note fields.
   * At random: Hold the CTRL key and select the note fields.
6. Click Add to add the selected note fields to the card holder tab layout.
7. To remove a note field, select the note field and click Remove.
8. To change the order of note fields in the list, select the note field and click ▲ or ▼.
9. Click OK to add a new card holder tab layout.

Rearranging the Card Holder Tab Layouts
You can rearrange the card holder tab layouts in a sequence that has to be displayed in the Card Holder window.

To rearrange the card holder tab layouts:

2. Select the card holder tab layout to be rearranged.
3. Click ▲ or ▼ to move the selected tab up or down. The card holder tab layouts are rearranged accordingly.

Configuring Autocard Lookup
When a card is accessed, WIN-PAK identifies the card holder and displays the basic information in Autocard Lookup by default.

See the Autocard Lookup section in the chapter Monitoring Actions for more details on activating autocard lookup window and viewing the card holder details.

If you want to view additional information of the card holder in the Autocard Lookup window, you have to configure the settings using the Autocard Lookup option.

To include additional information (note fields) of the card holder:
1. Choose **Configuration > Card Holder > Configure Autocard Lookup**. The Autocard Lookup Configuration dialog box appears.

   ![Autocard Lookup Configuration](image)

   **Figure 8-6  Autocard Lookup Configuration**

2. In the **Show Note Field** list, select the note fields that must be displayed in the Autocard Lookup window.

3. Click **OK** to save the configuration and close the dialog box.

### Configuring Access Levels

Access levels provide restricted access to the WIN-PAK users for various areas in the access control system. The **Access Level** window contains information of the existing access levels and the corresponding access areas.

### Adding a New Access Level

To add a new access level:

1. Choose **Card > Access Level**. The **Access Level** window appears. The existing access levels are displayed on the left and the Access Areas on the right.

2. Click **Add**. The **Access Level** dialog box appears. The access level is account specific and so the current account is listed in the **Selected Accounts** list.
Configuring Additional Information

Figure 8-7 Adding a new Access Level

3. Type the **Name** of the access level and the **Description**.

4. If the access level is specific to visitors, select the **Visitor** check box. The visitor check box is displayed, only if you have license for Visitor Management. Refer to the “Adding Access Level” section in the chapter Visitor Management System for more details.

5. If you want to assign the access level to the other accounts, select the account in the **Available Account** list and click **Add**. The account is moved to the **Selected Account** list.

6. Click **OK** to save the details and close the dialog box.

Configuring Access Area

To configure an access area:

1. Choose **Card > Access Level**. The **Access Level** window appears.
Figure 8-8  Access Level window

The left-side of the window lists the access levels and the right-side of the window displays the access area tree.

2. Select the access level from the left-side to view the access areas of the selected level. The color of an icon defines the access permission of a group (folder) or an entrance.
   - Red - No access is permitted to any of the entrances in the area.
   - Yellow - Access permitted to some entrances in this area.
   - Green - Access permitted to all the entrances in this area during the assigned time zone.

3. In the Access Level window, right-click the access area to which you want to set the access levels and select Configure. The Configure Entrance Access dialog box appears.

4. For an entrance, select one of the following:
   - Remove Access from all entrances in this area to deny access through this entrance for this access level.
   - Set Access for all entrances in this area to allow access through this entrance for a particular time zone. Select the time zone in the Time Zone list to determine periods of access.

For group entrance, select one of the following:
Card Holders
Configuring Additional Information

- **Leave Access for all entrances in this area as it currently is** to continue the same for each entrance in this group.
- **Remove Access from all entrances in this area** to deny access through these entrances for this access level.
- **Set Access for all entrances in this area** to allow access through these entrances for a particular time zone. Select the time zone in the Time Zone list to determine periods of access.

5. To search for a specific reader or device in a tree, right-click and select Find. Type the full text and click OK. The reader or device is selected.
6. To refresh the list, right-click and select Refresh.

**Copying the Access Level**
WIN-PAK enables you to create a copy of the existing access level with the same properties.
To create a copy of an access level:
2. Select the access level to be copied and click Copy. The Access Level dialog box appears with the existing set up.
3. Type the new Name for the access level. By default, the name is prefixed by the word “Copy of”.
4. Change other settings if required and click OK. This duplicates the access level.

**Isolating and deleting Access Levels**
You cannot delete an access level, when it is associated to a card or card holder. In such a case, you must isolate the access level from the card and card holder and reassign it to an alternate access level.
To isolate the access level:
2. Select the access level to be deleted and then click Isolate. The Isolate dialog box appears with a list of associated cards and card holders.
3. Select the card and the alternate access level.
4. Click Reassign to reassign the selected card.
   OR
   Click Reassign All to reassign all the associated cards.
5. Click OK to close the Isolate dialog box.

To delete the access level:
2. Select the access level and click Delete. The access level is deleted.
Configuring Card and Card Holder Information

In WIN-PAK, you can configure card and card holder information by:

1. Adding a card and card holder in WIN-PAK manually.
   
   See the Adding a Card and Card Holder Information section in this chapter for adding a card and card holder information in WIN-PAK manually.

2. Importing the card and card holder information from an Excel sheet to WIN-PAK.
   
   See the Importing from Excel Sheet section in this chapter for importing a card and card holder information from an excel sheet.

Adding a Card and Card Holder Information

Adding a Card Holder

Adding a card holder involves:

- Providing card holder basic information
- Providing card holder additional information
- Adding a new card and attaching the card to the card holder

Providing card holder basic information


   ![Card Holder window](image)

   Figure 8-10 Card Holder window

2. Click Add or click in the toolbar. The Card Holder dialog box appears.
Card Holders
Configuring Card and Card Holder Information

3. In the Basic Info tab, type the First Name and Last Name of the card holder. These fields are mandatory.
4. Click OK. The basic information is saved.

Providing Card Holder additional information

Using the user-defined tabs, you can add the additional information of the card holder.

2. Click Add. The Card Holder dialog box appears.
3. Select the user-defined tab to add the additional information of the card holder.
Card Holders
Configuring Card and Card Holder Information

4. Enter the additional information of the card holder in the fields under the Card Holder Data column.
5. Repeat steps 3 and 4 for the remaining user-defined tabs.
6. Click Apply. The additional information is saved.

Adding and attaching a Card to a Card Holder

Using the Cards tab, you can attach a new card or an existing card to a card holder. In addition, you can print a badge associated to it or you can print the card reports.

1. In the Card Holder dialog box, click the Cards tab.
Card Holders
Configuring Card and Card Holder Information

2. Click Add to add a new card. The Card Record dialog box appears. See the Adding a Card section in this chapter for details on adding cards. The new card is automatically attached to the card holder, after adding it here.

3. Click Attach to attach an existing card to the card holder. The Select dialog box appears.

4. Select Card Number or Access Level in the Find Key list.

5. Enter the keyword in the Find What list and click Find. The cards that match the criteria are displayed.
6. Select the card and click **OK**. The selected card is attached to the card holder.

To edit the card details:

a. Select the card from the list of cards and click **Edit**. The **Card Record** dialog box appears.

b. Change the required card details and click **OK**.

To delete a card:

a. Select the card from the list of cards and click **Delete**. A confirmation message appears for deletion.

b. Click **OK**. The card is deleted from the database.

To detach a card:

a. Select the card from the list and click **Detach**. The card is detached from the card holder.

**Attaching User Codes to a Card Holder**

A card holder can be attached to the user codes for accessing and working on the Galaxy panel or Vista panel.

To attach user codes to the card holder:

1. In the **Card Holder** dialog box, click the **Attach User Codes** tab.

![Attached User Codes tab](image)

**Figure 8-15 Attached User Codes tab**

2. In the **Panel Name** list, select the panel to which you want to associate the user codes. The user codes that are configured for the selected panel are listed out.

   The **Panel Name** list contains the Galaxy and Vista panels that are configured in the Device Map.

   See the "Adding a Galaxy Panel" in Chapter 10 or "Adding a Vista Panel" in Chapter 10 sections for configuring panels in WIN-PAK.

---

**Card Holders**

*Configuring Card and Card Holder Information*
3. In the **Available User Codes** list, select the user codes to be associated to the card holder.

4. Click **Add**. The selected user codes are moved to the **User Codes associated** list.

   **Tip:** If you want to remove the associated user codes, select the user codes from the User Codes associated list and click **Remove**.

### Printing a Badge and Card Report

To print a badge associated with the card,

1. Select the card from the list and click **Print Badge**. The badge is printed.

   **OR**

   Perform the following steps:

   a. Select the card from the list and click **Print**. The **Select Printed Output** dialog box appears.

   b. Click **Print Cards**. The **Print Badge Preview** of the badge associated to the selected card appears.

   ![Print Badge Preview](image)

   **Figure 8-16**  **Print Badge Preview**

   c. Click **Print**. The badge is printed.

### Attaching a Photo or Badge to a Card Holder

To attach a photo:

1. In the **Card Holder** dialog box, click the **Card Biometrics** tab.

2. In the **Frame Selected** list, select **Photo** to attach a photo or badge to the card holder. The **Photo** frame is highlighted.

3. Under **Badge Layout**, select **Photo** to attach a photo.

4. To import an image file for the photo:

   a. Click **Import**. The **Import Image** dialog box appears.
b. Click **Open** and browse through the required folder.

c. Select the image file and click **Open**. The selected photo appears in the display area.

d. Select the **Whole Image** check box to import the photo without cropping.

e. To crop the photo, clear the **Whole Image** check box. The cropping tool appears on the photo.

f. To increase the grid size, click the corners of the grid and drag it to the required size.

g. To maintain the consistent height and width, enter the **Aspect Ratio** value.

h. To maintain the same ratio of height and width, select the **Lock Aspect** check box.

i. Adjust the **Compression** setting at this point, if required.

j. Click **OK** to close the dialog box and import the photo.

5. To capture a photo using a camera:

   a. Click **Capture**. The **Capture Image** window appears with the live show from your video camera.

   b. Click **Settings** to expand the window and access the video settings.
c. Adjust the Video settings for a satisfactory image.

Table 8-2 Live Screen Video Image Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Lightens or darkens the entire tonal range of the image.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Expands or contracts the entire tonal range of the image.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Adjusts the vibrancy or the level of color in the image.</td>
</tr>
<tr>
<td>Hue</td>
<td>Adjusts the value of color in the image. This corrects the incorrect coloring of images.</td>
</tr>
<tr>
<td>Sharpen</td>
<td>Sharpens blurry images by increasing the contrast of the adjacent pixels.</td>
</tr>
</tbody>
</table>

Table 8-3 Live Screen Grab Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Lightens or darkens the entire tonal range of the image.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Expands or contracts the entire tonal range of the image.</td>
</tr>
</tbody>
</table>

These settings are applied to the camera when an image is captured. If you are not using a flash, set the Contrast to the same as the Video settings. If a flash is used, reduce the Contrast settings to lower than the Video settings. This prevents overexposure of the picture.

**Note:** The exact settings must be determined by experimentation, as they vary depending on the type of flash, distance from the subject, and other lighting being used.

d. Click Freeze to capture the image.

e. To crop the captured image, use the cropping frame or enter the image proportion in Aspect Ratio, and select the Lock Aspect Ratio check box.

**Tip:** If you are using the default badge size, set the aspect ratio to 625, to fill the entire badge outline.
f. Adjust the **Photo settings** of the captured image.

**Table 8-4 Live Screen Photo Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Brightness</td>
<td>Lightens or darkens the entire tonal range of the captured image.</td>
</tr>
<tr>
<td>Compress</td>
<td>The captured image is saved as a .jpg file. If required, use the slider to adjust the compression of the saved image. The lower the number, the greater the compression. <strong>Example:</strong> A setting of 100 applies the least amount of compression and provides the best image quality. A setting of 30 applies the most compression, but provides lower image quality.</td>
</tr>
</tbody>
</table>

6. To export the captured image into a file:
   a. Click **Export**. A confirmation message appears indicating that the image is exported.

   ![Image file exported successfully](image.png)

   **Figure 8-20 Export confirmation message**

   The image is exported to a file and the file is stored in the **Database\Exported Files** folder in the WIN-PAK installation path. The format of the file is `<First Name>b<Last Name>b<index of the photo>.jpg`, where b indicates blank.

   b. Click **OK**.

   To capture additional card holder photos:
   - Follow the same procedure of capturing a card holder’s photo.
   - Change or increase the **Index** number.

   **Caution:** If you capture a different image with the same index number, the new photo replaces the existing photo.

   To attach a badge to a card holder:
   1. In the **Card Holder** dialog box, click the **Card Biometrics** tab.
   2. In the **Frame Selected** list, select **Photo** to attach a photo or badge to the card holder. The **Photo** frame is highlighted and the attached photo is displayed in the preview area.
   3. Under **Badge Layout**, select **Badge Back** or **Badge Front** to attach a badge to a card holder at the back or front.
Card Holders
Configuring Card and Card Holder Information

4. Select the badge design in the **Badge Layout Name** list. The selected badge design is displayed in the preview area.

   **Tip:** To detach a badge, select None in the **Badge Layout Name** list.

**Attaching a Signature to a Card Holder**

1. In the **Card Holder** dialog box, click the **Card Biometrics** tab.

2. In the **Frame Selected** list, select **Signature** to attach a signature to the card holder. The **Signature** frame is highlighted.

3. To import an existing signature file:
   a. Click **Import**. The **Open** dialog box appears.
Configuring Card and Card Holder Information

Figure 8-22 Open dialog box

b. Select the signature file (.sig or.emp file) and click Open. The signature is displayed in the preview area.

OR

To capture the signature, click Capture. The Enter Signature dialog box is displayed.

a. Select the Signature Width as Thin, Bold, Thick.

b. Click OK to close the dialog box and display the signature on the Card Biometrics tab.

4. To delete the signature, click Delete.

To capture additional card holder signatures:
- Follow the same procedure of capturing card holder signature.
- Change or increase the Index number.

Caution: If you capture a different image with the same index number, the new signature replaces the existing signature.

Adding a new Card and attaching it to a Card Holder

The Card Biometrics tab enables you to add a new card (with basic details like card number and access level) and attach it to the card holder.

To add a new card:
1. In the Card Holder dialog box, click the Card Biometrics tab.
2. At the bottom, click New next to Card Number.
3. Type a unique Card Number and press ENTER.
4. Select the Access Level of the new card. The new card is added and attached to the card holder.
   Tip: To verify the card attachment, click the Card tab and view the new card in the card list.
5. To print the badge design attached to the card, click Print Badge.
6. Click OK to save and close the Card Holder dialog box.

Editing Card Holder Information

To edit the card holder details:
2. Select the card holder from the list and click Edit. The Card Holder dialog box appears.
Card Holders
Configuring Card and Card Holder Information

See the Adding a Card Holder section in this chapter for information on editing card holder details.

Deleting a Card Holder

To delete a card holder:

2. Select the card holder to be deleted from the list and click Delete. The Card Holder - Dependency Conflict dialog box appears.

![Dependency Conflict dialog box](image)

3. Select Delete Attached Cards to delete the cards attached to the card holder.

   OR

   Select Detach Attached Cards to detach the cards from the card holder.

4. Click OK. A confirmation for deletion or detachment appears.
5. Click Yes to confirm the deletion or detachment.
6. Select the appropriate option to delete or detach the attached images or signatures and click OK.
7. Click Yes to confirm the deletion or detachment.

Adding a Card

A card holder is uniquely identified by the card. The access levels can be defined for the cards. When a card is attached to a card holder, the card holder has access only to those areas of the access level.

To add a card:

1. Choose Card > Card or click in the toolbar. The Card window is displayed.
2. Click **Add** to add a new card. The **Card Record** dialog box appears.
3. The **Card Properties** tab is selected by default.

4. Type a unique **Card Number**.

5. Click the ellipsis button to select the **Card Holder**. The **Select** dialog box appears.

6. Select the **First Name** or **Last Name** in the **Find Key** list.

7. Enter the keyword in the **Find What** box and then click **Find**. A list of card holders that matches the criteria is displayed.

8. Select the card holder and click **OK**. The **Select** dialog box is closed and returned to the **Card Record** dialog box.

9. Select the **Status** of the card:
   - **Active**: The card is ready for access. It is selected by default.
   - **Inactive**: The card is on hold for access.
   - **Lost or Stolen**: The card is lost or stolen and the access is restricted.
   - **Trace**: The card is ready for access and given special attention while accessing. The card details are displayed in Alarm View while accessing the card.

10. Select the access level of the card in the **Access Level** list. You must assign an access level, if you have selected the Status as **Active** or **Trace**.

11. Type the **Issue** number to trace the number of times the card is issued.

12. Type the unique **PIN** number. The PIN number adds more security to the card.

   **Note:** 6 digit PINs are compatible only with the NetAXS panels. If N1000 panels are present in the system, then you must configure the PIN between 1 and 65535.

13. Select the **Privileged** check box if the card must be assigned as a privileged card. The card holder can set or clear the galaxy groups associated to the reader on which the card is presented. If the Vista feature is enabled, the card holder can or arm or disarm the vista partitions.

14. Describe the card details in **Description**.

15. Select the **Visitor** check box if the card holder is a visitor.

   **Note:** Only applies if Lobby Works version 3.2 is used on a Windows XP operating system.

16. Under **P-Series Trigger Control**, type the **User Level** number to trigger certain controls when this card is used. You can use or buttons to increase or decrease the current index number.

---

**Defining a custom Access Level**

**Note:** Currently NetAXS panels have a limit of 128 access levels. Hence this option should be used sparingly when NetAXS panels are used

1. In the **Card Properties** tab, next to **Custom Access Level**, click **Add** (if you are defining newly) or **Edit** (if you have defined already). The **Custom Access Level** dialog box appears.

2. Right-click and select configure area access or double-click the area where you want to provide access. The **Configure Entrance Access** or **Configure Area Access** dialog box appears based on the selected area; Entrance or Area.

3. For one entrance, select one of the following:
Figure 8-26  Defining custom Access level

- **Remove Access from all entrances in this area** to deny access through this entrance for this access level.
- **Set Access for all entrances in this area** to allow access through this entrance for a particular time zone. Select the time zone in the Time Zone list to determine periods of access.

For group entrance, select one of the following:

Figure 8-27  Configuring Group Entrance

- **Leave Access for all entrances in this area as it currently is** to continue the same for each entrance in this group.
- **Remove Access from all entrances in this area** to deny access through these entrances for this access level.
- **Set Access for all entrances in this area** to allow access through these entrances for a particular time zone. Select the time zone in the Time Zone list to determine periods of access.

4. Click **OK** to set the access for the selected area and return to the **Custom Access Level** dialog box.
Card Holders
Configuring Card and Card Holder Information

Figure 8-28  Custom Access Level dialog box

5. To set the start date for the customized access level, click None in First Valid Date. The First Valid Date calendar appears.

Figure 8-29  First Valid Date

6. Select the Month, Year and then select the date.

7. To select the current date, click Today and then click OK to return to the Custom Access Level dialog box.

8. To set the end date for the customized access, click None in Last Valid Date. The Last Valid Date dialog box appears.

9. Select the date in the same way that you have selected for First Valid Date and click OK.

10. Select the Show Original Access only check box to view the original access levels of the areas.

11. Click OK to save the access levels and return to the Card Record dialog box.

Defining an Action Group for the Card

1. In the Card Properties tab, click View next to Action Group. The Abstract Device Record dialog box appears.

2. Select the Name of the action group and click OK. The Abstract Device Record dialog box is closed.
Setting the NetAXS Card type

Cards used with a NetAXS panel can be set with a Card Type. The card types available are: Standard, Supervisor, and VIP. Different card types are introduced to have more flexibility in providing appropriate privileges to card holders.

1. Under NetAXS Advanced in the Card Properties tab, select one of the following card types.
   - **Standard** - Select this card type if the card holder is an employee. This is the default selection.
   - **Supervisor** - Select this card type if the card holder is a supervisor. See Glossary for definition of Supervisor.
   - **VIP** - Select this card type if the card holder is a VIP. VIP card has the maximum privileges. They override all Access mode restrictions like Disable, lockdown, card and PIN, card or PIN, pin only and card only. VIP cards do not need a supervisor card to gain access.
   - **Limited Number of Uses** - Select this check box and type the number of times a card can be used at the NetAXS panel before it expires in the text box provided. Maximum number of uses is 255. The **Limited Number of Uses** check box is ONLY applicable to the NetAXS panels.

   **Note:** If you select "VIP", then the fields, PIN and Limited Number of Uses and its corresponding text box are disabled.

2. Select the Temporary check box to set a temporary flag for selected card holder.

Temporary cards are generally issued to visitors and employees (if they forget their access card).

**Note:** If the card is to be used with a NetAXS panel, then the Temporary check box must be selected for the Expiration Date field to be active.

Defining an Activation and Expiry date

1. In the Card Properties tab, click Change under Activation Date to define or change the activation date (the date on which the card is activated). The Select Activation Date calendar appears.

2. Select the activation date and click OK to return to the Card Record dialog box.

3. Click Clear to clear the activation date.

4. To define or change the expiration date (the date on which the card access is expired), click Change under Expiration Date. The Select Expiration Date calendar appears.

5. Select the expiry date and click OK to return to the Card Record dialog box.

6. Click Apply to save the card properties.

Assigning a Badge to a Card

1. In the Card dialog box, click the Badge tab.

2. Select the badge design in the Front Side list for the front side design of the card. The preview is displayed at the preview area.

3. Select the badge design in the Back Side list for the back side design of the card. The preview is displayed at the preview area.
Configuring Card and Card Holder Information

Card Holders

Figure 8-30  Attaching a Badge to a Card

4. After printing the card, the Print Status automatically changes to Printed. However, you are provided with an option to change the print status.

5. Click OK to save the card details.

Editing a Card

To edit a card:

1. Choose Card > Card or click in the toolbar. The Card window appears.
2. Select the card to be edited from the list and click Edit. The Card Record dialog box appears.

See the Adding a Card section in this chapter for information on editing the card.

Deleting a Card

To delete a card:

1. Choose Card > Card or click in the toolbar. The Card window appears.
2. Select the card to be deleted from the list and click Delete. A message asking for confirmation appears, if you have set to confirm the card deletion in the Workstation Defaults setting.

3. Click Yes to confirm the deletion. The card is deleted.

Adding Bulk Cards

To add cards in bulk:

2. Type the Start Number and the End Number of the card series. For example, type 100 and 200 to add 100 cards starting with the card number 100.

3. Select the Status of the cards.

4. Select the Access Level of the cards.

5. Select the Visitor check box, if the cards are for visitors.

6. Select the front and back badge designs of the cards in Badge Front and Badge Back.

7. Select the Activation Date and Expiration Date.

8. Click Start to add the cards. The progress bar displays the progress of adding bulk of cards.

   Caution: Do NOT close any WINPAK services or turn-off the computer while the Bulk Card Add is in progress.

9. Click Stop, if you want to cancel generating cards in bulk.

10. Click Close to close the Bulk Card Add dialog box.

**Deleting Cards in Bulk**

To delete a bulk of cards,

Card Holders
Importing Card and Card Holder Information

Assigning a Card to a Card Holder
You can assign a card to a card holder in two different ways:

- **While adding a card**: Select the card holder name while defining the card properties. See the Adding a Card section for more details on adding cards.
- **While adding a card holder**: Create a new card or attach the existing card while adding cards to a card holder. See the Adding a Card Holder section for more details on adding card holders.

Importing Card and Card Holder Information
The WIN-PAK Import Utility is used for importing the card and card holder details into WIN-PAK from an excel sheet. When you import these details into WIN-PAK, cards are assigned to the card holders accordingly.

Importing card and card holder details to WIN-PAK involves:
1. Defining note fields and card holder tab layouts, and configuring access levels. See the Configuring Additional Information section in this chapter for more details on defining note fields, card holder tab layouts and access levels.
2. Defining the order of the fields.
3. Entering card and card holder details in an excel sheet.
4. Assigning default values to certain fields like Activation Date, Expiration Date and User-defined fields.
5. Importing the excel sheet into WIN-PAK.

Logging on to Import Utility
To log on to WIN-PAK Import Utility:
1. Click Start > Programs > Honeywell Access Systems > WIN-PAK Import Utility. The Login Information dialog box appears.
Card Holders
Importing Card and Card Holder Information

2. Type the Name of the user and the Password.
3. Click Connect. The system retrieves the data from database and displays the WIN-PAK ImportUtility dialog box.

Defining Order of Fields
After you define the note fields and card holder tabs, you must define the order of the card and card holder fields.

To define the order of the fields:
1. Log on to the WIN-PAK Import Utility. The WIN-PAK ImportUtility dialog box appears.

2. Select the Account to which the order is to be defined. The card holder fields for the selected account are listed in Columns Order.
3. To change the order of a row, select the row in the list and click the up ▲ button and/or down ▼ button.

Entering Card and Card Holder Information in an Excel Sheet
Before you create the excel sheet, make a note of the column order in which the fields must be entered.
To enter the card and card holder information in the excel sheet:
Card Holders
Importing Card and Card Holder Information

1. Open Microsoft Excel.
2. Enter the card and card holder information as in the order you defined in the WIN-PAK Import Utility. The name of the this sheet must be “Sheet1”.
3. Save the excel sheet in the. xls or. csv format.

![Figure 8-36 Entering Card Holder data in the Excel sheet]

Card 3478 will be assigned to the card holder Flores Nelson

Tips:
- Do not enter the field names in the first row. If you enter the field names to identify the columns, delete it before you import the data into WIN-PAK.
- For the Status field, type 1, 2, or 4 to indicate the card status as Active, Inactive, or Trace.
- Ensure that access levels are configured in WIN-PAK for the respective account, before you enter the name of the access levels.
- Avoid duplication of card numbers.
- To assign default values for fields, leave the fields blank. You can assign default value to the Issue Number, Status, Access Level, Activation Date, and Expiry Date fields and the user-defined fields.
- Use the format for note field templates for the user-defined fields.
- To assign the photo of the card holder, enter the name of the photo image file in the Photo column.

Assigning Default Values
You can assign the default values to certain fields like Issue Number, Status, Access Level, Activation Date, and Expiry Date. You can also assign default values for user-defined fields.

To assign the default values to certain fields:
1. Log on to the WIN-PAK Import Utility. The WIN-PAK Import Utility window appears.
2. Select the Account for assigning the default values. The fields for the selected account are displayed in Columns Order.
3. Under Columns Order, select the field to which the default value must be assigned. The Default Value box appears on the right.
4. Type or select the default value that must be assigned to all the card holders belonging to the selected account.

Tip: To set the current dates for Activation Date or Expiration Date, select the check box. To set different dates, click the drop-down list and select the required date in the calendar.

Importing from Excel Sheet

You can import the card and card holder information from the excel sheet in which the card and card holder information is entered.

To import the card and card holder information from an excel sheet:

1. Log on to WIN-PAK Import Utility. The WIN-PAK Import Utility dialog box appears.

Figure 8-37 Assigning Default values

Figure 8-38 Importing from Excel Sheet
Card Holders
Importing Card and Card Holder Information

2. Select the **Account** to which the card and card holder information must be imported. The corresponding fields are displayed in **Columns Order**.

3. In **CSV File Path**, specify the path of the excel sheet or click the ellipsis button and select the path.

4. In **Images Folder**, select the folder in which the photo images are stored.

5. Click **OK**. A message asking for confirmation appears.

![Figure 8-39 Import confirmation](image)

6. Click **OK** to import the data. A message appears indicating that import is successful.

![Figure 8-40 Import successful](image)

**Correcting Errors in Excel Sheet**

Errors might occur while importing the data from the excel sheet. You cannot import the card and card holder information to WIN-PAK until you correct these errors.

To view and correct the errors:

1. In case of errors during an import, the following message appears prompting you to open and view the error list.

![Figure 8-41 Message for opening and viewing the Error list](image)

2. Click **Yes** to view the errors. The **ErrorLog.xls** file opens.
3. Review and correct the errors in the source file.

The following table lists the possible errors and provides the corrective action to resolve them:

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datatype mismatch</td>
<td>This error may occur if you have entered alphabets for numeric datatype and vice-versa. Check the datatype and enter the correct data.</td>
</tr>
<tr>
<td>Card Number already exists in the Database</td>
<td>Avoid duplicate card numbers.</td>
</tr>
<tr>
<td>Card Status is mentioned as Active/Trace but Activation date also specified.</td>
<td>The activation date is not applicable for the card status of Active or Trace. Therefore, if you have entered 1 or 4 in the card status column, leave the Activation Date column empty.</td>
</tr>
<tr>
<td>Invalid Card Status Value</td>
<td>Ensure that you select only 1, 2, or 4 for Active, Inactive or Trace status. Any other number will lead to such error.</td>
</tr>
<tr>
<td>The Activation date cannot be the same or after the Expiration date</td>
<td>The Expiration date must be later than Activation Date.</td>
</tr>
<tr>
<td>Mandatory data is missing</td>
<td>Card Number is a mandatory field.</td>
</tr>
<tr>
<td>Invalid Access Level</td>
<td>Enter the correct name of the access level and ensure that it belongs to the account to which the data must be imported.</td>
</tr>
</tbody>
</table>
Card Holders
Visitor Management

Visitor Management

Note: Only Lobby Works version 3.2 when used on a Windows XP operating system is supported.

LobbyWorks, a Visitor Management system that tracks the movement of visitors, assets, and deliveries, can be integrated with WIN-PAK. By doing this, the access cards that are created for visitors in LobbyWorks can be used in WIN-PAK as access cards. After the access cards are copied from LobbyWorks to WIN-PAK, they are provided with the necessary access levels for allowing or restricting visitors to the different areas in the premises.

Integrating LobbyWorks

Before you begin:
- Ensure to install WIN-PAK and LobbyWorks on the same network.
- Procure the license for integrating LobbyWorks with WIN-PAK.

Setting Key Values

To integrate LobbyWorks with WIN-PAK:
1. Choose Start > Run, and then type regedit. The Registry Editor window appears.
2. In the left pane, expand HKEY_LOCAL_MACHINE, Software, and then Northern Computers.
3. Select WPLobbyWorks. The relevant keys are displayed in the right-pane.

- Right-click the Pass key and click Modify. The Edit String dialog box appears.
- Enter the password in the Value Data box.

Figure 8-43 Registry Editor
c. Right-click the User key and click Modify. The Edit String dialog box appears.

d. Enter the user name in the Value Data box.

5. Set the Value data of WinAuth as 0, if you are logging on to WIN-PAK in the WIN-PAK authentication mode.

   OR

   Set the Value data of WinAuth as 1, if you are logging on to WIN-PAK in the Windows authentication mode.

6. Close the Registry Editor window.
Time Management

In this chapter...

- Introduction 9-2
- Time Zone 9-3
- Schedule 9-8
- Holiday Group 9-20
- Daylight Saving Group 9-23
Introduction

This chapter describes how to configure a time zone, holiday group, daylight saving group, and schedule a task.

Time Zone

A time zone is a group of time slots that define the access of the associated item. For example, a particular time zone can be mapped to an access level. When a card holder is associated to an access level, the card holder's access is allowed or denied depending on the time zone associated to the access level.

You can create any number of Time Zones.
See the Time Zone section for configuring a time zone.

Schedule

A schedule is planned task that must be performed at the defined time periods. In WIN-PAK, a task includes running a command file, guard tour, or generating a report, and so on.
See the Schedule section in this chapter for scheduling a task.

Holiday Group

A holiday group is a set of holidays. The access decision is based on the time zone that you associate to an entrance in the access level and the holiday group you associate while configuring panels.
See the Holiday Group section for configuring a holiday group.

Daylight Saving Group

Daylight saving group is a set of daylight saving time slots. Daylight Saving Time is the time during which clocks are set one hour ahead of local standard time.
See the Daylight Saving Group section in this chapter for configuring a daylight saving group.
Time Zone

Time Zones can be assigned to cards, action groups, ADVs, operators, panels, and access levels. Therefore, ensure that you define the time zone first, before defining these items.

Always On and Never On are the system-generated time zones that are available in WIN-PAK by default.

- **Always On** - This time zone allows full-time access to the card holder assigned to it.
- **Never On** - This time zone restricts the access of the card holder assigned to it.

**Note:** You cannot edit the Always On and Never On time zones, as these are generated by WIN-PAK.

Adding a Time Zone

To add a new time zone:

1. Choose **Configuration > Time Management > Time Zone**. The **Time Zone** window appears.
2. Click **Add**. The **Time Zone Record** dialog box appears to add a new time zone.
3. Type the name of the **Time Zone** and a brief **Description**.
4. Select the corresponding **Snap Time**. The Snap Time option enables you to set the time slot according to the selected snap time.

**Example:** If you set a **Snap Time** of 60 minutes, you can only define time slots with a minimum of 1 hour interval. This time slot must start and end as a whole hour and would not include any minutes or seconds. For example, you can set time slots of 8 AM to 9 AM, or 3 PM to 4 PM. However, you cannot set a time slot of 4:30 to 5:30 or 1:15 to 2:15.
Time slots including minutes and seconds as interval can be set by selecting 30 and 15 snap time options.

Time slot with an interval of a minute can be set by selecting the snap time of 0.

**Figure 9-2  Setting the Time Slots**

5. To define a time slot:

   a. Click any of the weekdays and drag the mouse pointer to reach the end time of the time slot.

   OR

   a. Right-click any of the weekday to display the **Time Zone Range** dialog box. Enter the **Start Time** and **End Time** and click **OK** to set the time slot.

**Figure 9-3  Time Zone Range**

- When you hover the mouse pointer over the time range area, the time at the mouse pointer is displayed in the **Mouse Time** box.

- When you define a time slot, the start and the end time is displayed in the **Mouse Time** box when you click and drag the mouse pointer.
For an already defined time slot, the start and the end time is displayed in the Mouse Time box when you hover the mouse pointer over the time slot.

Tip: It is sufficient to define the time slot for Monday, so that you can copy the time slot for the rest of the weekdays using the Copy Monday to Weekdays option.

6. If you want to set the hour format of the ruler as 24 hours, select the Military Time check box.

7. After you set the time range for Monday, click Copy Monday to Weekdays to copy it to the other weekdays.

Tip: If you want to delete the time slot, place the cursor over the time slot and right-click to display the Time Zone Range dialog box. Click Delete Range.

8. Follow the same procedure to set the time slot for Saturday and Sunday.

9. Set the time slots for holidays in H1, H2, and H3.

Note: When time zones and holiday group are assigned to a panel, the time slots defined for the holidays H1, H2, and H3 are applied to the holiday group.

Note: Holiday Type H2 is applicable only to NS2+ panels. Both Holiday Type H2 and Holiday Type H3 is applicable to NetAXS panels.

10. Click the Accounts tab to associate accounts to the time zone.

Note: You must assign an account to a time zone, after setting the time slots.

11. Under Available Accounts, select an account and then click Add. For multiple selections, use the Shift or Ctrl key while selecting the accounts.

12. To remove an account from the selected account list, select an account and click Delete. The selected accounts are moved to the Available Accounts list.

13. Click OK to save the Time Zone.

Tip: You can also add a Time Zone while adding a NetAXS panel. See the "Assigning Time zones and Holiday groups to the NetAXS panel" in Chapter 10 section for more information.

Edit a Time Zone
To edit a Time Zone:

1. Choose Configuration > Time Management > Time Zone. The Time Zone window appears.

2. Select a time zone and then click Edit. The Time Zone Record dialog box appears.

3. Make the required changes and then click OK to save the changes and to close the Time Zone Record dialog box.

Isolating and deleting a Time Zone
Time Zones are used in many places throughout the access control system. Therefore, to delete a time zone, you must isolate the time zone if it is assigned to any panel, operator, or access level.

Isolating a Time Zone
To isolate a time zone:

1. Choose Configuration > Time Management > Time Zone. The Time Zone window appears.
2. Select a time zone and then click **Isolate**. The **Isolate** dialog box appears.

   The Cards, Action Groups, ADVs, Operators, Panels, and Access Levels associated to the time zone are displayed in the relevant tabs.

   ![Isolate dialog box](image)

   **Figure 9-4  Isolating a Time Zone**

3. Click each tab to view the list of associated items.

4. To dissociate a panel from the time zone, select the panel in the list and click **Delete** or to dissociate all the panels from the time zone click **Delete All**. However, you cannot assign a panel to a different time zone.

   OR

   To reassign a time zone for other devices:

   a. Select the device from the list of devices

   b. Select the alternate time zone from the drop-down list.

   c. Click **Reassign** to reassign the selected devices or click **Reassign All** to reassign all the devices to the selected time zone.

5. Click **OK**. The time zone is isolated from the selected device and is assigned to the different time zone.

   ![Warning message box](image)

   Click **OK** to close the message box.
Deleting a Time Zone

After you have isolated a time zone, you can delete the time zone.

To delete a time zone:

1. In the Time Zone window, select the time zone from the list of time zones.
2. Click Delete. The time zone is deleted.
Time Management

Schedule

You can schedule tasks so that they run automatically at a defined time.

Scheduling a Task

To schedule a task:

1. Choose Configuration > Time Management > Schedule. The Schedule window appears with the list of the following system-generated schedules:

   **Update cards every day** - Updates the card details every day in the panel. If this schedule is not generated, the panel will allow the card access of the inactivated or expired card also.

   **Update Custom AL every day** - Updates the custom access level start date and expiry date in the panel. If this schedule is not generated, the panel will still consider the global access level of an operator.

   **Update date and time every day** - Updates the date and time in the panel every day. If this schedule is not generated, the panel does not sync with the system time and it may cause in outdated data in the panel.

   ![Schedule](image)

   **Figure 9-5 Schedule**

2. Click Add. The Schedule Record dialog box is displayed.
3. Type the **Schedule Name** for the task.

4. Select a task **Type**. Based on the selected task type, other options on the dialog box are activated.

   Task types include:
   
   - **Activate and Deactivate Cards**: Activates or deactivates cards depending on the card activation and deactivation dates. This helps to update the card details in the panel.
   
   - **Backup Database**: This schedule takes a backup of the database in a defined interval such as daily, monthly, weekly, and so on.
   
   - **Card Frequency Report**: Generates the card frequency report in a defined interval.
   
   - **Dial Remote Area**: Establishes the dial-up connection between WIN-PAK systems and sends the command to the panel.
   
   - **Run Command File**: This schedule runs a command file at a specific time in a defined frequency.
   
   - **Run Guard Tour**: This schedule runs the guard tour in a defined interval.
   
   - **Run Report**: Generates the report at a defined interval.
   
   - **Send Date and Time**: Sends the system date and time to all the panels attached to WIN-PAK.
   
   - **Update Custom Access Level**: Updates custom access level of cards in the panels at a defined frequency.

   See the **Task Type** section in this chapter, for more details on task types and scheduling a task.

5. In the **Frequency** list, select how often the task is to be performed.

6. Under **Next Scheduled Date and Time**, select the date and enter the time (in hours and minutes) for the task to be performed.
   
   - To select the date, click the ellipsis button and select the date in the calendar.
   
   - To enter the time, type the **Hour** and **Minute**. The hour ranges from 0 to 23 and minute ranges from 0 to 59.
   
   - To enter the current date and time, click **Now**.
Task Type
For every Task type that you select in the Schedule dialog box, a different set of options appear. This section describes the task types and guides you how to schedule a task for the various task types.

Activate and Deactivate Cards
Select this task type to schedule a task for activating and deactivating the cards, depending on the card activation and deactivation dates. However, this task is scheduled by default. If you select this type, perform the following steps:

1. In the Schedule dialog box, select how often the task is to be performed in the Frequency list.

   Figure 9-7    Activate and Deactivate Cards

2. Under Next Scheduled Date and Time, select the date and enter the time (in hours and minutes) for the task to be performed.
   • To select the date, click the ellipsis button and select the date in the calendar.
   • To enter the time, type the Hour and Minute. The hour ranges from 0 to 23 and minute ranges from 0 to 59.
   • To enter the current date and time, click Now.

3. Click OK to save the schedule.

Backup Database
Select this task type to backup the database on a daily, weekly, bi-weekly, hourly, and monthly basis. If you select this type, perform the following steps:

1. In the Schedule dialog box, select how often the task is to be performed (Monthly, Once per two weeks, Weekly, Daily, Hourly) in the Frequency list.
2. Under **Next Scheduled Date and Time**, select the date and enter the time (in hours and minutes) for the task to be performed.
   - To select the date, click the ellipsis button and select the date in the calendar.
   - To enter the time, type the Hour and Minute. The hour ranges from 0 to 23 and minute ranges from 0 to 59.

3. To enter the current date and time, click **Now**.

4. Under **Backup Information**
   - Type the **Backup Name**.
   - Type the **Backup Description**.
   - Select **Database - Complete** or **Database - Differential** as the **Backup Type**.
   - Click . The **Save As** dialog box appears.
     - Select an existing .bak file to overwrite the contents with the new data or type a new **File Name** to save the data to a new file.
     - Click **Append** to append the data that is backed up to contents of selected .bak file.

5. Click **OK** to save the schedule.

**Card Frequency Report**

Select this task type, if you want to generate the Card Frequency Report at the defined intervals. If you select this type, the **Card Frequency Report Configuration** form appears on the lower-left corner of the **Schedule** dialog box.
In addition to the basic steps, perform the following steps for scheduling a task:


2. To set the date and time range for generating the card frequency report, click the Date and Time Filter tab.
   a. To generate reports for events occurring during the specified period, select the Only list events between these hours each day check box, under Daily Time Range. The From and To text boxes are enabled.
b. In the From and To boxes, select the time range (in hours and minutes).

c. Select the standard time zone in the Time Zone list.

3. To set the card frequency limits for generating reports on card frequency, click the Frequency Filter tab.

4. Under Frequency, type the Lower Frequency Limit and Higher Frequency Limit to filter the cards between these limits.

5. To generate the card frequency reports by filtering the readers, type the Reader name under Location or select the reader by clicking the ellipsis button.

6. To generate the frequency filter reports for access areas, type the Access Area name under Location or select the access area by clicking the ellipsis button.

7. To include only certain devices, click Filter ADVs to select the ADVs. In the Filter Devices dialog box, select the appropriate ADV or ADV type from the tree and click OK.

8. Under Disposition, select one of the following actions that must be performed on the cards after you have filtered for frequency report:

   a. None: Perform no action on the cards.

   b. Deactivate and Report cards that are between the limits: Deactivate and generate a report for the cards whose access frequency falls between the frequency limits.
c. **Deactivate, Detach and Report cards that are between the limits:**
   Deactivate, detach and generate a report for the cards whose access frequency falls between the frequency limits.

d. **Reassign cards between limits to Access Level:** Reassign and generate a report for the cards whose access frequency falls between the frequency limits.

9. To filter the card holders for generating the card frequency report, click the **Card Holder Filter** tab.

![Figure 9-12 Card Holder Filter tab](image)

10. Type the **First Name** and **Last Name** of the card holder, or select them by clicking the ellipsis button.

11. Type the **Card Number** of the card holder or select it by clicking the ellipsis button.

12. To generate the card frequency reports of the card holders accessing a specific area, select one of the options from the **Tracking Area** list.
   - **Exit Area:** **Card reads not shown:** To generate the reports of the cards accessed in the Exit area.
   - **Tracking and Mustering Area:** To generate the reports of the cards accessed only in the Tracking and Mustering Area.

13. Select one or more **Card Codes** which define the card transaction.

14. Select the **Note Fields** to be displayed in the report. You can also specify the range if you select the numerical note field.

15. Click **Save & Close** to save the configuration details and close the dialog box.

16. Click **OK** to save the schedule.

**Dial Remote Area**

Select **Dial Remote Area** as the task type, if you want the WIN-PAK system to send the commands to the panel connected through modem.
If you select this type, the **Dial Remote Area** box is enabled on the lower-right corner of the **Schedule** dialog box.

![Schedule dialog box]

**Figure 9-13**  Scheduling a task for the “Dial Remote Area” task type

In addition to the basic steps, perform the following steps for scheduling a task:

1. In the **Schedule** dialog box, select a remote area in the **Remote Area** list.
2. Select the following commands to be sent to the panel:

   **Table 9-1  Describing Dial Remote Area commands**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buffer</td>
<td>Select this option, if you want the panel to store the task data in the panel buffer.</td>
</tr>
<tr>
<td>Unbuffer</td>
<td>Select this option, if you want the panel to send the stored data to the WIN-PAK system.</td>
</tr>
<tr>
<td>Send Card DB Changes</td>
<td>Select this option, if you want the WIN-PAK system to send the updated card details to the panel.</td>
</tr>
<tr>
<td>Send Date and Time</td>
<td>Select this option, if you want the WIN-PAK system to send the system date and time to the panel.</td>
</tr>
</tbody>
</table>

3. Click **OK** to save the changes.

**Run Command File**

Select **Run Command File** as a task type, if you want to run the command files in a defined frequency.

When you select this task type, the Command File list is enabled in the **Schedule** dialog box.
In addition to the basic steps, perform the following steps for scheduling a task:

1. In the Schedule dialog box, select a command file in the Command File list. The command files available in WIN-PAK are listed.

2. Click OK to save the schedule.

**Run Guard Tour**

Select Run Guard Tour as a task type, if you want to run a guard tour at a defined interval. See the "Adding a Guard Tour" in Chapter 14 for more details on defining the guard tour.

When you select this task type, the Guard Tour Configuration frame appears on the lower-right corner of the Schedule dialog box.

In addition to the basic steps, perform the following steps for scheduling a task:

3. In the Schedule dialog box, under GuardTour Configuration, select the guard tour in the Guard Tour list.

4. To select the card attached to the card holder (guard), click the ellipsis button and select the card.

   If you want to remove the card, click Clear.

5. Click OK to save the schedule.

**Run Report**

Select Run Report as a task type, if you want to generate card holders report or history report at a defined interval. In addition, the reports that are configured in Report Templates can be executed.
When you select this task type, the **Configure Reports** frame appears on the lower-right corner of the **Schedule** dialog box.

**Figure 9-16  Scheduling a task for the “Run Report” task type**

In addition to the basic steps, perform the following steps for scheduling a task:

1. Select the type of the report to be generated in the **Report Type** list.
   - **Card Holder** - To generate the report for card holders.
   - **History** - To generate the report of the history.

2. Select the template for the report in the **Report Template** list. The templates are listed for the selected report type. You must have created the templates using the **Report Template** menu option.

3. Click **Reconfigure** to edit the report template configuration. The **Report - Card Holder** or **Report - History** dialog box appears.
   
   See "**Report Templates**" in **Chapter 17** for adding or editing a report template.

4. Select the **Print Report** check box to print the report immediately after the configuration.

5. Select the **E-Mail Report** check box to send the report to the selected e-mail Ids after the configuration.

6. Click **EMail IDs** to select the e-mail Ids for sending the report. The **Select Email Ids** dialog box appears.
Time Management

Schedule

Figure 9-17 Select Email IDs

7. Select the Id type in the Show Ids from the Account list. The available Id list types are Consolidated Id List, To Id List, Cc Id List, and Bcc Id List. The e-mail Ids of the selected ID type are listed.

8. Select the Id from the list and click To or Cc or Bcc to move it to the corresponding recipients list.

OR

Type the e-mail Ids in the corresponding Message Recipients boxes.

9. Click OK to save the e-mail Ids and close the dialog box.

Send Date and Time

Select Send Date and Time task type to update the panel date and time with the system timing. However, this task is scheduled by default.

If you select this type, perform the following steps:

1. In the Schedule dialog box, select how often the task is to be performed in the Frequency list.
2. Under **Next Scheduled Date and Time**, select the date and enter the time (in hours and minutes) for the task to be performed.
   - To select the date, click the ellipsis button and the calendar appears.
   - To enter the time, type the **Hour** and **Minute**. The hour ranges from 0 to 23 and minute ranges from 0 to 59.
   - To enter the current date and time, click **Now**.

3. Click **OK** to save the schedule.

**Update Custom Access Level**

Select **Custom Access Level** task type to send the card details with the custom access level to the panel at a scheduled time. However, this task is scheduled by default.

If you select this type, perform the following steps:

1. In the **Schedule** dialog box, select how often the task is to be performed in the **Frequency** list.

2. **Figure 9-19** *Updating Custom Access Level*

   2. Under **Next Scheduled Date and Time**, select the date and enter the time (in hours and minutes) for the task to be performed.
      - To select the date, click the ellipsis button select the date in the calendar.
      - To enter the time, type the **Hour** and **Minute**. The hour ranges from 0 to 23 and minute ranges from 0 to 59.
      - To enter the current date and time, click **Now**.

3. Click **OK** to save the schedule.

**Editing a Schedule**

To edit the schedule:

1. Choose **Configuration > Time Management > Schedule**. The **Schedule** window appears.

2. Select the schedule to be edited and click **Edit**. You can also edit the default schedule generated by WIN-PAK.

3. Change the required details and click **OK** to save the changes.
Deleting a Schedule

To delete a schedule:

2. Select the schedule to be deleted and click Delete. You can also delete the default schedule generated by WIN-PAK.
3. Click Delete. The selected schedule is deleted.

Holiday Group

Holiday group is a set of holidays. For example, you can group the holidays like Christmas, Thanksgiving Day, and Independence Day as a Government Holiday group. Holiday Groups are useful for grouping the departments that would close on holidays and the departments that would remain open on holidays.

Associating Holiday Groups to Panels

A holiday group can be associated to a panel to control or restrict the panel access on holidays. For example, the access of the doors attached to the panel can be restricted on holidays.

Associating Holiday Groups and Time Zones

When Time Zones and a Holiday Group are assigned to a panel, the start and end times for the H1, H2 and H3 time slots are applicable to the Holiday Group.

Adding a Holiday Group

To add a holiday group:

2. Click Add to add holidays to the holiday group. The Holiday Group Record dialog box appears.

![Holiday Group Record](image1)

Figure 9-21 Holiday Group Record

3. Type the Holiday Group Name. For example, Federal Holidays.

4. Click Add. The Holiday Group - Holidays dialog box appears to add a list of holidays in the holiday group.

![Holiday Group-Holidays](image2)

Figure 9-22 Holiday Group-Holidays

5. Type the Name of the holiday.

6. Click the ellipsis button to select the date.

7. Select the Apply to all years check box, if the holiday must recur every year.

8. Select the holiday category as Holiday 1 or Holiday 2 or Holiday 3. The holiday groups are grouped into three major categories as Holiday 1, Holiday 2, and Holiday 3. You can use these categories to group the mandatory holidays and optional holidays. Holiday 1 category is applicable to all panels. Holiday 1 and Holiday 2 categories are applicable only to the NetAXS, NS2 and NS2+ panels. Holiday 1, Holiday 2 and Holiday 3 categories are applicable only to the NetAXS panels.

9. Click OK to save the holiday.

10. Repeat steps 4 to 9 for adding more holidays to the holiday group.

11. After adding the required holidays, click OK.
Edited a Holiday Group
To edit a holiday group:

1. Choose Configuration > Time Management > Holiday Group. The Holiday Group window appears with the list of existing holiday groups.
2. Select a holiday group from the list.
3. Click Edit. The Holiday Group Record dialog box appears.
4. Change the required details.
5. If you want to add a holiday to a holiday group, click Add and follow the same procedure as described in the Adding a Holiday Group section.
6. Click OK to save the changes.

Isolating and Deleting a Holiday Group
If a holiday group is associated to a panel, you cannot delete the holiday group until you isolate it from the panel.

To isolate a holiday group:

1. Choose Configuration > Time Management > Holiday Group. The Holiday Group window appears with the list of existing holiday groups.
2. Select a holiday group from the list.
3. Click Isolate. The Isolate dialog box appears with the list of associated panels.
4. Select a panel and reassign it to a different holiday group.
5. Click Reassign to reassign the selected panel to a different holiday group. A confirmation message appears.
   OR
   If you want to reassign all the panels to the selected holiday group, click Reassign All. A confirmation message appears.
6. Click OK to confirm reassignment.
7. Repeat steps 4 to 6 to isolate the holiday groups from the panels.
8. Click **OK** to close the dialog box.

To delete a holiday group:

1. Choose **Configuration > Time Management > Holiday Group**. The **Holiday Group** window appears with the list of existing holiday groups.
2. Select a holiday group from the list.
3. Click **Delete**. The selected holiday group is deleted.

### Daylight Saving Group

You can create a custom daylight saving group for the locations where the standard daylight saving group is not used. These daylight saving groups are attached to the panels for using the custom timings.

**Note:** This feature is currently applicable only to the “P-Series” panels.

### Adding a Daylight Saving Group

To add a daylight saving group:

1. Choose **Configuration > Time Management > Daylight Saving Group**. The **Daylight Saving Group** window appears.
2. Click **Add**. The **Daylight Saving Record** dialog box appears.

![Figure 9-24 Daylight Saving Record](image)

3. Type a **Name** for the daylight saving group and a **Description**.
4. Click **Add** to add daylight savings to a daylight saving group. The **Daylight Time Saving** dialog box appears.
5. To set the **Start Date and Time**:
   a. Click the ellipsis button to open the calendar.
   b. In the calendar, select the month, year and date or click **Today**, if you want to select the current date.
   c. Click **OK**. The date is selected and the calendar is closed.
   d. Type the start time. You can use \( \text{ or } \) arrow to increase or decrease the current time.

6. To set the **End Date and Time**:
   a. Click the ellipsis button to open the calendar.
   b. In the calendar, select the month, year and date or click **Today**, if you want to select the current date.
   c. Click **OK**. The date is selected and the calendar is closed.
   d. Type the end time. You can use \( \text{ or } \) arrow to increase or decrease the current time.

7. Click **OK** to add the daylight time saving.

**Editing a Daylight Saving Group**

To edit a daylight saving group:

1. Choose **Configuration > Time Management > Daylight Saving Group**. The **Daylight Saving Group** window appears with the list of existing daylight saving groups.
2. Click **Edit**. The **Daylight Saving Record** dialog box appears with the details.
3. Change the details of the daylight saving group.
4. If you want to add new daylight timing to a daylight saving group, click **Add** and follow the same procedure of adding daylight timing as described in the **Adding a Daylight Saving Group** section.
5. Click **OK** to save the changes.

**Deleting a Daylight Saving Group**

If a daylight saving group is associated to a panel, you cannot delete the daylight saving group.

To delete a daylight saving group:

1. Choose **Configuration > Time Management > Daylight Saving Group**. The **Daylight Saving Group** window appears with the list of existing groups.
2. Select a daylight saving group from the list.
3. Click **Delete**. The selected Daylight Saving Group is deleted.
4. Click **OK** to close the message box.
Device Map

In this chapter...

- Introduction 10-2
- Server Configuration 10-4
- Communication Loops 10-20
- Video Management System 10-37
- Modem Pools 10-53
- CCTV Switcher 10-64
- RS-232 Connection 10-69
- Ethernet Module (Galaxy Panel) 10-71
- Panel Configuration 10-75
- Abstract Device 10-170
- Action Group 10-176
Introduction

This chapter describes how to configure servers, loops, panels, modem pools, and so on, and also describes adding abstract devices and action groups.

Device Map Structure

The Device Map in WIN-PAK is a graphical tree structure that represents the physical connections of the devices, which include communication hardware, servers, panels, readers, and CCTV equipment.

The following is the list of device types that can be added to the Device Map.

- Servers
- Communication Servers
- Communication Loops
- Panels
- Digital Video Recorder (DVR)
- Abstract Devices

In the Device Map tree structure, under the Devices folder, Servers and CCTV Switcher form the high level nodes of the tree. Communication Server is one of the servers added to the Devices folder, where you can add loops, modem pools and also direct connections to the P-Series panels. The physical devices such as card readers, keypads, input points, and output points are defined while configuring panels. The following figure illustrates the structure of the Device Map tree.

![Device Map Tree Structure](image)

Physical Devices and Abstract Devices

Abstract Devices logically represent physical devices in the access control system. Physical devices and connections must be configured as ADVs in WIN-PAK.

Servers and Devices

WIN-PAK has different servers to perform different tasks. The following is the list of servers in WIN-PAK.
Database Server
The database server listens to the requests send from the WIN-PAK User Interface and other servers, and fetches the data from the SQL database. In addition, whenever the data is updated in the WIN-PAK User Interface, it is sent to the database server, which in turn updates it in the SQL database.

Archive Database Server
The archive database server enables you to restore the backed up data and view the reports.

Communication Server
The communication server establishes the connection between panels and WIN-PAK or other servers. The servers must request the communication server to interact with panels.

Command File Server
The WIN-PAK User Interface and other servers must communicate with the command file server to execute the command file. In turn, the command file server communicates with the communication server to send the commands to the hardware that are configured in command file server.

Schedule Server
The schedule server communicates with the database server to configure the schedules, and also communicates with other servers to run the schedules.

Guard Tour Server
The WIN-PAK User Interface and other servers must communicate with the guard tour server to run the guard tour. In turn, the guard tour server communicates with the communication server to interact with panels or communicates with the database server to retrieve data from the SQL server.

Tracking and Muster Server
The WIN-PAK User Interface and other servers must communicate with the tracking and muster Server to monitor the tracking and mustering area. In turn, the tracking and muster server communicates with the communication server to interact with panels for retrieving the up-to-date data on card reads.

Video Management Server
The Video Management Server (VMS) is an enterprise-class video management and storage solution. It is a truly hybrid solution which, enables you to operate the traditional analog and the network and IP based video equipment in the same surveillance network.

Interacting with Intrusion Panels
In WIN-PAK, the intrusions happening in the premises of the access control system are monitored using the Galaxy and Vista panels. To monitor intrusions of a particular area in the access control system, the Galaxy panel groups or the Vista panel partitions in that area must be activated.

To set the Galaxy groups or arm the Vista partitions, you must:
1. Associate Galaxy groups or Vista partitions to the readers and the input points.

   See the Configuring a Reader to the Panel section for associating Galaxy groups or Vista partitions to the reader and the input point.

2. Add these readers and input points to the access area.

3. Assign access levels for these readers and input points.

4. Add privileged cards.

   The Galaxy Groups are set or Vista partitions are armed when a privileged card is swiped and the input button is pressed within 15 seconds.

Interacting with Cameras

In WIN-PAK, the monitoring and viewing of live and recorded videos for a selected area is possible using the integrated DVRs. This version of WIN-PAK supports an enhanced level of integration with the Fusion and HRDP Performance DVRs.

The integration enables you to configure various advanced settings for the cameras using WIN-PAK after some basic configuration in the DVR software. In addition, you can select the DVRs to be monitored and track actions captured by them (both live and recorded) along with the alarms and notifications.

See the Video Management System section for configuring and interacting with digital video.

Server Configuration

Servers are configured in the Device Map for every WIN-PAK service. In addition, the servers can be placed on the floor plans and the server access can be assigned in the control area.

Servers establish the communication between various WIN-PAK devices and databases. This section explains how to set up the communication server, Command File Server, Guard Tour Server, Schedule Server, Tracking and Muster Server and Digital Video.

Communication Server

The Communication Server establishes the connection between WIN-PAK and the panels that are physically located in the access control system. The communication server must be available on the WIN-PAK Device tree for the WIN-PAK system to communicate with the system devices including the P-Series Intelligent Controller.

Multiple communication servers can be configured in WIN-PAK in a networked environment. This speeds up the communication when there are many devices in the communication. However, it depends on the type of WIN-PAK license that you availed.

Adding a Communication Server

To communicate with system devices such as panels, readers, inputs, or outputs, you must configure the Communication Server for your access control system. The Communication Server can be installed on the same machine as the Database Server or on another computer in a networked system.

To add a communication server:


3. Type a Name (maximum 30 characters) for the communication server.

4. Type the Description (maximum 60 characters) for the communication server.

5. Click Add under ADV to add an ADV for the communication server. The Abstract Device Record - Server dialog box appears.

   See the Configuring an Abstract Device section for more information on ADV configuration.

6. After adding an ADV, click OK to return to the Com Server Configuration dialog box.
   - Under ADV, use the Edit, Isolate, and Delete buttons to edit, isolate and delete the ADV.
   - Select the Show check box to view the ADV details.

7. Enter the Machine Name for the communication server. By default, the name of the local computer displays in Machine Name.

   Tip: To find the machine name:
   a. Right-click the My Computer icon on your desktop and click Properties. The System Properties dialog box appears.
   b. Click the Computer Name tab. The machine name is displayed in the Full computer name field.
   c. Note down the machine name and click OK.

8. Type a Protocol end point number that is not used by any other application or service on that computer.

9. Type the Alarm Priority for notification value. An action with lower priority than this value is displayed as an event in the Event view.

10. Set the Alarm Priority for required acknowledgement value. An action with higher priority than this value and with lower priority than “Alarm Priority for notification” value is displayed as an alarm in the Alarm View.

11. Select the Write Transactions to file? check box to write a record of the server transactions, message exchanges between communication server and panels into a text file. This file is used for debugging purposes.
Device Map
Server Configuration

- For N-1000/PW-2000, NS/NS2+ panels, a text file is generated every hour with the name of the file that indicates the date and time of the file generation. This file is stored in the RSDUMP folder where the WIN-PAK system is installed.

- For P-Series panel types, the transactions are written in the MCBdebug.txt file. Here the same file is updated every time the file is generated. This file is stored in C:\Windows\System32 or C:\Winnt\System32 folder based on the operating system used in the computer.

12. Click Next. The Com Server Configuration - Ports dialog box appears.

![Com Server Configuration - Ports](image)

**Figure 10-3  ComServer Configuration-Ports**

13. In the Ports list, select the required check boxes for the COM port that are used on this server for the access control equipment.

14. Click Next and then click Finish to add the communication server to the Device Map.

**Editing a Communication Server**

To edit the communication server:


2. Expand the Devices folder to display the servers and devices added to the device map.

3. Right-click the communication server and click Configure. The Com Server Configuration dialog box appears.

4. Edit the required details of the communication server.

See the Adding a Communication Server section for the field descriptions.

**Isolating and deleting a Communication Server**

You can delete a communication server only if you delete the devices attached to the communication server. In addition, you must isolate an ADV of the communication server from floor plans and operator levels.
Isolating a Communication Server

To isolate a communication server

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the communication server and click Isolate. The Isolate Device or ADV dialog box appears.

4. To isolate floor plans from an ADV of communication server:
   a. Click the Floor Plans tab. The list of floor plans associated to the communication server is displayed.
   b. Select the floor plans to be isolated from the communication server and click Remove. The selected floor plans are dissociated.

   OR

   Click Remove all to isolate all the floor plans from the communication server.

5. To isolate operator levels from an ADV of the communication server:
   a. Click the Operator Levels tab. The list of operator levels associated to the communication server is displayed.
   b. Select the operator levels that must be isolated from the communication server and click Remove. The selected operator levels are dissociated from the communication server.

   OR

   Click Remove all to isolate all the operator levels from the communication server.

6. To remove the communication server from the control area, clear the presence of an ADV of the communication server in the control area by clearing the Present in Control Area check box.

6. Click OK.
Device Map
Server Configuration

Deleting a Communication Server

After deleting or moving the devices and isolating the associated floor plans and operator levels, you can delete the communication server.

To delete a communication server

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the communication server and click Delete. A message asking for confirmation appears.
4. Click OK to confirm the deletion. The communication server is deleted from the device map.

Command File Server

Before using the Command File functions, you must configure the Command File Server. Normally this server is located on the same machine as the Database Server.

Adding a Command File Server

To add a command file server:

3. Type a Name for the command file server.
4. Type the Description for the command file server.
5. Click **Add** under **ADV** to create an ADV for the command file server. The **Abstract Device Record - Server** dialog box appears. See the **Configuring an Abstract Device** section for more information on ADV configuration.

6. After adding an ADV, click **OK** to return to the **Communication Server Configuration** dialog box.
   - Under **ADV**, use the **Edit**, **Isolate**, and **Delete** buttons to edit, isolate and delete the ADV.
   - Click the **Show** check box to view the ADV details.

7. Enter the **Machine Name** for the communication server.

   **Tip:** To find the machine name:
   a. Right-click the **My Computer** icon on your desktop and click **Properties**. The **System Properties** dialog box appears.
   b. Click the **Computer Name** tab. The machine name is displayed in the **Full computer name** field.
   c. Note down the machine name and click **OK**.

8. Type a **Protocol end point** number that is not used by any another device on the network.

9. Click **Next** to proceed to the final dialog box for the Command File Server Configuration.

10. Click **Finish** to add the server to the Device Map.

### Editing a Command File Server

To edit a command file server:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Expand the **Devices** folder to display the servers and devices added to the device map.

3. Right-click the command file server and click **Configure**. The **Command File Server Configuration** dialog box appears.

   ![Command File Server Configuration](image)

   **Figure 10-7**  **Editing a Command File Server**

4. Edit the required details of the command file server.

   See the **Adding a Command File Server** section for configuring a command file server.
5. Click OK to configure the command file server.

**Isolating and Deleting a Command File Server**

You can delete a command file server, only if you isolate an ADV of the command file server from floor plans and operator levels.

**Isolating a Command File Server**

To isolate a command file server:

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the command file server and click Isolate. The Isolate Device or ADV dialog box appears.

![Isolate Device or ADV dialog box](image)

**Figure 10-8 Isolating a Command File Server**

4. To isolate floor plans from an ADV of the command file server:
   a. Click the Floor Plans tab. The list of floor plans associated to the command file server is displayed.
   b. Select the floor plans to be isolated from the command file server and click Remove. The selected floor plans are dissociated.

   OR

   Click Remove all to isolate all the floor plans from the command file server.

5. To isolate operator levels from a device or an ADV of the command file server:
   a. Click the Operator Levels tab. The list of operator levels associated to the command file server is displayed.
   b. Select the operator levels to be isolated from the command file server and click Remove. The selected operator levels are dissociated.

   OR
Click **Remove all** to isolate all the operator levels from the command file server.

c. To remove the command file server from the control area, clear the presence of an ADV of the command file server in the control area by clearing the **Present in Control Area** check box.

6. Click **OK**.

### Deleting a Command File Server

After isolating the associated floor plans and operator levels, you can delete the command file server.

To delete a command file server:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder to display servers and devices added to the device map.
3. Right-click the command file server and click **Delete**. A message asking for confirmation appears.
4. Click **OK** to confirm the deletion. The command file server is deleted from the device map.

### Guard Tour Server

Before using the Guard Tour functions, you must configure the Guard Tour Server. Normally this server is located on the same machine as the Database Server.

### Adding a Guard Tour Server

To add a guard tour server:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Right-click the **Devices** folder and choose **Add > Guard Tour Server**. The **Guard Tour Server Configuration** window appears.

![Guard Tour Server Configuration](image)

**Figure 10-9 Guard Tour Server Configuration**

3. Type the **Name** of the schedule server and the **Description** for guard tour server.
4. Create an ADV for the guard tour server. Click **Add** under **ADV** to display the **Abstract Device Record - Server** dialog box.
See the Configuring an Abstract Device section for more information on ADV configuration.

5. After adding an ADV, click OK to return to the Guard Tour Server Configuration dialog box.
   - Under ADV, use the Edit, Isolate and Delete buttons to edit, isolate and delete the ADV.
   - Click the Show check box to view the ADV details.

6. Enter the Machine Name for the guard tour server.
   Tip: To find the machine name:
   a. Right-click the My Computer icon on your desktop and click Properties. The System Properties dialog box appears.
   b. Click the Computer Name tab.
   c. Look for Full computer name field. This is the machine name of your computer.
   d. Note down the machine name and click OK.

7. Type a Protocol end point number that is not used by any other device on the network.

8. Click Next to proceed to the final dialog box for the Guard Tour Server Configuration.

9. Click Finish to add the server.

Editing a Guard Tour Server

To edit a guard tour server:


2. Expand the Devices folder to display the servers and devices added to the device map.

3. Right-click the guard tour server and click Configure. The Guard Tour Server Configuration dialog box appears.

4. Make the required changes of the guard tour server.

   See the Adding a Guard Tour Server section for configuring guard tour server.

5. Click OK to save the changes.
Isolating and deleting a Guard Tour Server

You can delete a guard tour server, only if you isolate an ADV of the guard tour server from floor plans and operator levels.

Isolating a Guard Tour Server

To isolate a guard tour server:

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the guard tour server and click Isolate. The Isolate Device or ADV dialog box appears.

4. To isolate floor plans from an ADV of the guard tour server:
   a. Click the Floor Plans tab. The list of floor plans associated to the guard tour server is displayed.
   b. Select the floor plans to be isolated from the guard tour server and click Remove. The selected floor plans are dissociated.

   OR

   Click Remove all to isolate all the floor plans from the guard tour server.

5. To isolate operator levels from an ADV of the guard tour server:
   a. Click the Operator Levels tab. The list of operator levels associated to the guard tour server is displayed.
   b. Select the operator levels to be isolated from the guard tour server and click Remove. The selected operator levels are dissociated.

   OR

   Click Remove all to isolate all the operator levels.
c. To remove a guard tour server from the control area, clear the presence of guard tour server by clearing the Present in Control Area check box.

6. Click OK.

**Deleting a Guard Tour Server**

After deleting the child nodes and isolating the associated floor plans and operator levels, you can delete the guard tour server.

To delete a guard tour server:

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the guard tour server and click Delete. A message asking for confirmation appears.
4. Click OK to confirm the deletion. The guard tour server is deleted from the device map.

**Schedule Server**

Before using the Scheduling functions, you must configure a Schedule Server. Normally the Schedule Server is located on the same machine as the Database Server.

**Adding a Schedule Server**

To add a schedule server:

2. Right-click the Devices folder and choose Add > Schedule Server. The Schedule Server Configuration window appears.

![Schedule Server Configuration](image)

Figure 10-12 Schedule Server Configuration

3. Type the Name of the schedule server.
4. Type the Description for the schedule server.
5. Click Add under ADV to create an ADV for the schedule server. The Abstract Device Record - Server dialog box appears.
   
   See the Configuring an Abstract Device section for more information on ADV configuration.
6. After adding an ADV, click **OK** to return to the **Schedule Server Configuration** dialog box.
   - Under **ADV**, use the **Edit**, **Isolate**, and **Delete** buttons to edit, isolate and delete the ADV.
   - Click the **Show** check box to view the ADV details.

7. Enter the **Machine Name** for the schedule server.
   **Tip**: To find the machine name:
   a. Right-click the **My Computer** icon on your desktop and click **Properties**. The **System Properties** dialog box appears.
   b. Click the **Computer Name** tab.
   c. Look for **Full computer name** field. This is the machine name of your computer.
   d. Note down the machine name and click **OK**.

8. Type a **Protocol end point** number that is not used by any another device on the network.

9. Click **Next** to proceed to the final dialog box for the Schedule Server Configuration.

10. Click **Finish** to add the server to the Device Map.

### Editing a Schedule Server

To edit a schedule server:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Expand the **Devices** folder to display the servers and devices added to the device map.

3. Right-click the schedule server and click **Configure**. The **Schedule Server Configuration** dialog box appears.

4. Edit the required details of the schedule server.

   **See the Adding a Schedule Server section for configuring guard tour server.**

5. Click **OK** to configure the schedule server.
Isolating and deleting a Schedule Server

You can delete a schedule server, only if you isolate the device or an ADV of schedule server from floor plans and operator levels.

Isolating a Schedule Server

To isolate a schedule server:

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the schedule server and click Isolate. The Isolate Device or ADV dialog box appears.

4. To isolate floor plans from an ADV of the schedule server:
   a. Click the Floor Plans tab. The list of floor plans associated to the schedule server is displayed.
   b. Select the floor plans to be isolated from the schedule server and click Remove. The selected floor plans are dissociated.

   OR

   Click Remove all to isolate all the floor plans.

5. To isolate operator levels from a device or an ADV of schedule server:
   a. Click the Operator Levels tab. The list of operator levels associated to the schedule server is displayed.
   b. Select the operator levels to be isolated from the schedule server and click Remove. The selected operator levels are dissociated.

   OR

   Click Remove all to isolate all the operator levels.
c. To remove the schedule server from the control area, clear the presence of an ADV of the schedule server in the control area, clear the Present in Control Area check box.

6. Click OK.

Deleting a Schedule Server

After isolating the associated floor plans and operator levels, you can delete the schedule server.

To delete a schedule server:

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the schedule server and click Delete. A message asking for confirmation appears for deleting the server.
4. Click OK to confirm the deletion. The schedule server is deleted from the device map.

Tracking and Muster Server

Before using the Tracking and Muster functions, you must configure a Tracking and Muster Server. Normally the server is located on the same machine as the Database Server.

Adding a Tracking and Muster Server

To add a tracking and muster server:

2. Right-click the Devices folder at the top of the tree, choose Add, then click Tracking and Muster Server. The Tracking and Mustering Server Configuration dialog box appears.
3. Type a unique Name of the tracking and muster server and the Description for tracking and muster server.
4. Click Add under ADV to create an ADV for the tracking and muster server. The Abstract Device Record - Server dialog box appears.
Device Map
Server Configuration

See the Configuring an Abstract Device section for more information on ADV configuration.

5. After adding an ADV, click OK to return to the Tracking and Mustering Server Configuration dialog box.
   - Under ADV, use the Edit, Isolate, and Delete buttons to edit, isolate and delete the ADV.
   - Click the Show check box to view the ADV details.

6. Enter the Machine Name where the tracking and muster server is located.

   Tip: To find the machine name:
   a. Right-click the My Computer icon on your desktop and click Properties. The System Properties dialog box appears.
   b. Click the Computer Name tab.
   c. Look for Full computer name field. This is the machine name of your computer.
   d. Note down the machine name and click OK.

7. Type a Protocol end point number that is not used by any other device on the network.

8. In Hours of History to Prime on startup, increase or decrease the number of hours the tracking history is processed and displayed when the Muster View is opened. The hours can range from 0 to 99. By default, it is set to 8 hours.

9. Click Next to proceed to the final dialog box for the Tracking and Muster Server configuration.

10. Click Finish to add the server to the Device Map.

Editing a Tracking and Muster Server

To edit a tracking and muster server:


2. Expand the Devices folder to display the servers and devices added to the device map.

3. Right-click the tracking and muster server and click Configure. The Tracking and Muster Server Configuration dialog box appears.

![Figure 10-16 Tracking and Muster Server Configuration]
4. Edit the required details of the tracking and muster server.
   See the Adding a Tracking and Muster Server section for configuring the tracking and muster server.
5. Click OK to configure the tracking and muster server.

**Isolating and Deleting a Tracking and Muster Server**

You can delete a tracking and muster server, if only you isolate an ADV of tracking and muster server from floor plans and operator levels.

**Isolating a Tracking and Muster Server**

To isolate a tracking and muster server:

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the tracking and muster server and click Isolate. The Isolate Device or ADV dialog box appears.

![Image of Isolate Device or ADV dialog box]

**Figure 10-17   Isolating a Tracking and Muster Server**

4. To isolate floor plans from an ADV of tracking and muster server:
   a. Click the Floor Plans tab. The list of floor plans associated to the tracking and muster server is displayed.
   b. Select the floor plans to be isolated from the tracking and muster server and click Remove. The selected floor plans are dissociated.

OR

Click Remove all to isolate all the floor plans from the tracking and muster server.

5. To isolate operator levels from an ADV of tracking and muster server:
   a. Click the Operator Levels tab. The list of operator levels associated to the command file server is displayed.
b. Select the operator levels to be isolated from the command file server and click Remove. The selected operator levels are dissociated.

OR

Click Remove all to isolate all the operator levels.

c. To remove the tracking and muster server from the control area, clear the presence of an ADV of the tracking and muster server in the control area, clear the Present in Control Area check box.

6. Click OK.

Deleting a Tracking and Muster Server

After isolating the associated floor plans and operator levels, you can delete the tracking and muster server.

To delete a tracking and muster server:

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the tracking and muster server and click Delete. A message asking for confirmation appears for deleting the server.
4. Click OK to confirm the deletion. The tracking and muster server is deleted from the device map.

Communication Loops

A communication loop is an interface between the panels and the communication server. It must be added to an existing communication server on the Device Map. You must have an available communication port, for each panel or a communication loop to be added to a loop.

C-100 Panel Loop

Panels using 20-milliamp communications can be connected to the WIN-PAK system by a C-100 communication adaptor. The C-100 connection is defined by adding it to the Device Map.

Adding a C-100 Panel Loop

To add a C-100 panel loop:

2. Expand the Devices folder and then right-click the communication server and click Panel Loop (C-100). The C-100 Loop Configuration - Basic Information dialog box appears.
3. Type a unique **Name** for the panel loop. This field is mandatory.

4. Type a **Description** for the panel loop.

5. Create an ADV for the communication loop. Click **Add** under **ADV** to display the **Abstract Device Record - Server** dialog box.

   See the **Configuring an Abstract Device** section for more information on ADV configuration.

6. After adding an ADV, click **OK** to return to the **Communication Server Configuration** dialog box.
   - Under **ADV**, use the **Edit**, **Isolate** and **Delete** buttons to edit, isolate and delete the ADV.
   - Select the **Show** check box to view the ADV details.

7. Increase or decrease the **Loop Verification Interval (Sec)** to verify whether the loop is responding when a signal is send from WIN-PAK to the C-100 loop.

   Increasing the interval improves the bandwidth. The default interval is set to 60 seconds as it is an optimal value.

8. Select **Buffer all panels on exit** to buffer the events on all the panels when the communication server is stopped.

9. Select **Unbuffer all panels on startup** to unbuffer all the panel events when the communication server is started.

10. Select the standard **Time Zone** based on the loop location.

11. Set the **Panel Defaults** for the panel loop.
   - **I/O Poll Interval**: Select the interval at which the signal must be sent to the panel to verify the communication and check the panel's input and output states. By default, the frequency interval is 60 seconds.
   - **Panel CMD Retry Count**: Specify the number of times a command must be resent to the panel, if the event of the panel not responding to the command. By default, the command is resent 3 times.
   - **Panel CMD Time Out**: Specify the waiting time for receiving a response from the panel and for time out the command. By default, the loop waits for 5 seconds.
12. Click **Next** to set the port for the loop.

![Figure 10-19 Setting the Ports](image)

13. In the **Port** list, select a port of the communication server to which the loop is to be connected. The ports that are selected for the communication server and not used for other loops are listed.

14. If you select a port,
   a. Select the communication baud rate for the loop in **Bits per second**.
   b. Select the number of bytes that can be transferred in **Data Bits**. Select a number between 4 and 8. By default, it is set to 8.
   c. Select the type of **Parity** for the error detecting procedure. By default, it is set to **None**. The available parity types are **Even**, **Odd**, **Mark**, and **Space**.
   d. Select the **Stop Bits** value. By default, it is 1. In serial communications, a stop bit is an extra bit transmitted after each unit of information (usually a byte) to indicate that transmission of that unit is complete.

15. If you select a **TCP/IP Connection** port,
   a. Type the **TCP/IP IP-Address or Node name** of the computer where the loop is connected. The corresponding **Port No.** is displayed.

16. If you select a **TCP/IP Encrypted Connection** port,
   a. Type the **TCP/IP IP-Address or Node name** and the **Encryption Password** of the computer where the loop is connected. The corresponding **Port No.** is displayed.

17. Click **Next** to display the **C-100 Loop Configuration - Finish** dialog box.

18. Click **Finish** to add the C-100 panel loop and return to the **Device** window. The corresponding loop icon is displayed for the panel loop in the **Device** tree structure. For the communication port loop the icon is displayed. For the TCP/IP port loop the icon is displayed.

**Editing a C-100 Panel Loop**

To edit a C-100 panel loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder.
3. Right-click the C-100 loop and click **Configure**. The **Loop Configuration** dialog box appears.

4. Configure the loop using the Basic Information and Port Settings tabs. See the **Adding a C-100 Panel Loop** section for configuring C-100 panel loop.
5. Click **OK** to configure the loop.

### Isolating and Deleting a C-100 Panel Loop

You cannot delete a C-100 panel loop, until you delete the panels attached to it and remove all references to the C-100 Panel Loop from floor plans and operator levels.

**Isolating a C-100 Panel Loop**

To isolate a C-100 panel loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and right-click the C-100 panel loop and click **Isolate**. The **Isolate Device or ADV** dialog box appears.
Device Map
Communication Loops

3. To isolate floor plans from an ADV of C-100 panel loop:
   a. Click the Floor Plans tab. The floor plans associated to the C-100 panel loop are listed.
   b. Select the floor plans to be isolated from the C-100 panel loop and click Remove. The selected floor plans are dissociated from the C-100 loop.
   OR
   Click Remove all to isolate floor plans from the panel loop.
4. To isolate operator levels from an ADV of C-100 panel loop:
   a. Click the Operator Levels tab. The operator levels associated to the C-100 panel loop are listed.
   b. Select the operator levels to be isolated from the C-100 panel loop and click Remove. The selected operator levels are dissociated.
   OR
   Click Remove all to isolate all the operator levels from the panel loop.
   c. To remove the panel loop from the control area, clear the presence of an ADV of C-100 panel loop in the control area by clearing the Present in Control Area check box.
5. Click OK.

Deleting a C-100 Panel Loop

After deleting the panels attached to a panel loop and isolating the associated floor plans and operator levels, you can delete the C-100 panel loop.

To delete a C-100 panel loop:
2. Expand the Devices folder.

Figure 10-21 Isolating a C-100 Panel Loop
3. Right-click the C-100 panel loop and click **Delete**. A message asking for confirmation appears for deleting the panel loop.
4. Click **OK** to delete. The C-100 panel loop is deleted from the device map.

### 485/PCI Panel Loop

Panels using the RS-485 communication protocol can be connected to the WIN-PAK system by the PCI3 or N-485-PCI-2 communication adaptor. The 485 communication protocol offers better data supervision and increased system performance compared to the 20-milliamp communication protocol. A 485 PCI (with or without ACK/NAK) connection is defined by adding it to the Device Map.

#### Adding a 485/PCI Panel Loop

To add a 485/PCI panel loop

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder, right-click the communication server and then click **Panel Loop (485/PCI)**
   OR
   Right-click the 485/PCI panel loop and select **Configure**.

   The **485/PCI Loop Configuration** dialog box appears.

   ![485/PCI Loop Configuration](image)

   *Figure 10-22  485/PCI Loop Configuration*

3. Type a unique **Name** for the 485/PCI panel loop. This field is mandatory.
4. Type a **Description** of the 485/PCI panel loop.
5. Create an ADV for the 485/PCI panel loop. Click **Add** under **ADV** to display the **Abstract Device Record - Server** dialog box.
   See the **Configuring an Abstract Device** section for more information on ADV configuration.
Device Map

Communication Loops

6. After adding an ADV, click **OK** to return to the **Communication Server Configuration** dialog box.
   - Under **ADV**, use the **Edit**, **Isolate**, and **Delete** buttons to edit, isolate and delete the ADV.
   - Click the **Show** check box to view the ADV details.
7. Select the **ACK/NAK** check box, if you are using a ACK/NAK protocol. ACK/NAK protocol requires acknowledgement, which can be positive (ack) or negative (nak). ACK indicates a successful message receipt, while nak indicates an invalid message.
8. Select the **PCI3** check box to enable PCI3 support for the loop. PCI3 support helps in using higher baud rates for communication.
   
   **Note:** Selecting the **PCI3** check box results in addition of the following baud rates: 19200, 38400, 57600, and 115200 to the **Bits Per Second** field under **Port Settings**.
9. Select the **Buffer all panels on exit** check box to buffer the events in the respective panels when the communication server stops.
10. Select the **Unbuffer all panels on startup** check box to unbuffer all the panel events when the communication server restarts.
11. Select the standard **Time Zone** based on the loop location.
12. Set the **Panel Defaults** for the panel loop.
   a. **I/O Poll Interval**: Select the interval at which the signal must be sent to the panel to verify the communication and check the panel's input and output states. By default, the frequency interval is 60 seconds.
   b. **Panel CMD Retry Count**: Specify the number of times a command must be resent to the panel, if the event of the panel not responding to the command. By default, the command is resent 3 times.
   c. **Panel CMD Time Out**: Specify the waiting time for receiving a response from the panel and for time out of the command. By default, the loop waits for 5 seconds.
13. Click **Next** to set the port for the loop.
14. In the **Port** list, select a port of the communication server to which the loop is to be connected. The ports that are selected for the communication server and not used for other loops are listed.
15. If you select a port,
   a. Select the transmission baud rate for the loop in **Bits per second**.
   b. Select the number of bytes that can be transferred in **Data Bits**. Select a number between 4 and 8. By default, it is set to 8.
   c. Select the type of **Parity** for error detecting procedure. By default, it is set to **None**. The available parity types are **Even**, **Odd**, **Mark**, and **Space**.
   d. Select the **Stop Bits** value. By default, it is 1. In serial communications, a stop bit is an extra bit transmitted after each unit of information (usually a byte) to indicate that transmission of that unit is complete.
16. If you select the **TCP/IP Connection** port,
   a. Type the **TCP/IP IP-Address or Node name** of the computer where the 485/PCI loop is configured. The corresponding port number is displayed in **Port No**.
17. If you select the **TCP/IP Encrypted Connection** port,
   a. Type the **TCP/IP IP-Address or Node name** and the **Encryption Password** of the computer where the 485/PCI loop is configured. The corresponding port number is displayed in **Port No**.
18. Click **Next** to display the **485/PCI Loop Configuration - Finish** dialog box.
19. Click **Finish** to add the 485/PCI panel loop and return to the **Device** window.
   The corresponding loop icon is displayed for the panel loop in the **Device** tree structure. For
   the communication port loop the  ☐ icon is displayed. For the TCP/IP port loop the  ☐ icon
   displayed.

**Editing a 485/PCI Panel Loop**

To edit a 485/PCI panel loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder.
3. Right-click the 485/PCI loop and click **Configure**. The **Loop Configuration** dialog box
   appears.
4. Configure the loop using the Basic Information and Port Settings tabs.
   See the **Adding a 485/PCI Panel Loop** section for configuring 485/PCI panel loop.
5. Click **OK** to save the changes.

**Isolating and deleting a 485/PCI Panel Loop**

You cannot delete a 485/PCI panel loop, until you delete the panels attached to it and remove
all references to the 485/PCI panel loop from floor plans and operator levels.

**Isolating a 485/PCI Panel Loop**

To isolate 485/PCI panel loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder.
3. Right-click the 485/PCI panel loop and click **Isolate**. The **Isolate Device or ADV** dialog
   box appears.
To isolate floor plans from an ADV of 485/PCI panel loop:

a. Click the **Floor Plans** tab. The floor plans associated to the 485/PCI panel loop are listed.

b. Select the floor plans to be isolated from the 485/PCI panel loop and click **Remove**. The selected floor plans are dissociated.

OR

Click **Remove all** to isolate all the floor plans from the panel loop.

5. To isolate operator levels from an ADV of 485/PCI panel loop:

a. Click the **Operator Levels** tab. The operator levels associated to the 485/PCI panel loop are listed.

b. Select the operator levels to be isolated from the 485/PCI panel loop and click **Remove**. The selected operator levels are dissociated.

OR

Click **Remove all** to isolate all the operator levels from the loop.

c. To remove the panel loop from the control area, clear the presence of an ADV of 485/PCI panel loop in the control area by clearing the **Present in Control Area** check box.

6. Click **OK**.

**Deleting a 485/PCI Panel Loop**

After deleting the panel attached to it and isolating the associated floor plans and operator levels, you can delete the 485/PCI panel loop.

To delete a 485/PCI panel loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Expand the **Devices** folder.
3. Right-click the 485/PCI panel loop and click **Delete**. A message asking for confirmation appears for deleting the panel loop.

4. Click **OK** to delete. The 485/PCI panel loop is deleted from the device map.

**RS-232 Panel Loop**

The RS-232 loop is an interface between the computer or communication server and the NS2 or NS2+ panel (single panel per port).

**Adding an RS-232 Panel Loop**

To add an RS-232 panel loop

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder.
3. Right-click the communication server and click **RS-232 Port (Single Panel)**. The **RS-232 Port (Single Panel) Configuration - Basic Information** dialog box appears.

![Figure 10-24 RS-232 Port (Single Panel) Configuration - Basic Information](image)

4. Type a unique **Name** for the panel. This field is mandatory.
5. Type a **Description** of the panel.
6. Create an ADV for the RS-323 loop. Click **Add** under **ADV** to display the Abstract Device Record - Server dialog box.

   See the **Configuring an Abstract Device** section for more information on ADV configuration.

7. After adding an ADV, click **OK** to return to the **RS-232 Port (Single Panel) Configuration** dialog box.
   - Under ADV, use the **Edit**, **Isolate**, and **Delete** buttons to edit, isolate, and delete the ADV.
   - Select the **Show** check box to view the ADV details.
8. Increase or decrease the **Loop Verification Interval (Sec)** to verify whether the loop is responding when a signal is send from WIN-PAK.
Increasing the interval improves the bandwidth. The default interval is set to 60 seconds as it is an optimal value.

9. Select **Buffer all panels on exit** to buffer the events in all the panels when the communication server stops.

10. Select **Unbuffer all panels on startup** to automatically unbuffer all panel events to WIN-PAK when the communication server restarts.

11. Select the standard **Time Zone** based on the loop location.

12. Set the **Panel Defaults** for the panel loop.
   
   a. **I/O Poll Interval**: Select the interval at which the signal must be sent to the panel to verify the communication and check the panel's input and output states. By default, the frequency interval is 60 seconds.
   
   b. **Panel CMD Retry Count**: Specify the number of times a command must be resent to the panel, if the event of the panel is not responding to the command. By default, the command is resent 3 times.
   
   c. **Panel CMD Time Out**: Specify the waiting time for receiving a response from the panel and for time out the command. By default, the loop waits for 5 seconds.

13. Click **Next** to set the port for the loop.

![Figure 10-25 Setting the Ports for RS-232 Panel Loop](image)

14. In the **Port** list, select a port of the communication server to which the loop is to be connected. The ports that are selected for the communication server and not used for other loops are listed.

15. If you select a port,
   
   a. Select the transmission baud rate for the loop in **Bits per second**.
   
   b. Select the number of bytes that can be transferred in **Data Bits**. Select a number between 4 and 8. By default, it is set to 8.
   
   c. Select the type of **Parity** for the error detecting procedure. By default, it is set to **None**. The available parity types are **Even**, **Odd**, **Mark**, and **Space**.
   
   d. Select the **Stop Bits** value. By default, it is 1. In serial communications, a stop bit is an extra bit transmitted after each unit of information (usually a byte) to indicate that transmission of that unit is complete.
16. If you select TCP/IP Connection port,
   a. Type the TCP/IP IP-Address or Node name of the computer where the panel is
      connected. The corresponding Port No. is displayed.

17. If you select TCP/IP Encrypted Connection port,
   a. Type the TCP/IP IP-Address or Node name and the Encryption Password of
      the computer where the panel is connected. The corresponding Port No. is
      displayed.

18. If you select TCP/IP Reverse Initiate port,
   a. The port number displays by default in Port No field.

19. If you select TCP/IP Reverse Initiate with Encryption port,
   a. Type the password of the computer where the panel is connected in the
      Encryption Password and Confirm Encryption Password fields. The
      corresponding Port No. is displayed

20. Click Next to display the Finish dialog box.

21. Click Finish to add the RS-232 panel loop and return to the Device window.

The corresponding loop icon is displayed for the panel loop in the Device tree structure. For
the communication port loop the icon is displayed. For the TCP/IP port loop the icon is
displayed.

**Editing an RS-232 Panel Loop**

To edit an RS-232 panel loop:

2. Expand the Devices folder.
3. Right-click the RS-232 loop and click Configure. The Loop Configuration dialog box
   appears.

   [Figure 10-26 Editing an RS-232 Panel Loop]

   4. Configure the loop using the Basic Information and Port Settings tabs.

   See the Adding an RS-232 Panel Loop section for configuring the RS-232 panel loop.

5. Click OK to save the changes.
Isolating and deleting an RS-232 Panel Loop

You cannot delete an RS-232 panel loop, until you delete the panels attached to it and remove all the references to the RS-232 panel loop from floor plans and operator levels.

Isolating an RS-232 Panel Loop

To isolate RS-232 panel loop:

2. Expand the Devices folder and right-click the RS-232 panel loop and click Isolate. The Isolate Device or ADV dialog box appears.

3. To isolate floor plans from an ADV of RS-232 panel loop:
   a. Click the Floor Plans tab. The list of floor plans associated to the RS-232 panel loop is displayed.
   b. Select the floor plans to be isolated from the RS-232 panel loop and click Remove. The selected floor plans are dissociated.

   OR

   Click Remove all to isolate all the floor plans from the panel loop.

4. To isolate operator levels from an ADV of RS-232 panel loop:
   a. Click the Operator Levels tab. The list of operator levels associated to the 485/PCI panel loop is displayed.
   b. Select the operator levels to be isolated from the RS-232 panel loop and click Remove. The selected operator levels are dissociated.

   OR

   Click Remove all to isolate all the operator levels from the panel loop.

   c. To remove the panel loop from the control area, clear the presence of an ADV of RS-232 panel loop in the control area by clearing the Present in Control Area check box.
5. Click OK.

Deleting an RS-232 Panel Loop

After deleting the panels attached to the panel loop and isolating the associated floor plans and operator levels, you can delete the RS-232 panel loop.

To delete an RS-232 panel loop:

2. Expand the Devices folder and right-click the RS-232 panel loop and click Delete. A message asking for confirmation appears for deleting the panel loop.
3. Click OK to delete. The RS-232 panel loop is deleted from the device map.

P-Series Panel Loop

A P-Series panel loop represents a configuration of more than one P-Series Intelligent Controller panel board. A loop requires only one com port on a communication server, and there can be up to eight Intelligent Controllers per loop, and up to 8 SIO Boards per Intelligent Controller.

Adding a P-Series Panel Loop

To add a P-Series panel loop:

2. Expand the Devices folder and then right-click the communication server and click Panel Loop (P-Series). The Loop P-Series Configuration - Basic Information dialog box appears.

3. Type a unique Name for the P-Series panel loop. This field is mandatory.
4. Type a Description of the panel loop.
5. Click Next to include port details.
Communication Loops

Figure 10-29  Setting the Ports for the P-Series Panel Loop

In the **Type** list, **Serial (RS485)** is displayed by default. When you establish a PRO-2200 panel loop, the only applicable type is RS485.

6. In the **Port** list, select a port of the communication server to which the loop is to be connected. The ports that are added to the communication server and are not used by any other device are listed.

7. Enter the following port details:
   
   - **Bits per Second**: The transmission baud rate of the communication port. The default baud rate is 38400. It can be set to 9600 or 19200 when the RS-485 communication port is used.
   
   - **IC Reply Timeout**: The duration the Host PC waits for an acknowledgment after it has sent an outgoing packet. If acknowledgment is not received within the specified time, the Host PC re-sends the packet. The host retries according to the Host Retry Count set in the panel.
   
   - **RTS Mode**: The Request to Send mode that enables the host PC to know that the Intelligent Controller is ready to send information. The RTS Mode defaults to **Always On**.

   The **Toggle** RTS Mode applies when there is an RS-485 to RS-232 converter that requires a handshake. The RS-485 converter needs to know when it is sending and when it is receiving. Toggle enables you to control the direction on an external converter. The converter specified by Honeywell Access Systems has handshaking turned off and therefore, do not set the RTS Mode to Toggle.

8. Click **Next** to display the **Loop P-Series Configuration - Finish** dialog box.

9. Click **Finish** to add a P-Series panel loop.

**Editing a P-Series Panel Loop**

To edit a P-series panel loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Expand the **Devices** folder.

3. Right-click the P-series loop and click **Configure**. The **Loop P-Series Configuration** dialog box appears.
Isolating and deleting a P-Series Panel Loop

You cannot delete a P-Series panel loop, until you delete the P-series panels attached to it and remove all the references of a P-series panel loop from floor plans and operator levels.

Isolating a P-series Panel Loop

To isolate a P-series panel loop:

2. Expand the Devices folder and right-click the P-series panel loop and click Isolate. The Isolate Device or ADV dialog box appears.
3. To isolate floor plans from an ADV of P-series panel loop:
   a. Click the Floor Plans tab. The list of floor plans associated to the P-series panel loop is displayed.
   b. Select the floor plans to be isolated from the P-series panel loop and click Remove. The selected floor plans are dissociated.

   OR

   Click Remove all to isolate all the floor plans from the panel loop.

4. To isolate operator levels from an ADV of P-series panel loop:
   a. Click the Operator Levels tab. The list of operator levels associated to the P-series panel loop is displayed.
   b. Select the operator levels to be isolated from the P-series panel loop and click Remove. The selected operator levels are dissociated.

   OR

   Click Remove all to isolate all the operator levels from the panel loop.

   c. To remove the P-series panel loop from the control area, clear the presence of an ADV of P-series panel loop in the control area by clearing the Present in Control Area check box.

5. Click OK.

**Deleting a P-series Panel Loop**

After deleting the panels attached to the panel loop and isolating the associated floor plans and operator levels, you can delete the P-series panel loop.

To delete a P-series panel loop:

2. Expand the Devices folder and right-click the P-series panel loop and click **Delete**. A message asking for confirmation appears for deleting the panel loop.
3. Click **OK** to delete. The P-series panel loop is deleted from the device map.

**Video Management System**

*Note:* The Video Management functionality is not applicable to WIN-PAK XE.

The Video Management System (VMS) is an enterprise-class video management and storage solution. It is a truly hybrid solution which, enables you to operate the traditional analog and the network and IP based video equipment in the same surveillance network. Using the user interface, you can easily add cameras, recorders, and other devices. Monitoring locations is more effective through features like color correction, digital zoom, and others. Events such as failure of camera or loss of video can be logged. You can retrieve and view video pertaining to specific events. In addition, you can configure alarms to notify the operators when events occur.

**Add or Edit a Video Management Server**

The Video Management Server information must be added to the device map to perform the basic video surveillance operations.

To add or edit a Video Management Server:

1. Choose **Configuration** > **Device** > **Device Map**. The Device window appears.
2. Right-click the Devices folder and choose **Add** > **Video Management Server**. The Video Management Server Configuration dialog box appears.

![Video Management Server Configuration](image)

**Figure 10-32  Video Management System Configuration**

Under **Configuration Settings**

3. Type the **Name** of the server.
4. Type the **Description** for the server.

Under **Connection Settings**

5. The information In the following fields appears by default.
Device Map

Video Management System

- **Server Machine Name/IP Address** (Name of the computer where the Database Server is configured)
- **Server Port** (Default Video Management Server Port: 20007)

  **Note:** The Video Management Server is installed on the WIN-PAK DB Server.

6. Select the *Allow Edit* check box, and change the **Server Machine Name/IP Address**, and the **Server Port** as applicable.

7. The Communication Server that you have configured displays in the **Select Communication Server (to receive alarms)** drop-down list.

8. Click **Add** under **ADV** to create an **ADV** for the Video Management Server. The **Abstract Device Record** dialog box appears. See the *Configuring an Abstract Device* section for more information.

9. After adding an ADV, click **OK** to return to the **Video Management System Configuration** dialog box.

  **Note:**
  
  - Under **ADV**, use the **Edit**, **Isolate**, and **Delete** buttons to edit, isolate and delete the ADV.
  
  - Click the **Show** check box to view the ADV details.

**Connect**

**Note:** The **Connect** option is enabled only when WIN-PAK is **NOT** connected to Video Management Server.

You can connect WIN-PAK server to Video Management Server using the **Connect** option.

To connect to a Video Management Server:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Right-click the Video Management Server and choose **Connect**.

**Synchronize Event Types**

This option helps you to synchronize all the Video Management Server event types to WIN-PAK.

To synchronize Video Management Server event types:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Right-click Video Management Server and choose **Synchronize Event Types**.

![Figure 10-33 Synchronize Event Types](image)
All the event types supported for recorder, cameras, input/output in Video Management Server are imported to the WIN-PAK database.

Note: If new device drivers are installed, you must manually synchronize event types using this option.

Adding a Recorder

Recorders are devices used for streaming video and recording video from surveillance cameras (analog cameras and IP based digital cameras).

Recorders and Events

Events are predefined actions. Recorders have predefined events by default. An alarm is triggered whenever an event is generated. For example, when a recorder is disconnected from network, an event ‘RecorderDisconnected’ is generated.

Recorder Configuration

The recorders must be configured before using them for surveillance purposes.

To add a recorder:

2. Right-click the Video Management Server folder and choose Add > Recorder. The Recorder Configuration dialog box appears.
3. Enter the Recorder details under General Settings.
4. Type the Device Name for the recorder.
5. Type the Description for the recorder.
6. In the **Recorder Type** drop-down list, select the recorder. Device settings for the selected recorder appear.

For example, if you select "Fusion" as the recorder type, configure the device settings for the selected recorder as listed in the following table.

<table>
<thead>
<tr>
<th>Recorder Type</th>
<th>To configure the device settings</th>
</tr>
</thead>
</table>
| Fusion        | • In the **Site Address** box, type the numeric IP address or the host name of the Fusion recorder. Click **Ping** to verify the connection. The field appears in green if the IP address or the host name is valid.  
  • Select the **Check duplicate hostname** to check the availability of the host name.  
  • In the **Site Port** box, the port number appears by default.  
  • In the **User ID** box, type the user name to access the recorder.  
  • In the **Password** box, type the password to access the recorder.  
  • Click the **Time Zone** check box to enable the global time zone box and select the required time zone. |
| HRDP          | • In the **Site Address** box, type the numeric IP address or the host name of the HRDP recorder. Click **Ping** to verify the connection. The field appears in green if the IP address or the host name is valid.  
  • Select the **Check duplicate hostname** to check the availability of the host name.  
  • In the **Site Port** box, the port number appears by default.  
  • In the **User ID** box, type the user name to access the recorder.  
  • In the **Password** box, type the password to access the recorder.  
  • In the **Device Type** drop-down list, select the device type as applicable.  
  • Click the **Time Zone** check box to enable the global time zone box and select the required time zone. |
| MAXPRO NVR    | • In the **Unit Address** box, type the numeric IP address or the host name of the MAXPRO NVR recorder. Click **Ping** to verify the connection. The field appears in green if the IP address or the host name is valid.  
  • Select the **Check for duplicate IP address/ device name** to check the availability of the host name.  
  • In the **Site Port** box, the port number appears by default.  
  • In the **User Name** box, type the user name to access the recorder.  
  • In the **Password** box, type the assigned password for the user. |
7. In the **Recorder Version** drop-down list, select the recorder version.
8. In the **Site** drop-down list, select the site to which the recorder is to be associated.
9. Associate Events to the recorder. See the **Camera Configuration** section for more information.
10. Click **Next**. A message appears displaying that the recorder details are saved.
11. Click **Yes** to begin with the discovery of all the associated devices. See the **Camera Configuration** section for more information.

Or

11. Click **Yes** to begin with the discovery of all the associated devices. See the **Camera Configuration** section for more information.

12. Click **Add** under ADV to create an ADV for the Recorder. The **Abstract Device Record** dialog box appears.
13. After adding an ADV, click **OK** to return to the **Video Management Server Recorder Configure** dialog box.

**Note:**

- Under **ADV**, use the **Edit**, **Isolate**, and **Delete** buttons to edit, isolate and delete the ADV.
- Click the **Show** check box to view the ADV details.

### Associating Events and Event Attributes to a Recorder

You can associate one or more events to a recorder. An alarm is triggered whenever any of the associated event occurs for the recorder. For certain events, you can also associate event attributes. For example, for an Encoder Disabled event, you can associate attributes such as Encoder Name, Encoder ID and so on. For every attribute that you associate, you can set a value based on which the event is triggered. In the above example, you can associate the attribute Encoder Name to the event and set its value as Encoder A. When this event is associated to the recorder, an alarm is raised when the event “Encoder Disabled” occurs for the Encoder Name “Encoder A”.

Attributes are available only for certain events. These events can be associated to a recorder multiple times. The event attributes are listed in the details of the alarm in Alarm window. To view the event attributes of an alarm, right-click the alarm, and then click **Show Details**.
To associate events to a recorder:

1. Click the **Events** tab. The screen displays the associated events if any.

2. Click **Associate**. The **Select from List** dialog box appears.

3. Select the check box corresponding to the event you want to associate.

4. Click **OK**.

To disassociate events from a recorder:

- Select the check box corresponding to the event, and then click **Remove**.

To assign severity level:

1. Select the check box corresponding to the event you want assign severity level.
2. Double-click on the **Severity Level (priority)** box and edit the severity level. The maximum value you can specify is 99.

**Note:**

- Each action must be set with a priority for considering the action as an alarm or an event. When an action is triggered, the action priority is compared with the values set for **Alarm Priority for notification** and **Alarm Priority for required acknowledgement** fields that are configured in the Communication Server.
- The action is considered as an alarm, if the action priority is less than the value in the **Alarm Priority for required acknowledgement** field.
- The action is considered as an event, if the action priority is greater than the value in the **Alarm Priority for required acknowledgement**.

To enter remarks:

1. Select the check box corresponding to the event you want to enter remarks.
2. Click the **Remarks** box and type the remarks.
   
   **Note:** The remarks for the corresponding event is reflected in the WIN-PAK UI.

**Note:** Ensure that you retain the information in the remaining fields to their default settings.

### Associating Event Attributes

**Before you begin**

**Associate events**

To associate event attributes:

1. Select the check box corresponding to the event for which you want to associate event attributes. The **Event attributes Settings** appear in the lower pane.
2. Click **Associate**. The **Select Available Event Attributes** dialog box appears.
3. Select the check box corresponding to the event attributes that you want to associate.
4. Click **OK**.

To disassociate event attributes from a recorder:

- Select the check box corresponding to the event attribute, and then click **Remove**.

### Discover Devices

Discover devices helps you to connect the video server to the recorder, and retrieve all the cameras, inputs, and relays that are configured in the recorder.

All the discovered devices are automatically included in WIN-PAK. You must associate ADV’s for the devices that are to be used.

To discover input and output devices:

1. Click **Discover Devices** under **Device Settings** in the **Video Management Server Recorder Configure** dialog box. The **Discovery Wizard** dialog box appears.
Figure 10-37  Discovery Wizard dialog box

2. Under **Please select the Device Type to discover**, select the check boxes for the device types that you want to discover.

3. Click **View Advanced Settings** to configure the advanced settings and the order of the discovered devices.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start from last Callup number</td>
<td>Select this option if you want to add the device from the last callup number of the device type that has been selected.</td>
</tr>
<tr>
<td>Use free Callup number</td>
<td>Select this option to use the available callup number in the device type that has been selected.</td>
</tr>
<tr>
<td>Select starting Callup number</td>
<td>Type the starting callup number, and then choose an option from If Callup number already exists, what do you want to do? section. See step 7.</td>
</tr>
<tr>
<td>Override device name if it already exists</td>
<td>Select this check box to override the existing device name. The override device gets the name configured in the recorder and uses the same name while adding devices such as cameras, inputs, and outputs.</td>
</tr>
</tbody>
</table>
4. Click **Add** to add the devices.
5. Click **Close** after the “Discovery completed” message appears in the **Discovery Status** section.
6. Click **View Discover Log** to view logs if any.

**Editing a Recorder**

To edit a recorder:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the Video Management Server, right-click a recorder and select **Configure**. The **Recorder Configuration** window appears.
3. Click the appropriate tab to make the necessary changes to the configuration settings.
4. Click **Apply** to save the changes.

**Deleting a Recorder**

You can delete a recorder only after you delete the devices attached to the recorder. In addition, you must isolate the ADV of the recorder from floor plans and operator levels.

**Note:** If you delete a recorder, all the associated cameras, inputs / outputs, and recorders are deleted. A warning message appears if an ADV is associated in the Control Map/Floor Map.

**Camera Configuration**

Adding a camera involves defining the camera’s set up and operation across recorders. You can update or configure the general settings of a camera to configure PTZ settings and connect a camera to a recorder. After configuring the basic DVR details, you must configure settings for the cameras in the **Camera Configuration** dialog box.

Camera configuration involves the following three sections.

- **General Settings**
- **PTZ Settings**
- **Recording Settings**

**General Settings**

You can add, edit, and delete cameras.

**Add a Camera**

1. Click **Add** under **General Settings** in the **Camera Configuration** tab. The **Device Configure** dialog box appears.
2. Under **Camera Type**, click **PTZ** if the configured camera is PTZ or click **Fixed** if the camera type is fixed.

3. Under **Video Input Details**, specify the camera details listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Input Name</td>
<td>Type a camera name. The camera name appears in the devices window making it easy to select.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a description for the camera.</td>
</tr>
<tr>
<td>Callup Number</td>
<td>A unique number that identifies the camera. By default, the next available number is allocated.</td>
</tr>
<tr>
<td>Site</td>
<td>Location of the camera. You cannot edit the <strong>Site</strong> field.</td>
</tr>
</tbody>
</table>

4. Under **Alternative Camera Settings**, specify the details listed in the following table.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternate Camera</td>
<td>Type the number of the camera that has to be selected. The alternate camera option is selected from the context menu while playing or viewing live video. The range of valid camera numbers is 1 – 999999999. Zero (0) is the default value and indicates no alternate camera is defined.</td>
</tr>
</tbody>
</table>

5. The **Recorder** check box is selected by default displaying the recorder name in the text box.

6. You can change the **Input Number (recorder)**, if required. the input number is the physical input number on the recorder.

7. Associate **Events**. See “**Camera Configuration**” on page 45.
8. Click Save.

**Note:** The Switcher and Net Source fields are reserved for future releases of WIN-PAK.

**To preview video**
- Under Preview on the Camera Configuration tab, click Live Video to view live video from the camera.

**Note:** You can also define presets and set the PTZ.

**To Add/Delete bulk ADV**
- Under ADV Bulk Add/Delete, click
  - Add ADV, to add ADV’s for all the cameras if it is not added. During Bulk Add Operations, any cameras where ADV has already been manually added remains unchanged.
  - Delete ADV, to delete ADV’s for all the cameras.

**Note:** Any camera which has ADV associated with other devices or control map will not be deleted. You must manually isolate and then delete the ADV’s.

**Edit a Camera**
1. Under General Settings, select the camera to be edited and click Edit Settings.
2. Edit the required details. The settings for the selected camera is changed.
3. Click Save to save the settings.

**Note:** You must disassociate the ADV and then change the PTZ type. After the changes to the PTZ type is saved, you must again associate ADV for this device.

**Delete a Camera**
You can delete a camera only after you delete the devices attached to the camera. In addition, you must delete any associated ADV’s of the camera.
1. Under General Settings, select the camera to be deleted and click Delete.
2. Click OK. The selected camera is deleted.

**Associate a recorder to a video input device**
Video input devices like cameras can be associated with different recorders. Video clips are recorded and stored in recorders.

**To associate a camera to a recorder:**
1. In the Connected To section, click Recorder. The Recorder drop-down list is enabled.
2. Select the recorder. The device settings for the recorder appear.
Figure 10-39  Recorder Settings

3. Specify the recorder settings listed in the following table.

<table>
<thead>
<tr>
<th>Recorder Type</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rapid Eye</td>
<td>• Record Settings</td>
</tr>
<tr>
<td></td>
<td>- In the <strong>Live Resolution</strong> drop-down list, select the required resolution.</td>
</tr>
<tr>
<td></td>
<td>- In the <strong>Live Frame Rate</strong> drop-down list, select the required frame rate.</td>
</tr>
<tr>
<td></td>
<td>- In the <strong>PTZ Sensitivity</strong> drop-down list, select a number for PTZ sensitivity.</td>
</tr>
<tr>
<td>Note:</td>
<td>The <strong>PTZ Sensitivity</strong> drop-down list is enabled only when you select the PTZ option in the General Settings of the camera. The numbers represent speed of the PTZ. The higher the number, the more is the PTZ speed.</td>
</tr>
<tr>
<td>Fusion</td>
<td>• Record Settings</td>
</tr>
<tr>
<td></td>
<td>- In the <strong>Live Resolution</strong> drop-down list, select the required resolution.</td>
</tr>
<tr>
<td></td>
<td>- In the <strong>Live Frame Rate</strong> drop-down list, select the required frame rate</td>
</tr>
<tr>
<td></td>
<td>- In the <strong>PTZ Sensitivity</strong> drop-down list, select a number for PTZ sensitivity.</td>
</tr>
<tr>
<td>Note:</td>
<td><strong>PTZ Sensitivity</strong> drop-down list is enabled only when you select the PTZ option in the General Settings of the camera. The numbers represent speed of the PTZ. The higher the number, the more the PTZ speed.</td>
</tr>
</tbody>
</table>
PTZ Settings

Note: These settings are applicable only to PTZ cameras.

To configure the PTZ settings:

1. Select the camera under General Settings in the Camera Configuration tab.
2. The Select Home option helps you to set the selected preset as the home preset. The default home preset is Preset 1.
3. Specify a maximum Home Delay Sec limit of 255 seconds and a minimum limit of 1 second. The default value for the home delay for a PTZ camera is the value that is set during camera configuration.

Home Delay is the time delay (seconds) in returning the PTZ camera to the configured Home position.

Recording Settings

To configure the settings for the Instant and Intensive recording modes:

1. Click Instant or Intensive to set the mode for which you want to configure the settings.
2. Select the Record rate [IPS] from the drop-down list (images or frames/second).
3. Set the Duration in sec value for recording.
4. Select the Resolution and Quality parameters.

Note: You cannot configure the Quality and Resolution settings in Intensive mode.

5. Click Apply.
6. After the settings are applied to the camera, the message Setup values set successfully in camera is displayed. Click OK.
7. If the configured settings are not applied to the DVR, the message Error in setup values is displayed.

Note:

- The Pre-event sec value can only be configured in the server.
- The IPS value for Intensive recording must be higher than that for the Instant recording.
- The Recording settings are applicable only for Fusion cameras.
Input Configuration
You can add an alarm input and associate it to the devices. These alarm inputs trigger alarm whenever an event occurs.

1. In the Input Configuration tab, under General Settings, click Add. The Device Configure dialog box appears.

2. Select the Enabled check box to enable the alarm.
3. In the Alarm Input Name box, type the alarm input name.
4. The Site drop-down list displays the default site that is configured.
5. The Alarm Input Number field is reserved for future releases of WIN-PAK.
6. In the Normal State drop-down list, select Open or Closed as the normal state for the alarm input.
7. From the Operating Mode drop-down list, select the required mode. The available modes are listed in the table.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct</td>
<td>The alarm condition activates or de-activates when it physically changes state, or is set or cleared with macros.</td>
</tr>
<tr>
<td>Latched</td>
<td>Once the alarm is triggered, it remains active until it is reset manually using the alarm clear option.</td>
</tr>
<tr>
<td>Toggle</td>
<td>The first time the alarm is triggered it becomes active, the next time it is cleared.</td>
</tr>
</tbody>
</table>
8. In the **Connected To (Master)** section, click one of the devices for which you want to add the alarm input. The following table lists the available devices to which an Alarm Input can be connected.

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorder</td>
<td>For details on connecting a recorder, see the <strong>Output Configuration</strong> section.</td>
</tr>
</tbody>
</table>

**Note:** The fields **Switcher**, **Remote Camera**, **Network**, **High Level Device**, and **Keyboard** are reserved for future releases of WIN-PAK.

9. Select **Link** if you want to broadcast the status changes and actions performed on the current alarm input on the network.

10. See the **Output Configuration** section to change the **Input Settings** and **Event Settings**.

11. Click **Save**.

**Note:** You can switch on or switch off an alarm input using the On and Off buttons under **Trigger Alarm Input**.

### Connect an Alarm Input to a Recorder

To connect alarm input to a recorder:

1. The **Recorder** drop-down list by default displays the recorder name.
2. Configure the recorder settings under the following three tabs: **Input Settings**, **Event Settings**, and **Event Groups**.
3. In the **Input Settings** tab, type the **Alarm Input ID**.
4. In the **Event Settings** tab, specify the details listed in the following table.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Description</td>
<td>Type a event description for the event.</td>
</tr>
<tr>
<td>Global ID</td>
<td>Type the unique global ID. If the Global Event ID is not assigned, WIN-PAK assigns a unique global ID automatically when you save the event settings.</td>
</tr>
</tbody>
</table>
| Severity                        | Type the severity level.  
**Note:** Severity level is set to trigger alarms when the threshold is met. For example, if the threshold is set to 50 on the preferences tab, an alarm is triggered when threshold becomes 51. |
| Start Macro and End Macro       | These fields are reserved for future releases of WIN-PAK.                   |

5. The Information in the **Event Groups** tab is reserved for future releases of WIN-PAK.

6. Click **Save**.
Edit Input Settings
1. Under General Settings, select the input to be edited and click Edit Input Settings.
2. Edit the required details. The settings for the selected input is changed.
3. Click Save to save the settings.

Delete Inputs
1. Under General Settings, select the input to be deleted and click Delete Inputs.
2. Click OK. The selected input is deleted

Note: Click Refresh to refresh the list of available inputs.

Output Configuration
You can add an alarm output and associate it to the devices.
1. In the Output Configuration tab, under General Settings, click Add. The Device Configure dialog box appears.

Figure 10-41  Output Configuration

2. In the Callup Number box, an automatic number is allocated by default. The operator uses this number to select the output device from the keyboard.
3. In the Relay Description box, type a description for the relay.
4. The Site drop-down list displays the default site that is configured.
5. In the Connected To (Master) section, click one of the devices from which you want to add a relay. The following table lists the available devices to which a relay can be connected.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorder</td>
<td>For details on connecting to a recorder, see the Connecting a relay to the recorder section.</td>
</tr>
</tbody>
</table>

Note: The fields, Switcher, Analog Camera, Keyboard, Network, and High Level Device are reserved for future releases of WIN-PAK.
6. Select **Output Default State On** if you want the relay to be set to On, when the Video Management Server is started.
7. Click **Save**. The **Trigger Relay** options appear.
8. See the **Connecting a relay to the recorder** section to change the **Output Settings**.
9. Click **On** to trigger relay.
10. Click **Off** to trigger relay.

**Connecting a relay to the recorder**

To connect relay to a recorder:

1. The **Recorder** drop-down list displays the name of the recorder that is configured. The Output Settings appear in the **Output Settings** tab.
2. In the **Relay ID** box, type the relay ID number for the recorder.

**Edit output settings**

1. Under **General Settings**, select the output to be edited and click **Edit Output Settings**.
2. Edit the required details. The settings for the selected output is changed.
3. Click **Save** to save the settings.

**Delete outputs**

1. Under **General Settings**, select the output to be deleted and click **Delete Outputs**.
2. Click **OK**. The selected output is deleted.

**Note:** Click **Refresh** to refresh the list of available outputs.

**Deleting a Video Management Server**

You can delete a Video Management Server when you do not want to record video from it. All the associations made to the Video Management Server are removed, when you delete it.

**Before you begin**

From ADV, you must isolate and delete all the associations with the cameras, input, output, and recorders.

You must delete all the recorders before deleting the Video Management Server. To delete the recorder, ensure that you have deleted all the associated devices.

To delete a Video Management Server:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Right-click the Video Management Server and choose **Delete**. A dialog box appears.
3. Click **OK** to delete the Video Management Server.

**Modem Pools**

Modem can be used for enabling the communication between panel loops at remote sites. Modems are defined in the modem pool and then added to the communication loop. Modems
Device Map

Modem Pools

enable communication between WIN-PAK User Interface and panels. The C-100, 485 with a HUB (non ACK/NAK), 485 with a HUB (ACK/NAK), and P-Series panel loops can communicate to the modems. The procedure for configuring these panel loops is similar to the procedure for configuring local panel loops.

Modem pools are defined by adding them to the Device Map. You must have a communication server with an available com port for each modem. Once the pool is defined, the panel loops are added to the modem pool, rather than adding them directly to the communication server, as is the case with local loops.

Adding a Modem Pool

To add a modem pool:

2. Expand the Devices folder.
3. Right-click communication server and select the type of modem pool connection. The Modem Pool Configuration - Basic Information dialog box for the selected modem pool type appears.

4. Type a unique Name for the modem pool. This field is mandatory.
5. Enter a Description for the modem pool.
6. Click Add on the left of the dialog box to add the modems to the pool. The Modem Configuration dialog box appears.

Figure 10-42   Modem Pool Configuration-Basic Information
7. Type a unique Modem Name and the Local Phone Number for the modem. These fields are mandatory.

8. In the Port on Server list, select the port on the communication server to which the modem must be connected. The list of ports on the communication server and are not used in any modem pool or loop is displayed.

9. Click OK to close the Modem Configuration dialog box and return to Modem Pool Configuration dialog box.

10. Create an ADV for the modem pool. Click Add under ADV, enter the ADV properties and click OK.

   See the Configuring an Abstract Device section for more information on ADV configuration.

11. Click Next and in the next dialog box click Finish. The modem pool is added to the Communication Server.
Editing a Modem Pool

To edit a modem pool:

2. Expand the Devices folder and right-click the modem pool (ACK/NAK or non ACK/NCK) and click Configure. The Modem Pool Configuration dialog box appears for the ACK/NAK or non-ACK/NAK modem pool.

3. Configure the modem pool using the Basic Information tab. You can also add, edit, or delete the modems to the modem pool.

   See the Adding a Modem Pool section for configuring the modem pool.

4. Click OK to configure a modem.

Isolating and deleting a Modem Pool

You cannot delete a modem pool, until you delete the loops added to it and remove all the references of the modem pool ADV from floor plans and operator levels.

Isolating a Modem Pool

To isolate a modem pool:

2. Expand the Devices folder.
3. Right-click the modem pool and click Isolate. The Isolate Device or ADV dialog box appears.
4. To isolate floor plans from a modem pool ADV:
   a. Click the Floor Plans tab. The floor plans associated to the modem pool are listed.
   b. Select the floor plans to be isolated from the modem pool and click Remove. The selected floor plans are dissociated.

   OR
Click **Remove all** to isolate all the floor plans from the modem pool.

5. To isolate operator levels from a modem pool ADV:
   a. Click the **Operator Levels** tab. The operator levels associated to the modem pool are listed.
   b. Select the operator levels to be isolated from the modem pool and click **Remove**. The selected operator levels are dissociated.

**OR**

Click **Remove all** to isolate all the operator levels from the modem pool.

c. To remove the modem pool from the control area, clear the presence of an ADV of the modem pool in the control area by clearing the **Present in Control Area** check box.

6. Click **OK**.

**Deleting a Modem Pool**

After isolating the panel loops attached to the modem and the associated floor plans and operator levels, you can delete the modem pool.

To delete a modem pool:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder.
3. Right-click the modem pool and click **Delete**. A message asking for confirmation appears.
4. Click **OK** to confirm the deletion. The modem pool is deleted from the device map.

**C-100 or 485 (non-ACK/NAK) Remote Communication Loop**

You can add C-100 or 485 (non-ACK/NAK) remote communication loops only to the modem pools defined as non-ACK/NAK hub.

**Adding a C-100 or 485 (non-ACK/NAK) Remote Communication Loop**

To add a C-100 loop or 485 (non-ACK/NAK) to a modem pool:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and the communication server.
3. Right-click the non-ACK/NAK modem pool and click **Add New C-100 Loop** or **Add New 485 Loop**. The **Loop Configuration - Basic Information** dialog box appears for the selected loop type (C-100 or 485/PCI).
4. Type a unique Name of the remote communication loop. This field is mandatory.

5. Type a Description for the C-100 or 485 (non-ACK/NAK) loop.

6. Create an ADV for the communication loop. (Click Add under ADV, set the ADV properties and click OK.)

   See the Configuring an Abstract Device section for more information on ADV configuration.

7. Increase or decrease the Loop Verification Interval (Sec) to verify whether the loop is responding to a signal that is sent from WIN-PAK to the C-100 loop or 485/PCI panel loop.

8. Select Buffer all panels on exit to buffer the events on all the panels when the communication server stops.

9. Select Unbuffer all panels on startup to unbuffer all panel events when the communication server restarts.

10. Select the standard Time Zone based on the loop location.

11. Set the Panel Defaults for the remote communication loop.

   a. I/O Poll Interval: Select the interval at which the signal must be sent to the panel to verify the communication and check the panel's input and output states. By default, the frequency interval is 60 seconds.

   b. Panel CMD Retry Count: Specify the number of times a command must be resent to the panel, if the panel event is not responding to the command. By default, the command is resent 3 times.

   c. Panel CMD Time Out: Specify the waiting time for receiving a response from the panel and for time out of the command. By default, the loop waits for 5 seconds.

12. In Remote Phone Number, type the phone number of the modem in the remote site. Include the area code and dialing prefix, if they are needed to dial in from the remote site like 3125551212. This field is mandatory.

13. Select the Modem of the remote site.

14. Click Next to display the Finish dialog box.
15. Click Finish. The C-100 or 485 (non-ACK/NAK) remote communication loop is added to the modem pool.

**Editing a C-100 or 485 (non-ACK/NAK) Remote Communication Loop**

To edit a non-ACK/NAK remote communication loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder.
3. Right-click the C-100 or 485 non-ACK/NAK remote communication loop and click **Configure**. The **Loop Configuration** dialog box appears for the selected loop type.

   ![Figure 10-46: Editing a C-100 or 485 (non-ACK/NAK) Remote Communication Loop](image)

4. Configure the loop using the Basic Information tab.

   See the *Adding a C-100 or 485 (non-ACK/NAK) Remote Communication Loop* section for configuring the non-ACK/NAK remote communication loop.

5. Click **OK** to configure the panel loop.

**Isolating and deleting a non-ACK/NAK Remote Communication Loop**

You cannot delete a non-ACK/NAK remote communication loop, until you delete the panels attached to it and remove all the references of an ADV of a non-ACK/NAK remote communication loop from floor plans and operator levels.

**Isolating a non-ACK/NAK Remote Communication Loop**

To isolate a non-ACK/NAK remote communication loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder.
3. Right-click the non-ACK/NAK remote communication loop and click **Isolate**. The **Isolate Device or ADV** dialog box appears.
4. To isolate floor plans from an ADV of non-ACK/NAK remote communication loop:
   a. Click the **Floor Plans** tab. The list of floor plans associated to the non-ACK/NAK remote communication loop is displayed.
   b. Select the floor plans to be isolated from the non-ACK/NAK remote communication loop and click **Remove**. The selected floor plans are dissociated.

   OR

   Click **Remove all** to isolate all the floor plans from the panel loop.

5. To isolate operator levels from an ADV of non-ACK/NAK remote communication loop:
   a. Click the **Operator Levels** tab. The list of operator levels associated to the non-ACK/NAK remote communication loop is displayed.
   b. Select the operator levels to be isolated from the non-ACK/NAK remote communication loop and click **Remove**. The selected operator levels are dissociated.

   OR

   Click **Remove all** to isolate all the operator levels from the panel loop.

   c. To remove the panel loop from the control area, clear the presence of an ADV of non-ACK/NAK remote communication loop in the control area by clearing the **Present in Control Area** check box.

6. Click **OK**.

**Deleting a non-ACK/NAK Remote Communication Loop**

After deleting the panels attached to the panel loops and isolating the associated floor plans and operator levels, you can delete the non-ACK/NAK remote communication loop.

To delete a non-ACK/NAK remote communication loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and right-click the non-ACK/NAK remote communication loop and click **Delete**. A message asking for confirmation appears.
3. Click **OK** to delete. The non-ACK/NAK remote communication loop is deleted from the device map.

**485 ACK-NAK Remote Communication Loop**

You can add a 485 ACK-NAK remote communication loop only to a modem pool with ACK-NAK Hub.

**Adding a 485 ACK-NAK Remote Communication Loop**

To add 485 remote connection (with ACK/NAK) to a modem pool:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and the communication server.
3. Right-click the ACK/NAK modem pool and click **Add New 485 ACK/NAK Loop**. The **485/PCI Loop Configuration - Basic Information** dialog box for appears.
4. Type a unique **Name** of the remote communication loop. This field is mandatory.

5. Type the **Description** for the 485 (ACK/NAK) loop.

6. Create an ADV for your communication loop. (Click **Add** under **ADV**, set the ADV properties and click **OK**.)
   
   See the **Configuring an Abstract Device** section for more information on ADV configuration.

7. Increase or decrease the **Loop Verification Interval (Sec)** to verify whether the loop is responding to a signal that is sent from WIN-PAK to the C-100 loop.

8. Select **Buffer all panels on exit** to buffer the events on all the panels when the communication server stops.

9. Select **Unbuffer all panels on startup** to unbuffer all panel events when the communication server restarts.

10. Select the standard **Time Zone** based on the loop location.

11. Set the **Panel Defaults** for the remote communication loop.
   
   a. **I/O Poll Interval**: Select the interval at which the signal must be sent to the panel to verify the communication and check the panel's input and output states. By default, the frequency interval is 60 seconds.

   b. **Panel CMD Retry Count**: Specify the number of times a command must be resent to the panel, if the panel event is not responding to the command. By default, the command is resent 3 times.

   c. **Panel CMD Time Out**: Specify the waiting time for receiving a response from the panel and for time out of the command. By default, the loop waits for 5 seconds.

12. In **Remote Phone Number**, type the phone number of the modem in the remote site. Include the area code and dialing prefix, if they are needed to dial in from the remote site like 3125551212. This field is mandatory.

13. Select the **Modem** of the remote site.

14. Click **Next** to configure the hub settings. The **485/PCI Loop Configuration - Hub Settings** dialog box appears.
Device Map

Modem Pools

15. Set the following hub settings:

- **Delay for Connection**: The duration (in seconds) to pause between the dialing prefix and dialing phone number. Enter a number between 0 and 120 seconds.

- **Number of Redial Attempts**: The number of redial attempts to make. Enter a number between 0 and 50 times. The default is 3 times.

- **Wait Time for Disconnect**: The wait time allowed before disconnect. Enter a number between 1 and 999 seconds. The default is 5 seconds.

- **Delay before Next Attempt**: The wait time allowed between two dialings. Enter a number between 1 and 999 seconds. The default is 60 sec.

- **Modem Initialization String**: Enter the remote initialization string as:
  ATE0Q0V1&K0&C1&D0S0+1&W.
  Refer to the modem documentation for further details.

- **Dial Prefix**: The command prefix for dial. In most cases it is ATDT, which is set as the default.

- **Call In Option**: Select the call in option as **On Invalid Transaction** or **Never** for the panel to dial-up in case an alarm is raised.

16. To set a new site ID and password, click **Set New Site ID and Password**. The **Site - Password** dialog box appears. The Site ID and password must be given while dialing-up the modem.

17. Type a **New Password**. This field is mandatory and it can be up to 20 characters.

18. Retype the password in **Confirm Password**.

19. In the **Site ID** field, enter the site ID in @A [unique 4-digit number for area], S [unique 4-digit number for site] format. For example @A0002, S0003 is area 2 site 3.

20. Click **OK** to return to the **Hub Settings** dialog box.

21. Click **Next** and then click **Finish** in the next dialog box.

**Editing a 485 ACK/NAK Remote Communication Loop**

To edit a 485 ACK/NAK remote communication loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and communication server.
3. Right-click the 485 ACK/NAK remote communication loop and click **Configure**. The **485/PCI Loop Configuration** dialog box appears.

4. Configure the panel loop using Basic Information and Port Settings tabs.
   
   See the **Adding a 485 ACK-NAK Remote Communication Loop** section for configuring the 485 ACK/NAK remote communication loop.

5. Click **OK** to save the changes.

## Isolating and deleting a 485 ACK/NAK Remote Communication Loop

You cannot delete a 485 ACK/NAK remote communication loop, until you delete the panels attached to it and remove all the references of an ADV of a 485 ACK/NAK remote communication loop from floor plans and operator levels.

### Isolating a 485 ACK/NAK Remote Communication Loop

To isolate a 485 ACK/NAK remote communication loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and right-click the 485 ACK/NAK remote communication loop and click **Isolate**. The **Isolate Device or ADV** dialog box appears.
3. To isolate floor plans from an ADV of 485 ACK/NAK remote communication loop:
   a. Click the **Floor Plans** tab. The floor plans associated to the 485 ACK/NAK remote communication loop are listed.
   b. Select the floor plans to be isolated from the 485 ACK/NAK remote communication loop and click **Remove**. The selected floor plans are dissociated.

   OR

   Click **Remove all** to isolate all the floor plans from the panel loop.
4. To isolate operator levels from an ADV of 485 ACK/NAK remote communication loop:
Device Map

CCTV Switcher

a. Click the **Operator Levels** tab. The operator levels associated to the 485 ACK/NAK remote communication loop are listed.

b. Select the operator levels to be isolated from the 485 ACK/NAK remote communication loop and click **Remove**. The selected operator levels are dissociated.

OR

Click **Remove all** to isolate all the operator levels from the panel loop.

c. To remove the panel loop from the control area, clear the presence of an ADV of 485 ACK/NAK remote communication loop in the control area by clearing the **Present in Control Area** check box.

5. Click **OK**.

**Deleting a 485 ACK/NAK Remote Communication Loop**

After deleting the panels in the panel loop and isolating the associated floor plans and operator levels, you can delete the 485 ACK/NAK remote communication loop.

To delete a 485 ACK/NAK remote communication loop:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Expand the **Devices** folder and right-click the 485 ACK/NAK remote communication loop and click **Delete**. A message asking for confirmation appears for deleting the 485 ACK/NAK remote communication loop.

3. Click **OK** to delete. The 485 ACK/NAK remote communication loop is deleted from the device map.

**CCTV Switcher**

In addition to the local or remote panel loops, CCTV networks can be connected to the WIN-PAK system using CCTV Switchers. A CCTV Switcher is defined by adding it to a communication server on the Device Map. You must have an available communication port for each Switcher.

**Adding a CCTV Switcher**

To add a CCTV Switcher:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Expand the **Devices** folder, right-click the communication server and click **CCTV Switcher**. The **CCTV Switcher Configuration - Basic Information** dialog box appears.
3. Type a **Name** for the CCTV switcher. This field is mandatory.
4. Type a **Description** for the CCTV switcher.
5. Select the manufacturer of the CCTV switcher in the **Type** list.
6. In the **Port** list, select a port of the communication server to which the CCTV Switcher is to be connected. The ports that are selected for the communication server and not used for other loops are listed.
7. If you select a port:
   a. Select the transmission baud rate for the switcher in **Bits per second**.
   b. Select the number of bytes that can be transferred in **Data Bits**. Select a number between 4 and 8. By default, it is set to 8.
   c. Select the type of **Parity** for the error detecting procedure. By default, it is set to **None**. The available parity types are **Even**, **Odd**, **Mark** and **Space**.
   d. Select the **Stop Bits** value. By default, it is 1. In serial communications, a stop bit is an extra bit transmitted after each unit of information (usually a byte) to indicate that transmission of that unit is complete.
8. If you select a TCP/IP connection:
   a. Type the **TCP/IP IP-Address or Node name** of the computer where the CCTV switcher is connected. The corresponding **Port No.** is displayed.
9. If you select a TCP/IP encrypted connection:
   a. Type the **TCP/IP IP-Address or Node name** and the **Encryption Password** of the computer where the CCTV switcher is connected. The corresponding **Port No.** is displayed.
10. Click **Next** to configure cameras to the CCTV switcher. The **CCTV Switcher Configuration - Cameras** dialog box appears.
11. Select the check box to select the camera to be controlled by this switcher.

12. Type the **Camera Title** and create an ADV for the camera.

13. Click **Next** to configure the monitors of the CCTV switcher. The **CCTV Switcher Configuration - Monitors** dialog box appears.

14. Select the check box to select the monitor to be controlled by this switcher.
15. Create an ADV for the monitor.
16. Click **Next** and in the next dialog box click **Finish**. The CCTV switcher is configured.

### Editing a CCTV Switcher

To edit a CCTV switcher:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and right-click the CCTV switcher and click **Configure**. The **CCTV Switcher Configuration** dialog box appears.

![CCTV Switcher Configuration dialog box](image)

#### Figure 10-53  Editing a CCTV Switcher

3. Configure the CCTV Switcher using the Basic Information, Cameras, and Monitors tabs.

See the **Adding a CCTV Switcher** section for configuring the CCTV switcher.

4. Click **OK** to save the changes.

### Isolating and Deleting a CCTV Switcher

You cannot delete a CCTV switcher until you isolate CCTV switcher ADV from floor plans, operator levels, action groups, and ADVs.

#### Isolating a CCTV switcher

To isolate a CCTV switcher:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and the communication server.
3. Right-click the CCTV switcher and click **Isolate**. The **Isolate Device or ADV** dialog box appears.
4. To isolate floor plans from a CCTV switcher ADV:
Device Map
CCTV Switcher

a. Click the **Floor Plans** tab. The floor plans associated to the CCTV switcher are listed.

b. Select the floor plans to be isolated from the CCTV switcher and click **Remove**. The selected floor plans are dissociated.

OR

Click **Remove all** to isolate all the floor plans from the CCTV switcher.

5. To isolate operator levels from a CCTV switcher ADV:

   a. Click the **Operator Levels** tab. The operator levels associated to the CCTV switcher are listed.

   b. Select the operator levels to be isolated from the CCTV switcher and click **Remove**. The selected operator levels are dissociated.

   OR

   Click **Remove all** to isolate all the operator levels from the CCTV switcher.

   c. To remove the CCTV Switcher from the control area, clear the presence of a CCTV switcher ADV in the control area by clearing the **Present in Control Area** check box.

6. To isolate action group from a CCTV switcher ADV:

   a. Click the **Action Groups** tab. The action groups associated to the CCTV switcher are listed.

   b. Select the action groups to be isolated from the CCTV switcher and click **Remove**. The selected action groups are dissociated.

   OR

   Click **Remove all** to isolate all the action groups from the CCTV switcher.

7. To isolate ADV from a CCTV switcher ADV:

   a. Click the **Action Groups** tab. The ADVs associated to the CCTV switcher are listed.

   b. Select the ADVs to be isolated from the CCTV switcher and click **Remove**. The selected ADVs are dissociated.

   OR

   Click **Remove all** to isolate all the ADVs from the CCTV switcher.

8. Click **OK**.

**Deleting a CCTV switcher**

Isolate the floor plans and operator levels associated to a CCTV switcher, before delete the CCTV switcher.

To delete a CCTV switcher:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and the communication server.
3. Right-click the CCTV switcher and click **Delete**. A message asking for confirmation appears.
4. Click **OK** to delete. The CCTV switcher is deleted from the device map.
RS-232 Connection

RS-232 connection settings are used for the debugging purpose. An RS-232 connection is defined by adding it to the Device Map. The communication server must have a port available for each communication interface in your system.

Adding an RS-232 Connection

To add an RS-232 connection:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder, right-click the communication server and click **Add > RS-232 Connection**. The **RS-232 Connection Configuration - Basic Information** dialog box appears.

3. Type a **Name** for the RS-232 connection. This field is mandatory.
4. Type a **Description** for the RS-232 connection.
5. Under **Port Settings**, select a **Port** for the RS-232 Connection.
6. If you select a port,
   a. Select the transmission baud rate for the switcher in **Bits per second**.
   b. Select the number of bytes that can be transferred in **Data Bits**. Select a number between 4 and 8. By default, it is set to 8.
   c. Select the type of **Parity** for the error detecting procedure. By default, it is set to **None**. The available parity types are **Even**, **Odd**, **Mark**, and **Space**.
   d. Select the **Stop Bits** value. By default, it is 1. In serial communications, a stop bit is an extra bit transmitted after each unit of information (usually a byte) to indicate that transmission of that unit is complete.
7. If you select a TCP/IP connection,
   a. Type the **TCP/IP IP-Address or Node name** of the computer where the RS-232 protocol is connected. The corresponding **Port No.** is displayed.
8. If you select a TCP/IP encrypted connection:
a. Type the TCP/IP IP-Address or Node name and the Encryption Password of the computer where the RS-232 protocol is connected. The corresponding Port No. is displayed.

9. Create an ADV for the RS-232 Connection. Click Add under ADV, set the ADV properties and click OK.

See the Configuring an Abstract Device section for more details on ADV configuration.

10. Click Next and in the next dialog box click Finish. The RS-232 Connection is configured.

Editing an RS-232 Connection

To edit an RS-232 connection:


2. Expand the Devices folder and the communication server.

3. Right-click the RS-232 connection and click Configure. The RS-232 Connection Configuration dialog box appears.

4. Configure the RS-232 connection using the Basic Information tab.

See the Adding an RS-232 Connection section for configuring the RS-232 connection.

5. Click OK to save the changes.

Isolating and deleting an RS-232 Connection

You cannot delete an RS-232 until you isolate RS-232 connection from floor plans and operator levels.

Isolating an RS-232 connection

To isolate an RS-232 connection:

2. Expand the **Devices** folder and right-click the RS-232 connection and click **Isolate**. The **Isolate Device or ADV** dialog box appears.

3. To isolate floor plans from an ADV of RS-232 connection:
   a. Click the **Floor Plans** tab. The list of floor plans associated to the RS-232 connection is displayed.
   b. Select the floor plans to be isolated from the RS-232 connection and click **Remove**. The selected floor plans are dissociated.

   OR

   Click **Remove all** to isolate all the floor plans from the RS-232 connection.

4. To isolate operator levels from an ADV of RS-232 connection:
   a. Click the **Operator Levels** tab. The list of operator levels associated to the RS-232 connection is displayed.
   b. Select the operator levels to be isolated from the RS-232 connection and click **Remove**. The selected operator levels are dissociated.

   OR

   Click **Remove all** to isolate all the operator levels from the RS-232 connection.

   c. To clear the presence of an ADV of RS-232 connection in the control area, clear the **Present in Control Area** check box.

5. Click **OK**.

### Deleting an RS-232 Connection

Isolate the associated floor plans and operator levels from RS-232 connection to delete the RS-232 connection.

To delete an RS-232 connection:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and the communication server.
3. Right-click the RS-232 connection and click **Delete**. A message asking for confirmation appears for deleting the RS-232 connection.
4. Click **OK** to delete. The RS-232 connection is deleted from the device map.

### Ethernet Module (Galaxy Panel)

Galaxy panel helps you to monitor and track intrusion happening at different zones in the access control system. Zones are areas monitored by a device in the galaxy panel. Galaxy panel is configured in the Galaxy Gold User Interface application and then downloaded to WIN-PAK. However, the virtual keypad provided on WIN-PAK enables you to configure certain features in the Galaxy panel.

WIN-PAK communicates with the Galaxy panel through the Galaxy Ethernet module. Therefore, you must configure Galaxy Ethernet Module in the communication server to add the Galaxy panel in WIN-PAK. When you add the galaxy panel, its connection with WIN-PAK is established and the panel configuration details are downloaded to WIN-PAK.

### Adding a Galaxy Ethernet Module

To add a galaxy Ethernet module:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Right-click the communication server and choose **Add > Ethernet Module (Galaxy Single Panel)**. The **Ethernet Module configuration** dialog box appears.

![Ethernet Module Configuration dialog box](image)

**Figure 10-56  Ethernet Module Configuration dialog box**

3. Type a **Name** and a **Description** for the Ethernet module.

4. Type the **IP address** of the Galaxy Panel. This field is mandatory.

5. Under **Panel Defaults**, select the frequency at which the Galaxy panel is polled to know the status of the panel. The available polling options are:
   a. **Default Polling**: Select this option to poll continuously at the interval of 2 seconds.
   b. **Poll Once**: Select this option to poll only once after the Communication server is started.
   c. **Polling Interval**: Select this option to set the interval for polling. If you select this option, specify the interval in seconds for polling.

6. Click **Next** to configure the Galaxy port. The **Port Configuration** dialog box appears.
7. In the **Galaxy Gold Port Number** box, type the TCP IP port number used by the Galaxy Gold User Interface in WIN-PAK. By default, it is set to 10001. If you change the port number, the configuration of the Galaxy Gold UI must be changed accordingly.

8. In the **Alarm Report: Primary IP Port Number** box, type the TCP IP port number used by the Galaxy Gold UI for reporting alarms in WIN-PAK. By default, it is set to 10002.

9. In the **Control Command Port Number** box, type the TCP port used for Control Commands. By default, it is set to 10005.

10. In the **Remote PIN** box, type a PIN number to remotely access the Galaxy panel. The default PIN number for the panel is 543210.

11. In the **Connection Password** box, type the password to connect WIN-PAK to Galaxy panel. The connection password is configured in the Galaxy Gold UI.

12. Select or clear the **Encryption** check box to enable encryption of password when an alarm is sent to WIN-PAK from the Galaxy panel.

13. Under **ADV**, click **Add** to create an ADV for the Ethernet module (E080) of Galaxy.

See the **Configuring an Abstract Device** section for more details on ADV configuration.

14. Click **Next** to advance to the Finish dialog box.

15. Click **Next** to configure the Ethernet module for Galaxy. The Ethernet module (E080) for Galaxy panel is configured.

See the **Adding a Galaxy Panel** section for configuring the galaxy panel.

**Vista Panel Port (Home Automation Mode)**

The Vista panel helps you to monitor and track intrusion happening at different zones in the access control system. Zones are areas monitored by a device in the vista panel. The Vista panel is configured separately and then it is added in WIN-PAK with its configuration settings.

WIN-PAK communicates with the Vista panel through the Vista Panel Port. Therefore, you must configure the Vista Panel Port in the communication server to add the Vista panel in WIN-PAK.
Adding a Vista Panel Port

To add a vista panel port:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Right-click the communication server and choose **Add > Vista Panel Port (Home Automation Mode)**. The **Vista Port Configuration - Basic Information** dialog box appears.

3. Type a **Name** and a brief **Description** for the Vista panel port.

4. Set the **Loop Verification Interval (Sec)** in seconds to verify the connection between WIN-PAK and the Vista panel.

5. Create an ADV for the Vista Port. Click **Add** under **ADV**, set the ADV properties and click **OK**.

   See the **Configuring an Abstract Device** section for more information on ADV configuration.

6. Click **Next** to configure the Vista port. The **Vista Port Configuration - Port Settings** dialog box appears.

7. Select the **Port** for communication. You can select the TCP/IP Connection, if you use the Micro Cobox converter for converting RS-232 to TCP/IP.
8. Type the **Master/User Code** of the Vista panel. This enables you to operate on the Vista panel in WIN-PAK.

9. Type the **Installer Code** of the Vista panel. This enables you to change the Vista panel settings in WIN-PAK.

10. If you select the **TCP/IP Connection**, type the **IP-Address or Node Name** of the Micro Cobox converter.

    See the **Configuring an Abstract Device** section for more information on ADV configuration.

11. Click **Next** to advance to the Finish dialog box.

12. Click **Next** to configure the vista panel port. The Vista Panel Port for vista panel is configured.

    See the **Adding a Vista Panel** section for configuring the vista panel.

---

### Panel Configuration

The panel configuration is required in setting up your access control system. Configuring panels include:

- Setting up card formats
- Configuring different types of readers and keypads
- Configuring input and output points with numerous options.

As the number of options to set up the panel is too high, adding panels to a large system can be a time consuming job. To reduce the time effort:

- Define a panel and make a copy of it to create panels
- Define templates for action groups and use it to define ADVs of the same action type
- Copy an action group and edit. This enables you to create a variety of action groups quickly.

Panels are configured in WIN-PAK by adding them to the Device Map.
Adding an N-1000/PW-2000 Panel

A N-1000 or PW-2000 panel can be added to C-100 and 485/PCI panel loops.

To add an N-1000/PW-2000 panel:

2. Expand the Devices folder and the communication server folder.
3. Right-click the 485/PCI Loop or C-100 Loop and select Add New N-1000/PW-2000 Panel. The Panel Configuration - Basic dialog box appears.
4. Type a unique Name for the panel. This field is mandatory.
5. Type a Description for the panel.
6. Select the type of panel in the **Type** list. The number suffixed in the panel type indicates the number of readers, inputs, or outputs that can be connected to a panel.

7. The **Firmware Version** list automatically displays the firmware version of the panel.

8. Select the **Status** of the panel.
   - **Active** - The panel is configured and currently connected to the WIN-PAK system.
   - **Inactive** - The panel is configured but temporarily disconnected for maintenance purpose. When you add or delete a card to an inactive panel, the card details are simply saved.
   - **Not Present** - To define the panel before completing the panel installation. If the panel is marked as **Not Present**, no card transactions are saved.

9. Enter the unique **Address** for the panel from 1 through 31. The address corresponds to the DIP Switches setting on the panel.
   
   Refer to the NS2+ installation manual for further information.

10. Click **Add** under **ADV** and set the ADV properties to create an ADV for the panel.

    See the **Configuring an Abstract Device** section for more information on ADV configuration.

11. Click **Next** to specify the Card Format. The **Panel Configuration - Card Format** dialog box appears.

### Setting the Card Format for the Panel

To set the card formats:

1. In the **Panel Configuration - Card Format** dialog box, select the card format type as **ABA** or **WIEGEND**. The card formats are displayed, based on the selected card format type.
2. If you select **ABA**, select one of the following card formats:
   - 12-digit card format
   - 16-digit card format
   - User-defined card format and type the format value.

3. If you select **WIEGAND**, Honeywell recommends you to retain the default card format values.

4. Click **Next** to assign time zones and holiday group to this panel. The **Panel Configuration - Time Zones** dialog box appears.

**Assigning Time Zones and Holiday Groups to a Panel**

To assign times and holiday groups:

1. In the **Panel Configuration - Time Zones** dialog box, select the time zones from the **Available Time Zone** list and click **[ ]**. The time zones are moved to the **Selected Time Zone** list. For multiple selections, use the Shift and Ctrl keys.
Tip: If you want to remove a time zone from the Selected Time Zone list, select the time zone and click .

Only the time zones that are listed in Selected Time Zone are available for readers, input points and output points of this panel.

2. Select the holiday group in the Holiday Group list.

3. Click Next to set the panel options. The Panel Configuration - Options dialog box appears.

Setting the Panel Options

You can set certain panel options such as anti-passback, groups, key pads for providing access for the readers, input points, and output points attached to the panel.

- Anti-passback

  Anti-Passback discourages card holders to enter without using their cards.

  Anti-passback violation occurs at the following scenarios:

  a. If you have entered the building without using the card and exited from the building using your card. And then, if you try to enter the building the access is denied.

  b. If you have entered the building using the card and exited from the building without using the card. And then, if you try to enter the building the access is denied.

  - Anti-passback requires a reader on each side of the door. If anti-passback is selected for a panel in the Options tab, the anti-passback is locally implemented.

  - In the two readers panels such as PW-2000-II and PW-2000-III, the reader 1 is used as in-reader and reader 2 is used as out-reader.
- In the four readers panels such as PW-2000-IV (X), the readers 1 and 3 are used as in-readers and the readers 2 and 4 are used as out-readers.

- **Groups**

  Output groups enable a card read to activate more than one output points for the applications such as elevator control. For example, when Reader 1 is associated to a group, a valid card read on Reader 1 pulses all points in the group. Groups must be selected to access the AEP-3 in Hardware Options.

- **Forgiveness**

  Anti-passback violation can be forgiven by selecting the Forgiveness option. When this option is selected, all cards are reset during midnight. Therefore, the cardholders who have violated the anti-passback option can now access their cards to enter the building.

- **Keypads**

  Indicates that the panel is using matrix style (11-wire) keypads. If Wiegand style (5-wire) keypads are used, the keypad is treated as a reader and this option must be cleared.

- **PIN and Time Zone for PIN**

  The PIN number must be entered in the keypad during a particular time zone, before presenting a card to gain access in an entrance.

- **Continuous Card Reads**

  Card readers do not recognize valid cards while the corresponding output is energized. Continuous Card Reads enables card readers to read cards continuously, independent of output pulse time.

  **Example:** When Output 1 is assigned a 10 second pulse time, a valid card read at Reader 1 causes Output 1 to energize for 10 seconds. During this time the card reader does not recognize any other valid cards, if the Continuous Card Reads option is not selected.

- **Reverse Read LEDs**

  This option reverses the standard LED operation of the reader. If this option is selected, a reader that normally changes from green to red on a valid card read, changes from red to green.

- **Host Grant**

  Host Grant option provides the fault tolerance even if the card is not found in the panel. Host Grant options are used when, for example, a number of cards have been entered in the database, but have not yet been downloaded to the panel.

- **Site Codes**

  Site codes ensure that the card belongs to the facility where the card is used for gaining access. The site code is encoded with a card number on cards.

- **Hardware Options**

  Hardware Options enable you to include additional input and output points to the panel using the extendable boards. The available hardware options vary depending on the type of panel selected. The AEP-5 (supervised input board) and ERB (Expanded Relay Board) are only used with PW-2000-II panels.

  If the Groups option is selected in this dialog box, you can select one or two AEP-3 Output Expansion Boards. Each board adds eight output relays to a panel.

To set the panel options:

1. In the **Panel Configuration - Options** dialog box, select the **Anti-passback** check box to ensure that the card holders present the cards while entering and exiting a building.
2. Select the **Groups** check box to create output relay groups.

3. Select the **All readers use the same group** check box to pulse the group when a valid card is presented on any reader to pulse the group.

4. Select the **Keypads** check box if matrix style (11-wire) keypads are used in the panel. If you are using Wiegand style (5-wire) keypads, the keypad is treated as a reader and this option must be cleared.

5. Select the **PIN** check box, if a keycode must be entered before presenting a card to gain access.

6. Select a time zone in the **Time Zone** list during which a PIN is required for card access.

7. Select the **Continuous Card Reads** check box to enable card readers to read cards continuously, independent of output pulse time.

8. Select the **Reverse Read LEDs** check box to reverse the standard LED operation of the reader. If this check box is selected, a reader that normally changes from green to red on a valid card read, changes from red to green.

9. In the **Command File** list, select a command file that is applicable to a panel.

10. Select the following **Host Grant** options to grant the permission for the card holders, even if the card is not found in the panel:

    - **Disable** - Denies access to the card holders whose card details are not present in the panel.
    - **Open Door** - Enables the door to open, even if the card is not found in the panel.
    - **Open Door and Update Panel** - Enables the door to open and also to download the card details to the panel. Therefore, the panel is updated.

11. Enter a **Site Code** to ensure that cards belong to the facility where access is attempted. You can enter up to eight site codes.
Tip: To enter a site code, double-click any cell in the table, type the site code and press ENTER. If no site code is defined, the reader does not check for site codes to enable card access.

12. Under Hardware Options, select the required hardware expandable boards check boxes for including the additional input or output points.

13. To configure the Advanced options:
   a. Click Advanced. The Panel Configuration - Advanced Options dialog box appears.

   b. Select the Multiple Interlock Protection (MIP) check box to return all input points tied to a single output to a normal state before the output is de-energized. Without MIP, just one input returning to the normal state de-energizes the output. This is available with all the PW-2000 series panels.

   c. Select the PFR (Power Fail Reroute) check box to allow Input 8 (Primary Power) to be re-routed to Input 9 (Primary Power–System Alarm), freeing up Input 8 on the AEP-5 to be used as a standard/supervised input point. This is available only with the PW-2000-II using AEP-5.

   d. Select the OL (16 bit card number plus site code) check box to create WIEGAND card numbers by concatenating the site code and the card numbers. The result is transmitted as a 12-digit number. This is available with all PW-2000 series panels. Do not add site codes to the panel with this option.

   e. Select the OJ (20 bit card number plus site code) check box to set the format for 20-bit card numbers. This is only available with firmware 8.03 version or later. The first 12 bits are interpreted as the site code and the last 8 as the card number. The card number is sent to the head end software as a 12-digit number.

   f. Select the OH (25-bit card number plus site code) check box to enable special card format applications. This is available for use with firmware later than 8.03.

   g. Select the U Option check box to change the number of cards the panel can support. This option is available only for PW-2000 panel series. It enables the user to change the number of cards the panel supports. Selecting more cards reduces the number of buffers available to store events when the panel is not on-line with the computer or when heavy traffic prevents immediate transmission of all events.

   h. Select the OD (Duress Option) check box to activate the pulse action for the output defined in the Outputs for Duress, when the PIN is used one value low or high in case of emergencies like threatening. When configured with firmware
later than 8.03, two outputs can be selected. This is only available with the PW-2000 with firmware 8.03 version.

i. In the **Initialization Command** box the command string that is sent to the panel at initialization is displayed.

j. In the **Number of cards for U option** box, enter the number of cards for the panel. This option is enabled only if the U option is selected.

k. In the **Outputs for duress (OD Option)** box, enter the value for Outputs for duress. This option is enabled only if the OD option is selected.

l. Click **OK** to configure the advanced options.

14. Click **Next** to configure the Input points to the panel.

**Configuring Input Points to the Panel**

To configure input points to the panel:

1. In the **Panel Configuration - Inputs** dialog box, select an input point check box under **Name**. The other settings in the dialog box are available only for the selected input point.

   ![Panel Configuration - Inputs](image)

   **Figure 10-66  Panel Configuration-Inputs**

   - WIN-PAK sets some input points as active and may assign them an interlock value. These default settings vary depending on the type of panel.
   - The settings of these input points can be changed, but you cannot make it inactive if it is interlocked with an output point.

2. Click **Add** under **ADV**, set the ADV properties and click **OK** to define an ADV for each input point.

3. Select a **Time Zone** during which an input point must be deactivated.
4. Select **Sec**, **Min** or **Hr** and change the **Shunt Time**. Shunt time is the maximum time allowed for the door to close after it has been unlocked. If the time taken to close the door exceeds the shunt time, an alarm is raised.

5. Enter the **Debounce Time** in seconds. Debounce time is the maximum time allowed for the door to close after the shunt time is exceeded. If the time taken to close the door exceeds the debounce time, an alarm is raised. This debounce time is meant for the doors that swing often due to wind.

For example, consider the following scenarios:

### Table 10-1 Explaining Shunt Time and Debounce Time

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Shunt Time</th>
<th>Debounce Time</th>
<th>Alarm raised at...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>15 sec</td>
<td>0 sec</td>
<td>16th sec</td>
</tr>
<tr>
<td>2</td>
<td>15 sec</td>
<td>10 sec</td>
<td>25th sec</td>
</tr>
</tbody>
</table>

6. Enter the time interval after which the changed state of an input point is reported.

**Example:** An input point with a debounce time of 5 can be in active condition for five seconds before it is reported as an alarm. The same is true when returning to normal condition. The input point would not report as normal until it was in the normal state for five seconds.

7. Select the **Supervised** check box to report the troubles when there is a change in the state of input points.

8. Select **Normally Closed** or **Normally Opened** to specify the normal state of the door.

9. Under **Report Alarms**, select the following:
   - **Never**: To prevent from reporting the alarms.
   - **Always**: To report alarms.
   - **Trouble**: To report the trouble conditions. This is typically used for egress devices to detect tampering. This option is enabled only for supervised input point.

10. Set the **Interlocking** option for the input point.
    
    See the **Interlocking** section for more information on interlocking.

11. Click **Next** to configure the output points to the panel. The **Panel Configuration - Outputs** dialog box appears.

### Configuring Output Points to the Panel

To configure output points to the panel:

1. In the **Panel Configuration - Outputs** dialog box, select an output point check box under **Name**. The other settings in the dialog box are applicable only for the selected output point.
WIN-PAK sets some output points as active and may assign them an interlock value. These default settings vary depending on the type of panel.

- The settings of these output points can be changed, but you cannot make it inactive if it is interlocked with an input point.

2. Click **Add** under **ADV**, set the ADV properties and click **OK**, define an ADV for each output point.

3. Select a **Time Zone** during which the output point must be turned on.

4. Select **Sec**, **Min**, or **Hrs** and enter the **Pulse Time** to set the period during which the output point must be energized when triggered.

5. Set the **Interlocking** for the output point. See the **Interlocking** section for more information.

6. Click **Next** to set the group properties. The **Panel Configuration - Group** dialog box appears.

### Configuring Groups to the Panel

A group is one or more active output points that are grouped together. Output relay groups enable a card read to activate more than one output relay for applications such as elevator control. As many as 32 groups can be defined per panel.

To define an output group:

1. In the **Panel Configuration - Groups** dialog box, select a group under **Name**. The output points belonging to the selected groups are listed in **Available Outputs**.
Device Map
Panel Configuration

2. Select the output points under Available Groups and click Move to “Selected”. Alternatively, click Select All to select all outputs points. The output points are moved under the Selected Outputs list.

3. Select a Time Zone during which the output group must be turned on.

4. Select the required time unit for the pulse time and then set the Pulse Time for the output group to stay energized when it is triggered.

5. Set the interlocking for the output group.

   See the Interlocking section for more information on interlocking.

6. Define ADV for each group. Click Add under ADV, set the ADV properties and click OK.

   See the Configuring an Abstract Device section for more information on ADV configuration.

7. Click Next to configure readers to the panel. The Panel Configuration - Readers dialog box appears.

**Configuring a Reader to the Panel**

The number of readers available for the panel depends on the type of panel being configured. The WIN-PAK system automatically adds readers to the panel. By default, all available readers are active and are defined as doors. If the anti-passback option is not set, the readers are set for a free egress configuration.

In addition, you can associate galaxy groups or vista partitions to the reader and the input point. After the association you can set/unset galaxy groups or arm/disarm vista partitions using the privileged card. Present the privileged card to the reader and press the input button to unset the galaxy groups or disarm the vista partitions. However, present the privileged card to the reader to set the galaxy groups or arm the vista partitions.

To define a reader:
1. In the **Panel Configuration - Readers** dialog box, select a reader from the list to view its settings. The panel configuration is depicted on the lower-half of the dialog box.

![Panel Configuration - Readers dialog box](image)

**Figure 10-69  Panel Configuration-Readers**

2. Select a reader from the **Reader** list.

3. To detach a reader from the door, clear the **Door** check box. For example, a reader used in the muster area can be used without a door.

4. Click **Add** under **ADV** and set the ADV properties to create an ADV for the reader.

   **Warning**: Once a reader is added to the device map, you cannot attach the reader to a door or detach it from the door. Therefore, confirm the reader's usage, before adding it to the device map.

   If a reader is not attached to a door, it remains as a reader without any door properties.

   If a reader is attached to a door, the graphical form depicts the way the door is configured.

5. To associate galaxy groups or vista partitions to this reader, click **Groups/Partitions** and select the groups from the list.

6. To associate galaxy groups or vista partitions to the input point, select the input point from the **Input to Set/Arm Galaxy Grps/Partitions** list.

7. To change the input point used as a free egress input:

   a. Click **Free Egress** in the graphical form. The **Configure Free Egress** dialog box appears.
b. Select the Egress Input from the list.

c. Select Sec, Min or Hr and change the Shunt Time. Shunt time is the maximum time allowed for the door to close after it has been unlocked. If the time taken to close the door exceeds the shunt time, an alarm is raised.

d. Enter the Debounce Time in seconds. Debounce time is the maximum time allowed for the door to close after the shunt time is exceeded. If the time taken to close the door exceeds the debounce time, an alarm is raised. This debounce time is meant for the doors that swing often due to wind. See Table 10-1 for examples.

e. Click OK to save the settings or click Set Defaults to retain the default settings.

8. To change the output pulsed on a valid card read

a. Click Direct Point in the graphical form. The Configure Direct Point dialog box appears.

b. Select I, O or G to indicate Input Point, Output Point, or Group. The corresponding points are enabled in Direct Point.

c. Select the Direct Point from the list.

d. Select Sec, Min or Hr and change the Pulse Time.

e. Click OK to save the settings or click Set Defaults to retain the default settings.

The changes to the pulse time are automatically reflected in the appropriate input, output, or group.

9. Select the Free Egress Input shunts Status Input / Shunt Device check box to follow no action on the direct point when a Free Egress Input is activated.

10. To trigger an action in another input, output or group as a series action of direct point:

a. Click Status Input / Shunt Device in the graphical form. The Configure Status Input / Shunt Device dialog box appears.
b. Select I, O or G to indicate Input Point, Output Point, or Group. The corresponding points are enabled in Status Input / Shunt Device.

c. Select the Status Input / Shunt Device from the list.

d. Select the unit of time as Sec, Min or Hr and change the Shunt Time. Shunt time is the maximum time allowed for the door to close after it has been unlocked. If the time taken to close the door exceeds the shunt time, an alarm is raised.

e. Enter the Debounce Time in seconds. Debounce time is the maximum time allowed for the door to close after the shunt time is exceeded. If the time taken to close the door exceeds the debounce time, an alarm is raised. The debounce time is meant for the doors that swing often due to the wind. See Table 10-1 for examples.

f. Click OK to save the settings or click Set Defaults to retain the default settings.

11. Click OK to save the panel configuration.

Adding a NS2+ Panel

A NS2+ panel can be added to an RS-232 (single panel) and 485/PCI panel loops.

To add a NS2+ panel:


2. Expand the Devices folder and the communication server folder.

3. Right click the RS-232 Loop or 485/PCI Loop and select Add New NS2+ Panel. The Panel Configuration - Basic dialog box appears.
4. Type a unique Name for the panel. This field is mandatory.

5. Type a Description for the NS2+ panel.

6. Select the type of panel in the Type list. The only available type is NS2+.

7. Select the firmware version number of your panel in the Firmware Version list. This refers to the version of firmware of the PROM chip in your NS2+ panel. The default is 1.0 or later.

8. Select the Status of the panel:
   - **Active** - If the panel is configured and presently connected to the WIN-PAK system.
   - **Inactive** - If the panel is configured but temporarily disconnected for maintenance purpose. When you add or delete a card to an inactive panel, the card details are simply saved.
   - **Not Present** - If you want to configure the panel in WIN-PAK before completing the panel installation. If the panel is marked Not Present, no transactions are saved.

9. Enter a unique panel Address. The address corresponds to the DIP Switches setting on the panel and ranges from 1 through 31.

   Consult the NS2+ installation manual for further information.

10. Click Add under ADV and set the ADV properties to create an ADV for the panel.

    See the Configuring an Abstract Device section for more information on ADV configuration.

11. Click Next to set the Card Format. The Panel-Configuration - Card Format dialog box appears.
Setting the Card Format for the Panel

WIEGEND is the only card format type available for NS2+ panels. It supports 32 card formats to be used.

To set the card formats:

1. In the Panel-Configuration - Card Format dialog box set the WIEGEND card format values.
   Honeywell recommends you to retain the default card format values.

   ![Figure 10-74 Panel Configuration - Card Format](image)

2. Click Next to assign time zones and holiday group to this panel. The Panel Configuration - Time Zones dialog box appears.

Assigning Time Zones and Holiday Group to a Panel

To assign time zones and holiday groups to a panel:
1. In the **Panel Configuration - Time Zones** dialog box, select the time zones from the **Available Time Zone** list and click ![Add](image). The time zones are moved to the **Selected Time Zone** list. For multiple selections use the **SHIFT** and **CTRL** keys.

![Panel Configuration - Time Zones](image)

**Figure 10-75  Panel Configuration-Time Zones**

**Tip:** If you want to remove a time zone from the Selected Time Zone list, select the time zone and click ![Remove](image).

The time zones that are listed in Selected Time Zone are available for readers, inputs and outputs of this panel.

2. If you are using holiday overrides, select the holiday group in the **Holiday Group** list.

3. Click **Next** to set the panel options. The **Panel Configuration - Options** dialog box appears.

**Setting the panel options**

- **Global Anti-passback**

  An Anti-passback violation occurs when a card holder does not access the card at a reader while entering or exiting a building.

  Anti-passback violation occurs at the following two scenarios:

  - **In-Out-In:** If you have entered the building using the card and exited from the building without using the card. And then, if you try to enter the building the access is denied.
  
  - **Out-In-Out:** If you have entered the building without using the card and exited from the building using your card. And then, if you try to enter the building the access is denied.

  - **Forgiveness**
Anti-passback violation can be forgiven by selecting the **Forgiveness** option. When this option is selected, all cards are reset during midnight. Therefore, the cardholders who have violated the anti-passback option can now access their cards to enter the building. This option is enabled only if Global Anti-passback is selected.

- **Keypads**
  Indicates that the panel is using matrix style (11-wire) keypads. If Wiegand style (5-wire) keypads are used, the keypad is treated as a reader and this option must be cleared.

- **PIN**
  The PIN number must be entered in the keypad, before presenting a card to gain access at an entrance. This option is disabled and it is selected when the Keypad option is selected.

- **Continuous Card Reads**
  Card readers do not recognize valid cards while the corresponding output is energized. Continuous Card Reads allow card readers to read cards continuously, independent of output pulse time.

  **Example:** When Output 1 is assigned a 10 second pulse time, a valid card read at Reader 1 causes Output 1 to energize for 10 seconds. During this time the card reader does not recognize any other valid cards, if the Continuous Card Reads option is not selected.

- **Reverse Read LEDs**
  This option reverses the standard LED operation of the reader. If this option is selected, a reader that normally changes from green to red on a valid card read changes from red to green.

- **Host Grant**
  The Host Grant option provides the fault tolerance even if the card is not found in the panel. Host Grant options are used when, for example, a number of cards have been entered in the database, but have not yet been downloaded to the panel.

- **Site Codes**
  Site codes ensure that the card belongs to the facility where the card is used for gaining access. The site code is encoded with a card number on cards.

To configure the panel options for the NS2+ panel:

1. In the **Panel Configuration - Options** dialog box, select the following options:
1. Select the **Global Anti-passback** check box to ensure that the card holders present the cards while entering and exiting a building. When you select this option, the anti-passback is globally implemented.

2. Select the **Forgiveness** check box to allow the door to open but to report the anti-passback violation. This check box is enabled only if Global Anti-passback is selected.

3. Select the **Keypads** check box if matrix style (11-wire) keypads are used in the panel. If you are using Wiegand style (5-wire) keypads, the keypad is treated as a reader and this option must be cleared.

4. Select the **Continuous Card Reads** check box to allow card readers to read cards continuously, independent of output pulse time.

5. Select the **Reverse Read LEDs** check box to reverse the standard LED operation of the reader. If this check box is selected, a reader that normally changes from green to red on a valid card read changes from red to green.

6. In the **Command File** list, select a command file that is applicable to a panel.

7. Select the following **Host Grant** options to grant the permission for the card holders, even if the card is not found in the panel:
   - **Disable** - Deny access to the card holders whose card details are not present in the panel.
   - **Open Door** - Enables the door to open, even if the card is not found in the panel.
   - **Open Door and Update Panel** - Enables the door to open and also to download the card details to the panel. Therefore, the panel is updated.

8. Enter a **Site Code** to ensure that cards belong to the facility where access is attempted. You can enter up to 8 site codes.
Tip: To enter a site code, double-click any cell in the table, type the site code and press ENTER. You can press the ESC key to cancel the site code entry. If no site code is defined, the reader does not check for site codes to enable card access.

9. To configure the Advanced options:
   a. Click Advanced. The Panel Configuration - Advanced Options dialog box appears.

   ![Figure 10-77 Panel Configuration-Advanced Options]

   b. Select the Multiple Interlock Protection (MIP) check box if you want all input points tied to a single output return to a normal state before the output is de-energized. Without MIP, just one input returning to the normal state de-energizes the output.

   c. Select the OD (Duress Option) check box to activate the pulse action for the output defined in the Outputs for Duress, when the PIN is used one value low or high in case of emergencies like threatening. This check box is enabled only when the PIN option is selected.

   d. Select the OL (16 bit card number plus site code) check box to create WIEGAND card numbers by concatenating the site code and the card numbers. The result is transmitted as a 12-digit number. Do not add site codes to the panel with this option.

   e. Select the OJ (20 bit card number plus site code) to set the format for 20-bit card numbers. The first 12 bits are interpreted as the site code and the last 8 as the card number. The card number is sent to the head end software as a 12-digit number.

   f. Select the OH (25-bit card number plus site code) check box to set the special card format applications.

   g. In the Initialization Command box, the command string that is sent to the panel at initialization is displayed.

   h. In the Number of cards for U option box, enter the number of cards for the panel. This option is enabled only if the U option is selected.

   i. In the Outputs for duress (OD Option) box, enter the value for Outputs for duress. This option is enabled only if the OD option is selected.

10. Click Next to configure the Input points to the panel.

**Configuring Input Points to the Panel**

To configure input points to the panel:
1. In the **Panel Configuration - Inputs** dialog box, select an input point check box under **Name**. The other settings in the dialog box are applicable only for the selected input point.

   ![Panel Configuration - Inputs](image)

   **Figure 10-78  Panel Configuration-Inputs**

   - WIN-PAK sets some input points as active and may assign them an interlock value. These default settings vary depending on the type of panel.
   - The settings of these input points can be changed, but you cannot make it inactive if it is interlocked with an output point.

2. Click **Add** under **ADV**, set the ADV properties and click **OK** to define an ADV for each input point.

3. Select the **Time Zone** during which the input point must be activated.

4. Select **Sec**, **Min** or **Hr** and change the **Shunt Time**. Shunt time is the maximum time allowed for the door to close after it is unlocked. If the time taken to close the door exceeds the shunt time, an alarm is raised.

5. Enter the **Debounce Time** in seconds. Debounce time is the maximum time allowed for the door to close after the shunt time is exceeded. If the time taken to close the door exceeds the debounce time, an alarm is raised. This debounce time is meant for the doors that swing often due to wind.

6. Select the **Supervised** check box to report the troubles when there is a change in state of input points.

7. Select **Normally Closed** or **Normally Opened** to specify the normal state of the door.

8. Under **Report Alarms**, select one of the following options:
   - **Never**: Never report an alarm on this input point.
   - **Always**: Report an alarm always.
   - **Trouble**: Report only the trouble conditions of the input point. This is typically used for egress devices to detect tampering. This option is enabled only if the input point is supervised.
9. Set the Interlocking for the input point. See the Interlocking section for more information.

10. Click Next to configure the output points to the panel. The Panel Configuration - Outputs dialog box appears.

**Configuring Output Points to the Panel**

To configure output points to the panel:

1. In the Panel Configuration - Outputs dialog box, select an output point check box under Name. The other settings in the dialog box are applicable only for the selected output point.

![Panel Configuration Outputs](image)

**Figure 10-79  Panel Configuration Outputs**

2. Define an ADV for each output point. Click Add under ADV, set the ADV properties and click OK.

3. Select a Time Zone during which the output point must be activated.

4. Select the First Valid Read Activates Time Zone check box to activate the output point only when a valid card is read, though the time zone is set for the output point. And then at the end of the Time Zone, the output is turned off automatically.

5. Select the time unit for the pulse time, and then select the Pulse Time to set the maximum time required for the output to be energized when it is triggered.

6. Select the Interlocking check box to interlock the points. See the Interlocking section for more information.

7. Select the required Report ON/OFF option.

8. Click Next to configure the reader of the panel. The Panel Configuration - Readers dialog box appears.
Configuring a Reader to the Panel

The number of readers available for the panel depends on the type of panel being configured. The WIN-PAK system automatically adds readers to the panel. By default, all available readers are active and are defined as doors.

If you have not set the anti-passback option, the readers are set for a free egress configuration. If the anti-passback option is set, the reader settings are changed to anti-passback settings.

In addition, you can associate galaxy groups or vista partitions to the reader and the input point. After the association you can set/unset galaxy groups or arm/disarm vista partitions using the privileged card. Present the privileged card to the reader and press the input button to unset the galaxy groups or disarm the vista partitions. However, Present the privileged card to the reader to set the galaxy groups or arm the vista partitions associated to the reader.

To define a reader:

1. In the Panel Configuration - Readers dialog box, select a reader from the list to view its settings. The dialog box displays the panel configuration in a graphical form.

![Figure 10-80 Panel Configuration-Readers](image)

2. Select a reader from the Reader list.

3. Select the Anti-Passback check box to set the anti-passback and implement it locally.
4. Select one of the following options to set the reader as IN or OUT and set anti-passback properties:

**Table 10-2 Describing the anti-passback options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In</td>
<td>The reader is considered as IN-Reader. The anti-passback violation occurs, when the In-Out-In link is broken while accessing the readers.</td>
</tr>
<tr>
<td>Out</td>
<td>The reader is considered as OUT-Reader. The anti-passback violation occurs, when the Out-In-Out link is broken while accessing the readers.</td>
</tr>
<tr>
<td>Hard</td>
<td>When an anti-passback violation occurs, the reader strictly restricts the access.</td>
</tr>
<tr>
<td>Soft</td>
<td>When an anti-passback violation occurs, the reader allows the access but sends a report on anti-passback violation.</td>
</tr>
</tbody>
</table>

5. In the **Card+PIN Time Zone**, select a time zone for the reader during which the access is allowed only when both card and PIN number are used.

6. In the **PIN Only Time Zone**, select a time zone for the reader during which the access is allowed only by using the PIN number. In this duration, the access is denied on the reader even for the valid card read.

7. To use the reader without attaching it to a door, clear the **Door** check box. For example, a reader used in the muster area can be used without a door.

8. Click **Add** under **ADV** and set the ADV properties to create an ADV for the reader.

   If a reader is not attached to a door, it remains as just a reader without any door properties.

   If a reader is attached to a door, the graphical form depicts the way the door is configured.

9. To associate galaxy groups or vista partitions to this reader, click **Groups/Partitions** and select the groups from the list.

10. To associate galaxy groups to the input point, select the input point from the **Input to Set/Arm Galaxy Grps/Partitions** list.

11. To change the input point used as a free egress input:
    a. Click **Free Egress** in the graphical form. The **Configure Free Egress** dialog box appears.

    ![Configure Free Egress](image)

    **Figure 10-81  Configure Free Egress**

    b. Select the **Egress Input** from the list.
c. Select **Sec**, **Min** or **Hr** and change the **Shunt Time**. Shunt time is the duration allowed for the door kept unlocked. If the door remains in the unlocked state even after the shunt time, the alarm is raised.

d. Enter the **Debounce Time** in seconds. Debounce time is the duration allowed after shunt time for the door to remain in the unlock status. If the door remains in the unlocked state even after the debounce time, the alarm is raised. This duration is meant for the doors that swing often due to wind.

e. Click **OK** to save the settings or click **Set Defaults** to retain the default settings.

12. To change the output pulsed on a valid card read:

a. Click **Direct Point** in the graphical form. The **Configure Direct Point** dialog box appears.

![Configure Direct Point](image)

**Figure 10-82  Configure Direct Point**

b. Select **I**, or **O** to indicate Input Point or Output Point. The corresponding points are enabled in Direct Point.

c. Select the **Direct Point** from the list.

d. Select **Sec**, **Min** or **Hr** and change the **Pulse Time**.

e. Click **OK** to save the settings or click **Set Defaults** to retain the default settings.

The changes to the pulse time are automatically reflected in the appropriate input, output or group.

13. Select the **Free Egress Input shunts Status Input / Shunt Device** check box to follow no action on the direct point when a **Free Egress Input** is activated.

14. To trigger an action in another input or output as a series action of direct point:

a. Click **Status Input / Shunt Device** in the graphical form. The **Configure Status Input / Shunt Device** dialog box appears.

![Configure Status Input/Shunt Device](image)

**Figure 10-83  Configure Status Input/Shunt Device**

b. Select **I** or **O** to indicate Input Point or Output Point. The corresponding points are enabled in **Status Input / Shunt Device**.

c. Select the **Status Input / Shunt Device** from the list.
d. Select **Sec, Min or Hr** and change the **Shunt Time**. Shunt time is the duration allowed for the door to be kept unlocked. If the door remains in the unlocked state even after the shunt time, the alarm is raised.

e. Enter the **Debounce Time** in seconds. Debounce time is the duration allowed for the door to remain in unlock status after the shunt time. If the door remains in the unlocked state even after the debounce time, the alarm is raised. This duration is meant for the doors that swing often due to wind.

f. Click **OK** to save the settings or click **Set Defaults** to retain the default settings.

15. Click **OK** to configure the NS2+ panel.

**Interlocking**

The interlocking feature enables an input point or output point to take a specified action based on the change of state of another input point or output point. In an interlock sequence, an action on one point causes a reaction from a second point.

To enable Interlocking:

1. In the **Panel Configuration** dialog box, select the interlocked point (input point, output point, or group - let it be considered as Component A) under **Name**, and then select the **Interlocking** check box.

2. Select **I**, **O** or **G** option to indicate Input Point, Output Point, or Group.

3. Select the interlocking point in the **Point** list (let it be considered as Component B). Only input points, output points or groups that have already been activated, are listed out. If the required point is not listed, go to the appropriate dialog box and activate the point, then return to this dialog box.

4. If the interlocked point is an input point,
   a. Select **Alarm Action** to be taken by Component B when Component A goes to the Alert state.
   b. Select **Normal Action** to be taken by Component B when Component A returns to the normal state.

5. If the interlocked point is an output point or a group:
   a. Select the **On Action** that has to be taken by Component B when Component A is on.
   b. Select the **Off Action** that has to be taken by Component B when Component A is off.

<table>
<thead>
<tr>
<th>Table 10-3 Describing the available actions for points</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action</strong></td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Energize</td>
</tr>
<tr>
<td>De-Energize</td>
</tr>
<tr>
<td>Pulse</td>
</tr>
<tr>
<td>Pulse Off</td>
</tr>
<tr>
<td>No Action</td>
</tr>
<tr>
<td>Component A</td>
</tr>
</tbody>
</table>
Interlocking Examples

**Example 1:**

**Component A:** Input 5, motion detector

**Component B:** Output 3, siren

**Action 1:** Energize

**Action 2:** De-energize

When the motion detector is triggered, input 5 goes into active state, output 3 energizes, turning on the siren. When input 5 returns to normal state, output 3 de-energizes, turning off the siren.

**Example 2:**

**Component A:** Input 6, door status switch

**Component B:** Output 4, bell

**Action 1:** Pulse

**Action 2:** No Action

When the door status switch is opened illegally, input 6 goes into active state, output 4 pulses based on the pulse time set. The pulse time is set in the Output Point dialog box.

Adding a P-Series Panel

A P-Series panel is added to a P-Series Loop, a P-Series Modem Pool, or directly to a Communication Server. A direct connection to the Intelligent Controller enables the Host PC to communicate directly with the P-Series panel through RS-232 connection or through TCP/IP on the P-Series panel.

P-Series panel types available in WIN-PAK are PRO-2000 and PW-5000. Eight SIO Boards can be included in the PRO-2000 panel and 32 SIO Boards can be included in the PW-5000 panel.

Setting Up a Direct Connection

To set up a direct connection of P-Series panel:

1. Choose **Configuration > Device > Device Map.** The **Device** window appears.

2. Expand the **Devices** folder and right-click the communication server folder and select **Direct P-Series Panel.** The **Panel Configuration - Basic** dialog box appears.

---

**Table 10-3 Describing the available actions for points**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Energize</td>
<td>Turns the point on</td>
</tr>
<tr>
<td>Component B</td>
<td>Input 1, door status switch</td>
</tr>
<tr>
<td>Action 1</td>
<td>Follow</td>
</tr>
<tr>
<td>Action 2</td>
<td>No Action</td>
</tr>
</tbody>
</table>
Figure 10-84  Panel Configuration-Basic Information

3. Type a unique Name for the panel. This field is mandatory.

4. Type the Description of the panel.

5. Select the type of panel in the Type list. The available P-Series panel types are PRO-2000 and PW-5000.

6. In the IC Address, enter a unique address of the Intelligent Controller board. It must be uniquely defined for each panel.

Refer to the PRO-2200 Intelligent Controller Installation Manual for details.

7. Enter the value for Host Retry Count. The Host Retry Count is the number of times the Host computer has to send a command packet to the Intelligent Controller, if the Host computer receives:
   - A bad command packet from the Intelligent Controller.
   - No response from the Intelligent Controller for the command packet sent from the Host computer.

8. Enter the value for Time to IC Offline. This is the maximum time allowed for the software to declare the panel as offline, when there is no response from the Intelligent Controller.

9. Click Add under ADV and set the ADV properties to create an ADV for the P-Series panel.

10. Click Next to configure the connection settings.

To configure the connection settings of the direct P-Series panel

1. In the P-Series Configuration - Connection Settings dialog box, select the Type of connection (Serial RS-232 or TCP/IP) used for connecting the P-Series directly to the Host computer.
2. If you select the connection type as **Serial RS-232**, enter the following:

   a. **Port**: The port in which the panel is connected to the communication server.

   b. **Bits per Second**: The communication rate for the panel. This field defaults to 38400, but can be set at 9600 or 19200 as well, depending on the baud rate set on the Intelligent Controller.

   c. **RTS Mode**: The RTS Mode (Request to Send) enables the Host PC to know that the Intelligent Controller is ready to send information. The RTS Mode defaults to **Always On**.

   The **Toggle** RTS Mode applies when there is an RS-485 to RS-232 converter that requires a handshake. The Toggle option is never used for a direct connection.

3. If a network card is installed on the computer and the PRO-Intelligent Controller is configured for a **TCP/IP** connection, enter the following:

   a. **IC Reply Timeout**: It is the duration the Host computer waits for an acknowledgment after it has sent an outgoing packet.

   b. **Poll Delay**: This enables the system to delay polling to avoid loading down the network, if there is no activity. The default for the Poll Delay is 2 seconds, but can range from zero to 5.

   c. **TCP/IP Retry Connect Interval**: This is the time the system waits to reopen a socket after a connection to the network is lost and the socket is closed. The system waits for this time and then tries to determine if there is a device at the other end of the socket. If a device is found, a new socket is opened. The default for this interval is 15 seconds, but it can be set from 5 to 30 seconds.

   d. **IP Address or Node Name of the IC**: The IP address configured for the LAN card or the node name of the Intelligent Controller.

4. Click **Next** to set the system configuration.
Configuring the System Settings

To configure the system settings:

1. In the **P-Series Configuration - System** dialog box, select the standard **Time Zone** for setting the time zone for the PRO-2000 Intelligent Controller.

2. Select the **Daylight Savings** group for setting the daylight saving option in the P-Series Intelligent Controller. See the **Daylight Saving Group** section for more information on configuring daylight saving groups.

3. In the **No. of Card Holders** text box, specify the maximum number of card holders details to be stored based on the memory available in the board. By default, you can store details of 5000 card holders in controller.

4. Select the **Enable card user levels for trigger control** to trigger certain controls on the usage of specific cards.

5. In the **No. of Transactions to hold when offline** text box, specify the number of transactions to be buffered in the controller. By default, you can store 10000 transactions in a buffer storage. This number is decreased or increased to provide more or less memory for cards if necessary.
   
   1 transaction = 16 bytes (so 100,000 transactions takes up 1.6 MB of memory)
   
   1 card record = within 20 to 80 bytes. This depends upon the use of precision access levels versus multiple access levels, and the number of card readers per Intelligent Controller.

   **Tip:** Adding an extended memory board to the Intelligent Controller provides more memory to work with.

6. Select the **Host Grant** option to provide fault tolerance, even if the card is not found in the panel device.
   
   - Host Grant options are used when, for example, a number of cards are entered in the database, but not yet downloaded to the panel.
   
   - The available options are:
Device Map
Panel Configuration

- **Disable** - Does not allow the card holder, if the card is not found in the panel.
- **Open Door** - Enables the door to open, even if the card is not found in the panel.
- **Open Door and Update Panel** - Enables the door to open and also to download the card details to the panel. Therefore, the panel is updated.

7. Click **Next** to set the card formats for the P-Series panel.

**Configuring Card Formats**

The available card format types for P-Series panels are Wiegand and ABA. The first three formats are set by default, however, you can set the other card formats using the Custom option.

To configure the card format:

1. In the **P-Series Configuration - Card Formats** dialog box, select a card format to be used for the panel, in the **Format #** list. The format number ranges from 1 through 8.

![Figure 10-87 Panel Configuration-Card Formats]

2. Under **Option**, select the following options:
   a. **Default**: To view the default settings for the card format. Selecting this option enables you to set the Site Code, Card ID offset, and the Default Formats.
   b. **Custom**: To define the customized settings for the card format. Selecting this option enables you to set Format Type of the card and other properties of the card like site code, number of bits on card, and so on.
   c. **Not Used**: To prevent the usage of card formats for the P-Series panel. If you select this option, all the fields are disabled.

3. Click **Next** to configure time zones for the panel.

Configuring ABA card format

This section helps you to configure the 12-digit ABA card format for the P-Series Intelligent Controller.
To configure the 12-digit ABA card format:

1. In the P-Series Configuration - Card Formats dialog box, select the default card formats (Format #1, Format #2 and Format #3) and set each format as Not Used.
2. Then select Format #4 and set the Custom option to set the ABA card format.
3. Select the Format Type as ABA and set the following:

<table>
<thead>
<tr>
<th>Site Code</th>
<th>No value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card ID Offset</td>
<td>0</td>
</tr>
<tr>
<td>35 bit Corporate Cards</td>
<td>Cleared</td>
</tr>
<tr>
<td>Minimum # of digits on card</td>
<td>1</td>
</tr>
<tr>
<td>Maximum # of digits on card</td>
<td>12</td>
</tr>
<tr>
<td>Site code digits</td>
<td>Start digit: 1 No of: 0</td>
</tr>
<tr>
<td>Cardholder ID digits</td>
<td>Start digit: 1 No of: 12</td>
</tr>
<tr>
<td>Issue code digits</td>
<td>Start digit: 1 No of: 0</td>
</tr>
</tbody>
</table>

4. Click OK to save the ABA format configuration details.

**Assigning time zones and holiday groups to a panel**

**To assign Time Zones and Holiday Groups**

To assign times zones and holiday groups:

1. In the Panel Configuration - Time Zones dialog box, select the time zones from the Available Time Zone list and click . The time zones are moved to the Selected Time Zone list. For multiple selections use the SHIFT and CTRL keys.
Tip: If you want to remove a time zone from the Selected Time Zone list, select the time zone and click .

The time zones that are listed in Selected Time Zone are available for readers, inputs and outputs of this panel.

2. If you are using holiday overrides, select the holiday group in the Holiday Group list.
3. Click Next to set the panel options. The Panel Configuration - Options dialog box appears.

### Adding SIO boards to Intelligent Controller

The number of readers, inputs, and outputs that can be connected to the controller is based on the type of SIO Board that is added to the Intelligent Controller. The available SIO Board types are:

<table>
<thead>
<tr>
<th>SIO Board Type</th>
<th>Maximum Inputs</th>
<th>Maximum Outputs</th>
<th>Maximum Readers</th>
</tr>
</thead>
<tbody>
<tr>
<td>16-Zone Input/Output</td>
<td>16</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>16-Relay Output</td>
<td>0</td>
<td>16</td>
<td>0</td>
</tr>
<tr>
<td>2-Reader I/O</td>
<td>2</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>1-Reader I/O</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

This section explains how to add an SIO board of 2-Reader I/O board type. You can use the same procedure for adding other types of SIO board.

To add an SIO board of 2-Reader IO board type:
1. In the **P-Series Configuration - SIO Boards** dialog box, click **Add**. The **Select Board Type** dialog box appears for you to select the SIO board type.

![Select Board Type dialog box](image)

**Figure 10-89  Panel Configuration-SIO Boards**

2. In the **Select Board Type** dialog box, select the **2-Reader I/O** board type.

3. Click **OK** to configure the basic information of SIO Board. The **SIO Board Configuration** dialog box appears.

4. Click the **Basic** tab. It is displayed by default.
5. Type a unique Address for the SIO Board.

6. In the Port list, select the port from which the board communicates with the Intelligent Controller.

7. In the Number of Errors before Going Off-Line field, type a number of attempts the panel must make to communicate with the communication server before tripping the offline trigger. This field defaults to 3.

8. Select the Enable Communication with SIO check box for enabling connection with the SIO Board. Select this check box, only if the board is installed.

9. Select the Reverse I/O poll sequence check box to reverse the sequence in which the inputs and outputs are polled.

10. Create an ADV for the selected board type. Click Add under ADV and set the ADV properties.

    See the Configuring an Abstract Device section for more information on ADV configuration.

11. Click the Input tab to configure the input point details of SIO Board.
12. Select the check box to select an input point and create an ADV. Here you can decide on the alarm or trouble condition of an input point.

See the Configuring an Abstract Device section for more information on ADV configuration.

For 2 readers SIO board, In 1 and In 3 are status inputs and In 2 and In 4 are free egress inputs. Whereas for 1 reader SIO board, In 1 is the status input and In 2 is the free egress input.

See the Free Egress Input and Status Input sections for more information on free egress input and status input.

13. In the Time Zone list, select a time zone during which input point must be shunt or deactivated.

14. Type the Hold Time to report the Normal state of the input point only after a specified duration. By default, it is set to zero.

15. Enter the debounce cycle time in Debounce Cycles. If an input point state changes before the debounce time, the change is not reported. Debounce time can be set from 2/60 through 15/60 of a second.

Example: If the debounce time is set to 4 and if the Alert state of the input point changes to the Normal state before the debounce time, the Alert state is not reported.

16. In Shunt Time, select Sec, Min, or Hr and specify the shunt time. By default, the field is set to zero, but can be set from 0 through 32400 seconds, 0 through 540 minutes, 0 through 9 hours.
17. In the **Mode** list, select the mode of input point.

**Table 10-4 Describing the modes of input point**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>The input acts normal reporting alert, normal and troubled states.</td>
</tr>
</tbody>
</table>
| Non-Latching | **Entry**: A door is set up as an input point, with an entry delay of 10 seconds. If the door remains open more than 10 seconds, it is reported.  
**Exit**: The exit delay is the amount of time a contact can be unshunted (unmasked) before being reported. |
| Latching | **Entry**: If a door-set up as an input point, with an entry delay of 10 seconds, the card holder has 10 seconds to shunt the point, otherwise it reports as an alarm. Even if the point returns to normal before the entry delay time, if the point has not been shunted (masked), it reports as an alarm.  
**Exit**: The exit delay is the amount of time a contact can be unshunted (unmasked) before being reported. |

18. Enter the entry delay time in **Entry Delay**. This is the duration an input point can remain open before an alarm is activated. This field defaults to zero seconds, but can be set up to 255 seconds.

19. Enter the exit delay time in **Exit Delay**. This is the duration a point can be unshunted (unmasked) before being reported as an alarm. This field defaults to zero seconds, but can be set up to 255 seconds.

20. Select the **Interlocking** check box to activate the interlocking for a particular input point.

See the **Interlocking Points on SIO Board** section for more information on interlocking.

21. Select the **Input Circuit Type** for specifying whether a point is supervised or unsupervised. The available types are:

**Table 10-5 Describing Input Circuit Types**

<table>
<thead>
<tr>
<th>Input Circuit Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NC: No end of line</td>
<td>Refers to contact points that always touch when a device is in its normal position. A normally closed device, such as most door contacts, complete a circuit when they are in their normal, at rest condition.</td>
</tr>
<tr>
<td>Normally Closed</td>
<td></td>
</tr>
<tr>
<td>NO: No end of line</td>
<td>Refers to contact points that do not touch when a device is in its normal position. A normally open device, such as most REX switches, complete the circuit when pushed.</td>
</tr>
<tr>
<td>Normally Opened</td>
<td></td>
</tr>
<tr>
<td>NC: Std end of line</td>
<td>Refers to a three-state circuit (Alert, Normal, or Trouble) in a normally closed contact points.</td>
</tr>
<tr>
<td>Normally Closed</td>
<td></td>
</tr>
<tr>
<td>NO: Std end of line</td>
<td>Refers to a three-state circuit (Alert, Normal, or Trouble) in a normally opened contact points.</td>
</tr>
<tr>
<td>Normally Opened</td>
<td></td>
</tr>
</tbody>
</table>
22. In the Transaction Mask list, select the type of transaction mask that enables masking for the log of transaction information related to input points. By default, it is Log all Transactions, indicating that all input points are monitored and all transaction is logged to WIN-PAK.

23. Click the Output tab to configure the output point details of SIO Board:

![SIO Board Configuration-Output tab](image)

24. Select the check box to select an output point and create an ADV. See the Configuring an Abstract Device section for more information on ADV configuration.

25. In the Time Zone list, select a time zone during which the output point must be shunt or deactivated.

26. Select Sec, Min, or Hr and enter a value in the Pulse Time field to set the amount of time that the output point is energized when triggered. By default, the field is set to zero, but can be set from 0 through 32400 seconds, 0 through 540 minutes, 0 through 9 hours.
27. In the **Output Inverter** list, select a default setting for the output:

### Table 10-6 Describing the Output Inverter settings

<table>
<thead>
<tr>
<th>Output</th>
<th>Setting</th>
</tr>
</thead>
</table>
| Normal  | • Relay defaults to a de-energized state.  

• Pulsing the output energizes it for its designated pulse time (or pulses the output on). At the end of the pulse time, the output de-energizes. (The output responds the same upon a valid egress, a valid card read, and/or a manual pulse command.)  

• Energizing a relay turns the relay on (LED on).  

• De-energizing a relay turns the relay off (LED off).  

• Normally Open circuit acts as a NO circuit; Normally Closed circuit acts as an NC circuit. |
| Inverted| • Relay defaults to an energized state.  

• Pulsing the output de-energizes it for its designated pulse time (or pulses the output off). At the end of the pulse time, the output re-energizes. (The output responds the same upon a valid egress, a valid card read, and/or a manual pulse command.)  

• Energizing a relay turns the relay off (LED off).  

• De-energizing a relay turns the relay on (LED on).  

• Normally Open circuit acts as a Normally Closed circuit; Normally Closed circuit acts as a Normally Open circuit. |

28. Select the **Interlocking** check box to activate the interlocking for a particular output point.

See the **Interlocking Points on SIO Board** section for more information on interlocking.

29. Click the **Reader** tab to configure readers for SIO board.
30. Select a reader and create an ADV for the reader. See the Configuring an Abstract Device section for more information on ADV configuration.

31. In the Reader Types list, select the type of reader.

32. If Custom is selected as the reader type, select a Keypad Mode. This keypad mode includes the following:
   - MR-20 8-bit with (or without) tamper support, which represents a Mercury Magstripe reader with keypad attached
   - Hughes ID 4-bit
   - Motorola/Indala which sends an 8-bit key code

33. Select the LED Drive Mode for the reader. The default is Generic 1-wire, tri-state bi-color. Alternatively, you can select Separate red and green, no buzzer dependent on the physical reader.

34. Select the Card Format Flags, which represent how the reader must interpret the access card to be used.

35. Select the Access Configuration option to define the reader access in a door.
   - Single, controlling the door: The door is defined by only one reader.
   - Paired, primary reader: The door is defined by two readers in which this reader becomes a primary reader.
- **Paired, secondary reader**: The door is defined by two readers in which this reader becomes a secondary reader. Selecting this option disables the *Door Interlocks* button.

36. Under **Pair Reader**, select the SIO Board and the corresponding reader which pairs with this for defining a door. Pair Reader is enabled, only if you define a door by two readers. In that case, you must select the other reader.

37. Click **Door Interlocks** for configuring door interlock. The Door Interlocks dialog box appears.

See the *Door Interlocks* section for more information on door interlock.

38. Anti-Passback discourages card holders to enter without using their cards. Under **Anti-Passback**, select the Direction and Processing Mode for the anti-passback:

- **Direction** enables you to specify if the reader is in or out. (It is None by default.)
- **Processing Mode** enables you to specify the processing mode of the reader:
  - **Hard**: When an anti-passback violation occurs, the reader strictly restricts the access.
  - **Soft**: When an anti-passback violation occurs, the reader allows the access but sends a report on anti-passback violation.
  - **Reader Based Timed APB**: A card cannot be swiped twice at the same Anti-Passback reader, before the time specified for the delay.
  - **Card Based Timed APB**: A card cannot be swiped twice anywhere in the system, before the time specified for the delay.
  - **Panel Based Timed APB**: A card cannot be swiped twice at the same panel, before the time specified for the delay.

39. Select the following **Control Flags**:

 **Table 10-7 Describing Control Flags**

<table>
<thead>
<tr>
<th>Control Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deny a duress request</td>
<td>Works in a card and PIN mode only. Unless this option is selected, duress is always enabled. Notify the monitoring station you are under duress. Always one number higher than the PIN code.</td>
</tr>
<tr>
<td>Log all access requests as used</td>
<td>If selected, logs all card reads as “door used”, without actually determining if the door is used. If unchecked, logs all card reads, but waits until the door times out, or the door is opened, to report. Cancel this option when using anti-passback.</td>
</tr>
<tr>
<td>Do not pulse the door strike on rex</td>
<td>Door strike does not pulse upon free egress, however, door contact still gets shunted.</td>
</tr>
<tr>
<td>Filter CosDoor transaction</td>
<td>Throughout the door cycle the IC generates about 4 to 5 messages (door strike relay on, door strike relay off, door opening, and son.). If more message are needed, this feature can be disabled.</td>
</tr>
<tr>
<td>Require two-card control at this reader</td>
<td>Needs 2 valid cards within a 20 second window to grant access. Used in vaults, high security areas.</td>
</tr>
</tbody>
</table>
40. Select the following Online Door Mode that indicates the mode in which the Intelligent Controller is operating:

**Table 10-8 Describing Online Door Mode options**

<table>
<thead>
<tr>
<th>Online Door Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Only</td>
<td>The card is sufficient for door access.</td>
</tr>
<tr>
<td>PIN Only</td>
<td>The PIN number is sufficient for door access.</td>
</tr>
<tr>
<td>Card and PIN</td>
<td>Both card access and PIN are required for door access.</td>
</tr>
<tr>
<td>Card or PIN</td>
<td>Either card or PIN is sufficient for door access</td>
</tr>
</tbody>
</table>

41. Select an Offline Door Mode that indicates the mode in which the SIO Reader board will run if the system goes offline. The available options are Disable the reader, Unlock, Locked, and Facility code only.

42. To associate galaxy groups or vista partitions to this reader, click Groups/Partitions and select the groups from the list.

43. To associate galaxy groups or vista partitions to the input point, select the input point from the Input to Set/Arm Galaxy Grps/Partitions list.

44. Click OK to configure the SIO Board.

45. Click Next to configure triggers and procedures.

See the Configuring Triggers and Procedures section for more information on triggers and procedures.

**Interlocking Points on SIO Board**

Interlocking enables you to interlock an input or output point within the SIO Board points or across other SIO Board points.

To interlock an input or output point:

1. In the SIO Board Configuration dialog box, click the Inputs or Outputs tab.
2. Select an Input point or Output point.
3. Select the Interlocking check box to activate the interlocking for a particular input point.
4. Select I (input point) or O (output point) to interlock the input point with an input point or output point of the SIO Board.
5. In the Activate a Time Zone list, select a time zone during which the interlock must be active.
6. Select the SIO Board in which you want the input or output point to be interlocked.
7. In the Point list, select the interlocking input point, output point, or reader, of the selected SIO Board.
8. In the Alarm Action (for an input point) or On Action list, select an action to be taken when the interlocked point raises an alarm (Alert state) or becomes active. The actions include:
   - No Action - Take no action
   - Energize - Turn the point on
   - De-Energize - Turn the point off
   - Pulse On - Energize the point for a particular period
9. In the Normal Action (for input point) or Off Action list, select an action to be taken when the interlocked point becomes Normal state or becomes inactive.

**Door Interlocks**

Door Interlocks show input and output relationships available for the reader. Two types of locking devices can be configured with WIN-PAK PE:

- Magnetic Locks - which require power for the door to be closed.
- Door Strikes - which require power for the door to be opened.

To configure door interlock:

1. In the SIO Board Configuration dialog box, click the Reader tab.
2. Click Door Interlocks to display the Door Interlocks dialog box.
3. Use this dialog box to edit the default settings of the Direct Point, Free Egress Input, and Status Input as desired.

**Direct Point**

The Direct Point indicates the output that will be directly controlled by the reader.

1. In the Door Interlocks dialog box, click Direct Point to display the Direct Point Output dialog box.
2. Select an SIO Board with which you configure the direct point.
3. Select an Output that has to be used as the door output or door lock.
4. Specify the Strike Time. This is the amount of time the direct point relay is pulsed or interlocked. The default for this field is ten seconds, but can be set up to 60 seconds.

5. In Unlock for Time Zone list, select a Time Zone during which the door must be kept unlocked.

6. Select the Control Mode. This is an auto-relock function. By default, the field is set to Strike off when door closed, but can be set to strike off when door is opened.

7. Click OK to return to Direct Interlocks dialog box.

**Free Egress Input**

Free Egress Input is used for indicating which input must be used for the Free Egress device, and for configuring a door’s free egress point. Free Egress Input can only be linked to an input point.

1. In the Direct Interlocks dialog box, click Free Egress Input. The PRO 2200 - Free Egress Input dialog box appears.

![PRO 2200 - Free Egress Input](image)

*Figure 10-96  PRO 2200-Free Egress Input*

2. Select the SIO Board with which you want to configure the free egress point.

3. Select the Input that you want to use as the Free Egress Input.

4. In the Disable Egress for Time Zone list, select a time zone during which the Egress is disabled.

5. Click OK to return to Door Interlocks dialog box.

**Status Input**

Status Input indicates the status of the door such as normal, closed, forced open, ajar, and so on. The Status Input may only be linked to an input. It is normally connected to a door position sensor, such as a magnetic door contact to detect the status of the door (open, closed, and so on.).

1. In the Door Interlocks dialog box, click Status Input to display the Status Input dialog box.
2. Select an **SIO Board** with which you want to configure the status point.

3. In the **Input** list, select an input used as the door status input. Only active input points that have not been added as ADVs appear on this list. The contents of the list depend on the SIO Board selected.

4. Select the **Held Open Time**. This is the time that elapses after the door is opened, before the door is reported as ajar. By default, this field is set to 16 seconds.

5. Specify the **Pre Alarm Time** if required. Pre Alarm Time is the time that elapses after the door is opened, before a warning (typically a beeping sound) indicates that the alarm is activated.

6. In the **Mask Alarms for Time Zone** list, select a time zone during which the alarms must be masked.

7. Click **OK** to return to the Door Interlocks dialog box.

8. Click **OK** to save door interlocks.

### Configuring Triggers and Procedures

In response to a panel event (trigger), define a set of actions a panel must carry out. The occurrence of the event triggers the execution of the procedure.

- Triggers and procedures are used to define interlocks (an action on a point triggered by an action on a different point).
- Assigning points and readers to time zones can also be done through triggers and procedures on the P-Series Intelligent Controller.
- User triggers are those defined for site-specific events and actions.
- User triggers are added, edited, or deleted at any time from the Triggers and Procedures dialog boxes of the P-Series Configuration dialog boxes.
- System triggers are those created when points are assigned to interlock definitions. System triggers can only be viewed and cannot be edited in Triggers and Procedures dialog box.

### System Triggers and Procedures

System triggers and procedures are created as a result of an interlock defined on one of the P-Series Configuration SIO Board Inputs or Outputs tabs. After an action is assigned to an interlock point, two system triggers and procedures are created to correspond to the interlock. One trigger and procedure set deals with the “On” action, and the other deals with the “Off” action.
**Adding a new Procedure**

Procedures are assigned to triggers, and therefore, are defined first. Use the Procedure Definition dialog boxes to build a script of actions that take place based on the event (trigger) to which the procedure is linked. Procedures are limited by the type of device or point defined.

To add a new procedure:

1. In the **Triggers and Procedures** dialog box, click **Add** at the bottom of the Procedures section. The **Procedure Definition** dialog box appears.

![Procedure Definition Dialog Box](image1)

**Figure 10-98**  **Triggers and Procedures**

2. Enter a **Procedure Name**. This name is unique and descriptive for easy reference.

3. To define a new action for the procedure, click **Add** at the bottom of the **Action List** box. The **Action Definition** dialog box appears.

![Action Definition Dialog Box](image2)

**Figure 10-99**  **Procedure Definition**
4. Type an **Action Name**.

5. In the **Action Target Type** list, select the target of the action: Reader, Output, Input, Delay.

   The remaining fields in the dialog box are activated, based on the selected action target type.

6. If you select **Do Output Action** as an Action Target Type, perform the following steps:
   a. In the **Select Output SIO** list, select the SIO board on which the output action must occur.
   b. In the **Select Output Device** list, select a point on which the output action must occur.
   c. In the **Select Output Action** list, select an action to be performed.
   d. Click **OK** to return to the Procedure Definition dialog box.

7. If you select **Delay** as an Action Target type, perform the following steps:
   a. In **Seconds to Delay** box, type the number of seconds to delay for proceeding to the next action.
   b. Click **OK** to return to **Procedure Definition** dialog box.

After you define the procedures, the actions are listed in the **Procedure Definition** dialog box.
8. Click **OK** to return to the Triggers and Procedures dialog box.

![Figure 10-102 Procedure Definition](image)

**Figure 10-102  Procedure Definition**

8. Click **OK** to return to the Triggers and Procedures dialog box.

![Figure 10-103 Triggers and Procedures](image)

**Figure 10-103  Triggers and Procedures**

**Tip:** The newly-defined procedure is shown in the Procedures list. To look at the detailed view of each action defined for this procedure, expand the **Procedure Actions** tree.

### Adding a new Trigger

After defining the procedures, it must be associated to a trigger for triggering an action.

To add a new trigger:

1. Click **Add** at the bottom of the Triggers section of the Triggers and Procedures dialog box. The **Trigger Definition** dialog box appears.
2. Enter a Name for the trigger. This name relates to its corresponding procedure.

3. Select a Procedure in the list. Only user-defined procedures (as opposed to system procedures) are displayed in this list.

4. In the Trigger Source Type list, select the type of trigger point defined (Input, Output, Reader, or Time Zone).

5. Select the All Sources check box if you want the trigger to apply to all inputs, outputs, and readers.

6. Select a Source SIO Board. Only the boards configured for this panel are displayed in the list.

7. Select a Source SIO Board to select the SIO Board in which you want to select a trigger point.

8. In the Trigger Source list, select the exact point on the SIO Board that you want to use as the trigger point. The Trigger Source field is activated only if Source SIO Board is selected.

9. Select a Time Zone during which the trigger is active. This field defaults to Always On.

10. In the Transaction Type list, select the type of transaction.

11. In the Trigger Transactions list, select the events to associate with the trigger.

12. Click OK to save the definition and return to the Triggers and Procedures dialog box.
13. After you complete adding Triggers and Procedures, click **Next** to advance to the Finish dialog box.

14. Click **Finish** to complete the direct P-Series panel configuration.

**Adding P-Series Panel in Modem Pool**

The procedures for adding a P-Series panel in a Modem Pool is similar to adding a Direct P-Series panel. When you add a P-Series panel in the Modem Pool, you must provide Remote details of the panel and more details on System settings.

See the **Adding a P-Series Panel** section for more information on panel configuration.

This section helps you in detailing procedures for providing Remote details and System settings.

**Configuring Remote details**

When configuring a P-Series panel on a Modem Pool, the Remote dialog box appears next to the Basic dialog box.

To configure the remote:

1. In the **P-Series Configuration** dialog box, enter the **Panel Phone Number** for the remote site. Enter the number as it would be dialed, including any required prefix or area code. This is the phone number the system uses to connect to the panel.
2. Select a Host Modem. The options in this field are those previously entered in the Modem Pool when the interface was set up.

3. In the New Password text box, enter a password and re-enter the password in the Confirm Password field. WIN-PAK requires a password for remote dial-ups. The password can be up to 16 alphanumeric characters in length.

Refer to the PRO-2200 Intelligent Controller Installation Manual for details on setting the password switch.

4. In the Call In Option list, select an event that determines when the remote panel calls in to the communication server.

5. Enter a value in the Delay Before Connect text box, if a pause is required between the dialing prefix and the phone number.

6. Enter the value in the Number of Redial Attempts text box. By default, it is set to 3 but can be up to 50.

7. In the Redial Delay text box, enter the time allowed between dial attempts. This field defaults to 60 seconds, but you can enter between 5 to 120 seconds.

8. In the Wait Time for Disconnect text box, enter the time allowed before disconnecting. By default, it is set to 30 seconds but can be from 1 through 30 seconds.

9. Click Next to save the panel remote configuration.

Configuring System Settings

Several broad operating parameters are set up using the System dialog box, including those dealing with the PRO-2200 Intelligent Controller board capabilities, as well as the Time Zone in which it operates.

To configure the system settings:

1. In the P-Series Panel Configuration - Remote dialog box, click Next. The P-Series Configuration - System dialog box appears.
2. In the **Time Zone** list, select a standard time zone which indicates the panel location. The default time zone depends on the time set in the local system.

3. In the **Daylight Saving Group** list, select a daylight saving group for this panel. This field defaults to None.

4. In the **No. of Card Holders** field, specify the maximum number of card holders details to be stored based on the memory available in the board. By default, you can store 5000 card holders details in the controller.

5. Select the **Enable card user levels for trigger control** to trigger certain controls on the usage of specific cards.

6. In the **No. of Transactions to hold when offline** text box, specify the number of transactions to be buffered in the controller. By default, you can store 10000 transactions in a buffer storage. This number is decreased or increased to provide more or less memory for cards if necessary.

   1 transaction = 16 bytes (so 100,000 transactions takes up 1.6 MB of memory)

   1 card record = within 20 to 80 bytes. This depends upon the use of precision access levels versus multiple access levels, and the number of card readers per Intelligent Controller.

   **Tip:** Adding an extended memory board to the Intelligent Controller provides more memory to work with.

7. In the **No. of Transactions to accumulate before dialup** text box, specify the number of transactions to be accumulated in the memory before dialing up.

8. Select the **Host Grant** option to provide fault tolerance, even if the card is not found in the panel device.

   - Host Grant options are used when, for example, a number of cards have been entered in the database, but have not yet been downloaded to the panel.
   
   - The available options are:
     - **Disable** - Do not allow the card holder, if the card is not found in the panel.
− **Open Door** - Enables the door to open, even if the card is not found in the panel.
− **Open Door and Update Panel** - Enables the door to open and also to download the card details to the panel. Therefore, the panel is updated.

9. Click **Next** to set the card formats for the P-Series panel.

See the *Setting the Card Format for the Panel* section and the following section for more information on configuring the P-Series panel.

### Adding a NetAXS Panel

Following are the two types of NetAXS panels that are available.

- NetAXS-123
- NetAXS-4

The NetAXS-4 panel and NetAXS-123 panel is called as a “Gateway” when added directly to the communication server.

Following are the two different “NetAXS Gateway panel” scenarios.

- **NetAXS-4 panel as a Gateway supports 30 downstream NetAXS-4 panels.**
  - **Tip:** The downstream devices help in extending the input/output capabilities of the NetAXS panels.
  - **Note:** The NetAXS-4 Gateway panel does not support adding of NetAXS-123 downstream panels.
- **NetAXS-123 panel as a Gateway supports 30 downstream NetAXS-4 or NetAXS-123 panels.**
  - **Note:** Mixing of NetAXS panels is supported by the NetAXS-123 Gateway panel.

**Note:**

- The N1000, PW2000, NS2 or NS2+, and P-Series panels **CANNOT** be configured as downstream panels.
- A Gateway panel has an in built PCI on board and works as a drop line. Hence a maximum of 30 panels can be connected to the Gateway panel.
  - **Tip:** The PCI3 Communications Adapter functions as the interface between a host computer’s RS 232 port and one or more Honeywell access control panels connected on an RS485 multi-drop line.

The following table lists the features of NetAXS-123 and NetAXS-4 Gateway panels.

<table>
<thead>
<tr>
<th>Downstream panel support</th>
<th>NetAXS-123 Gateway panel</th>
<th>NetAXS-4 Gateway panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downstream panel support</td>
<td>NetAXS-4 panel as a Gateway supports 30 downstream NetAXS-4 panels.</td>
<td>NetAXS-123 panel as a Gateway supports 30 downstream NetAXS-4 or NetAXS-123 panels</td>
</tr>
</tbody>
</table>

**Tip:** The communication types help the NetAXS panels in communicating with WIN-PAK.
To add a NetAXS gateway panel:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder and right-click the communication server, and then click **Direct NetAXS Gateway Panel**. The **Panel NetAXS Gateway** dialog box appears.

### Table: NetAXS-123 Gateway panel and NetAXS-4 Gateway panel

<table>
<thead>
<tr>
<th>Feature</th>
<th>NetAXS-123 Gateway panel</th>
<th>NetAXS-4 Gateway panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCI3 support</td>
<td>The NetAXS-4 gateway panel can be added to a 485 loop when the PCI3 is used.</td>
<td>The NetAXS-123 gateway panel can be added to a 485 loop when the PCI3 is used.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The NetAXS panels (NetAXS-4 and NetAXS-123) can be added to a 485 loop when the PCI3 is used. Support of this is consistent with “legacy” versions of WIN-PAK where the NetAXS panel is programmed per the NetAXS documentation section 3 as an N-1000-IV-X. There is no GUI support for this configuration in the scope of this release.</td>
<td></td>
</tr>
<tr>
<td>Panel Address</td>
<td>Always 1</td>
<td>Always 1</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>3.4 or later</td>
<td>3.4 or later</td>
</tr>
</tbody>
</table>

3. Type a unique **Name** for the panel. This field is mandatory, and is limited to a maximum of 30 alphanumeric characters.
4. Select either “NetAXS-4 Gateway” or “NetAXS-123 Gateway” from the Panel Type list. The default selection is “NetAXS-4 Gateway”.

5. Type a Description for the selected panel. You can type a description limited to a maximum of 30 alphanumeric characters.

6. For a Gateway panel, the Panel Address always defaults to “1”, and cannot be changed.

7. In the Firmware Version list, select the firmware version of the panel as applicable.

   The following are the NetAXS panel firmware versions compatible with WIN-PAK.
   - NetAXS – 4 firmware version is 3.4. or later
   - NetAXS – 123 firmware version is 3.4 or later

8. In the Communication Type list, select any one of the following communication types (for WIN-PAK - NetAXS panel communication) as applicable.

   - If you select “COM1”, then select a value from the Bits Per Second list. The available values are 19200, 38400, 57600, and 115200. The default value is 38400.
   - If you select “TCP/IP Connection”, then type the IP-Address or Node name of the NetAXS panel.
   - If you select “TCP/IP Encrypted Connection”, then type the IP-Address of the NetAXS panel followed by the Encryption Password and Confirm Encryption Password.

   **Note:** The Encryption Password field is limited to a maximum of 32 hexadecimal characters (0-9, a-f, A-F) only. The “AES Encryption” standard is used for encryption.

   - If you select “TCP/IP Reverse Initiate Connection”, then type the Port Number (in range 5001 to 65535).
   - If you select “TCP/IP Reverse Initiate with Encryption”, then type the Port Number (in range 5001 to 65535) followed by the Encryption Password and Confirm Encryption Password.

   **Note:** As NetAXS-123 Gateway supports only TCP/IP communication, the “COM1” option is not listed in the Communication Type list.

9. In the Status list, select one of the following states for the panel.

   - Active - The panel is configured and currently connected to the WIN-PAK system.
   - Inactive - The panel is configured but temporarily disconnected for maintenance purpose.
   - Not Present - The panel is not available and no transactions are saved.

10. In the Downstream Baud Rate list, select the baud rate (38400 or 115200) for the downstream panels. The default value is 38400.

11. Select the following panel defaults as applicable.

   - IO Poll Interval - Select an interval between 10 and 600 at which the signal must be sent to the panel to verify the communication, and check the panel's input and output states. By default, the frequency interval is 60 seconds.
   - Loop Verification Interval Offset (sec) - Select an interval between 15 to 255. By default, the Loop Verification Interval is set to 15 seconds.
   - Panel CMD Retry Count - Select the number of times (between 0 and 5) at which a command must be resent to the panel, if the event of the panel is not responding to the command. By default, the command is resent 3 times.
• **Panel CMD Time Out** - Select the waiting time (between 1 and 30) for receiving a response from the panel and time out of the command. By default, the loop waits for 5 seconds.

12. Select the **Buffer all panels on exit** check box to buffer the events on all the panels when the communication server is stopped.

13. Select the **Unbuffer all panels on startup** check box to unbuffer all the panel events when the communication server is started.

14. In the **Time Zone** list, select the geographic time zone in which the NetAXS panel operates.

15. Click **Add** under **ADV** and set the ADV properties to create an ADV for the panel. See the **Configuring an Abstract Device** section for more information on ADV configuration.

16. Click **Next** to specify the card format details.

**Setting the Card Formats**

NetAXS panels support only the WIEGAND card format, which supports 128 different card formats limited to a maximum length of 128 bits. Among this 128 card formats, the following eight card formats are standard to all the NetAXS panels (NetAXS-4 and NetAXS-123).

- Default 26 Bit Wiegand
- Default 32 Bit Wiegand
- Default 34 Bit Wiegand
- 35 Bit Corporate 1000
- Default 25 bit Wiegand
- Default 29 bit Wiegand
- Default 37 bit Wiegand
- Default 75 bit Wiegand

**Note:** The 75-bit Wiegand is the default FIPS card format and while this FIPS format is commonly used, you may need to adjust for your application – consult your WIN-PAK support representative for further assistance if any.

To configure the card formats:

1. In the **Panel NetAXS - Card Formats** dialog box, the list displays the card formats types supported by NetAXS. The check boxes corresponding to the standard card formats supported by NetAXS are selected by default.
2. Default values appear under the First Bit and Bit Count columns for each the 128 card format types corresponding to the following fields.
   - Card Numbers A through D
   - Site Codes A through D
   - Even Parity
   - Odd Parity
   - Issue Code

Select a card format and change the default First Bit and Bit Count values for the above listed fields.

**Note:** You can change the default values for any of the fields listed above. However, click Restore Defaults to reset the default values for these fields.

3. The Total Bits list by default displays the total number of bits supported by a card format. For card formats Format 9 through Format 128, the total number of bits is defaulted to 0. You must select a bit value greater than 3 for all these formats.

4. Under Read Direction, select the Forward or Inverted option button as applicable for reading the card. By default, the Forward option button is selected.

5. Under Card Number Equals, select any one of the following option buttons:
   - Card Number only - represents the standard mode of operation where the card number associated to the card holder is exactly the card number.
6. The Exponent field is grayed out unless the Site Code + Card Number is selected. To generate a card's new ID, use this field to insert the desired number of zeroes to be appended to the Site Code value. Then add the card ID to calculate the card's new ID.

For example, a 26-bit card has a site code of 123 and the card ID is 637. When the Concatenate Site Code is enabled with an exponent of 4, 4 zeroes are appended to the site code. The result is a final value of 1230000. This newly modified site code value is then added to the number that the panel has read as the card's ID, 1230000 + 637 = 1230637. The newly combined number becomes the card's new ID value.

7. Click Next to assign time zones and holiday group to the NetAXS panel. The Panel NetAXS - Time Zones dialog box appears.

Assigning Time zones and Holiday groups to the NetAXS panel

A maximum of 128 time slots and 256 holidays (per holiday group) can be associated to NetAXS panels (NetAXS-123 and NetAXS-4). A new provision that allows an operator to create and add a new Time Zone while inside the panel database is added to the Panel NetAXS - Time Zones tab. When the Add New Time Zone is selected it opens up the Time Zone Record window that helps you to create and name the new time zone. After the time zone is created, the new time zone is added to the Time Zones database and applied to the panel’s database. When the Time Zone Record window is closed, the user interface returns to the Panel NetAXS – Time Zones tab. The newly created time zone is automatically added to the Selected Time Zone list and uses the default account.

To configure time zones and holiday groups:

1. In the Panel NetAXS- Time Zones dialog box, select the time zones under Available Time Zone list and click . The time zones are moved to the Selected Time Zone list. For multiple selections, use the Shift and Ctrl keys.
Device Map
Panel Configuration

Figure 10-110  Panel NetAXS-Time Zones

Tip: If you want to remove a time zone under **Selected Time Zone**, select the time zone and click ![Remove](remove_icon.png).

Only the time zones that are listed in **Selected Time Zone** are available for the readers, the input points, and the output points of this panel.

**Note:** The “Always On” time zone is displayed default under **Selected Time Zone** for all the NetAXS panels.

1. Click **Add New Time Zone** to add a new time zone. The **Time Zone Record** dialog box appears. The newly added time zone is automatically added to the **Selected Time Zone** list.

2. If you are using holiday overrides, select the holiday group in the **Holiday Group** list.

3. Click **Next** to set the panel options. The **Panel NetAXS- Options** dialog box appears.

### Setting the NetAXS Panel Options

You can set certain panel options such as anti-passback, groups for providing access to the readers, input points, and output points attached to the NetAXS panel.

- **Anti-passback/Global Anti-passback**

  Anti-Passback discourages card holders to enter without using their cards. Anti-passback violation occurs in the following scenarios.

  a. **In-Out-In** - If you have entered the building without using the card and exited from the building using your card. And then, if you try to enter the building the access is denied.
b. **Out-In-Out** - If you have entered the building using the card and exited from the building without using the card. And then, if you try to enter the building the access is denied.

**Note:** Anti-passback requires a reader on each side of the door. If anti-passback is selected for a panel in the **Options** tab, the anti-passback is locally implemented.

- **Forgiveness**
  Anti-passback violation can be forgiven by selecting the **Forgiveness** option. When this option is selected, all cards are reset during midnight. Therefore, the cardholders who have violated the anti-passback option can now access their cards to enter the building.

- **Groups**
  Output groups enable a card read to activate more than one output points for the applications such as elevator control. For example, when Reader 1 is associated to a group, a valid card read on Reader 1 pulses all points in the group.

**Note:** Groups are not supported by NetAXS-123 panels.

- **Continuous Card Reads**
  Enables continuous card reading while the output is energized. When this option is not enabled, a reader cannot read a second card during the pulsing of the output caused by the previous card read.

**Example:** When Output 1 is assigned a 10 second pulse time, a valid card read at Reader 1 causes Output 1 to energize for 10 seconds. During this time the card reader does not recognize any other valid cards, if the **Continuous Card Reads** option is not selected.

- **Reverse Read LEDs**
  This option reverses the standard LED operation of the reader. If this option is selected, a reader that normally changes from green to red on a valid card read, changes from red to green.

- **Host Grant**
  Host Grant option provides the fault tolerance even if the card is not found in the panel. Host Grant options are used when, a number of cards have been entered in the database, but have not yet been downloaded to the panel.

- **Site Codes**
  Site codes identify an enterprise’s site. You can create a maximum of eight site codes to serve as secondary IDs (in addition to the card number) on the card for additional validation.

- **Command File**
  Command files contain a list of commands that can be executed manually or automatically.

To configure the panel options:

1. In the **Panel NetAXS-Options** dialog box, select the **Anti-Passback** check box to ensure that the card holders present the cards while entering and exiting a building.
   - **Local** - Select this option to enforce anti-passback only at doors configured locally to the panel controlling the original card read.
   - **Global** - Select this option to enforce anti-passback at panels throughout the system after a successful card read at any one of the system’s readers.
   - **Forgiveness** - Select this check box to forgive anti-passback violation.
2. Select the **Continuous Card Reads** check box to enable card readers to read cards continuously, independent of output pulse time.

3. Select the **Reverse Read LEDs** check box to reverse the standard LED operation of the reader. If this check box is selected, a reader that normally changes from green to red on a valid card read, changes from red to green.

4. Select the **Groups** check box to create output relay groups.
   - **Groups for Reader1 only** - Select this check box to enable group operation for reader 1. Other readers use their default or defined relays based on valid card reads.
   - **All readers use groups** - Select this check box to pulse the group when a valid card is presented on any reader.

5. In the **Command File** list, select a command file that is applicable to a panel.

6. Select one of the following **Host Grant** options to grant the permission for the card holders, even if the card is not found in the panel.
   - **Disable** - Denies access to the card holders whose card details are not present in the panel.
   - **Open Door** - Enables the door to open, even if the card is not found in the panel.
   - **Open Door and Update Panel** - Enables the door to open and also to download the card details to the panel. Therefore, the panel is updated.

7. Enter a **Site Code** to ensure that cards belong to the facility where access is attempted. You can enter up to eight site codes.
Tip: To enter a site code, double-click any cell in the table, type the site code and press Enter. If no site code is defined, the reader does not check for site codes to enable card access.

8. Click Next to configure the Input points to the panel. The Panel NetAXS-Inputs dialog box appears.

### Configuring Inputs Points to the NetAXS panel

A maximum of 14 Inputs are displayed for NetAXS-4 Gateway panel in the Inputs tab with the following default options:

1. 1= Door 1 Egress. (Disable Alarm and Normal Messages Time Zone to Always (24X7); Interlocked to O1, Pulse, No Action)
2. 2= Door 1 Status. (Shunt time 15.0 Seconds, Auto-Relock enabled to O1)
3. 3= Door 2 Egress. (Disable Alarm and Normal Messages Time Zone to Always (24X7); Interlocked to O2, Pulse, No Action)
4. 4= Door 2 Status. (Shunt time 15.0 Seconds, Auto-Relock enabled to O2)
5. 5= Door 3 Egress. (Disable Alarm and Normal Messages Time Zone to Always (24X7); Interlocked to O3, Pulse, No Action)
6. 6= Door 3 Status (Shunt time 15.0 Seconds, Auto-Relock enabled to O3)
7. 7= Door 4 Egress. (Disable Alarm and Normal Messages Time Zone to Always (24X7); Interlocked to O4, Pulse, No Action)
8. 8= Door 4 Status. (Shunt time 15.0 Seconds, Auto-Relock enabled to O4)
9. 9= Reader 1 Tamper / aux
10. 10= Reader 2 Tamper / aux
11. 11= Reader 3 Tamper / aux
12. 12= Reader 4 Tamper / aux
13. 13= Primary Power Status
14. 14= Tamper

A maximum of 17 Inputs are displayed for NetAXS-123 Gateway panel in the Inputs tab with the following default options.

1. 1= Door 1 Egress. (Disable Alarm and Normal Messages Time Zone to Always (24X7); Interlocked to O1, Pulse, No Action)
2. 2= Door 1 Status. (Shunt time 15.0 Seconds, Auto-Relock enabled to O1)
3. 3= Reader 1A Tamper.
4. 4= Reader 1B Tamper.
5. 5= General.
6. 6= Primary Power
7. 7= Reserved (not wired – allow no ADV).
8. 8= Reserved (not wired – allow no ADV).
9. 9= Door 2 Egress (Disable Alarm and Normal Messages Time Zone to Always (24X7); Interlocked to O7, Pulse, No Action)
10. 10= Door 2 Status (Shunt time 15.0 Seconds, Auto-Relock enabled to O7)
11. 11= Reader 2A Tamper
12. 12= Reader 2B Tamper
13. 13= Door 3 Egress (Disable Alarm and Normal Messages Time Zone to Always (24X7); Interlocked to O11, Pulse, No Action)
14. 14= Door3 Status (Shunt time 15.0 Seconds, Auto-Relock enabled to O11)
15. 15= Reader 3A Tamper
16. 16= Reader 3B Tamper
17. 20= Panel Tamper

To configure inputs to the panel:

1. In the Panel NetAXS - Inputs dialog box, select an input point check box under Name. The other settings in the dialog box are available only for the selected input point.

2. Click Add under ADV, set the ADV properties and click OK to define an ADV for each input point.

3. In the Shunt Time Zone list, select a time zone during which the input is ignored.

4. In the Block Interlock Time Zone list, select a time zone during which the programmed action on this input from another point is disabled.

5. In the Disable Alarms and Normal Messages Time Zone list, select a time zone during which Alarm and Normal is not reported, but Short and Cut are reported.

6. Select Sec, Min or Hr and change the Shunt Time. Shunt time is the maximum time allowed for the door to close after it is unlocked. If the time taken to close the door exceeds the shunt time, an alarm is raised.

**Figure 10-112  Panel NetAXS-Inputs**

**Note:** WIN-PAK sets some input points as active and may assign them an interlock value. These default settings vary depending on the type of panel. The settings of these input points can be changed, but you cannot make it inactive if it is interlocked with an output point.
The maximum number of hours is 1. When the hour field is blank, the maximum number of minutes is 59. When 1 is entered in the hour field, the maximum number of minutes is 45 and the maximum number of seconds is 59. The sum of all three units is the shunt time.

7. Enter the **Debounce Time** in seconds. The maximum number of seconds is 6553.5 seconds as 10th of a second is allowed. Debounce time is the maximum time allowed for the door to close after the shunt time is exceeded. If the time taken to close the door exceeds the debounce time, an alarm is raised. This debounce time is meant for the doors that swing often due to wind.

**Note:** If the value is set to zero, the debounce time is a minimum of 0.33 seconds on events going to normal, but alarms are reported immediately. The debounce time is 0 seconds on alarm.

**Example:** Consider the scenarios listed in the following table.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Shunt Time</th>
<th>Debounce Time</th>
<th>Alarm raised at...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>15 sec</td>
<td>0 sec</td>
<td>16th sec</td>
</tr>
<tr>
<td>2</td>
<td>15 sec</td>
<td>10 sec</td>
<td>25th sec</td>
</tr>
</tbody>
</table>

8. Select **Normally Closed** or **Normally Open** to specify the normal state of the door. The **Normally Open** state indicates that the door's normal state is open and the **Normally Closed** state indicates that the door's normal state is closed.

9. Select the **Supervised** check box to specify that the door's electrical circuit is wired with alternative paths supervised by resistors.

10. In the **Resistor Value** list, select the resistor values used in the supervised mode. The available values are: 1K (default), 2.2K, 4.7K, 10K.

**Note:** The **Resistor Value** field is enabled only if you select the **Supervised** check box.

11. Select the **Auto-Relock** check box, and then select the associated output from the **Output** list to re-lock the door immediately when the door status switch closes after entry. The output relay that controls the door strike de-energizes, when the associated input returns to normal state instead of remaining energized for the duration of the pulse time.

12. Set the **Interlocking** option for the input point. See the **Interlocking** section for more information.

**Note:** Group Interlock is not displayed for NetAXS-123 panels.

13. Click **Next** to configure the output points to the panel. The **Panel NetAXS - Outputs** dialog box appears.

### Configuring the Output Points to the NetAXS panel

A maximum of 16 outputs are displayed for NetAXS-4 Gateway panel in the **Outputs** tab with the following default options:

1. O1 = Door 1 lock (Pulse Time 10.0 seconds; Interlock to I2 follow / follow)
2. O2 = Door 2 lock (Pulse Time 10.0 seconds; Interlock to I4 follow / follow)
3. O3 = Door 3 lock (Pulse Time 10.0 seconds; Interlock to I6 follow / follow)
4. O4 = Door 4 lock (Pulse Time 10.0 seconds; Interlock to I8 follow / follow)
5. O5 = Aux Output 1 (Pulse Time to 10.0 seconds)
6. O6 = Aux Output 2 (Pulse Time to 10.0 seconds)
7. O7 = Aux Output 3 (Pulse Time to 10.0 seconds)
8. O8 = Aux Output 4 (Pulse Time to 10.0 seconds)
9. O9 = Reader 1 Beeper
10. O10 = Reader 2 Beeper
11. O11 = Reader 1 LED (Pulse Time to 2.0 seconds)
12. O12 = Reader 2 LED (Pulse Time to 2.0 seconds)
13. O13 = Reader 3 LED (Pulse Time to 2.0 seconds)
14. O14 = Reader 4 LED (Pulse Time to 2.0 seconds)
15. O15 = Reader 3 Beeper
16. O16 = Reader 4 Beeper

A maximum of 14 outputs are displayed for NetAXS-123 Gateway panel in the Outputs tab with the following default options:

1. O1 = Door 1 lock (Pulse Time 10.0 seconds; Interlock to I2 follow / follow)
2. O2 = Reader 1A/1B LED (Pulse Time to 2.0 seconds)
3. O3 = Aux (Pulse Time to 10.0 seconds)
4. O4 = Reader 1A/1B Buzzer
5. O5 = n/a – allow no ADV
6. O6 = n/a – allow no ADV
7. O7 = Door 2 lock (Pulse Time 10.0 seconds; Interlock to I10 follow/follow)
8. O8 = Reader 2A/2B LED (Pulse Time to 2.0 seconds)
9. O9 = Aux (Pulse Time to 10.0 seconds)
10. O10 = Reader 2A/2B Buzzer
11. O11 = Door 3 lock (Pulse Time 10.0 seconds; Interlock to I14 follow/follow)
12. O12 = Reader 3A/3B LED (Pulse Time to 2.0 seconds)
13. O13 = Aux (Pulse Time to 10.0 seconds)
14. O14 = Reader 3A/3B Buzzer

To configure output points to the panel:

1. In the Panel NetAXS - Outputs dialog box, select an output point check box under Name. The other settings in the dialog box are applicable only for the selected output point.
Note: WIN-PAK sets some output points as active and may assign them an interlock value. These default settings vary depending on the type of panel. The settings of these output points can be changed, but you cannot make it inactive if it is interlocked with an input point.

2. Click Add under ADV, set the ADV properties and click OK, define an ADV for each output point.

Note: In the ADV definition, three actions are listed for an output point: Energized, De-Energized, and Trouble.

3. In the Energized/Active Time Zone list, select a time zone.

4. Select any one of the following option buttons.

   - **Door Unlocks - No Action On Card Read** - Door gets unlocked during the time zone. No actions are taken on the card events. This is selected by default.
   - **First Valid Card Activates Time Zone (First Card Rule)** - Requires a valid card read within the time zone to enable the time zone (period in which doors are unlocked) to take effect.
   - **Output Toggles During Time Zone** - Requires, like the First Card Rule, a valid card read within the time zone to enable the time zone period in which doors are unlocked) to take effect. Unlike the First Card Rule, you can swipe the card a second time to return the doors to a locked state.

Note: All the above three options are enabled only if you select a valid time zone from the Energized/Active Time Zone list.

5. In the Block Interlock Time Zone list, select a period during which the interlock, a programmed interaction between selected inputs and outputs, is disabled. During the selected time zone this point ignores all interlock actions to it, effectively disabling it
from being a Reacting Component during the time zone. Outside this time zone, the point reacts to interlocks as expected.

**Note:** Any interlock having the output as the Reacting Component is disabled, if the Block Interlock Time Zone is active at that time.

6. Select the **Latching / Toggle Outside of Time Zone Disables Pulse Time** check box to toggle the state of the outputs between energized and de-energized status upon every activation (code use, interlock, or manual pulse).

7. Select **Sec**, **Min**, or **Hrs** and enter the **Pulse Time** to set the period during which the output point must be energized when triggered.

**Tip:** The Pulse time specifies the duration for which a device assumes abnormal status. For example, it specifies how long a horn blows or a door strike remains released. The maximum number of hours is 1; the maximum number of Minutes is 59 when no hours are set – if hours is set to 1, then the maximum number of Minutes is 45; the maximum number of seconds is 59.9 seconds as 10th of a second is allowed.

8. Set the **Interlocking** for the output point. See the **Interlocking** section for more information.

**Note:** Group Interlock is not displayed for NetAXS-123 panels.

9. Click **Next** to set the group or reader properties. **The Panel NetAXS - Group/Reader** dialog box appears.

## Configuring Groups to the NetAXS panel

A Group is one or more active output points that are grouped together. Output relay groups enable a card read to activate more than one output relay for applications such as elevator control. As many as 32 groups can be defined per panel. A maximum of 128 groups are supported for NetAXS panels (NetAXS-4). A maximum of 76 outputs can be selected for one group.

**Note:**

- The “Groups” feature is not supported by NetAXS-123 panels
- The Panel NetAXS - Groups dialog box appears ONLY if you have selected the Group check box in the Panel NetAXS - Options dialog box.

To define an output group:

1. In the Panel NetAXS - Groups dialog box, select a group under **Name**. The output points belonging to the selected groups are listed in **Available Outputs**.
2. Select the output points under **Available Groups** and click **Move to ‘Selected’**. Alternatively, click **Select All** to select all outputs points. The output points are moved to the **Selected Outputs** list.

3. In the **Energized/Active Time Zone** list, select a time zone.

4. Select any one of the following option buttons:
   - **Door Unlocks - No Action On Card Read** - Door works based on the time zone. This is the default selection.
   - **First Valid Card Activates Time Zone** - Requires a valid card read within the time zone to enable the time zone (period in which doors are unlocked) to take effect.
   - **Output Toggles During Time Zone** - Requires, like the First Card Rule, a valid card read within the time zone to enable the time zone period in which doors are unlocked) to take effect. Unlike the First Card Rule, however, the user can swipe the card a second time to return the doors to a locked state.

   **Note:** All the three options listed are enabled only if you select a valid time zone from the **Energized/Active Time Zone** list.

5. In the **Block Interlock Time Zone** list, select a period during which the interlock, a programmed interaction between selected inputs and outputs, is disabled.

   **Note:** Any interlock having that group as the Reacting Component is disabled, if the Block Interlock Time zone is active at that time.

6. Select the **Latching / Toggle Outside of Time Zone Disables Pulse Time** check box to toggle the state of the outputs between energized and de-energized status upon every activation (code use, interlock, or manual pulse).
7. Select Sec, Min, or Hrs and enter the Pulse Time to set the period during which the output point must be energized when triggered. The maximum number of Hours is 1; the maximum number of Minutes is 59 when there is no hours set – if hours is set to 1, then the maximum number of Minutes is 45; the maximum number of seconds is 59.9 seconds as 10th of a second are allowed.

8. Set the Interlocking for the output point. See the Interlocking section for more information.

   Note: Group Interlocking is not applicable for NetAXS-123 panels

9. Define ADV for each group. Click Add under ADV, set the ADV properties and click OK.

10. Click Next to configure readers to the panel. The Panel NetAXS- Readers dialog box appears.

### Configuring Readers to the NetAXS panel

The number of readers available for the panel depends on the type of panel being configured. The WIN-PAK system automatically adds readers to the panel. By default, all the available readers are active and are defined as doors.

If you have not set the anti-passback option, the readers are set for a free egress configuration. If the anti-passback option is set, the reader settings are changed to anti-passback settings.

NetAXS-4 panel supports 4 readers. NetAXS-123 panel supports 6 readers controlling 3 doors, where the "A" reader is the primary reader for the door and the "B" reader is the Out reader for the door if it is used. The B Reader can be programmed separately using the Name, Advanced Options, Anti-Passback configuration and Intrusion support. The B Reader cannot work alone as a Reader only. When used, the B reader is tied to the A reader in terms of the interlock relationships pertaining to the Door operation.

To define a reader:

1. In the Panel NetAXS-Readers dialog box, select a reader from the list to view its settings. The panel configuration displays on the lower-half of the dialog box.
Note: The Direct Point (the point that is pulsed on a valid card read), Pulse Time, Status Input and Shunt Time, and Free Egress Input are displayed.

2. Select a reader from the Reader list.
3. Select the Advanced Rules check box to define advanced card rules for the selected reader. The Advanced Reader-Options dialog box appears.
4. Select one or more check boxes corresponding to a card format from the Card Formats list.
5. Click Add New Format to add a new card format.
6. Under Card Rules, perform the following:
   - In the Disable Reader/Door - No Entry, No Exit allowed during this time list, select a time zone for a reader during which all the card reads are ignored, with the exception of a VIP card, which is allowed access. Contact and Egress will report, but Egress does not open the door.
   - In the Lock down Reader/Door - No Entry, Exit allowed during this time list, select a time zone for a reader during which all card reads are ignored (except a VIP card), denies door entry but allows egress.
   - In the Card and PIN - Required during this time list, select a time zone that grants card access with both a successful card read and a valid PIN entry at the door’s keypad. You can perform the card read and PIN entry in either sequence. You must make the second entry within 10 seconds of the first entry, in either sequence. After selecting the time zone, select the Standard or Supervisor or Escort option buttons as applicable.
Device Map

Panel Configuration

- In the **Card or PIN - Required during this time** list, select a time zone that grants access either with a successful card read or a valid PIN entry at the door's keypad. After selecting the time zone, select the Standard or Supervisor or Escort option buttons as applicable.

- In the **PIN only - Required during this time** list, select a time zone that grants access with only a valid PIN entered at the door's keypad. After selecting the time zone, select the Standard or Supervisor or Escort option buttons as applicable.

- In the **Card only - Card only allowed during this time** list, select a time zone that grants access to card having valid access level and time zone. After selecting the time zone, select the Standard or Supervisor or Escort option buttons as applicable.

7. Select the **Duress** check box and then select the output to be pulsed when a duress event is received from the Output for Duress list.

**Note:** You must select a valid time zone from the **Card and PIN - Required during this time** list for the Duress feature to function.

**Tip:** Duress Output: Configures the output that trips when a cardholder enters a “duress PIN” at a keypad/card reader. A duress PIN is the PIN a user enters at a keypad when being forced (perhaps in a robbery) to open a door. The user enters his normal PIN, except one of the digits is one number higher or lower than the normal digit. This PIN opens the door, but it also triggers the designated duress output and produces an alarm. The Duress Output requires the

8. Select the **Anti-Passback** check box to enable this feature on the reader, which requires a valid card for entry and exit. Select one of the following options:

- **In** - Applies to readers located outside the Anti-passback controlled area. Card holders use these readers when attempting to enter the Anti-passback controlled area. To detach a reader from the door, clear the Door check box. For example, a reader used in the muster area can be used without a door.

- **Out** - Applies to readers located inside the Anti-passback controlled area. Card holders use these readers when attempting to exit the Anti-passback controlled area.

- **Hard** - Validates IN/OUT status before allowing entry. A second swipe of the card at the same type of reader (IN/OUT) causes a Hard anti-passback violation and the user is denied entry.

- **Soft** - Validates IN/OUT status before allowing entry. A second swipe of a card at the same type of reader (IN/OUT) causes a Soft anti-passback violation but the user is allowed entry.

**Note:** The Anti-Passback feature is enabled only if you select the Anti-Passback check box in the Panel NetAXS-Options dialog box.

9. Click **Add** under ADV and set the ADV properties to create an ADV for the reader.

**Caution:** Once a reader is added to the device map, you cannot attach the reader to a door or detach it from the door. Therefore, confirm the reader’s usage, before adding it to the device map. If a reader is not attached to a door, it remains as a reader without any door properties. If a reader is attached to a door, the graphical form depicts the way the door is configured.

10. To associate groups to this reader, click **Groups/Partitions** and select the groups of Galaxy/Vista from the list.

**Note:** If you want to dissociate the group/partition from the reader, select the group and click **Delete Grps/Partitions**.

11. To associate Galaxy/Vista groups to the input point, select the input point from the **Input to set Arm Groups** list.
Note: Only the input points that are configured in this panel and which are not interlocked are listed in the Input to Set/Arm Grps/Partitions list.

12. To change the input point used as a free egress input:
   - Click **Free Egress Input** in the graphical form. The **Configure Free Egress** dialog box appears.
   - Select the **Egress Input** from the list.
   - Select **Sec**, **Min** or **Hr** and change the **Shunt Time**.
   Tip: The Shunt Time specifies the time for which the inputs are shunted, or de-activated. For example, it specifies how long a door strike remains released. Enter the desired number of hours (1024 maximum), minutes (60 maximum), and seconds (60 maximum). The sum of all three units is the shunt time.
   - Enter the **Debounce Time** in seconds.
   Tip: The Debounce Time specifies the time during which the input remains in a new state before generating an alarm. For example, if a Normal state is changed to Alarm, the state must remain in Alarm for five seconds before an alarm is generated. The maximum number of seconds is 6553.5 seconds as 10th of a second is allowed.
   - In the **Shunt Time Zone** list, select a time zone during which the input is ignored.
   - Click **OK** to save the settings or click **Set Defaults** to retain the default settings.

13. To change the output pulsed on a valid card read:
   - Click **Direct Point** in the graphical form. The **Configure Direct Point** dialog box appears.
   - Select **I** or **O** to indicate Input Point, Output Point. The corresponding points are enabled in Direct Point. The Groups option “G” is disabled for NetAXS-4 panels.
   Note: The Input Point, **i** and Groups, **G** are disabled for NetAXS-123 panels.
   - Select the **Direct Point** from the list.
   - Select **Sec**, **Min** or **Hr** and change the **Pulse Time**.
   Tip: The Pulse Time specifies the duration for which the device assumes abnormal status. For example, it specifies how long a horn blows or a door strike remains released. Enter the desired number of hours (1024 maximum), minutes (60 maximum), and seconds (60 maximum). The sum of all three units is the pulse time.
   - In the **Energized /Active Time Zone** list, select a time zone.
   - Click **OK** to save the settings or click **Set Defaults** to retain the default settings.

The changes to the pulse time are automatically reflected in the appropriate input, output, or group.

14. Select the **Free Egress Input shunts Status Input / Shunt Device Pulse - No Action Direct Point** check box to follow no action on the direct point when a Free Egress Input is activated.

To trigger an action in another input, output or group as a series action of direct point:
   - Click **Status Input / Shunt Device** in the graphical form. The **Configure Status Input / Shunt Device** dialog box appears.
   - Select **I** or **O** to indicate Input Point, Output Point. The corresponding points are enabled in Status Input / Shunt Device.
   Note: The Output point, **O** is disabled for NetAXS-123 panel.
   - Select the **Status Input / Shunt Device** from the list.
- Select the unit of time as Sec, Min or Hr and change the Shunt Time. Shunt time is the maximum time allowed for the door to close after it has been unlocked. If the time taken to close the door exceeds the shunt time, an alarm is raised.

- Enter the Debounce Time in seconds. Debounce time is the maximum time allowed for the door to close after the shunt time is exceeded. If the time taken to close the door exceeds the debounce time, an alarm is raised. The debounce time is meant for the doors that swing often due to the wind.

- Click OK to save the settings or click Set Defaults to retain the default settings.

15. Click Next.

- The NetAXS Panel Configuration Finish dialog box appears if you are adding a NetAXS 123 Gateway panel. Click Finish to complete the configuration.

Or

- The Panel-NetAXS Downstream Devices dialog box appears if you are adding a NetAXS -4 Gateway panel. Go to step 16.

16. See the Adding Downstream Devices section for downstream devices configuration.

**Adding Downstream Devices**

By default, the NetAXS-4 panels come with a fixed number of inputs and outputs. Using the “Downstream Devices” feature support, you can extended the inputs and outputs for these panels. This feature is not available for NetAXS-123 panels.

The extended inputs and outputs can be added using the “NX4IN” and “NX4OUT” options. A maximum of two NX4IN and four NX4OUT can be added, resulting in a maximum of six downstream devices.

To add downstream devices:

1. In the Panel NetAXS - Downstream Devices dialog box, click Add. The Select Device dialog box appears.
2. Select “NX4IN” or “NX4OUT” as applicable.

NX4IN is a 32 input and 0 output downstream add on device.
NX4OUT is a 2 input and 16 output downstream add on device.

3. If you select “NX4IN”, then the Panel NX4IN dialog box appears.
   a. In the Address list, select “1” or “2” as applicable.
   b. Click the Inputs tab to configure the inputs. See the Configuring Inputs Points to the NetAXS panel section for more information.

   If you select Address as “1” in the NX4IN Basic tab, then the input number starts at 25 and ends at 56. If you select Address as “2” in the NX4IN Basic tab, then the input number starts at 57 and ends at 88.
   c. Go to step 5.

4. If you select “NX4OUT”, then the Panel NX4OUT dialog box appears.
   a. In the Address list, select any value from 3 through 6.
   b. Click the Inputs tab to configure the inputs. Click the Inputs tab to configure the inputs. See the Configuring Inputs Points to the NetAXS panel section for more information.

   If you select Address as “3” in the NX4OUT Basic tab, then the input number starts at 89 and ends at 90. If you select Address as “4” in the NX4OUT Basic tab, then the input number starts at 91 and ends at 92. If you select Address as “5” in the NX4OUT Basic tab, then the input number starts at 49 and ends at 64. If you select Address as “6” in the NX4OUT Basic tab, then the output number starts at 95 and ends at 96.
   c. Click the Outputs tab to configure the outputs. See the Configuring the Output Points to the NetAXS panel section for more information on configuring extended outputs.

   If you select Address as “3” in the NX4OUT Basic tab, then the output number starts at 17 and ends at 32. If you select Address as “4” in the NX4OUT Basic tab, then the output number starts at 33 and ends at 48. If you select Address as “5” in the NX4OUT Basic tab, then the input number starts at 49 and ends at 64. If you select Address as “6” in the NX4OUT Basic tab, then the input number starts at 65 and ends at 80.

5. To define an ADV for each NX4IN or NX4OUT, Click Add under ADV. Set the ADV properties and click OK. See the Configuring an Abstract Device section for more information.


7. Click Finish to complete the Panel configuration.

Adding Downstream NetAXS-4 panels to a NetAXS-4 Gateway panel

To add downstream NetAXS-4 panels to NetAXS-4 Gateway panel:

1. Right-click on a NetAXS-4 gateway panel, and click Add NetAXS Panel. The Panel-NetAXS Basic dialog box appears.
2. Type a unique **Name** for the panel. This field is mandatory, and is limited to a maximum of 30 alphanumeric characters. 

   **Note:** The **Name** field cannot contain empty spaces.

3. By default, “NetAXS-4” is the only option that appears in the **Type** list.

4. The **Firmware Version** of the panel is displayed by default.

5. In the **Status** list, select one of the following states for the panel.
   - **Active** - The panel is configured and currently connected to the WIN-PAK system.
   - **Inactive** - The panel is configured but temporarily disconnected for maintenance purpose.
   - **Not Present** - The panel is not present in the system.

6. Enter the panel **Address** between 2 and 31.

7. To continue the NetAXS-4 downstream panel configuration, repeat the procedure from step 14 onwards in the **Adding a NetAXS Panel** section.

---

**Adding Downstream NetAXS-123 panels or NetAXS-4 Panels to a NetAXS-3 Gateway panel**

To add downstream NetAXS-123 or NetAXS-4 panels:

1. Right-click on a NetAXS-123 gateway panel, and click **Add NetAXS Panel**. The **Panel-NetAXS Basic** dialog box appears.

2. Type a unique **Name** for the panel. This field is mandatory, and is limited to a maximum of 30 alphanumeric characters.

   **Note:** The **Name** field cannot contain empty spaces.
3. In the **Type** list, select “NetAXS-123” or “NetAXS-4” as applicable.
4. The **Firmware** Version of the panel is displayed by default.
5. In the **Status** list, select one of the following states for the panel.
   - **Active** - The panel is configured and currently connected to the WIN-PAK system.
   - **Inactive** - The panel is configured but temporarily disconnected for maintenance purpose.
   - **Not Present** - The panel is not present in the system.
6. Enter the panel Address between 2 and 31.
7. To continue the NetAXS-4 downstream panel configuration, repeat the procedure from step 14 onwards in the **Adding a NetAXS Panel** section.

**Adding a Galaxy Panel**

WIN-PAK monitors and controls the Galaxy panel through the Galaxy panel you add to the Galaxy Ethernet module. When you add a Galaxy panel to WIN-PAK, the Galaxy panel configuration details are downloaded to WIN-PAK.

To add a Galaxy panel

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the communication server.
3. Right-click the **Ethernet Module Galaxy (Single Panel)** and select **Add New Galaxy Panel**. The WIN-PAK system starts communicating with the Galaxy panel to establish the connection and download configuration details to WIN-PAK.

4. After the panel configuration details are downloaded, the **Panel Configuration - Basic** dialog box appears. Enter the basic details of the panel such as Name and Description.

**Entering the basic details**

1. In the **Panel Configuration - Basic** dialog box, type a **Name** and a **Description** for the Galaxy panel.
2. Details for Type and Firmware Version are automatically downloaded from the panel to WIN-PAK.

3. Click Next to view the groups in the panel. The Panel Configuration - Groups dialog box appears.

**Setting the Panel Groups**

A set of zones can be grouped in the Galaxy panel and called as groups. A zone is an area covered by the input device in the Galaxy panel. By default, all the zones are grouped under one group and later various groups are configured using the Galaxy Gold User Interface.

To set the panel groups:

1. In the Panel Configuration - Groups dialog box, double-click a group in the Name list to rename it.
2. Under **Alarm report Timezones**, select a time zone during which the alarms generated from a group must be reported.

3. To edit the group ADV configuration, click **Edit** under **ADV** and edit ADV and action groups.

4. Click **Next** to view the zone configuration details.

**Setting the Panel Zones**

A zone is the area covered by an input device in the Galaxy panel that monitors intrusions and creates alarms.

To set panel zones:

1. In the **Panel Configuration - Zone** dialog box, double-click a zone in the **Name** list to rename it.
2. Under Alarm Report Timezones, select a time zone during which the alarms generated from this zone must be reported.

3. Select the Always Report Trouble check box to report troubles irrespective of the selected time zone.
4. To edit the zone ADV configuration, click **Edit** under **ADV**.

   See the *Configuring an Abstract Device* section for more information on ADV configuration.

5. Click **Next** to view the output configuration details. The **Panel Configuration - Output** dialog box appears.

### Setting the Panel Outputs

An output is a device triggered by the input device to indicate a change in the device status. The indication could be an alarm, or an action that normalizes the situation.

For example, in case of glass break, the output device could be a Siren that beeps the alarm sound. In case of fire indication, the output device could be a Sprinkler which sprinkles the water to set off the fire.

To set panel outputs:

1. In the **Panel Configuration - Output** dialog box, double-click an output in the **Name** list to rename it.

![Figure 10-121 Panel Configuration-Output](image)

### Table 10-2 Describing Output Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Function</td>
<td>The function to be performed by the output device like beep an alarm.</td>
</tr>
<tr>
<td>Output Mode</td>
<td>The mode in which the output operates such as Latch, Reflex, and Pulse.</td>
</tr>
</tbody>
</table>

2. To edit the output ADV configuration, click **Edit** under **ADV** and edit ADV and action groups.
See the **Configuring an Abstract Device** section for more details on ADV configuration.

3. Click **Next** to view the RIO board configuration details.

**Setting the RIO board**

The Relay Input Output (RIO) board is the extendable board used for extending the number of zones or outputs that can be plugged in to the Galaxy panel.

To set the RIO board:

1. In the **Panel Configuration - RIO** dialog box, double-click an RIO board in the **Name** list to rename it.

2. Click **Next** to define the user codes. The **Galaxy - User Codes** dialog box appears.

**Defining User Codes**

User code is a unique code with a set of privileges for the user to work on the Galaxy panel keypad. The number of user codes that can be set in the panel can vary based on the Galaxy panel type. These user codes are associated to the card holder for the card holder to access the Galaxy panel.

In WIN-PAK UI, you can set the user name and password for the user code. However, the privileges for the user are set in the panel and cannot be modified in WIN-PAK UI.

1. In the **Galaxy - User Codes** dialog box, to change the user name and password, select a USER in the list and type the **User Name** and **User PIN** under **User Changes**.
2. Click **Next** for setting the keypad or Max for configuring Galaxy panel. The **Keypad & MAX** dialog box appears.

**Defining a Keypad and MAX**

A keypad is a data input device for the Galaxy panel. WIN-PAK enables you to work on keypad from WIN-PAK using the virtual keypad. MAX is the reader that helps the WIN-PAK users to gain access to a particular area and WIN-PAK enables you to set the MAX. You can define ADVs for the various keypads and MAX that are connected to the Galaxy panel.

1. In the **Keypad & MAX** dialog box, select a keypad or MAX in the **Name** list.
Device Map
Panel Configuration

Figure 10-124   Keypad&MAX

2. Select the type of keypad under Keypad / Max.
3. Set a unique address for the keypad or MAX.
4. In the Name list, double-click a name and press ENTER to create an ADV for the keypad.
5. Click Next to finish the Galaxy panel configuration.
6. Click Finish. The Galaxy panel is configured.

Right-Click Menu Options

The following options are available, when you right-click the Galaxy panel:

- Synchronize
- Edit Configuration
- Download Log Data
- Upload User Code
- Upload Date and Time
- Work on Virtual Keypad

Synchronizing with Galaxy Panel

Synchronizing the data in the Galaxy panel with WIN-PAK ensures that the data in WIN-PAK is updated with the latest data in Galaxy. In addition, any changes made in the Galaxy panel after it was downloaded to WIN-PAK are also updated in WIN-PAK.

To synchronize WIN-PAK data with the Galaxy panel:

1. Right-click the Galaxy panel and select Synchronize. The Synchronize with Panel dialog box appears.
2. Under **Retrieve Panel Data**, select the required check boxes such as Zones, Groups, Outputs, and so on.

3. To specify the range of data to be retrieved, select the required check box again. The selection is grayed and the **From** and **To** boxes are enabled.

4. Change the data range in the **From** and **To** boxes.

5. Click **OK**. A message asking for confirmation to stop polling at the Communication server appears.

6. Click **Yes** to stop polling and start downloading data from the Galaxy panel to WIN-PAK.

**Viewing Panel Configuration Details**

You can view the latest configuration details of the Galaxy panel that were downloaded to WIN-PAK.

To view the panel configuration details:

1. Right-click the Galaxy panel and select **Configure**. The Galaxy dialog box appears.
Device Map
Panel Configuration

2. Click the required tab to view and edit the ADV details.

See the Adding a Galaxy Panel section for more information on editing the Galaxy Panel configuration details.

Downloading Log Data
You can download the log information of the Galaxy panel into WIN-PAK.

To download the log data to WIN-PAK:

1. Right-click the Galaxy panel and select Download log data. A confirmation message asking to stop the communication server appears.

2. Click Yes to stop the communication server and download the log data to WIN-PAK. If you click No, you cannot download log data to WIN-PAK.

Uploading User Code
You can upload a range of user code details that are configured in WIN-PAK to the Galaxy panel.

To upload the user code to the Galaxy panel:

1. Right-click the Galaxy panel and select Upload User Code. The Upload User Code dialog box appears.
2. Type the **Manager Code**. If the manager code is invalid, you cannot upload the user code.

3. Under **Range**, type the **From** and **To** values.

4. Click **OK** to upload the user code details to the Galaxy panel.

### Uploading Date and Time

You can upload the current date and time of the WIN-PAK system to the Galaxy panel.

To upload the current date and time:

1. Right-click the Galaxy panel and select **Upload date and time** for uploading the current date and time. A confirmation message to stop the polling appears.

2. Click **Yes** to stop polling at communication server and upload the current date and time to the panel.

### Working on Virtual Keypad

The virtual keypad is displayed in WIN-PAK for the user to change the Galaxy panel configuration details.

To view and operate on virtual keypad:

1. Right-click the Galaxy panel and select **Virtual Keypad**. The **Galaxy Panel - Virtual Keypad** appears.
2. Use the keys on your keyboard to operate on keypad. The connectivity status is shown at the bottom of the keypad. When the connectivity is lost, the connectivity status color changes to red.

3. Click the button to close the keypad.

**Isolating and deleting a Galaxy Panel**

You can delete the configuration details of the Galaxy panel from WIN-PAK. However, the panel ADVs must be isolated from the floor plans and the operator levels.

**Isolating a Galaxy panel**

To isolate a Galaxy panel:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.

2. Expand the **Devices** folder to display the servers and devices added to the device map.

3. Right-click the Galaxy panel and click **Isolate**. The **Isolate Device or ADV** dialog box appears.
4. To isolate ADVs of the Galaxy panel from the floor panel:
   a. Click the **Floor Plans** tab. The list of floor plans associated to the panel is displayed.
   b. Select the floor plans and click **Remove**. The selected floor plans are dissociated.

   OR

   Click **Remove all** to isolate all the ADVs of Galaxy panel from the floor plan.

5. To isolate operator levels from an ADV of the Galaxy panel:
   a. Click the **Operator Levels** tab. The list of operator levels associated to the panel is displayed.
   b. Select the operator levels that must be isolated from the communication server and click **Remove**. The selected operator levels are dissociated from the communication server.

   OR

   Click **Remove all** to isolate all the operator levels from the communication server.

   c. To remove the communication server from the control area, clear the presence of an ADV of the panel in the control area by clearing the **Present in Control Area** check box.

6. Click **OK**.

**Deleting a Galaxy panel**

After isolating the associated floor plans and operator levels, you can delete the Galaxy panel.

To delete a Galaxy panel:

1. Choose **Configuration > Device > Device Map**. The **Device** window appears.
2. Expand the **Devices** folder to display the servers and devices added to the device map.
3. Right-click the Galaxy panel and click **Delete**. A message asking for confirmation appears.

4. Click **OK** to confirm the deletion. The Galaxy panel is deleted from the device map.

### Adding a Vista Panel

You can monitor and control intrusions using the Vista panel in WIN-PAK. In the Vista Panel Port, you can add only one Vista panel. To add multiple vista panels to the communication server, you must add multiple Vista Panel Ports.

To add a Vista panel:

1. Choose **Configuration > Device > Device Map**. The Device window appears.
2. Expand the communication server.
3. Right-click the **Vista Panel Port** and select **Add New Vista Panel**. The Panel Configuration - Basic dialog box appears.

![Panel Configuration - Basic](image)

**Figure 10-132  Panel Configuration-Basic**

4. Type the **Name** and **Description** of the Vista panel.
5. Select the **Type** of the vista panel. WIN-PAK supports two types of Fire Burglary Panels: **PANEL VISTA 250FBP** and **PANEL VISTA 128FBP**.
6. Click **Next** to configure the vista partitions. The Panel Configuration - Partitions dialog box appears.

**Configuring the Vista Panel Partitions**

In the Vista panel, a set of zones can be grouped and called as partitions.

To configure vista panel partitions:

1. In the Panel Configuration - Partition dialog box, create an ADV for the partition.
2. Click **Next** to configure the vista panel zones. The **Panel Configuration - Zones** dialog box appears.

**Configuring Vista Panel Zones**

A zone is the area covered by an input device in the Vista panel that monitors intrusions and creates alarms.

To configure vista panel zones:

1. In the **Panel Configuration - Zones** dialog box, select the panel zone and create an ADV.
Figure 10-134  Panel Configuration-Zones

2. In the Zone Type list, select the type of the zone.
3. In the Partition Name list, select the partition to which the zone belongs.
4. Click Next to configure the vista panel outputs. The Panel Configuration - Output dialog box appears.

Configuring the Vista Panel Outputs

To configure vista panel outputs:

1. In the Panel Configuration - Output dialog box, select an output and create an ADV for the output.
2. Click Next to define the user codes. The Panel Configuration - User Codes dialog box appears.

**Defining User Codes**

The user code is a unique code with a set of privileges for the user to work on the Vista panel keypad. These user codes are associated to the card holder for the card holder to access the Vista panel. In the WIN-PAK UI, you can set the password for the user code.

To set the password for the user code:

1. In the Panel Configuration - User Codes dialog box, select a code.
2. In the UserPIN box, type the password for the selected user code.
3. Click Next to finish the vista panel configuration. The Panel Configuration - Finish dialog box appears.
4. Click Next to configure the Vista panel.

**Editing a Vista Panel**

To edit the vista panel configuration details:
2. Expand the Devices folder and the communication server to display the loops and devices added to the communication server.
3. Expand the Vista Port and select the Vista panel.
4. Right-click the Vista panel and click Configure. The Panel Configuration dialog box appears.

![Panel Configuration](image)

*Figure 10-137  Editing a Vista Panel*

5. Edit the details of the vista panel, as required.

See the Adding a Vista Panel section for editing vista panel configuration details.

**Isolating and deleting a Vista Panel**

You can delete the configuration details of the Vista panel. However, the panel ADVs must be isolated from the floor plans and the operator levels.

**Isolating a Vista panel**

To isolate a vista panel:
2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the Galaxy panel and click Isolate. The Isolate Device or ADV dialog box appears.

![Isolate Device or ADV dialog box]

3. Right-click the Galaxy panel and click Isolate. The Isolate Device or ADV dialog box appears.

**Figure 10-138  Isolating a Vista Panel**

4. To isolate the ADVs of the Vista panel from the floor panel:
   a. Click the Floor Plans tab. The list of floor plans associated to the panel is displayed.
   b. Select the floor plans and click Remove. The selected floor plans are dissociated from the floor plan.

   OR

   Click Remove all to isolate all the ADVs of the Vista panel from the floor plan.

5. To isolate operator levels from an ADV of the Vista panel:
   a. Click the Operator Levels tab. The list of operator levels associated to the panel is displayed.
   b. Select the operator levels that must be isolated from the communication server and click Remove. The selected operator levels are dissociated from the communication server.

   OR

   Click Remove all to isolate all the operator levels from the communication server.

   c. To remove the communication server from the control area, clear the presence of an ADV of the panel in the control area by clearing the Present in Control Area check box.

6. Click OK.

**Deleting a Vista panel**

After isolating the associated floor plans and operator levels, you can delete the Vista panel.

To delete a Vista panel:

Device Map
Abstract Device

2. Expand the Devices folder to display the servers and devices added to the device map.
3. Right-click the Vista panel and click Delete. A message asking for confirmation appears.
4. Click OK to confirm the deletion. The Vista panel is deleted from the device map.

Abstract Device

An Abstract Device (ADV) is a logical representation of a physical device. An ADV is associated to an actual device in your access control system such as a panel or alarm. Therefore, ADVs must be configured for every device mapped to the Device tree structure. ADVs provide an interface for monitoring the device status and controlling the actions of a physical device.

Each ADV is associated to an Action Group. An Action Group defines the priority of a given event related to the device, as well as any actions that take place in response to an event. When you edit an Action Group, all ADVs associated to the action group are updated.

Configuring an Abstract Device

This section describes how to add, edit, delete an abstract device.

Adding an Abstract Device

You can add an abstract device only while configuring the device map. However, you can edit or delete an ADV using the Abstract Device window.

To configure an ADV:

1. Open the Abstract Device Record Configuration window. You can open this window by clicking Add under ADV in any device configuration dialog box.
2. The ADV Name, by default, is based on the name of device configured. However, you can change the name if required.

3. Enter the Description for ADV. The description enables you in selecting the ADV when setting up other aspects of the access control system.

4. In the Default Floor Plan list, select a floor plan in which the device is logically located. This floor plan can be opened in an Alarm View window, by right-clicking an alarm message and selecting Floor Plan. This helps you in locating the place from where the alarm is triggered.

5. Select an existing Action Group from the drop-down list and set the action properties. Each action group contains a group of actions.

6. To add a new action group, click Add. The Name drop-down list changes to a text box. Type a name of the action group and press ENTER. The Rename and Delete buttons helps you in renaming and deleting the action group.

7. Select an Action from the list. This list varies depending on the type of device configured and the selected action group.

See the ADV Action Groups section for examples.

8. Enter a Priority for the action. The maximum value you can specify is 99.

- Each action must be set with a priority for considering the action as an alarm or an event. When an action is triggered, the action priority is compared with the values set for Alarm Priority for notification and Alarm Priority for required acknowledgement fields that are configured in the Communication Server.

- The action is considered as an alarm, if the action priority is less than the value in the Alarm Priority for required acknowledgement field.
The action is considered as an event, if the action priority is greater than the value in the **Alarm Priority for required acknowledgement**.

**Example:** Alarm Priority for notification is set as 20 and Alarm Priority for required acknowledgement is set as 50 in the Com Server Configuration window. If you set 15 as the action priority, it is considered as an alarm. If you set 35 as the action priority, it is considered as an alarm and event.

9. Select the **Send Email** check box, if e-mails must be sent to the configured e-mail ids when the action takes place.

10. Select the **Time Zone** for the action. The default setting is *Always*, as the defined actions take effect regardless of the time.

11. Select the **Write to History** check box to write the event into the log file.

12. Select the **Print on alarm printer** check box to print the action details on the alarm printer.

13. Under **Command Files on**, select a **Command File** to be executed for the action.
   - In the **Receive** list, select the command file that must be executed when an alarm or an event for this action is received.
   - In the **Acknowledge** list, select the command file that must be executed when the alarm for the action is acknowledged.
   - In the **Clear** list, select the command file that must be executed when the alarm for the action is cleared.

14. To play a sound file when an action takes place, type the name of the **Sound File**, or select a sound file by clicking the ellipsis button.

15. To view a live video of the action, select the camera in the **Digital Video Camera** list. The Digital Video Camera is enabled only you select custom Action Group. When the action has taken place, the **Digital Video - Display** window is displayed showing the live video from the selected camera.
16. Click **Advanced** to select and configure the cameras for the Action Group. The **Advanced Action Properties** dialog box appears.

![Advanced Action Properties](image)

**Figure 10-140  Advanced Action Properties**

See the [Configuring Advanced ADV Actions](#) for information on Advanced camera configuration.

**Note:** You can configure the Advanced action settings only for the Custom Action Groups. The advanced settings are not supported for standard and template action groups.

17. Type a detail message for the alarm in **Alarm Detail View Message**.

18. Click **OK** to save the details.

**Configuring Advanced ADV Actions**

**Note:** You can configure the Advanced action settings only for the Custom Action Groups. The advanced settings are not supported for standard and template action groups.

1. In the **Available Cameras** list, select the cameras to be monitored. For multiple selections, use the SHIFT or CTRL key.

2. Click **Move to “Selected”**, to move the cameras to the **Selected Cameras** list.

   The selected cameras are displayed in the **Selected Cameras** box.

3. Click **Move to “Available”**, to revert the selection.

**Note:**
- The selected ADV, ADV actions, and cameras must belong to the same Communication Server.
• You can select a maximum of four cameras only.

4. Select one of the following options:

• **Record Instant using Fusion Defaults** - to set the camera properties under instant mode of recording and record an event.

• **Record Intensive using Fusion Defaults** - to set the camera properties under intensive mode of recording and record an event.

**Note:** The values displayed under Custom are the selected camera’s default settings.

• **Record using Custom settings** - to customize the camera properties for recording an event.

**Note:**

• The **Record Instant using Fusion Defaults**, **Record Intensive using Fusion Defaults**, and **Record using Custom settings** buttons are enabled only when one Fusion camera is selected from the **Selected camera** list.

• The camera custom settings for **Record Instant, Record Intensive**, and **Record using Custom settings** are available only for the fusion cameras 1 to 16.

• The default record data to the fusion camera is downloaded in real-time.

5. Under **Custom** settings, customize the following:

• **Record rate (IPS)** - to set the images per second (IPS). The value must be lesser than that for Intensive Recording.

• **Duration** - to set the time duration.

The camera reverts to the default recording value and home position when the time set in the **Duration** is completed.

**Note:** The values displayed for **Pre-event in Sec**, **Quality**, and **Resolution** under Custom are the default settings for the selected camera. The values for **Duration of recording** and **IPS** can be edited under Custom Actions.

6. Under **Preset Setting**, set the preset value (from a maximum of 8 presets) for the selected PTZ camera.

**Note:**

• You must select **Pan and Tilt** in the **Camera Configuration** tab to set a preset value for the camera.

• The configured preset fusion/HRDP Performance camera is downloaded in real-time.

7. Select **Return Home** to bring the camera back to its home position with the default focus, aperture, and zoom settings. You can select and set any of the presets as the default home preset value only in the DVR camera configuration page.

8. Specify a maximum **Home Delay** limit of 255 seconds and a minimum limit of 1 second. The default value for the home delay for a fusion/HRDP Performance camera is the value that is set during camera configuration.

9. Select **Set Selected cameras to this value** to set a common home delay value for the selected PTZ cameras.

10. Select **Allow Manual PTZ** to enable manual PTZ control of the selected camera and override the preset programming. When this check box is cleared, you cannot manually control the camera during the specified recording period.

11. Click **Copy to all Actions in this ActionGroup** to copy the settings in the **Advanced Action Properties** dialog box to all the other actions in the ADV Action Group.
12. Click **OK** to save the changes.

**Editing an Abstract Device**

To edit an abstract device:

1. Choose **Configuration > Abstract Device (ADV)**. The **Abstract Device** window appears with the list of ADVs added through device map.

2. Select an abstract device and click **Edit**. The **Abstract Device Record** dialog box for the selected ADV appears.

3. Edit the required details of an ADV.

   See the “**Configuring an Abstract Device**” section in this chapter for more details on ADV configuration.

**Deleting an ADV**

To delete an ADV not in use:

1. Choose **Configuration > Abstract Device (ADV)**. The **Abstract Device** window appears with the list of ADVs added through device map.
2. Select an abstract device and click Delete. The Abstract Device is deleted.

An Action Group is a set of actions assigned to a device when its ADV is defined. All the actions in the action group are set with the list of properties for a response to an action. Responses include executing a command file, activating a sound file, viewing a live video, and so on.

**Viewing Action Group Details**

To edit details of an action:

1. Choose **Configuration > Device > Action Group**. The **Action Group** window appears.
2. Select the action group and select the **Detail View** check box. The **Action Group** dialog box for the selected action group appears.

3. View the details of the action group. The priority of the action, time zone, command files and other details are displayed.

4. Select a different action from the list to view the related details.

5. Clear the **Detail View** check box in the Action Group window to close the dialog box.

**Editing an Action Group**

You can edit an Action Group from the Action Group window to make global changes to all ADVs associated with a particular Action Group.
To edit an action group:

1. Choose **Configuration > Device > Action Group**. The **Action Group** window appears.

2. Select the action group and click **Edit**. The **Action Group** dialog box for the selected action group appears.

3. Edit the required details and click **OK**. The action group for the selected device is changed globally.

See the steps 8 to 16 of the **Adding an Abstract Device** section for more information on setting the action group properties.
Copying an Action Group
You can create a copy of an Action Group with the same set of properties and then you can define a different set of properties.
To create a copy:
1. Select the action group and click **Copy**. The selected action group is duplicated.
2. Select the copied action group and click **Edit** to change the settings.

Deleting an Action Group
If an action group associated to an ADV is still in use, reassign the ADV associated to it to a different action group, before deleting the action group. Otherwise the warning message appears showing that the action group is in use.
To delete an action group:
1. Select the action group and click **Delete**. The selected action group is deleted.

ADV Action Groups
The following list of tables that describe you the types of actions defined for different ADVs used in WIN-PAK.

**Table 10-3 Describing 485 ACK/NAK and 485 non-ACK/NAK (loop) Actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop OK</td>
<td>The N-485 is working properly.</td>
</tr>
<tr>
<td>Loop Remote Dial-up Failed</td>
<td>The host computer was not able to connect through dialup to the panel.</td>
</tr>
<tr>
<td>Loop Remote Dial-up Successful</td>
<td>The host computer was able to connect through dialup to the control panel.</td>
</tr>
<tr>
<td>Loop Alarm</td>
<td>The N-485 is NOT working properly.</td>
</tr>
</tbody>
</table>

**Table 10-4 Describing C-100 (loop) Actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop OK</td>
<td>The C-100 is working properly.</td>
</tr>
<tr>
<td>Loop Remote Dial-up Failed</td>
<td>The host computer was unable to connect through dial-up to the control panel.</td>
</tr>
<tr>
<td>Loop Remote Dial-up Successful</td>
<td>The host computer was able to connect through dial-up to the control panel.</td>
</tr>
<tr>
<td>Loop Alarm</td>
<td>The C-100 is NOT working properly.</td>
</tr>
</tbody>
</table>
### Table 10-5 Describing Camera (CCTV camera) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCTV Camera OK</td>
<td>The camera is working properly.</td>
</tr>
<tr>
<td>CCTV Camera Trouble</td>
<td>The camera is NOT working properly.</td>
</tr>
</tbody>
</table>

### Table 10-6 Describing Camera PTZ (CCTV camera) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCTV Camera OK</td>
<td>The pan tilt camera is working properly.</td>
</tr>
<tr>
<td>CCTV Camera Trouble</td>
<td>The pan tilt camera is NOT working properly.</td>
</tr>
</tbody>
</table>

### Table 10-7 Describing Cards (Entrance Reader) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Passback Violation</td>
<td>A card was denied entry because it has already been used going in/out without properly going in/out.</td>
</tr>
<tr>
<td>Card Not Found</td>
<td>A card was denied entry because it was unknown to the reader.</td>
</tr>
<tr>
<td>Expired Card</td>
<td>A card was denied entry because it has been expired by date or number of uses.</td>
</tr>
<tr>
<td>Host Grant Card downloaded</td>
<td>Access was granted to the user, if the event is downloaded within two minutes of computer time. The control panel was updated with valid card information.</td>
</tr>
<tr>
<td>Host Grant Door unlocked</td>
<td>Access was granted to the user, if the event is unlocked within two minutes of computer time. The control panel was not updated with valid card information.</td>
</tr>
<tr>
<td>Invalid PIN</td>
<td>A card was denied entry because of an invalid PIN.</td>
</tr>
<tr>
<td>Invalid Site Code</td>
<td>A card was denied entry because of an improper site code.</td>
</tr>
<tr>
<td>Invalid Time Zone</td>
<td>A card was denied entry because it was used outside its time period.</td>
</tr>
<tr>
<td>Trace Card</td>
<td>A card that is being traced was used and entry was granted.</td>
</tr>
<tr>
<td>Valid Card</td>
<td>A valid card had been used and entry was granted.</td>
</tr>
</tbody>
</table>
### Table 10-8 Describing Command File Server Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server OK</td>
<td>The command file server is working properly.</td>
</tr>
<tr>
<td>Server Trouble</td>
<td>The command file server is NOT working properly. Verify that the “WIN-PAK Command File Server” is running in the WIN-PAK Service Manager.</td>
</tr>
</tbody>
</table>

### Table 10-9 Describing Communication Server Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server OK</td>
<td>The communication server is working properly.</td>
</tr>
<tr>
<td>Server Trouble</td>
<td>The communication server is NOT working properly. Verify that “WIN-PAK Communication Server” is running in the WIN-PAK Service Manager.</td>
</tr>
</tbody>
</table>

### Table 10-10 Describing Door (Entrance) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Passback Violation</td>
<td>A card was denied entry because it has already been used - going in/out without properly going out/in.</td>
</tr>
<tr>
<td>Card Not Found</td>
<td>A card was denied entry because it was unknown to the reader.</td>
</tr>
<tr>
<td>Door Ajar</td>
<td>The door has been left open longer than it must be based on a valid entry.</td>
</tr>
<tr>
<td>Door Normal</td>
<td>The door is now closed.</td>
</tr>
<tr>
<td>Door Troubled</td>
<td>The door status can not be accurately displayed due to tampering.</td>
</tr>
<tr>
<td>Expired Card</td>
<td>A card was denied entry because it was expired by date.</td>
</tr>
<tr>
<td>Forced Open</td>
<td>The door is in the alarm mode due to invalid entry.</td>
</tr>
<tr>
<td>Host Grant Card downloaded</td>
<td>Access was granted to the user, if event is downloaded within two minutes downloaded of computer time. The control panel was updated with valid card information.</td>
</tr>
<tr>
<td>Host Grant Door unlocked</td>
<td>Access was granted to the user, if the event is unlocked within two minutes unlocked of computer time. The control panel was not updated with valid card information.</td>
</tr>
<tr>
<td>Invalid PIN</td>
<td>A card was denied entry because it was used with an invalid PIN.</td>
</tr>
<tr>
<td>Invalid Site Code</td>
<td>A card was denied entry because it did not have a proper site code.</td>
</tr>
</tbody>
</table>
### Table 10-10 Describing Door (Entrance) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Time Zone</td>
<td>A card was denied entry because it was used outside its time period.</td>
</tr>
<tr>
<td>Trace Card</td>
<td>A card being traced was used and entry was granted.</td>
</tr>
<tr>
<td>Valid Card</td>
<td>A valid card has been used and entry was granted.</td>
</tr>
</tbody>
</table>

### Table 10-11 Describing Door Output Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-energized</td>
<td>The output of the door is not energized.</td>
</tr>
<tr>
<td>Energized</td>
<td>The output of the door is energized.</td>
</tr>
<tr>
<td>Trouble</td>
<td>The output of the door is not responding.</td>
</tr>
</tbody>
</table>

### Table 10-12 Describing Group Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-energized</td>
<td>The group of relays is not energized.</td>
</tr>
<tr>
<td>Energized</td>
<td>The group of relays is energized.</td>
</tr>
</tbody>
</table>

### Table 10-13 Describing Guard Tour Sequenced Group Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Early Arrival</td>
<td>The guard arrived early at the designated check point reader.</td>
</tr>
<tr>
<td>Late Arrival</td>
<td>The guard arrived late at the designated check point reader.</td>
</tr>
<tr>
<td>Missed</td>
<td>The guard missed the designated check point reader.</td>
</tr>
<tr>
<td>Out of Sequence</td>
<td>The guard is out of sequence.</td>
</tr>
</tbody>
</table>

### Table 10-14 Describing Guard Tour Server Group Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server OK</td>
<td>The Guard Tour server is working properly.</td>
</tr>
<tr>
<td>Server Trouble</td>
<td>The Guard Tour server is NOT working properly. Verify that “WIN-PAK Guard Tour Server” is running in the WIN-PAK Service Manager.</td>
</tr>
</tbody>
</table>
### Table 10-15 Describing Guard Tour Unsequenced Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checked</td>
<td>The guard has checked the required input/reader.</td>
</tr>
</tbody>
</table>

### Table 10-16 Describing Input Alarm Point (Input Supervised) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Active</td>
<td>The input is in the alarm state.</td>
</tr>
<tr>
<td>Input Normal</td>
<td>The input is in the normal state.</td>
</tr>
<tr>
<td>Input Trouble</td>
<td>The status can not be accurately displayed due to tampering. Note:</td>
</tr>
</tbody>
</table>

### Table 10-17 Describing Modem Pool ACK/NAK Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modem Pool OK</td>
<td>Modem pool is working properly.</td>
</tr>
<tr>
<td>Modem Pool Trouble</td>
<td>Modem pool is NOT working properly.</td>
</tr>
</tbody>
</table>

### Table 10-18 Describing Modem Pool non ACK/NAK Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modem Pool OK</td>
<td>Modem pool is working properly.</td>
</tr>
<tr>
<td>Modem Pool Trouble</td>
<td>Modem pool is NOT working properly.</td>
</tr>
</tbody>
</table>

### Table 10-19 Describing Monitor (CCTV Monitor) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCTV Monitor OK</td>
<td>Monitor is working properly.</td>
</tr>
<tr>
<td>CCTV Monitor Trouble</td>
<td>Monitor is NOT working properly.</td>
</tr>
</tbody>
</table>
### Table 10-20 Describing NS2+ Panel Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Port Failure</td>
<td>The auxiliary communication port is not working.</td>
</tr>
<tr>
<td>Auxiliary Port Normal</td>
<td>The auxiliary communication port is working.</td>
</tr>
<tr>
<td>External 5 Volt Normal</td>
<td>The 5 Volt reader power is normal.</td>
</tr>
<tr>
<td>External 5 Volt Alarm</td>
<td>The 5 Volt reader power is shorted.</td>
</tr>
<tr>
<td>Ground Fault Alarm</td>
<td>An input point or reader is shorted to earth ground causing a ground fault.</td>
</tr>
<tr>
<td>Ground Fault Normal</td>
<td>An input point or reader that caused the ground fault has returned to normal.</td>
</tr>
<tr>
<td>Low Voltage Alarm</td>
<td>Battery voltage is low.</td>
</tr>
<tr>
<td>Low Voltage Normal</td>
<td>Battery voltage is normal.</td>
</tr>
<tr>
<td>Panel Communication Alarm</td>
<td>Communication with the control panel has been lost.</td>
</tr>
<tr>
<td>Panel Communication Normal</td>
<td>Communication with the control panel has been restored.</td>
</tr>
<tr>
<td>Panel Reset</td>
<td>The control panel has been reset.</td>
</tr>
<tr>
<td>Poll Response Alarm</td>
<td>The control panel is NOT responding to computer polling.</td>
</tr>
<tr>
<td>Poll Response Normal</td>
<td>The control panel is responding normally to computer polling.</td>
</tr>
<tr>
<td>Primary Power Failure</td>
<td>Control panel primary power has been lost.</td>
</tr>
<tr>
<td>Primary Power Normal</td>
<td>Control panel primary power has been restored.</td>
</tr>
<tr>
<td>Tamper Switch Alarm</td>
<td>The control panel service door is open.</td>
</tr>
<tr>
<td>Tamper Switch Normal</td>
<td>The control panel service door is closed.</td>
</tr>
</tbody>
</table>
### Table 10-21 Describing N-1000-II/PW-2000-II Panel Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Port Failure</td>
<td>The auxiliary communication port is not working.</td>
</tr>
<tr>
<td>Auxiliary Port Normal</td>
<td>The auxiliary communication port is working.</td>
</tr>
<tr>
<td>Panel Communication Alarm</td>
<td>Communication with the control panel has been lost.</td>
</tr>
<tr>
<td>Panel Communication Normal</td>
<td>Communication with the control panel has been restored.</td>
</tr>
<tr>
<td>Panel Reset</td>
<td>The control panel has been reset.</td>
</tr>
<tr>
<td>Poll Response Alarm</td>
<td>The control panel is NOT responding to computer polling.</td>
</tr>
<tr>
<td>Poll Response Normal</td>
<td>The control panel is responding normally to computer polling.</td>
</tr>
<tr>
<td>Primary Power Failure</td>
<td>Control panel primary power has been lost.</td>
</tr>
<tr>
<td>Primary Power Normal</td>
<td>Control panel primary power has been restored.</td>
</tr>
</tbody>
</table>

### Table 10-22 Describing N-1000-III/PW-2000-IV Panel Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary Port Failure</td>
<td>The auxiliary communication port is not working properly.</td>
</tr>
<tr>
<td>Auxiliary Port Normal</td>
<td>The auxiliary communication port is working properly.</td>
</tr>
<tr>
<td>External 5 Volt Alarm</td>
<td>The 5 volt reader power is shorted.</td>
</tr>
<tr>
<td>External 5 Volt Normal</td>
<td>The 5 volt reader power is normal.</td>
</tr>
<tr>
<td>Ground Fault Alarm</td>
<td>An input point is shorted to earth ground causing a ground fault.</td>
</tr>
<tr>
<td>Ground Fault Normal</td>
<td>An input point that caused the ground fault has returned to normal.</td>
</tr>
</tbody>
</table>
### Table 10-22 Describing N-1000-III/PW-2000-IV Panel Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Voltage Alarm</td>
<td>Battery voltage is low.</td>
</tr>
<tr>
<td>Low Voltage Normal</td>
<td>Battery voltage is normal.</td>
</tr>
<tr>
<td>Panel Communication Alarm</td>
<td>Communication with the control panel has been lost.</td>
</tr>
<tr>
<td>Panel Communication Normal</td>
<td>Communication with the control panel has been restored.</td>
</tr>
<tr>
<td>Panel Reset</td>
<td>The control panel has been reset.</td>
</tr>
<tr>
<td>Poll Response Alarm</td>
<td>The control panel is not responding to computer polling.</td>
</tr>
<tr>
<td>Poll Response Normal</td>
<td>The control panel is responding normally to computer polling.</td>
</tr>
<tr>
<td>Primary Power Failure</td>
<td>Control panel primary power has been lost.</td>
</tr>
<tr>
<td>Primary Power Normal</td>
<td>Control panel primary power has been restored.</td>
</tr>
<tr>
<td>Tamper Switch Alarm</td>
<td>The control panel service door is open.</td>
</tr>
<tr>
<td>Tamper Switch Normal</td>
<td>The control panel service door is closed.</td>
</tr>
</tbody>
</table>

### Table 10-23 Describing P-Series SIO Board Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poll Response Alarm</td>
<td>The SIO Board is NOT responding to polling.</td>
</tr>
<tr>
<td>Poll Response Normal</td>
<td>The SIO Board is responding to polling.</td>
</tr>
<tr>
<td>Primary Power Failure</td>
<td>Primary power is down. Make a service call.</td>
</tr>
<tr>
<td>Primary Power Normal</td>
<td>You have about 2 hours of backup power.</td>
</tr>
</tbody>
</table>
The PRO-2200 enclosure is open. Check to see if service is done or dispatch security as needed. The tamper switch is a Norther Computers switch. When the door to the enclosure is opened (switch open), the firmware reports a Tamper Switch Alarm immediately, which is also shown at the same time as a Tamper Switch Alarm in the Alarm View of WIN-PAK.

The PRO-2200 enclosure is now closed. When the door to the enclosure is closed (switch closed), the firmware reports a Tamper Switch Normal after approximately 3 seconds, which is also shown at that time as a Tamper Switch Normal in the Alarm View of WIN-PAK.

**Table 10-23 Describing P-Series SIO Board Actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tamper Switch Alarm</td>
<td>The PRO-2200 enclosure is open. Check to see if service is done or dispatch security as needed. The tamper switch is a Norther Computers switch. When the door to the enclosure is opened (switch open), the firmware reports a Tamper Switch Alarm immediately, which is also shown at the same time as a Tamper Switch Alarm in the Alarm View of WIN-PAK.</td>
</tr>
<tr>
<td>Tamper Switch Normal</td>
<td>The PRO-2200 enclosure is now closed. When the door to the enclosure is closed (switch closed), the firmware reports a Tamper Switch Normal after approximately 3 seconds, which is also shown at that time as a Tamper Switch Normal in the Alarm View of WIN-PAK.</td>
</tr>
</tbody>
</table>

**Table 10-24 Describing P-Series Dial-Up Actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorrect Password</td>
<td>An incorrect password attempt was made to access the controller.</td>
</tr>
<tr>
<td>Panel Configuration Error</td>
<td>An error was generated by an incorrect panel configuration.</td>
</tr>
<tr>
<td>Panel Remote Dial-Up Failed</td>
<td>The N-485 remote dial-up is NOT Working properly.</td>
</tr>
<tr>
<td>Panel Remote Dial-Up Successful</td>
<td>The N-485 remote dial-up is working properly.</td>
</tr>
<tr>
<td>Poll Response Alarm</td>
<td>The P-Series Intelligent Controller is NOT responding to computer polling.</td>
</tr>
<tr>
<td>Poll Response Normal</td>
<td>The P-Series Intelligent Controller is responding to computer polling.</td>
</tr>
<tr>
<td>Primary Power Failure</td>
<td>P-Series Intelligent Controller primary power has been lost.</td>
</tr>
<tr>
<td>Primary Power Normal</td>
<td>P-Series Intelligent Controller primary power has been restored.</td>
</tr>
<tr>
<td>Tamper Switch Alarm</td>
<td>The P-Series Intelligent Controller service door is open.</td>
</tr>
<tr>
<td>Tamper Switch Normal</td>
<td>The P-Series Intelligent Controller service door is closed</td>
</tr>
<tr>
<td>Unsupported Panel</td>
<td></td>
</tr>
</tbody>
</table>
### Table 10-25 Describing P-Series Reader Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Passback Violation</td>
<td>A card was denied entry because it has already been used going in/out without properly going out/in.</td>
</tr>
<tr>
<td>Anti-Passback Violation, door not used</td>
<td>A soft Anti-Passback violation has occurred. The door was not opened by the card holder.</td>
</tr>
<tr>
<td>Anti-Passback Violation, door used</td>
<td>A soft Anti-Passback violation has occurred. The door was opened by the card holder.</td>
</tr>
<tr>
<td>Card Not Found</td>
<td>A card was denied entry because it was unknown to the reader.</td>
</tr>
<tr>
<td>Door Ajar</td>
<td>The door has been left open longer than it should be based on a valid entry.</td>
</tr>
<tr>
<td>Door Locked</td>
<td>Door is in a “Locked” mode of operation. No card access granted, free egress is allowed.</td>
</tr>
<tr>
<td>Door Normal</td>
<td>The door position is now closed.</td>
</tr>
<tr>
<td>Door Troubled</td>
<td>The door status can not be accurately displayed due to tampering.</td>
</tr>
<tr>
<td>Door Unlocked</td>
<td>A card was presented to the reader while the door was unlocked.</td>
</tr>
<tr>
<td>Duress, request denied</td>
<td>A duress code was entered. Access was denied.</td>
</tr>
<tr>
<td>Duress, door not used</td>
<td>A duress code was entered. Access was granted. Door was not opened.</td>
</tr>
<tr>
<td>Duress, door used</td>
<td>A duress code was entered. Access was granted. Door was opened.</td>
</tr>
<tr>
<td>Forced Open</td>
<td>The door is in the alarm mode due to invalid entry.</td>
</tr>
<tr>
<td>Free Egress, door not used</td>
<td>Free egress request was granted. Door was not opened.</td>
</tr>
<tr>
<td>Free Egress, door not verified</td>
<td>Free egress request was granted. Door is not monitored.</td>
</tr>
<tr>
<td>Free Egress, door used</td>
<td>Free egress request was granted. Door was opened.</td>
</tr>
<tr>
<td>Host Grant, card downloaded</td>
<td>Access was granted to the user. The P-Series Intelligent Controller was updated with valid card information.</td>
</tr>
<tr>
<td>Host Grant, door unlocked</td>
<td>Access was granted to the user. The P-Series Intelligent Controller was NOT updated with valid card information.</td>
</tr>
<tr>
<td>Invalid Format</td>
<td>The P-Series Intelligent Controller detected an invalid card format.</td>
</tr>
</tbody>
</table>
### Table 10-25 Describing P-Series Reader Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Format, reverse read</td>
<td>The P-Series Intelligent Controller detected a card swiped backwards. Invalid card format.</td>
</tr>
<tr>
<td>Invalid PIN</td>
<td>A card was denied entry because it was used with an invalid PIN.</td>
</tr>
<tr>
<td>Invalid Site Code</td>
<td>A card was denied entry because it did not have a proper facility code.</td>
</tr>
<tr>
<td>Invalid Time Zone</td>
<td>A card was denied entry because it was used outside its time report.</td>
</tr>
<tr>
<td>Issue Code</td>
<td>An invalid issue code was presented to the reader.</td>
</tr>
<tr>
<td>Never allowed at this door</td>
<td>This card is never allowed at this door even if Host Grant is enabled.</td>
</tr>
<tr>
<td>No second card presented</td>
<td>This door is using the two man rule. A second valid card was not presented to the reader.</td>
</tr>
<tr>
<td>Site Code Verified, door not used</td>
<td>Door is in the facility or site code mode. A valid facility or site code was presented. The door was not opened by card holder.</td>
</tr>
<tr>
<td>Site Code Verified, door used</td>
<td>Door is in the facility or site code mode. A valid facility or site code was presented. The door was opened by card holder.</td>
</tr>
<tr>
<td>Trace Card</td>
<td>A card that is traced was used and entry was granted.</td>
</tr>
<tr>
<td>Valid Card, door not used</td>
<td>A valid card was presented to the reader but the door was not opened during its pulse time.</td>
</tr>
<tr>
<td>Valid Card, door used</td>
<td>A valid card was presented to the reader and the door was opened.</td>
</tr>
</tbody>
</table>

### Table 10-26 Describing P-Series Input-Generic (Input P-Series Supervised) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Active</td>
<td>The input is in the alarm state.</td>
</tr>
<tr>
<td>Input Normal</td>
<td>The input is in the normal state.</td>
</tr>
<tr>
<td>Input Troubled</td>
<td>The status can not be accurately displayed because of tampering.</td>
</tr>
</tbody>
</table>

### Table 10-27 Describing P-Series Output (Output P-Series) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-energized</td>
<td>The output is not energized.</td>
</tr>
</tbody>
</table>
### Table 10-27 Describing P-Series Output (Output P-Series) Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Energized</td>
<td>The output is energized.</td>
</tr>
<tr>
<td>Trouble</td>
<td>The output is not responding.</td>
</tr>
</tbody>
</table>

### Table 10-28 Describing Galaxy Panel Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Cancel</td>
<td></td>
</tr>
<tr>
<td>Alarm Reset</td>
<td></td>
</tr>
<tr>
<td>Automatic Test</td>
<td></td>
</tr>
<tr>
<td>Battery Restore</td>
<td>The Module Battery which was low is restored.</td>
</tr>
<tr>
<td>Battery Trouble</td>
<td>The Module Battery is low.</td>
</tr>
<tr>
<td>Code Tamper</td>
<td>Wrong code alarm act.</td>
</tr>
<tr>
<td>Comm Fail</td>
<td>The communication between module and RS485 is lost.</td>
</tr>
<tr>
<td>Comm Restore</td>
<td>The communication between module and RS485 is restored.</td>
</tr>
<tr>
<td>Control Unit Fuse</td>
<td></td>
</tr>
<tr>
<td>Control Unit Fuse Trouble</td>
<td>The control unit fuse is restored.</td>
</tr>
<tr>
<td>Control Unit Fuse Trouble</td>
<td>The control unit fuse is in trouble.</td>
</tr>
<tr>
<td>Local Program End</td>
<td>Engineer mode exited.</td>
</tr>
<tr>
<td>Manual Test</td>
<td>Engineer test</td>
</tr>
<tr>
<td>Module AC Fail Restore</td>
<td>Module AC Fail is restored.</td>
</tr>
<tr>
<td>Module AC Fail Trouble</td>
<td>Module AC Fail is in trouble.</td>
</tr>
<tr>
<td>Module Removed</td>
<td>Module Removed</td>
</tr>
<tr>
<td>Panel Cold Start</td>
<td>Power Up Panel.</td>
</tr>
<tr>
<td>Power Up</td>
<td>Warm start of panel.</td>
</tr>
<tr>
<td>Program Begin</td>
<td>Engineer mode entered.</td>
</tr>
<tr>
<td>Recent Close</td>
<td>Panel Full Set</td>
</tr>
</tbody>
</table>
### Table 10-28 Describing Galaxy Panel Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Call End</td>
<td>Remote Call End</td>
</tr>
<tr>
<td>Remote Call Start</td>
<td>Remote Call is complete.</td>
</tr>
<tr>
<td>RF Jam</td>
<td>RF signal is jammed.</td>
</tr>
<tr>
<td>RF Jam Restore</td>
<td>RF signal which was jammed is restored</td>
</tr>
<tr>
<td>RF NVM RAM Fail</td>
<td>RF NVM RAM Fail</td>
</tr>
<tr>
<td>Standby Battery Low</td>
<td>Standby Battery is low</td>
</tr>
<tr>
<td>Standby Battery OK</td>
<td>Standby Battery is OK.</td>
</tr>
<tr>
<td>Tamper Alarm</td>
<td>Module is tampered.</td>
</tr>
<tr>
<td>Tamper Restore</td>
<td>Module tampered is restored.</td>
</tr>
<tr>
<td>Tel. Line Fail Restore</td>
<td>Module telephone line fail is restored.</td>
</tr>
<tr>
<td>Tel. Line Fail Trouble</td>
<td>Module telephone line fail is in trouble.</td>
</tr>
<tr>
<td>Time/Date changed</td>
<td>The time and date of the panel is changed.</td>
</tr>
<tr>
<td>Unset Early</td>
<td>Panel is unset.</td>
</tr>
<tr>
<td>Walk Test End</td>
<td>Walk Test is finished.</td>
</tr>
<tr>
<td>Walk Test Start</td>
<td>Walk Test is started.</td>
</tr>
</tbody>
</table>

### Table 10-29 Describing RS-232 Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232 Link OK</td>
<td>The RS-232 port is communicating properly.</td>
</tr>
<tr>
<td>RS-232 Link Trouble</td>
<td>The RS-232 port is NOT communicating properly.</td>
</tr>
</tbody>
</table>
### Table 10-30 Describing RS-232 Port (Single Panel) Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop Alarm</td>
<td>The RS-232 Port (Single Panel) is NOT working properly.</td>
</tr>
<tr>
<td>Loop OK</td>
<td>The RS-232 Port (Single Panel) is working properly.</td>
</tr>
</tbody>
</table>

### Table 10-31 Describing Schedule Server Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server OK</td>
<td>The Schedule Server is operating normally.</td>
</tr>
<tr>
<td>Server Trouble</td>
<td>The Schedule Server is not operating properly. Verify that the “WIN-PAK Schedule Server” is running in the WIN-PAK Service Manager.</td>
</tr>
</tbody>
</table>

### Table 10-32 Describing Tracking Server Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server OK</td>
<td>The Tracking Server is working.</td>
</tr>
<tr>
<td>Server Trouble</td>
<td>The Tracking and Muster Server is not operating properly. Verify that the WIN-PAK Muster Server is running in the WIN-PAK Service Manager.</td>
</tr>
</tbody>
</table>

### Table 10-33 Describing Video Switcher (CCTV Switcher) Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCTV Switcher OK</td>
<td>The video switcher is working properly.</td>
</tr>
<tr>
<td>CCTV Switcher Trouble</td>
<td>The video switcher is NOT working properly.</td>
</tr>
</tbody>
</table>

### Table 10-34 Describing Galaxy Communication Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galaxy Communication Alarm</td>
<td>Galaxy Communication is in trouble.</td>
</tr>
</tbody>
</table>
### Table 10-34 Describing Galaxy Communication Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galaxy Communication Ok</td>
<td>Galaxy Communication is working properly.</td>
</tr>
<tr>
<td>Galaxy Polling Started</td>
<td>Galaxy is started polling.</td>
</tr>
<tr>
<td>Galaxy Polling Started</td>
<td>Galaxy is stopped polling.</td>
</tr>
</tbody>
</table>

### Table 10-35 Describing Galaxy Group Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Alarm Cancel</td>
<td>Galaxy Group alarm is cancelled.</td>
</tr>
<tr>
<td>Group Alarm Confirm</td>
<td>Galaxy Group alarm is confirmed.</td>
</tr>
<tr>
<td>Group Alarm Reset</td>
<td>Galaxy Group alarm is reset.</td>
</tr>
<tr>
<td>Group Automatic Set</td>
<td>Galaxy Group is automatically set.</td>
</tr>
<tr>
<td>Group Bypass</td>
<td>Galaxy Group is bypassed</td>
</tr>
<tr>
<td>Group Closing Extend</td>
<td>The Galaxy group auto-arm extend is delayed.</td>
</tr>
<tr>
<td>Group Early Unset</td>
<td>The Galaxy group is unset early.</td>
</tr>
<tr>
<td>Group Fail to Set</td>
<td>The Galaxy group is fail to set.</td>
</tr>
<tr>
<td>Group Full Set</td>
<td>The Galaxy group is set.</td>
</tr>
<tr>
<td>Group in Alarm</td>
<td>Group in Alarm</td>
</tr>
<tr>
<td>Group Late to Open</td>
<td></td>
</tr>
<tr>
<td>Group Late to Set</td>
<td></td>
</tr>
<tr>
<td>Group Normal</td>
<td>Group returned to Normal.</td>
</tr>
<tr>
<td>Group Part Set</td>
<td></td>
</tr>
<tr>
<td>Group Part Unset</td>
<td></td>
</tr>
<tr>
<td>Group Rearm after alarm</td>
<td>Rearm after alarm.</td>
</tr>
</tbody>
</table>
### Table 10-35 Describing Galaxy Group Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Recent Close</td>
<td>Previous alarm was within 5 mins of set.</td>
</tr>
<tr>
<td>Group Reset Required</td>
<td>Reset is required to do any operation at the Group.</td>
</tr>
<tr>
<td>Group Unbypass</td>
<td>Group is unbypassed.</td>
</tr>
<tr>
<td>Group Unset</td>
<td>Group is unset.</td>
</tr>
<tr>
<td>Group Walk Test End</td>
<td>Group walk test is finished.</td>
</tr>
<tr>
<td>Group Walk Test Start</td>
<td>Group walk test is started.</td>
</tr>
<tr>
<td>Lid Tamper</td>
<td>Lid is tampered.</td>
</tr>
<tr>
<td>Lid Tamper Restore</td>
<td>Lid tamper is restored.</td>
</tr>
</tbody>
</table>

### Table 10-36 Describing Galaxy Keypad Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keypad Alarm</td>
<td>Keypad raised an alarm.</td>
</tr>
<tr>
<td>Keypad Communication Loss</td>
<td>The communication with keypad is lost.</td>
</tr>
<tr>
<td>Keypad OK</td>
<td>Keypad is working properly.</td>
</tr>
<tr>
<td>Keypad Tamper</td>
<td>Keypad is tampered.</td>
</tr>
<tr>
<td>Keypad Tamper Restore</td>
<td>Keypad tamper is restored.</td>
</tr>
</tbody>
</table>

### Table 10-37 Describing Galaxy Keyprox Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Door Forced</td>
<td></td>
</tr>
<tr>
<td>Door Propped</td>
<td>The door is supported with a prop.</td>
</tr>
<tr>
<td>Invalid Card</td>
<td>The accessed card is invalid.</td>
</tr>
<tr>
<td>Keyprox Alarm</td>
<td></td>
</tr>
</tbody>
</table>
### Table 10-37 Describing Galaxy Keyprox Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyprox Communication Loss</td>
<td>The communication with keyprox is lost.</td>
</tr>
<tr>
<td>Keyprox OK</td>
<td>Keyprox is working properly.</td>
</tr>
<tr>
<td>Keyprox Tamper</td>
<td>Keyprox is tampered.</td>
</tr>
<tr>
<td>Keyprox Tamper Restore</td>
<td>Keyprox tamper is restored.</td>
</tr>
<tr>
<td>Rejected Card</td>
<td>The accessed card is the rejected card.</td>
</tr>
<tr>
<td>Valid Card</td>
<td>The accessed card is the valid card.</td>
</tr>
</tbody>
</table>

### Table 10-38 Describing Fusion DVR Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVR Online</td>
<td>DVR is OK and online.</td>
</tr>
<tr>
<td>DVR Offline</td>
<td>DVR is not online. Connection is lost or is not able to establish the connection with the DVR.</td>
</tr>
<tr>
<td>Fusion Stationary Camera Video signal restored.</td>
<td></td>
</tr>
<tr>
<td>Fusion Stationary Camera Video signal loss.</td>
<td></td>
</tr>
<tr>
<td>Fusion Stationary Camera Camera motion alarm.</td>
<td></td>
</tr>
<tr>
<td>Fusion PTZ Camera Video signal restored.</td>
<td></td>
</tr>
<tr>
<td>Fusion PTZ Camera Video signal loss.</td>
<td></td>
</tr>
<tr>
<td>Fusion PTZ Camera Camera motion alarm.</td>
<td></td>
</tr>
<tr>
<td>Fusion DVR Input DVR Input is normal.</td>
<td></td>
</tr>
<tr>
<td>Fusion DVR Input DVR input is in alarm state.</td>
<td></td>
</tr>
<tr>
<td>Fusion DVR Output DVR output is de-energized.</td>
<td></td>
</tr>
<tr>
<td>Fusion DVR Output DVR output is energized.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 10-39 Describing HRDP DVR Action Groups

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HRDP DVR</td>
<td>DVR is OK and online.</td>
</tr>
<tr>
<td>HRDP DVR</td>
<td>DVR is not online. Connection is lost or is not able to establish connection with the DVR.</td>
</tr>
<tr>
<td>HRDP Stationary Camera</td>
<td>Video signal restored.</td>
</tr>
<tr>
<td>HRDP Stationary Camera</td>
<td>Video signal loss.</td>
</tr>
<tr>
<td>HRDP Stationary Camera</td>
<td>Camera motion alarm.</td>
</tr>
<tr>
<td>HRDP PTZ Camera</td>
<td>Video signal restored.</td>
</tr>
<tr>
<td>HRDP PTZ Camera</td>
<td>Video signal loss.</td>
</tr>
<tr>
<td>HRDP PTZ Camera</td>
<td>Camera motion alarm.</td>
</tr>
<tr>
<td>HRDP DVR Input</td>
<td>DVR Input is normal.</td>
</tr>
<tr>
<td>HRDP DVR Input</td>
<td>DVR input is in alarm state.</td>
</tr>
<tr>
<td>HRDP DVR Output</td>
<td>DVR output is deenergized.</td>
</tr>
<tr>
<td>HRDP DVR Output</td>
<td>DVR output is energized.</td>
</tr>
</tbody>
</table>

### Table 10-40 Describing NetAXS Entrance Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Expired</td>
<td>Card Expired.</td>
</tr>
<tr>
<td>Card Found</td>
<td>A valid card has been used and entry was granted.</td>
</tr>
<tr>
<td>Card Not Found</td>
<td>Card Not Found.</td>
</tr>
<tr>
<td>Duress Pin Entered</td>
<td>Duress Pin Entered.</td>
</tr>
<tr>
<td>Escort access granted</td>
<td>Escort access granted.</td>
</tr>
<tr>
<td>Hard Anti-Passback Violation</td>
<td>Card was denied entry because it has already been used going in/out without properly going out/in.</td>
</tr>
<tr>
<td>Host grant, Card downloaded</td>
<td>Access was granted to the user (if event is within 2 minutes of computer time). The control panel was updated with valid card information.</td>
</tr>
</tbody>
</table>
### Table 10-40 Describing NetAXS Entrance Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host grant, Door unlocked</td>
<td>Access was granted to the user (if event is within 2 minutes of computer time). The control panel was not updated with valid card information</td>
</tr>
<tr>
<td>Temp card expired number of uses</td>
<td>Temporary card expired by number of uses.</td>
</tr>
<tr>
<td>Input point tamper - Cut</td>
<td>Input point tamper - Cut.</td>
</tr>
<tr>
<td>Input point tamper - Shorted</td>
<td>Input point tamper - Shorted.</td>
</tr>
<tr>
<td>Invalid Format</td>
<td>Card was denied entry because it was unknown to the reader.</td>
</tr>
<tr>
<td>Invalid Pin</td>
<td>A card was denied entry because it was used with an invalid PIN.</td>
</tr>
<tr>
<td>Site Code Violation</td>
<td>Card was denied because it did not have a proper site code.</td>
</tr>
<tr>
<td>Soft Anti-Passback Violation</td>
<td>Card was denied entry because it has already been used going in/out without properly going out/in.</td>
</tr>
<tr>
<td>Supervisor Authenticated</td>
<td>Supervisor Authenticated.</td>
</tr>
<tr>
<td>Supervisor Card Found</td>
<td>Supervisor Card Present.</td>
</tr>
<tr>
<td>Supervisor mode disabled</td>
<td>Supervisor mode disabled.</td>
</tr>
<tr>
<td>Supervisor mode enabled</td>
<td>Supervisor mode enabled.</td>
</tr>
<tr>
<td>Supervisor Not Enabled</td>
<td>Supervisor Not Enabled.</td>
</tr>
<tr>
<td>Supervisor Required</td>
<td>Supervisor Required.</td>
</tr>
<tr>
<td>Temporary card expired by date</td>
<td>Temporary card expired by date.</td>
</tr>
<tr>
<td>Time Zone Violation</td>
<td>A card was denied because it was used outside its time period.</td>
</tr>
<tr>
<td>Trace Card</td>
<td>A card that is being traced was used and entry was granted.</td>
</tr>
<tr>
<td>VIP Card Found</td>
<td>VIP Card Present.</td>
</tr>
</tbody>
</table>
### Table 10-41 Describing NetAXS Group Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-energized</td>
<td>The group of relays is not energized.</td>
</tr>
<tr>
<td>Energized</td>
<td>The group of relays is energized.</td>
</tr>
</tbody>
</table>

### Table 10-42 Describing NetAXS Input Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Alarm</td>
<td>The Input is in the alarm state.</td>
</tr>
<tr>
<td>Input Normal</td>
<td>The Input is in the normal state.</td>
</tr>
<tr>
<td>Input Trouble Cut</td>
<td>The Input is cut.</td>
</tr>
<tr>
<td>Input Trouble Short</td>
<td>The Input is shorted.</td>
</tr>
</tbody>
</table>

### Table 10-43 Describing NetAXS NX4 Device Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poll Response Alarm</td>
<td>The NetAXS I/O Board is NOT responding to polling.</td>
</tr>
<tr>
<td>Poll Response Normal</td>
<td>The NetAXS I/O Board is responding normally to polling.</td>
</tr>
<tr>
<td>Primary Power Failure</td>
<td>The NetAXS I/O Board primary power has been lost.</td>
</tr>
<tr>
<td>Primary Power Normal</td>
<td>The NetAXS I/O Board primary power has been restored.</td>
</tr>
<tr>
<td>Tamper Switch Alarm</td>
<td>The NetAXS I/O Board service door is open.</td>
</tr>
<tr>
<td>Tamper Switch Normal</td>
<td>The NetAXS I/O Board service door is closed.</td>
</tr>
</tbody>
</table>

### Table 10-44 Describing NetAXS Output Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-energized</td>
<td>The Output relay is on.</td>
</tr>
<tr>
<td>Energized</td>
<td>The Output relay is off.</td>
</tr>
<tr>
<td>Trouble</td>
<td>The Output relay status is not responding.</td>
</tr>
</tbody>
</table>
### Table 10-45 Describing NetAXS Panel Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery Shorted</td>
<td>The NetAXS backup battery is shorted. Corrective action is required</td>
</tr>
<tr>
<td>Battery Voltage is low</td>
<td>The NetAXS backup battery voltage is low. Corrective action is required.</td>
</tr>
<tr>
<td>Battery Voltage is Normal</td>
<td>The NetAXS backup battery voltage has returned to normal.</td>
</tr>
<tr>
<td>Common Database Deleted</td>
<td>A common database table has been deleted.</td>
</tr>
<tr>
<td>Common Database Updated</td>
<td>A change in the common database table has occurred.</td>
</tr>
<tr>
<td>Hybrid Mode</td>
<td>NetAXS Gateway has enabled Hybrid Mode.</td>
</tr>
<tr>
<td>Offline</td>
<td>A NetAXS auxiliary board is offline.</td>
</tr>
<tr>
<td>Online</td>
<td>A NetAXS auxiliary board is online.</td>
</tr>
<tr>
<td>Panel Communication Alarm</td>
<td>Communication to the control panel has been lost.</td>
</tr>
<tr>
<td>Panel Communication Normal</td>
<td>Communication to the control panel has been restored.</td>
</tr>
<tr>
<td>Panel Database Deleted</td>
<td>A panel database table has been deleted.</td>
</tr>
<tr>
<td>Panel Database Updated</td>
<td>A change in panel database table has occurred.</td>
</tr>
<tr>
<td>Panel Reset</td>
<td>The control panel has been reset.</td>
</tr>
<tr>
<td>Panel Restarted</td>
<td>The panel has restarted. If this issue continues repeatedly contact your service provider.</td>
</tr>
<tr>
<td>Panel Time Changed</td>
<td>Panel time has been changed.</td>
</tr>
<tr>
<td>Poll Response Alarm</td>
<td>The control panel is not responding to computer polling.</td>
</tr>
<tr>
<td>Poll Response Normal</td>
<td>The control panel is responding normally to computer polling.</td>
</tr>
<tr>
<td>Primary Power Alarm</td>
<td>Control panel primary power has been lost.</td>
</tr>
<tr>
<td>Primary Power Normal</td>
<td>Control panel primary power has been restored.</td>
</tr>
</tbody>
</table>
### Table 10-45 Describing NetAXS Panel Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Watcher Restarted</td>
<td>A NetAXS process has been restarted. If this issue continues repeatedly contact your service provider.</td>
</tr>
<tr>
<td>RTC Clock Error</td>
<td>An error has occurred with the NetAXS clock. Verify that the time and date is set correctly.</td>
</tr>
<tr>
<td>Tamper Alarm</td>
<td>The control panel service door is open.</td>
</tr>
<tr>
<td>Tamper Normal</td>
<td>The control panel service door is closed.</td>
</tr>
<tr>
<td>Unknown System Event</td>
<td>An Unknown System Event has occurred. If this issue continues repeatedly contact your service provider.</td>
</tr>
</tbody>
</table>

### Table 10-46 Describing Fusion Recorder

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorder Disconnected</td>
<td>Alarm raised when DVR is disconnected.</td>
</tr>
<tr>
<td>Recorder Connected</td>
<td>The door is supported with a prop.</td>
</tr>
</tbody>
</table>

### Table 10-47 Describing Fusion Camera

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera User Recording Started</td>
<td>This alarm is raised when an Alarm Event starts Instant Recording.</td>
</tr>
<tr>
<td>Camera User Recording Completed</td>
<td>This alarm is raised when an Alarm Event stops Instant Recording after certain duration.</td>
</tr>
<tr>
<td>Motion Detected</td>
<td>Motion is detected in this camera View.</td>
</tr>
<tr>
<td>Video Lost</td>
<td>Video is lost from this camera.</td>
</tr>
<tr>
<td>Video Restored</td>
<td>Video is restored from this camera.</td>
</tr>
</tbody>
</table>
### Table 10-48 Describing Fusion Recorder Input

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Normal</td>
<td>DVR Input is in normal state.</td>
</tr>
<tr>
<td>Input Alarm</td>
<td>DVR Input is in alarm state.</td>
</tr>
</tbody>
</table>

### Table 10-49 Describing Fusion Recorder Output

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Enabled</td>
<td>DVR Output is Energized.</td>
</tr>
<tr>
<td>Output Disabled</td>
<td>DVR Output is De-energized.</td>
</tr>
</tbody>
</table>

### Table 10-50 Describing Rapid Eye Recorder

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorder Disconnected</td>
<td>Alarm raised when DVR is Disconnected.</td>
</tr>
<tr>
<td>Recorder Connected</td>
<td>Alarm raised when DVR is Connected.</td>
</tr>
<tr>
<td>Session Rejects</td>
<td>RE Sessions exhausted.</td>
</tr>
<tr>
<td>System - Self Restart</td>
<td>RE restarting on internal exception.</td>
</tr>
<tr>
<td>System - Reboot</td>
<td>Manual reboot of RE.</td>
</tr>
<tr>
<td>System - No Video Recording</td>
<td>DVR unable to record cameras.</td>
</tr>
<tr>
<td>System - Storage Devices Missing</td>
<td>DVR hardisk not getting detected by RE.</td>
</tr>
<tr>
<td>System - Time Server Unusable</td>
<td>RE unable to connect to NTP server.</td>
</tr>
<tr>
<td>System - No Synchronization in 24 Hours</td>
<td>RE unable to synchronize to NTP server.</td>
</tr>
<tr>
<td>Rule Engine Action Triggered</td>
<td>Rule Engine configured in RE is triggered.</td>
</tr>
</tbody>
</table>
### Table 10-50 Describing Rapid Eye Recorder

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System - Excessive System Clock Drift</td>
<td>Time difference between NTP Server and RE is large.</td>
</tr>
<tr>
<td>Maintenance - Configuration Modification</td>
<td>Configuration is modified in RE.</td>
</tr>
<tr>
<td>Maintenance - Security Modification</td>
<td>Security settings in RE is modified.</td>
</tr>
<tr>
<td>Maintenance - System Files Modification</td>
<td>System files in RE is modified.</td>
</tr>
<tr>
<td>Maintenance - Synchronize Time</td>
<td>Time has been synchronized in RE.</td>
</tr>
<tr>
<td>Maintenance - Clear Storage</td>
<td>Recordings has been erased on RE.</td>
</tr>
<tr>
<td>Maintenance - Clear Storage</td>
<td>Resetting video stream.</td>
</tr>
<tr>
<td>System - Runtime Failure</td>
<td>Resetting video stream.</td>
</tr>
<tr>
<td>System - Runtime Failure</td>
<td>Runtime error in RE.</td>
</tr>
<tr>
<td>Session Disconnected</td>
<td>Disconnected from RE.</td>
</tr>
<tr>
<td>Session Connected</td>
<td>Connected to RE.</td>
</tr>
</tbody>
</table>

### Table 10-51 Describing RapidEye Camera

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Detected</td>
<td>Motion is detected in this camera view.</td>
</tr>
<tr>
<td>Video Signal Lock</td>
<td>Video lost from this camera.</td>
</tr>
<tr>
<td>Video Signal Unlock</td>
<td>Video restored from this camera.</td>
</tr>
<tr>
<td>Camera Blind Detection Enabled</td>
<td>Camera Blind Detection Enabled for this camera in RE.</td>
</tr>
<tr>
<td>Camera Blind Detection Disabled</td>
<td>Camera Blind Detection Disabled for this camera in RE.</td>
</tr>
</tbody>
</table>
### Table 10-51 Describing RapidEye Camera

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Blur Detection Enabled</td>
<td>Camera Blur Detection Enabled for this camera in RE.</td>
</tr>
<tr>
<td>Video CSD Moved On</td>
<td>Camera scene of view changed.</td>
</tr>
<tr>
<td>Video CSD Moved Off</td>
<td>Camera scene of view restored.</td>
</tr>
<tr>
<td>Video Boost Record On</td>
<td>Boosted Recording for this Camera is turned ON.</td>
</tr>
<tr>
<td>Video Boost Record Off</td>
<td>Boosted Recording for this Camera is turned OFF.</td>
</tr>
<tr>
<td>Started moving in wrong direction</td>
<td>Video Analytics: Object started to move in Wrong Direction.</td>
</tr>
<tr>
<td>Stopped moving in wrong direction</td>
<td>Video Analytics: Object stopped to move in Wrong Direction.</td>
</tr>
<tr>
<td>On fence line</td>
<td>Video Analytics: Object on Fence line.</td>
</tr>
<tr>
<td>Running</td>
<td>Video Analytics: Object/ Person started running.</td>
</tr>
<tr>
<td>Stopped running</td>
<td>Video Analytics: Object/ Person stopped running.</td>
</tr>
<tr>
<td>People converged</td>
<td>Video Analytics: People Converged in an area.</td>
</tr>
<tr>
<td>People passed by</td>
<td>Video Analytics: People passed by.</td>
</tr>
<tr>
<td>Entered restricted zone</td>
<td>Video Analytics: Object/ Person/ Car entered Restricted Zone.</td>
</tr>
<tr>
<td>Exited restricted zone</td>
<td>Video Analytics: Object/ Person/ Car exited Restricted Zone.</td>
</tr>
<tr>
<td>Running in the wrong direction</td>
<td>Video Analytics: Object/ Person started running in wrong direction.</td>
</tr>
<tr>
<td>Trespassing line</td>
<td>Video Analytics: Object/ Person crossed Tress passing line.</td>
</tr>
<tr>
<td>Speeding</td>
<td>Video Analytics: Object/ Car Speeding.</td>
</tr>
<tr>
<td>Made illegal U-turn</td>
<td>Video Analytics: Car made illegal U Turn.</td>
</tr>
<tr>
<td>Car parked in handicapped zone</td>
<td>Video Analytics: Car Parked in Handicapped Zone.</td>
</tr>
<tr>
<td>Pulled off the road</td>
<td>Video Analytics: Car Pulled off the Road.</td>
</tr>
<tr>
<td>Needs assistance</td>
<td>Video Analytics: Car Needs Assistance.</td>
</tr>
<tr>
<td>Counted as exiting</td>
<td>Video Analytics: Car/ Person Counted Entering.</td>
</tr>
</tbody>
</table>
### Table 10-51 Describing RapidEye Camera

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counted as entering</td>
<td>Video Analytics: Car/ Person Counted Exiting.</td>
</tr>
<tr>
<td>Entered lot</td>
<td>Video Analytics: Car entered lot.</td>
</tr>
<tr>
<td>Exited lot</td>
<td>Video Analytics: Car exited lot.</td>
</tr>
<tr>
<td>Removed</td>
<td>Video Analytics: Object removed.</td>
</tr>
<tr>
<td>Left unattended</td>
<td>Video Analytics: Object left unattended.</td>
</tr>
<tr>
<td>Possible theft</td>
<td>Video Analytics: Possible theft of the object.</td>
</tr>
<tr>
<td>Loitering in restricted zone</td>
<td>Video Analytics: Person loitering in restricted zone.</td>
</tr>
<tr>
<td>Counted in lane</td>
<td>Video Analytics: Car counted in lane.</td>
</tr>
<tr>
<td>Entered target zone</td>
<td>Video Analytics: Object/Person/Car entered target zone.</td>
</tr>
<tr>
<td>Staying in target zone</td>
<td>Video Analytics: Object/Person/Car staying in target zone.</td>
</tr>
</tbody>
</table>

### Table 10-52 Describing RapidEye Recorder Input

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Normal</td>
<td>DVR Input is in normal state.</td>
</tr>
<tr>
<td>Input Alarm</td>
<td>DVR Input is in alarm state.</td>
</tr>
</tbody>
</table>

### Table 10-53 Describing RapidEye Relay Output

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Enabled</td>
<td>DVR Output is energized.</td>
</tr>
<tr>
<td>Output Disabled</td>
<td>DVR Output is de-energized.</td>
</tr>
</tbody>
</table>

### Table 10-54 Describing MAXPRO NVR Recorder

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAXPRONVR Server Connected</td>
<td>Alarm raised when NVR is Disconnected.</td>
</tr>
</tbody>
</table>
### Table 10-54 Describing MAXPRO NVR Recorder

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAXPRONVR Server Disconnected</td>
<td>Alarm raised when NVR is Connected.</td>
</tr>
<tr>
<td>Low Disk Space</td>
<td>Alarm raised when disk space is low.</td>
</tr>
<tr>
<td>Recording Server Connected</td>
<td>Alarm raised when the recorder begins recording.</td>
</tr>
<tr>
<td>Recording Server Disconnected</td>
<td>Alarm raised when the recorder stops recording.</td>
</tr>
<tr>
<td>MAXPRONVR Controller Connected</td>
<td>Alarm raised when the PTZ and status is regained by the recorder.</td>
</tr>
<tr>
<td>MAXPRONVR Controller Disconnected</td>
<td>Alarm raised when the PTZ and status is lost by the recorder.</td>
</tr>
</tbody>
</table>

### Table 10-55 Describing MAXPRO NVR Camera

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Blind Detection Enabled</td>
<td>Camera Blind Detection Enabled for this Camera in RE.</td>
</tr>
<tr>
<td>Camera Blind Detection Disabled</td>
<td>Camera Blind Detection Disabled for this Camera in RE.</td>
</tr>
<tr>
<td>Camera Blur Detection Enabled</td>
<td>Camera Blur Detection Enabled for this Camera in RE.</td>
</tr>
<tr>
<td>Camera Blur Detection Disabled</td>
<td>Camera Blur Detection Disabled for this Camera in RE.</td>
</tr>
<tr>
<td>Video CSD Moved On</td>
<td>Camera Scene of View Changed.</td>
</tr>
<tr>
<td>Video CSD Moved Off</td>
<td>Camera Scene of View Restored.</td>
</tr>
<tr>
<td>Camera User Recording Started</td>
<td>User started Recording.</td>
</tr>
<tr>
<td>Camera User Recording Completed</td>
<td>User stopped Recording.</td>
</tr>
</tbody>
</table>
### Table 10-55 Describing MAXPRO NVR Camera

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Disconnected</td>
<td>Camera disconnected from NVR.</td>
</tr>
<tr>
<td>Camera Connected</td>
<td>Camera connected to NVR.</td>
</tr>
<tr>
<td>Camera Background Recording Disabled</td>
<td>Camera Background Recording Disabled.</td>
</tr>
<tr>
<td>Camera Background Recording Enabled</td>
<td>Camera Background Recording Enabled.</td>
</tr>
<tr>
<td>Camera Event Recording Started</td>
<td>Camera Event Recording Started.</td>
</tr>
<tr>
<td>Camera Event Recording Completed</td>
<td>Camera Event Recording Completed.</td>
</tr>
<tr>
<td>Camera Disabled</td>
<td>Camera disabled in NVR.</td>
</tr>
<tr>
<td>Camera Enabled</td>
<td>Camera Enabled in NVR.</td>
</tr>
<tr>
<td>Camera User recording error</td>
<td>Failed to record.</td>
</tr>
<tr>
<td>Camera NoMotion Detected</td>
<td>No Motion is detected in this Camera View.</td>
</tr>
<tr>
<td>Camera Motion Detected</td>
<td>Motion is detected in this Camera View.</td>
</tr>
</tbody>
</table>

### Table 10-56 Describing HRDP Recorder

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorder Disconnected</td>
<td>Alarm raised when DVR is disconnected.</td>
</tr>
<tr>
<td>Recorder Connected</td>
<td>Alarm raised when DVR is connected.</td>
</tr>
</tbody>
</table>
Moving Loops and Panels
You can move loops and panels across communication servers if the following conditions are met:

1. Ports are available in the destination communication server.
2. The same type of loops are available in the destination communication server, while moving panels attached to loops. For example, when you move a panel attached to a P-Series loop, the destination communication server must have a P-Series Loop.

Moving loops across communication servers
To move a loop across communication servers:

1. Select a loop to be moved in the source communication server.
2. Drag and drop the loop onto the destination communication server. A message appears indicating that the port is reset for the loop.

Table 10-57 Describing HRDP Camera

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Detected</td>
<td>Motion is detected in this Camera View.</td>
</tr>
<tr>
<td>Video lost</td>
<td>Video lost from this camera.</td>
</tr>
<tr>
<td>Video restored</td>
<td>Video restored from this camera.</td>
</tr>
</tbody>
</table>

Table 10-58 Describing HRDP Recorder Input

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Normal</td>
<td>DVR Input is in Normal State.</td>
</tr>
<tr>
<td>Input Alarm</td>
<td>DVR Input is in Alarm State.</td>
</tr>
</tbody>
</table>

Table 10-59 Describing HRDP Recorder Output

<table>
<thead>
<tr>
<th>Action</th>
<th>Message/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Enabled</td>
<td>DVR Output is Energized.</td>
</tr>
<tr>
<td>Output Disabled</td>
<td>DVR Output is De-energized.</td>
</tr>
</tbody>
</table>
3. Click OK. The loop is moved to the destination communication server.

**Moving direct panels across communication servers**

To move a direct panel across communication servers

1. Select a direct panel (not attached to a loop) in the source communication server.
2. Drag and drop the direct panel onto the destination communication server.
3. Release the mouse button at the destination communication server. The direct panel is moved.

Moving panels across communication servers

To move a panel attached to a loop:

1. Select a panel (attached to a loop) in the source communication server.
2. Drag and drop the panel onto the destination communication server.
3. Release the mouse button at the same type loop of the destination communication server. The panel is moved.
**Copying Loops and Panels**

You can create a copy of loops and panels onto another communication servers if the following conditions are met:

1. Ports are available in the destination communication server.
2. The same type of loops are available in the destination communication server, while creating a copy of panels attached to loops. For example, you can create a copy of direct panel onto another communication server, but not onto a Modem Pool or a Loop on the communication server.

**Copying a direct panel**

To create a copy of a panel to other communication server:

1. Right-click the panel icon, hold and drag the panel icon to the Communication Server onto which you want it to be copied. When you release the mouse button, the pop-up (Move or Copy) menu is displayed, enabling you to select the desired action.

2. Click **Copy** to create a copy of it. The **Copying Device** dialog box appears, with an incremental number appended onto the device name.

3. Rename the device, or accept the default name.
4. Click **OK**. A message appears indicating that the loop or port has been reset.

5. Click **OK**. The device is copied to the other communication server.
Initializing Panels

Programming information entered into the WIN-PAK System is sent to the panels before it takes effect.

- When panels are first added to the system, they are initialized so that the information entered during panel configuration is sent to the panels.
- Likewise, whenever there is a change in the panel configuration, the new information is sent to the panels.
- The only exceptions to this are changes to individual cards and card holders, which are automatically sent to the panels.
- Panels are initialized from the Floor Plan view (the background) or from the Control Map. See the see "Initializing Panels from Floor Plan" in Chapter 12 section in the chapter Floor Plan for details on panel initializing on floor plans.

See the see "Initializing a Panel from Control Map" in Chapter 11 section in the chapter Defining Areas for details on panel initializing on floor plans.
Defining Areas

In this chapter...

Introduction 11-2
Defining Access Areas 11-3
Defining Tracking and Mustering Areas 11-7
Defining Control Areas 11-20
Viewing Control Maps 11-24
Defining Areas

Introduction

Areas in WIN-PAK are classified as Access Areas, Control Areas, Tracking Areas, and Muster Areas.

Access Areas are a logical grouping of doors and readers to which card holders can gain access. After the access areas are defined, they are mapped to access levels. When card holders are assigned to an access level, they can gain access to the access area for the time zone and access permissions set for the access level.

**Example:** An access area A can be defined with doors D1, D2 and readers R1 and R2, and a card holder C1 can be assigned to an access level AL1. When the access area A is mapped to the access level AL1, the card holder C1 can gain access to D1, D2, R1, and R2.

Control areas are logical areas containing devices such as communication servers, loops, panels, input points, output points, groups, and readers. Operators who are assigned to a control area, can view the status of the devices in the control areas and their relationship using a Control Map. In addition, an operator can control the devices from the control map.

Tracking Areas are used for tracking card holder movements and Mustering areas are used for tracking card holder movements in the event of emergency situations such as fire.

This chapter describes how to configure access areas, configure control areas and view control maps, define tracking and mustering areas.
Defining Access Areas

Access Areas are the logical areas in the Access Control System, in which entrances such as doors and readers are placed. The access area definition in WIN-PAK appears as a tree, to which branches and entrances can be added. The access areas are represented as branches, and panels, readers, and doors are represented as entrances by which you can gain access to the areas. An entrance can be added to the Access Area folder or it can be added to a branch inside the Access Area folder.

Example: If a reader R1 is located in the first floor of a building, you can define “First Floor” as the branch and R1 as the entrance within “First Floor.”

![Access Area Diagram]

Figure 11-1 Access Area

Readers, loops and doors that are already defined in the device map can be added to the access areas. The access areas are later mapped to access levels. The card holders who are associated with the access levels can gain access to the entrances in the access areas.

Adding a Branch

2. Right-click the Access Area folder or branch and select Add Branch. The Configure Branch dialog box appears.
Defining Areas

Defining Access Areas

Adding a Branch

Figure 11-2 Adding a Branch

Configuring a Branch

Figure 11-3 Configuring a Branch

3. Type the Branch Name.
4. Click OK. The new branch is listed below the Access Area folder.

Adding an Entrance

You can add entrances as an access area or you can group one or more entrances and add them under a branch in the access area.


2. To add entrances as access areas, right-click the Access Area folder or to add entrances to a branch, right-click the branch and click Add Entrances. The Add Devices dialog box appears.

3. Alternatively, select the Show Available Devices check box. The Add Devices dialog box appears.

Figure 11-4 Adding an Entrance
Defining Areas
Defining Access Areas

Figure 11-5  Adding Devices

4. Select the entrance and click Add.
5. Click Close to close the Add Devices dialog box. Alternatively, clear the Show Available Devices check box. The newly added entrance(s) are displayed in the Access Area window.

Moving an Entrance

To move an entrance from the access area to a branch or from one branch to another:
2. Click the entrance that you want to move.
3. Drag and place the entrance on the branch to which you want to move.

Renaming a Branch

2. Right-click the branch you want to rename.
3. Click Rename. The Configure Branch dialog box appears.
4. Type the new Branch Name.
5. Click OK to rename the branch.

Removing a Branch or Entrance

2. Right-click the branch or the entrance you want to remove.
Defining Areas
Defining Access Areas

3. Click Remove. A message asking for confirmation appears.
4. Click OK to confirm the deletion.
Defining Tracking and Mustering Areas

Tracking and Mustering areas in WIN-PAK are logical areas consisting of entrances, and are used for tracking cardholder movements.

**Tracking Areas**
A tracking area is an area defined for tracking cardholder movements. When a cardholder presents a card in the tracking area, a read event is recorded along with the card-read details.

![Tracking Areas Diagram](image)

Figure 11-7  Tracking Areas

In the preceding diagram, A, B, C, and D are Tracking Areas. Readers 1, 4, and 9 allow access to Tracking Area A. Readers 3 and 6 allow access to Tracking Area B. Reader 5 allows access to Tracking Area C and Reader 8 allows access to Tracking Area D.

The first time a cardholder presents a card at one of these readers, the details of the read event are recorded, and displayed in the **Tracking and Mustering View** window of the User Interface. Each time that card is presented at one of the readers in that same area, the details of the latest card-read is displayed in the user interface. When the cardholder moves to a different tracking area, the card-read details for the new area is displayed. When the cardholder moves out of the tracking area to a non-tracking area, the last card-read details of the cardholder are removed from the user interface.

One tracking area can be nested inside the other. This enables better tracking of cardholders in a specific area. For example, if “Building1” is created as a tracking area, then “Floor 1” and “Floor 2” can be created as nested areas in “Building1”. When a cardholder enters “Building1”, the card-read details are recorded and displayed in the user interface. When the cardholder moves to “Floor1”, the card-read details are displayed for “Floor1”.

**Mustering Areas**
Mustering areas are logical areas defined with readers, used for tracking cardholder movements in the case of emergency situations like fire. Muster readers are placed in the mustering areas, which must be accessed by the cardholders who are moving from the tracking areas into the mustering area. The details of the cardholders moving into the mustering areas are recorded and, in addition, displayed in the **Tracking and Mustering View** window of the user interface.

**Tracking and Mustering tree**
In the **Tracking and Mustering** tree of the User Interface, the tracking and mustering areas are configured as **Branches** and the readers are configured as **Entrances**.

**Exit Areas**
The entrances that are not defined as a part of the tracking and the mustering areas are considered as exit areas. During WIN-PAK installation, a branch “Exit Area” is created by default. Cardholders quitting the tracking areas present their cards to the readers in the exit area.

**Nested Areas**
Defining Areas
Defining Tracking and Mustering Areas

Nested areas are created when a tracking area is defined inside another tracking area and when a mustering area is defined under another mustering area. However, tracking areas cannot be nested inside mustering areas and vice versa.

When a area “A” is defined under area “B”, it indicates that the area “A” is nested under “B”. All the readers added under “A” belong to “B”.

Example:

- In a hospital, one branch can be defined as “Hospital” and another branch “Laboratory” can be added inside the “Hospital” branch. The “Laboratory” branch is nested inside the “Hospital” branch. When a card holder enters the laboratory, the card holder is seen as present in both the hospital and in the branch.
- If the “Laboratory” is not nested within the “Hospital” building, the card holder is seen as present only in the laboratory and not in the hospital.

Consider the following figure:

The difference between nested and non-nested areas is explained in the following scenarios, for the areas B and C:

In case of Nested area,

- C is defined inside B. If you are in area C, then you are in area B.
- The readers 3, 6 are defined in B because both the readers are used for entering into B. Reader 3 is used for entering into B, and reader 6 is used for quitting C, and entering into B.
- The reader 5 is defined in C as it is used for entering into C. In addition, this is included in B because C is defined within B.

In case of Non-nested area,

- The areas B and C are defined separately.
- The readers 3, 6 are defined in B because both the readers are used for entering into B. Reader 3 is used for entering into B, and reader 6 is used for quitting C, and entering into B.
- The reader 5 is defined in C as it is used for entering into C.

**Muster System Precautions**

While creating mustering areas in WIN-PAK, keep the following precautions in mind:
1. Use a separate dropline (communication port) to isolate muster readers from tracking units. An alternate/additional communication path from the N-1000 to the computer is achieved by using the N485DRLA (Digital Redundant Loop Adapter).

2. Run a special line for the muster units to provide a unique data path, even if the wiring from the main facility is damaged. The tracking units also have a unique data path.

3. Use 485 communications with ACK-NAK enabled. A battery backup power supply is required for the 485-API-2 on any N-1000 or NS2+ or P-Series panel.

4. Provide a UPS or other backup power source for the WIN-PAK computer and any other associated communication devices.

5. Provide a safe location for the computer and communication.

6. Keep the muster system on-line (not buffered) to ensure timely and complete information.

7. Perform regular checks to ensure that the muster system is functioning properly.

8. Check that all panels are maintaining the correct time and date. It is critical that the time and date be correct on card reads at the muster readers. If the time and/or date are earlier than that of other reads in the system they are ignored.

9. Program the scheduler to update the panel time and date at least once a day.

10. Create a check list for muster procedures.

11. Test the Muster Report printer.

Configuring Tracking Areas

Tracking areas can be defined as branches inside the Tracking and Mustering area tree in the WIN-PAK User Interface. Nested tracking areas can be created by defining branches one inside the other. After adding the branches for the tracking areas, you can add the readers in the tracking areas as entrances.

Adding a Tracking Area Branch

1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.
Defining Areas
Defining Tracking and Mustering Areas

2. Right-click the Tracking and Mustering Areas folder or the branch where you want to add the new branch, and select Add Branch. The Tracking and Mustering Area Configuration dialog box is displayed.

3. Type a name for the tracking area in Name.

4. Select the Mustering check box to define the area specified in Name as mustering area.

5. Click OK. The new branch is listed below the Tracking and Mustering Areas folder in the Tracking Area window.

Adding an Entrance to the Tracking Area

1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.

2. Right-click the branch to which you want to add an entrance and click Add Entrances. The Add Devices dialog box appears with the list of all entrances.

3. Alternatively, select the Show Available Devices check box. The Add Devices window appears with the list of all entrances.
Defining Areas

Defining Tracking and Mustering Areas

4. Select the entrance to be added to the branch and click **Add**.

5. Click **Close** or clear the **Show Available Devices** check box to close the window. The entrances are in the **Tracking Area** window.

### Moving an Entrance

To move an entrance from one branch to another:

1. Choose **Configuration > Define > Tracking Areas**. The **Tracking Area** window appears.
2. Select the entrance you want to move.
3. Drag and place the entrance on the branch to which you want to move.
   - You cannot move an entrance from and to the “Exit Area” branch.
   - You cannot move an entrance from a tracking area branch to a mustering area branch, and vice versa.

### Renaming a Branch

1. Choose **Configuration > Define > Tracking Areas**. The **Tracking Area** window appears.
2. Right-click the branch you want to rename.
Defining Areas
Defining Tracking and Mustering Areas

3. Click Configure. The Tracking and Mustering Area Configuration dialog box appears.

4. Type the new branch name in the Name box.
5. Click OK to rename the branch.

Removing a Branch or an Entrance
1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.
2. Right-click the branch or the entrance you want to remove.
3. Click Remove. A message asking for confirmation appears.
4. Click OK to remove the selected branch or entrance.

Finding an Item in the tree
1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.
2. Right-click on a branch or entrance, and click Find. The Find Item dialog box appears.
3. Type the item you want to search in the tree, in the Item in tree to Search for box.
4. Click OK. The item, if found, is highlighted in the tree.
   • From a tracking area you cannot search for a branch or an entrance in the mustering area.
   • Right-click on a branch, and click Refresh to refresh the items in the tree.

Configuring Mustering Areas
Mustering areas are defined as branches of the Tracking and Mustering area tree of the WIN-PAK User Interface. Nested mustering areas can be created by defining branches one inside the other. After adding the branches, you can add the readers in the mustering areas as entrances.

Adding a Mustering Area Branch
1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.
Defining Tracking and Mustering Areas

Defining Areas

Figure 11-14  Adding a Mustering Area Branch

2. Right-click the Tracking and Mustering Areas folder or the branch where you want to add the new branch, and select Add Branch. The Tracking and Mustering Area Configuration window is displayed.

Figure 11-15  Tracking and Configuration Area Configuration

3. Type a name for the mustering area in Name.
4. Select the Mustering check box to define the area as a mustering area.
5. Click OK. The new branch is displayed in the Tracking Area window.

Adding an Entrance to the Mustering Area

1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.
2. Right-click the Tracking and Mustering Areas folder or the mustering area branch to which you want to add an entrance and click Add Entrances. The Add Devices dialog box appears with the list of all entrances.
3. Alternatively, select the Show Available Devices check box. The Add Devices window appears with the list of all entrances.
Defining Areas
Defining Tracking and Mustering Areas

4. Select the entrance to be added to the branch and click **Add**.
5. Click **Close** or clear the **Show Available Devices** check box to close the window. The entrances are in the **Tracking Area** window.

**Moving an Entrance**

To move an entrance from one branch to another:

1. Choose **Configuration > Define > Tracking Areas**. The **Tracking Area** window appears.
2. Under a mustering area branch, select the entrance you want to move.
3. Drag and place the entrance on the mustering area branch to which you want to move.
   - You cannot move an entrance from and to the “Exit Area” branch.
   - You cannot move an entrance from a mustering area branch to a tracking area branch.
Renaming a Branch

1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.
2. Right-click the branch you want to rename.
3. Click Configure. The Tracking and Mustering Area Configuration dialog box appears.

4. Type the new branch name in the Name box.
5. Click OK to rename the branch.

Removing a Branch or an Entrance

1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.
2. Right-click the branch or the entrance you want to remove.
3. Click Remove. A message asking for confirmation appears.
4. Click OK to remove the selected branch or entrance.

Finding an Item in the tree

1. Choose Configuration > Define > Tracking Areas. The Tracking Area window appears.
2. Right-click the mustering area branch or entrance, and click Find. The Find Item dialog box appears.

3. Type the item you want to search in the Item in tree to Search for box.
4. Click OK. The item, if found, is highlighted in the tree.
   - From a tracking area you cannot search for a branch or an entrance in the mustering area.
   - Right-click on a branch, and click Refresh to refresh the items in the tree.

Tracking and Muster View

The tracking and muster view enables you to view the details of the card holders who are present in the tracking and the mustering areas.
Defining Areas
Defining Tracking and Mustering Areas

The tracking and the muster areas are displayed in a tree in the Tracking and Muster View window. Select the tracking or muster area in the tree, to view the details of the card holders present in the area.

Before viewing the muster information, ensure the following:

1. Verify that muster reads from the panel have the correct time and date.
2. If the date and time are wrong, stop the presentation of cards and send the time and date to the panel.
3. Test the correction.
4. Repeat all card presentations. Multiple presentations of the same card at the muster reader do not adversely affect the result of the muster as the most recent time and date stamp is displayed.

Viewing the Tracking and Mustering details

To view the details of card holders in tracking or mustering areas:

1. Choose Operations > Tracking and Mustering. The Tracking and Muster View window appears.

2. Expand the Tracking and Mustering Areas folder to list the branches and the entrances belonging to the selected branch.

3. Select the branch for which you want to view the card holder information.

   - Select a muster area branch to view the details of card holders who have accessed the readers in the mustering area.
   - Select a tracking area branch to view the details of card holders who have accessed the readers in the tracking area.
   - Select “Exit Area” branch to view the details of card holders who have accessed the readers in the exit area.

   The details of the card holders who have accessed the entrances in the selected branch are listed in the right pane of the Tracking and Muster View window.
Defining Areas

Defining Tracking and Mustering Areas

Figure 11-21  Tracking and Muster View (right pane)

4. Select the Refresh List periodically check box to automatically update the list of card holders every few seconds. Alternatively, click Refresh to refresh the list of card holders.

5. Click Close (X) on top of the window to close the window.

Deleting a Card holder from the Tracking and Muster View

When a card holder has moved out of the tracking area without accessing the reader in the area, you can delete the card holder details from the Tracking and Muster View window.

To delete the details of a card holder:

1. In the Tracking and Muster View window, select the card holder detail from the list on the left pane.

2. Click Delete to delete the card holder detail.

Printing Tracking and Mustering details

1. In the Tracking and Muster View window, click Print. The Report - Tracking and Muster View dialog box appears.
Defining Areas
Defining Tracking and Mustering Areas

2. In the Select Tracking or Muster Area list, select the tracking or mustering area for which you want to print the card holder details.

3. To print the card holder information in a sorted order, select the option for sorting in the Sort Order list.
   - Select Time and Date to sort the card holder details in a chronological order.
   - Select Card Number to sort the card holder details based on the card number.
   - Select Card Holder to sort the card holder details based on the card holder number.
   - Select Note Fields to sort the card holder details based on the Note field value. When you select this option, the Select NoteField list is enabled.
     - If you do not have a privilege to create a note field template, the Note Fields option will not be listed in Sort Order.
     - If you do not have the privilege for viewing or changing a note field, the note field will not be listed in Select NoteField.
     - The Select NoteField list contains the note fields that are specific to the selected account. If <All Accounts> is selected, the note fields that are common to all the accounts are listed. You can create a common note field by creating a note field in each account with the same name.

4. To sort the card holder details in the ascending order, click Ascending. OR To sort the card holder details in the descending order, click Descending.

5. To preview the report before printing, click Print Preview.

6. To print the card holder report, click Print.

7. To export the card holder details into a text file, click Export File. The Export File dialog box appears.
Defining Tracking and Muster Areas

Figure 11-23  Export File

a. Under **Delimiter**, click the required delimiter character or click **Other** and enter the character.

b. Under **File**, enter the following details:

c. Click the ellipsis  button in the **Directory to Save File to** box to select the folder in which the text file must be saved.

d. Type the name of the text file in the **Default File Name** box.

e. To append the report name to the file name, select the **Include Report Name in File Name** check box.

f. To append the date and time to the file name, select the **Include Date and Time in File Name** check box.

g. To set the delimiter and file name information as default for all text files, click **Set as Default**.

h. Click **OK** to export card holder details to the file.

8. To know about the number of pages that would be printed, click **Estim Pages**.

9. To clear the filter criteria, click **Clear All**.

10. To close the **Report-Tracking and Muster View** dialog box, click **Close**.
Defining Areas
Defining Control Areas

Control areas are logical areas containing devices such as communication servers, loops, panels, input points, output points, groups, and readers.

Control Areas are defined by creating a Control Map of the devices and adding them to a tree structure. This map shows the status of each device, the set of actions to be performed for the device when an event takes place, and the relationship between the various devices.

Control Maps are defined by adding a site, adding branches to the site and then adding devices to the branches. The devices can also be added directly to a site.

Figure 11-24 Control Area

Adding a Site

To add a new site:

1. Choose Configuration > Define > Control Areas. The Control Area window appears.
2. Right-click Control Area folder and then click Add Site. The Configure Site dialog box appears.
3. Enter the Site Name.
4. Click OK to add the site as a control area.
Adding a Branch to a Site

1. Choose **Configuration > Define > Control Areas**. The **Control Area** window appears.
2. Right-click the site to which you want to add the branch and click **Add Branch**. The **Configure Branch** dialog box appears.

![Figure 11-26 Adding a Branch to a Site](image)

3. Type the **Branch Name**.
4. Click **OK**. The branch is listed under the site or the branch in the **Control Area** window.

Renaming a Site or a Branch

1. Choose **Configuration > Define > Control Areas**. The **Control Area** window appears.
2. Right-click the branch or the site you want to rename.
3. Click **Rename**. The dialog box for renaming the branch or site appears.

![Figure 11-28 Configure Site](image)

4. Type the site or the branch name.
5. Click **OK** to save the change.
Adding a Device

1. Choose Configuration > Define > Control Areas. The Control Area window appears.

2. Right-click the site or branch to which you want to add the device and click Add Devices. Alternatively, select the Show Available Devices check box. The Add Devices dialog box appears.

3. Select the Device Type. The devices belonging to the selected device type are listed.

4. Select the device to be added and click Add.

5. Click Close or clear the Show Available Devices check box to close the Add Devices dialog box. The device(s) are displayed in the Control Area window.

Moving a Device

To move a device from one branch to another:

1. Choose Configuration > Define > Control Areas. The Control Area window appears.

2. Click the device you want to move.

3. Drag and place the device on the branch or the site to which you want to move.
Removing a Site, Branch or Device

1. Choose Configuration > Define > Control Areas. The Control Area window appears.
2. Right-click the branch, site or device you want to remove.
3. Click Remove. A message asking for confirmation appears.
4. Click OK to remove the selected site, branch or device. The site, branch or device is removed from the control map.
Defining Areas
Viewing Control Maps

Viewing Control Maps

Control Map enables you to view and control the devices belonging to the control area. In addition, you can view the status, acknowledge and clear alarms, and run various commands for each device.

Controlling Devices from a Control Map


![Control Map Window](image)

2. Expand the control area to view the details of its branches and devices.

The status of each device is indicated by the following icons to the left of the device name:

- 🟢 - Normal status
- ⚠️ - Alarm condition
- 🤔 - Unknown status
The icons for the Galaxy devices and Vista devices vary depending on the action that is set on them. In addition, the icon color changes for various device status. The following table provides you various icons that are displayed for different status:

<table>
<thead>
<tr>
<th>Device Types</th>
<th>Action</th>
<th>Icon</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone</td>
<td>Set/Arm</td>
<td><img src="image1" alt="Icon" /></td>
<td>Normal</td>
<td>No alarm in the Alarm View window (Alarm is acknowledged and cleared)</td>
</tr>
<tr>
<td></td>
<td>Reset/Disarm</td>
<td><img src="image2" alt="Icon" /></td>
<td>Normal</td>
<td>Alarm in the Alarm View window (Alarm waiting to be acknowledged or cleared)</td>
</tr>
<tr>
<td></td>
<td>Unbypassed</td>
<td><img src="image3" alt="Icon" /></td>
<td>Normal</td>
<td>Alarm in the Alarm View window (Alarm waiting to be acknowledged or cleared)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image4" alt="Icon" /></td>
<td>Alarm</td>
<td>No alarm in the Alarm View window (Alarm is acknowledged and cleared)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image5" alt="Icon" /></td>
<td>Alarm</td>
<td>Alarm in the Alarm View window (Alarm waiting to be acknowledged or cleared)</td>
</tr>
<tr>
<td>Zone</td>
<td>Unset</td>
<td><img src="image6" alt="Icon" /></td>
<td>Normal</td>
<td>No Alarm in the Alarm View window (Alarm is acknowledged and cleared)</td>
</tr>
<tr>
<td></td>
<td>Bypassed</td>
<td><img src="image7" alt="Icon" /></td>
<td>Normal</td>
<td>Alarm in the Alarm View window (Alarm waiting to be acknowledged or cleared)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image8" alt="Icon" /></td>
<td>Alarm</td>
<td>No Alarm in the Alarm View window (Alarm is acknowledged and cleared)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image9" alt="Icon" /></td>
<td>Alarm</td>
<td>Alarm in the Alarm View window (Alarm waiting to be acknowledged or cleared)</td>
</tr>
<tr>
<td>Zone</td>
<td>Tamper</td>
<td><img src="image10" alt="Icon" /></td>
<td>Alarm</td>
<td>No Alarm in the Alarm View window (Alarm is acknowledged or cleared)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image11" alt="Icon" /></td>
<td>Alarm</td>
<td>Alarm in the Alarm View window (Alarm waiting to be acknowledged or cleared)</td>
</tr>
<tr>
<td>Zone</td>
<td>Tamper</td>
<td><img src="image12" alt="Icon" /></td>
<td>Alarm</td>
<td>No Alarm in the Alarm View window (Alarm is acknowledged and cleared)</td>
</tr>
<tr>
<td></td>
<td>Bypassed</td>
<td><img src="image13" alt="Icon" /></td>
<td>Alarm</td>
<td>Alarm in the Alarm View window (Alarm waiting to be acknowledged or cleared)</td>
</tr>
</tbody>
</table>
### Defining Areas

#### Viewing Control Maps

Move the mouse over the icons to view a textual description of each device status.

3. To control a device, right-click the device and select the command.

The commands available for each ADV control are listed in the following table:

#### Table 11-1 Typical ADVs and Control Functions

<table>
<thead>
<tr>
<th>ADV</th>
<th>Control Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm View</td>
<td>Open Click <strong>Open</strong> to open the <strong>Alarm View</strong> window through the floor plan.</td>
</tr>
<tr>
<td>CCTV Switcher</td>
<td>Send Time &amp; Date, Send Camera Titles, Camera to Monitor Switch, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Comm Server</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Command File Server</td>
<td>Run Command File</td>
</tr>
<tr>
<td>C-100 Local Connection</td>
<td>Buffer All Panels, Unbuffer All Panels, Set Retry Count, Set Command Timeout, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>C-100 Remote Connection</td>
<td>Buffer All Panels, Unbuffer All Panels, Set Retry Count, Set Command Timeout, Acknowledge All Alarms, Clear All Alarms, Connect Remote, Disconnect Remote</td>
</tr>
<tr>
<td>Doors</td>
<td>Unlock, Lock, Shunt, Unshunt, Pulse, Timed Pulse, Restore to Time Zone, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
</tbody>
</table>
### Table 11-1  Typical ADVs and Control Functions

<table>
<thead>
<tr>
<th>ADV</th>
<th>Control Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event View</td>
<td>Open Click <strong>Open</strong> to open the <strong>Event View</strong> window through the floor plan.</td>
</tr>
<tr>
<td>Input Points</td>
<td>Acknowledge all Alarms, Clear all Alarms, Shunt, Unshunt, Restore to Time Zone</td>
</tr>
<tr>
<td>Links</td>
<td>Open Click <strong>Open</strong> to open the floor plan to which this floor plan is linked. This device is relevant only for the Floor Plan.</td>
</tr>
<tr>
<td>Modem Pool</td>
<td>Hang-Up Modem, Reset Modem, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>CCTV Monitor</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>N-485 Remote Dialup</td>
<td>Buffer All Panels, Unbuffer All Panels, Set Retry Count, Set Command Timeout, Connect, Remote, Disconnect Remote, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>N-485 Local Connection</td>
<td>Buffer All Panels, Unbuffer All Panels, Set Retry Count, Set Command Timeout, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Output Points &amp; Groups</td>
<td>Energize, De-energize, Pulse, Timed Pulse, Restore to Time Zone, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Panel</td>
<td>Initialize, Cancel Initialization, Buffer, UnBuffer, Acknowledge All Alarms, Clear All Alarms <strong>See the Initializing a Panel from Control Map</strong> section in this chapter for initializing a panel</td>
</tr>
<tr>
<td>Pan / Tilt Camera</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Readers</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>SIO Boards</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Static Camera</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Galaxy Communication</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
</tbody>
</table>
### Table 11-1  Typical ADVs and Control Functions

<table>
<thead>
<tr>
<th>ADV</th>
<th>Control Functions</th>
</tr>
</thead>
</table>
| Galaxy Panel                 | Acknowledge All Alarms, Clear All Alarms  
**Set All Groups** - Panel sets all the groups associated to the panel.  
**Unset All Groups** - Panel unsets all the groups associated to the panel.  
**Reset Panel** - Resets the panel.  
**Bypass Zones** - Panel bypasses alarms from the selected zone types.  
**Unbypass Zones** - Panel stops bypassing alarms the selected zone types.  
**Activate Output** - Activates the selected output.  
**Deactivate Output** - Deactivates the selected output.  
To select a zone type or output type, right-click the Galaxy panel and select the appropriate action, and then select the zone type or output type. |
| Galaxy Group                 | Acknowledge All Alarms, Clear All Alarms  
**Set Group** - Panel sets the selected group.  
**Unset Group** - Panel unsets the selected group.  
**Part Set** - Panel sets all the zones for which the Zone State (attribute) is set as Part Set.  
**Timed Set** - Panel sets all the zones after a specific time.  
**Group Bypass** - Panel bypasses alarms from all the zones in the group.  
**Group Unbypass** - Panel stops bypassing alarms from all the zones in the group.  
**Refresh** - Refreshes the latest status of a group.  
Acknowledge All Alarms, Clear All Alarms |
| Galaxy Zone                  | Acknowledge All Alarms, Clear All Alarms  
**Bypass Zone** - Panel bypasses alarms from the zone.  
**Unbypass Zone** - Panel stops bypassing alarms from the selected zones.  
**Force bypass Zone** - Forcefully bypasses the zones which cannot be bypassed using the Bypass Zone option. For example, Fire.  
**Refresh** - Refreshes the latest status of a zone. |
| Galaxy Output                | Acknowledge All Alarms, Clear All Alarms  
**Activate** - Activates the output.  
**Deactivate** - Deactivates the output.  
**Refresh** - Refreshes the latest status of an output. |
| Galaxy Keypad                | Acknowledge All Alarms, Clear All Alarms |
| Galaxy MAX                   | Acknowledge All Alarms, Clear All Alarms |
| Galaxy RIOs                  | Acknowledge All Alarms, Clear All Alarms |
Initializing a Panel from Control Map

When panels are added to the WIN-PAK system, they are initialized so that the information entered during panel configuration is sent to the panels. Panels are initialized from the Floor Plan view or from the Control Map.

To initialize panels from the control map:

1. Choose **Operations > Control Map**. The **Control Map** dialog box appears.

### Table 11-1 Typical ADVs and Control Functions

<table>
<thead>
<tr>
<th>ADV</th>
<th>Control Functions</th>
</tr>
</thead>
</table>
| Vista Panel | Acknowledge All Alarms, Clear All Alarms  
Arm Away - The panel completely arms the selected perimeter and interior burglary partitions by sensing the intruder’s movements. This option enables you to select multiple partitions of the panel.  
Arm Stay - Arms only the perimeter burglary protection, guarding protected doors, windows, and other perimeter protection points in the selected partitions. This enables automatic bypassing of certain areas that allows movement on those areas without causing an alarm.  
Disarm - The panel disarms the selected burglary partitions, silences alarms and audible trouble indicators. This option enables you to select multiple burglary partitions in the panel.  
Panel Reset - Resets the panel.  
Refresh - Refreshes the latest status of the vista panel. |
| Vista Partition | Acknowledge All Alarms, Clear All Alarms  
Arm Away - The panel completely arms the perimeter and interior burglary partition by sensing the intruder’s movements.  
Arm Stay - Arms only the perimeter burglary protection, guarding protected doors, windows, and other perimeter protection points in the partition. This enables automatic bypassing of certain areas that allows movement on those areas without causing an alarm.  
Disarm - The panel disarms the selected burglary partition, silences alarms and audible trouble indicators. |
| Vista Zone | Acknowledge All Alarms, Clear All Alarms  
Bypass Zone - The panel bypasses alarms from the zone. This allows movement on the bypassed area without causing an alarm.  
Unbypass Zone - The panel stops bypassing alarms from the selected zone. |
| Vista Output | Acknowledge All Alarms, Clear All Alarms  
Activate - Activates the output.  
Deactivate - Deactivates the output.  
Refresh - Refreshes the latest status of an output. |
2. Right-click the desired panel in the Control Map tree, and select Initialize. The Panel Initialization Options dialog box appears.

![Figure 11-32 Control Map](image)

**Figure 11-32 Control Map**

2. Right-click the desired panel in the Control Map tree, and select Initialize. The Panel Initialization Options dialog box appears.

![Figure 11-33 Panel Initialization Options](image)

**Figure 11-33 Panel Initialization Options**

See the Panel Initialization Options section in this chapter to know the description for initialization options.

3. To send all types of information, click Select All.

   OR

   To update only the selected information, select the corresponding check boxes.

4. Click OK to update the panel details.

   See the Initializing Status section in this chapter for details on status of the initialization.

### Panel Initialization Options

**Table 11-2 Describing panel initialization options**

<table>
<thead>
<tr>
<th>Panel Initialization Options</th>
<th>Description</th>
</tr>
</thead>
</table>
Defining Areas
Viewing Control Maps

Additionally, new or updated information on the following features, functions, and panel elements are sent to the panel:

- Access Levels
- Access Control Areas
- Card Formats
- Command File
- Conversion Tables
- Groups
- Holidays
- Inputs
- IC Configuration
- Input Groups
- Input Scan
- Outputs
- Procedures/Actions
- SIO Boards
- Triggers
- Reader LED/Buzzer specs
- Time Zones

Table 11-2 Describing panel initialization options

<table>
<thead>
<tr>
<th>Panel Configuration Options</th>
<th>Sends all panel configuration information. This resets your panel programming. It is recommended that you use the “Select All” feature (button) when the Panel Configuration Options are to be sent.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time &amp; Date</td>
<td>Updates panel time and date with the network time and date. You may notice a pause for up to 50 seconds when the time and date are sent because the time is sent at the top of the computer minute up to + 10 seconds. Closed circuit acts as a NC circuit.</td>
</tr>
<tr>
<td>Cards</td>
<td>Sends card information to the panel. When sending cards, it is recommended that you re-initialize the panel by choosing Select All. This ensures that old card information is removed when the new card information is added. When cards with an Active or Trace status are added, edited, or deleted from the card or card holder database, this information is automatically sent to the panels. All other card information changes are sent using this command.</td>
</tr>
</tbody>
</table>

Initializing Status
As the panel initializes, a status window indicates the status of sending the information. If an error occurs, the status window indicates which command caused the error.
Defining Areas
Viewing Control Maps

![Initialization Status](image)

*Figure 11-34  Initialization Status*

**Table 11-3  Describing fields in the Status dialog box**

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steps</td>
<td>Indicates what information is sent.</td>
</tr>
<tr>
<td>Message Count</td>
<td>Indicates the progress of messages sent.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates whether the proceeding initialization is successful or has failed.</td>
</tr>
<tr>
<td>Cmd Status</td>
<td>Indicates if a command has timed out.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Indicates if any errors occurred while transmitting information to the panel.</td>
</tr>
</tbody>
</table>
Floor Plan

In this chapter...

Introduction 12-2
Floor Plan Definition 12-3
Floor Plan Operations 12-16
Introduction

A floor plan is a map or plan of a building, used for viewing, monitoring, and controlling devices in the Access Control System.

This chapter describes how to create floor plans and to control system devices using floor plan views.

A floor plan comprises a floor plan background on which ADVs, links, and text blocks are placed. Images, photos, and simple graphs can be imported into the floor plan background. These images are imported as graphic files (Windows Metafile) and are stored in the WINPAK PRO\Database\FloorPlanImage folder.

ADVs, representing devices in the Access System, can be added to a floor plan. These ADVs can be monitored and controlled from the floor plan. Different objects (for example, a door, a panel or a C-100 loop) are available in the toolbox for the types of ADVs.

Links to other floor plans can be added to a floor plan. These links enable you to view other floor plans from the currently open floor plan.

Links to Alarm View and Event View of devices can be added to a floor plan. These links enable you to view the alarm and the event views of devices from the floor plan.

Text blocks can be added to the floor plan for adding additional information in the floor plan. For example, you can add a text block for creating a legend, explaining the color codes of the ADVs, or special instructions for the operator for viewing a particular floor plan.

After the floor plan is created with ADVs, links, and text blocks, you can view it through a floor plan view to monitor the status of the ADVs, and to control the ADVs by commands.
Floor Plan Definition

Defining a floor plan involves:

1. Adding a floor plan.
2. Creating floor plan designs, which involves placing ADVs on the floor plan, providing links to other floor plans, and links to alarm and event views.
3. Adjusting the size of the floor plan and previewing it.
4. Editing and deleting a floor plan.

Adding a Floor Plan

1. Choose Configuration > Floor Plan Definition. The Floor Plan Definition window appears.

2. Click Add. The Floor Plan Toolbox dialog box together with a blank window for creating a floor plan design appear.
3. Type a name for the floor plan in **Name**. The name can be up to 30 alphanumeric characters in length.

4. Type a **Description** for the floor plan. The description can be up to 60 alphanumeric characters in length.

5. Click **Open** in the **Background** area. The **Open** dialog box appears.

![Figure 12-3 Open](image)

6. Browse to the location of the image file and click **Open**. The selected graphic file opens in the window behind the **Floor Plan Toolbox** window and is also saved in the **WINPAK PRO\Database\FloorPlanImage** folder.

7. Add ADVs, links, and text objects to the background.

   See **Creating Floor Plan Design** section in this chapter for more information on adding ADVs, links, and text objects to the floor plan.

8. In the **Floor Plan Toolbox** dialog box, click **Save & Exit** to save the floor plan and return to the **Floor Plan Definition** window.

9. Click **Close (X)** to close the **Floor Plan Definition** window.

---

**Creating Floor Plan Design**

Designing a floor plan involves:

- Placing ADVs that must be monitored and controlled from the floor plan.
- Adding text blocks and links to other floor plans.
- Adding Event View and Alarm View links to the floor plan.

To create a floor plan design:

1. Choose **Configuration > Floor Plan Definition**. The **Floor Plan Definition** window appears.

2. Click **Add** to add a new floor plan or highlight a floor plan from the database list and click **Edit** to modify the selected floor plan. The **Floor Plan Toolbox** window together with the floor plan design window appear.

3. Add ADVs, Floor Plan links, Alarm View and Event View Links, and Text Blocks to the floor plan.

   See the sections **Adding an ADV to the Floor Plan**, **Adding Links to other Floor Plans**, **Adding Alarm View and Event View links to the Floor Plan** and **Adding a Text Box to the Floor Plan** for information on adding ADVs, links, or text objects to the floor plan.
Adding an ADV to the Floor Plan

ADVs that must be monitored and controlled from the floor plan are added to the floor plan design.

After adding ADVs to the floor plan, you can set the control properties for each of them. The control properties vary for each ADV control.

The following are the common control properties that can be set for an ADV:

General Configuration

- Enter the ADV name.
- Link the ADV control to the ADV.
- Set the rotation angle of the ADV.
- Specify whether the ADV name must appear with the ADV control in the floor plan.
- Specify whether a tool tip for the ADV must appear when you move the mouse over the ADV.

Status Configuration

- **Color**: A color swatch appears next to the various states for the selected ADV (the states vary depending on the type of device). Change the color scheme by selecting new colors for the three conditions (no alarms, alarms, alarms acknowledged) for each state.
- **Blink**: Set the blink settings for the various ADV states.

To add an ADV to the floor plan:

1. In the **Floor Plan Toolbox** window, drag and drop an ADV into the floor plan background.

See the following table for information on ADV icons, ADV names, and description:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Input Icon]</td>
<td>Input</td>
<td>Signals an alarm condition.</td>
</tr>
<tr>
<td>![Input II Icon]</td>
<td>Input II</td>
<td>Signals an input condition or state that is not associated with an alarm condition.</td>
</tr>
<tr>
<td>![Door Icon]</td>
<td>Door</td>
<td>Used with Entrance ADV.</td>
</tr>
<tr>
<td>![Door II Icon]</td>
<td>Door II</td>
<td>Used with Entrance ADV for configuring four different types of doors, namely, left, right, double, or garage. Each door type displays an open or closed animation.</td>
</tr>
</tbody>
</table>
### Table 12-1 ADV Icons and Description

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Panel" /></td>
<td>Used with all control panels.</td>
</tr>
<tr>
<td><img src="image" alt="Loop C-100" /></td>
<td>Used with C-100 ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Loop PCI" /></td>
<td>Used with N-485-PCI ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Modem Pool" /></td>
<td>Used with Modem Pool ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Communication Server" /></td>
<td>Used with the communication server ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Output" /></td>
<td>Used with relay output ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Group" /></td>
<td>Used with relay group ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Switcher" /></td>
<td>Used with the CCTV switcher ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Monitor" /></td>
<td>Used with the monitor ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Stationary Camera" /></td>
<td>Used with the stationary camera ADV.</td>
</tr>
</tbody>
</table>
### Table 12-1 ADV Icons and Description

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Reader" /></td>
<td>Reader Used with the reader ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Pan/Tilt Camera" /></td>
<td>Used with pan/tilt camera ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Text" /></td>
<td>Used for providing any additional information in the floor plan.</td>
</tr>
<tr>
<td><img src="image" alt="Command File Server" /></td>
<td>Used with the command server ADV. Enables you to select and run a command file.</td>
</tr>
<tr>
<td><img src="image" alt="SIO Board" /></td>
<td>Used with the SIO Board ADV. Provides tamper and power status of the PRO-2200 SIO boards.</td>
</tr>
<tr>
<td><img src="image" alt="NetAXS Input and Output" /></td>
<td>Used to extend the input and output capabilities of the NetAXS panels.</td>
</tr>
<tr>
<td><img src="image" alt="Galaxy Communication" /></td>
<td>Used with Galaxy Ethernet module (E080) ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Galaxy Panel" /></td>
<td>Used with Galaxy panel ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Galaxy Group" /></td>
<td>Used with Galaxy group ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Galaxy MAX" /></td>
<td>Used with Galaxy MAX ADV.</td>
</tr>
</tbody>
</table>
### Table 12-1 ADV Icons and Description

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Galaxy Keypad" /></td>
<td>Used with Galaxy keypad ADV.</td>
</tr>
<tr>
<td><img src="image" alt="RIO Control" /></td>
<td>Used with Galaxy RIO control ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Galaxy Output" /></td>
<td>Used with Galaxy output ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Galaxy Zone" /></td>
<td>Used with Galaxy zone ADV.</td>
</tr>
<tr>
<td><img src="image" alt="ADV Rotation Tool" /></td>
<td>Used for rotating the ADV object.</td>
</tr>
<tr>
<td><img src="image" alt="Vista Panel" /></td>
<td>Used with Vista panel ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Vista Partition" /></td>
<td>Used with Vista partition ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Vista Zone" /></td>
<td>Used with Vista zone ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Vista Output" /></td>
<td>Used with Vista output ADV.</td>
</tr>
<tr>
<td><img src="image" alt="Vista Comm" /></td>
<td>Used with the Vista panel port ADV.</td>
</tr>
</tbody>
</table>

2. Right-click the object and select **Control Properties**.
The Control Properties dialog box appears for the ADV object.  

**Example**: If you have selected a door, then the Door - Properties dialog box appears.

![Door Properties dialog box](image)

**Figure 12-4  Door Properties**

3. To set the general properties of the ADV, click the General tab.
   a. Select the ADV Name or click Find ADV to locate the ADV to be associated to the object. The Find ADV dialog box appears.
   
   ![Find ADV dialog box](image)

   **Figure 12-5  Find ADV**

   b. Type or select the name of the ADV in the Name list and click Find Now. A list of ADVs with similar names are retrieved in the list.
   c. Select an ADV from the list and click OK to return to the properties dialog box.
   d. Enter the angle at which the ADV must be rotated in Rotation Angle. By default, the rotation angle is set as zero.
   e. Select the Show Name check box to display the name of the ADV below the image in the floor plan design window.
f. Select the **Show Tooltip** check box display the ADV name as a tool tip.

4. To set the color, blink, and default options for the ADVs, click the **Status Configuration** tab.

![Figure 12-6 Status Configuration tab](image)

- To change the colors for each state (Normal, Fault, Trouble, and Unknown), double-click the color swatch to open the **Color** dialog box.
- Select a standard color or create a custom color and then click **OK**. The selected color appears in the swatch.
- Repeat this for every color you want to change.
- To set the blink option for a state-condition combination, select the check box provided next to the color swatch. Clear the check box to remove the blink option.

5. Select the **Save as Default** check box to set the configuration details as default.

6. Click **OK** to save the ADV properties and to return to the **Floor Plan Toolbox** window.

**Adding Links to other Floor Plans**

A floor plan link object helps you to open another floor plan within the current floor plan. You can view the floor plan that you open and control the devices that are placed on it. However, you cannot add new or remove the existing objects from the floor plan.

To add a floor plan link:

1. In the **Floor Plan Toolbox** window, drag ![link icon] and place it into the floor plan background.
2. Right-click the object and select **Control Properties**. The **Floor Plan Link - Properties** dialog box appears.
Floor Plan
Floor Plan Definition

Adding Alarm View and Event View links to the Floor Plan

Alarm View and Event View links enable you to view the alarms and events occurring for a device from the floor plan.

To add an Alarm View or an Event View link to the floor plan:

1. In the Floor Plan Toolbox dialog box, select the for Alarm View or for Event View and drag it to the floor plan design.
2. Right-click the link object and click Control Properties. A properties dialog box appears.

Figure 12-7 Floor Plan Link Properties

3. Type a name for the floor plan link in Name. By default, the link appears with Floor Plan Link as its name.
4. Select the name of the floor plan to be linked in the Floor Plan list.
5. To rotate the ADV control, enter the Rotation Angle or use the scroll bars to select an angle from the list.
6. Select the Show Name check box to display the name of the floor plan link below the ADV in the floor plan.
7. Select the Show Tooltip check box to display the ADV name as a tool tip.
8. Select the Open in same window check box to replace the original floor plan with the target floor plan in the floor plan view. Clear this check box to open the target floor plan in a new window.
9. Click OK.

Figure 12-8 Event View Properties
3. To set the general properties for the view link, click the **General** tab.
   a. Type a **Name** for the link.
   b. To rotate the ADV control, enter the **Rotation Angle** or use the scroll bars to select an angle from the list.
   c. Select the **Show Name** check box to display the **Name** below the ADV in the floor plan.
   d. Select the **Show Tooltip** check box to display the ADV name as a tool tip.

4. To select the device for which event or alarm views must be displayed in the floor plan, click the **Filter** tab.

   ![Filter tab](image)

   **Figure 12-9**  **Filter tab**

   a. Click **Control** to open the Control Map.
   b. Expand the Control Map by clicking the [+] sign.

   ![Control Area](image)

   **Figure 12-10**  **Control Area**

   c. Right-click the device and click **Select**. The icon for the selected device appears in red.
   d. Click **OK** to close the **Control Area** dialog box and to return to the **Filter** tab of the properties dialog box.
   e. Under **On**, select **Alarm Reads**, **Card Reads**, or **Both**.
   f. Click **OK**.

**Adding a Text Box to the Floor Plan**

You can add a text box to a floor plan for creating legends, or to give special instructions to the Operator viewing the floor plan.
After you drag and drop the text box to the floor plan background, enter the text, and resize or reposition the text box to accommodate the text. The Text box has no Control Properties to configure.

To add a text box to the floor plan:

1. In the Floor Plan Toolbox dialog box, drag and place it in the floor plan design window.
2. Enter the required text inside the text box.
3. Adjust the zoom percentage of the text box.
   a. Right-click the text box and select Zoom to adjust the Zoom percentage of the text box. The Zoom dialog box appears.
   b. Select the zoom percentage or enter the percentage in Custom.
   c. Click OK to save the zoom percentage and to close the Zoom dialog box.

Adjusting the Size of the Floor Plan

The zoom factor enables you to enlarge or reduce the size of the floor plan for a specified percentage.

To set the zoom factor:

1. Right-click anywhere inside the floor plan design.
2. Select Zoom from the pop-up menu. The Zoom dialog box appears.
3. Under Zoom to, click the required percentage for enlarging or reducing the floor plan, or click Custom and type the required percentage.
4. Click OK to save the changes.

**Previewing the Floor Plan**

You can preview the floor plan and customize the preview area.

To preview the floor plan:

1. Right-click anywhere inside the floor plan design.
2. Select **Show View** from the pop-up menu. A preview of the floor plan is displayed.
3. Right-click anywhere in the floor plan preview and select **View Area**. The **Floor Plan - Change View Area** dialog box appears.

![Floor Plan - Change View Area](image)

4. In **View Area**, type the percentage or use the slider at the bottom of the window for enlarging the floor plan preview.
5. Click OK to save the changes made.

**Working with Floor Plan Controls**

The following functions can be performed with the floor plan controls:

- Copy an already existing control to create new controls in the floor plan.
- Remove a control from the floor plan.
- Resize and re-arrange the controls in the floor plan.

**Copying and Pasting a Control**

1. In the floor plan design, right-click the object that you want to copy.
2. Select **Copy Selected Control** from the pop-up menu to copy the control.
3. Right-click the control and select **Paste Control** to paste the control in the floor plan design window.

**Removing a Control from the Floor Plan**

1. In the floor plan design, right-click the object you want to remove.
2. Select **Remove Selected Control** from the pop-up menu to delete the selected object from the floor plan.

**Resizing, Rotating, and Re-arranging Objects**

To resize an object:

1. In the floor plan design, select the object you want to resize.
2. Drag the corners of the object until the object is of the required size.

To rotate an object:

1. In the floor plan design, select the object you want to rotate.
2. Click 🔄 in the **Floor Plan Toolbox** dialog box.
3. Place the mouse pointer on one of the corners of the object you want to rotate.
4. Click and drag the mouse pointer to rotate the object.

To re-arrange the object:
1. In the floor plan design, select the object you want to re-arrange.
2. Drag the object and place it where you require in the floor plan.

**Editing a Floor Plan**

To edit a floor plan:
1. Choose **Configuration > Floor Plan Definition**. The **Floor Plan Definition** window appears.
2. Highlight the floor plan you want to edit from the list of floor plans.
3. Click **Edit**. The **Floor Plan Toolbox** dialog box and the floor plan design appear.
4. Change the name or description of the floor plan, add or delete objects, or edit the properties of existing objects.
5. Click **Save and Exit** to save the changes made to the floor plan and return to the **Floor Plan Definition** window.
6. Click **Close (X)** to close the **Floor Plan Definition** window.

**Deleting a Floor Plan**

To delete a floor plan:
1. Choose **Configuration > Floor Plan Definition**. The **Floor Plan Definition** window appears.
2. Select the floor plan you want to delete, from the list of floor plans.
3. Click **Delete**.
Floor Plan Operations

After defining floor plans, you can use floor plan views for monitoring and controlling the devices in the Access Control System. Monitoring and controlling of devices can be done by executing commands from floor plan views for each ADV in the floor plan. For example, a door can be locked by performing the Lock command on the door that is added as an ADV in the floor plan.

In addition, you can view the statuses of the ADVs, which is indicated by different colors. See the Adding an ADV to the Floor Plan section of this chapter for information on setting the status colors for ADVs.

Working with Floor Plan Views

Opening a Floor Plan View

1. Choose Operations > Floor Plan or click in the tool bar. The Open Floor Plan dialog box appears.

2. Click to select the floor plan you want to view.

3. Click OK. The floor plan is displayed in a floor plan view window.
Resizing and Previewing Floor Plan Views

You can resize a floor plan view by adjusting the zoom percentage. In addition, you can preview the floor plan view to view the entire floor plan as a snap shot inside the floor plan view window.

Resize the floor plan view

Using the Zoom factor you can enlarge or reduce the size of the floor plan to a specific percentage.

To set the zoom factor:

1. Right-click anywhere in the floor plan view.
2. Select Zoom from the pop-up menu. The Zoom dialog box appears.
3. Select the zoom percentage for enlarging or reducing the size of the floor plan view or click Custom and type the required percentage.
4. Click OK to save the zoom percentage.
**Previewing floor plan view**

You can preview the floor plan view and customize the preview area.

To preview the floor plan:

1. Right-click anywhere in the floor plan view.
2. Select **Show View** from the pop-up menu. A preview of the floor plan view is displayed.
3. Right-click anywhere in the floor plan preview and select **View Area**. The **Floor Plan - Change View Area** dialog box appears.
4. In **View Area**, type the percentage for reducing or enlarging the view area or use the slider at the bottom of the window.
5. Click **OK**. A preview of the floor plan is displayed.

**Controlling System Devices from the Floor Plan**

You can control system devices by executing commands from the floor plan view. In addition, you can view and control other floor plans by clicking the floor plan link and view the alarms and events for a specific device by clicking the alarm and the event view links.

To run commands for ADVs from a floor plan view:

1. Right-click an ADV on the floor plan view to open its control menu. Commands for performing actions on the ADV are displayed in the menu.
2. Select the required command from the menu.

   See **Table 12-2** in this section, for information on ADVs and their control functions.

To open other floor plans:

- Right-click [地板图] in the floor plan view and click **Open**. The floor plan linked to the source floor plan is displayed.

To open event view and alarm view:

- Right-click [事件图] for event view or [报警图] for alarm view in the floor plan view and click **Open**. The event view or the alarm view window appears.

**Table 12-2  ADV Control Functions from Floor Plan**

<table>
<thead>
<tr>
<th>ADV</th>
<th>Control Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCTV Switcher</td>
<td>Send Time &amp; Date, Send Camera Titles, Camera to Monitor Switch, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Comm Server</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Command File Server</td>
<td>Run Command File</td>
</tr>
<tr>
<td>C-100 Local Connection</td>
<td>Buffer All Panels, Unbuffer All Panels, Set Retry Count, Set Command Timeout, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
</tbody>
</table>


**Table 12-2 ADV Control Functions from Floor Plan**

<table>
<thead>
<tr>
<th>ADV</th>
<th>Control Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>C-100 Remote Connection</td>
<td>Buffer All Panels, Unbuffer All Panels, Set Retry Count, Set Command Timeout, Acknowledge All Alarms, Clear All Alarms, Connect Remote, Disconnect Remote</td>
</tr>
<tr>
<td>Doors</td>
<td>Unlock, Lock, Shunt, Unshunt, Pulse, Timed Pulse, Restore to Time Zone, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Input Points</td>
<td>Acknowledge all Alarms, Clear all Alarms, Shunt, Unshunt, Restore to Time Zone</td>
</tr>
<tr>
<td>Modem Pool</td>
<td>Hang-Up Modem, Reset Modem, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>CCTV Monitor</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>N-485 Remote Dialup</td>
<td>Buffer All Panels, Unbuffer All Panels, Set Retry Count, Set Command Timeout, Connect, Remote, Disconnect Remote, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>N-485 Local Connection</td>
<td>Buffer All Panels, Unbuffer All Panels, Set Retry Count, Set Command Timeout, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Output Points &amp; Groups</td>
<td>Energize, De-energize, Pulse, Timed Pulse, Restore to Time Zone, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Panel</td>
<td>Initialize, Cancel Initialization, Buffer, UnBuffer, Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Pan / Tilt Camera</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Readers</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>SIO Boards</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Static Camera</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Galaxy Communication</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
</tbody>
</table>
### Table 12-2  ADV Control Functions from Floor Plan

<table>
<thead>
<tr>
<th>ADV</th>
<th>Control Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Galaxy Panel</td>
<td>Acknowledge All Alarms, Clear All Alarm</td>
</tr>
<tr>
<td></td>
<td><strong>Set All Groups</strong> - Panel sets all the groups associated to the panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Unset All Groups</strong> - Panel unsets all the groups associated to the panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Reset Panel</strong> - Resets the panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Bypass Zones</strong> - Panel bypasses alarms from the selected zone types.</td>
</tr>
<tr>
<td></td>
<td><strong>Unbypass Zones</strong> - Panel stops bypassing alarms from the selected zone types.</td>
</tr>
<tr>
<td></td>
<td><strong>Activate Output</strong> - Activates the selected output.</td>
</tr>
<tr>
<td></td>
<td><strong>Deactivate Output</strong> - Deactivates the selected output.</td>
</tr>
<tr>
<td></td>
<td>To select a zone type or output type, right-click the Galaxy panel and select the appropriate action, and then select the zone type or output type.</td>
</tr>
<tr>
<td>Galaxy Group</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td></td>
<td><strong>Set Group</strong> - Panel sets the selected group.</td>
</tr>
<tr>
<td></td>
<td><strong>Unset Group</strong> - Panel unsets the selected group.</td>
</tr>
<tr>
<td></td>
<td><strong>Part Set</strong> - Panel sets all the zones for which the Zone State (attribute) is set as Part Set.</td>
</tr>
<tr>
<td></td>
<td><strong>Timed Set</strong> - Panel sets all the zones after a specific time.</td>
</tr>
<tr>
<td></td>
<td><strong>Group Bypass</strong> - Panel bypasses alarms from all the zones in the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Group Unbypass</strong> - Panel stops bypassing alarms from all the zones in the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Refresh</strong> - Refreshes the latest status of a group.</td>
</tr>
<tr>
<td>Galaxy Zone</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td></td>
<td><strong>Bypass Zone</strong> - Panel bypasses alarms from the zone.</td>
</tr>
<tr>
<td></td>
<td><strong>Unbypass Zone</strong> - Panel stops bypassing alarms from the selected zones.</td>
</tr>
<tr>
<td></td>
<td><strong>Force bypass Zone</strong> - Forcefully bypasses the zones which cannot be bypassed using the Bypass Zone option. For example, Fire.</td>
</tr>
<tr>
<td></td>
<td><strong>Refresh</strong> - Refreshes the latest status of a zone.</td>
</tr>
<tr>
<td>Galaxy Output</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td></td>
<td><strong>Activate</strong> - Activates the output.</td>
</tr>
<tr>
<td></td>
<td><strong>Deactivate</strong> - Deactivates the output.</td>
</tr>
<tr>
<td></td>
<td><strong>Refresh</strong> - Refreshes the latest status of an output.</td>
</tr>
<tr>
<td>Galaxy Keypad</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Galaxy MAX</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td>Galaxy RIOs</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
</tbody>
</table>
When panels are added to the WIN-PAK system, they are initialized so that the information entered during panel configuration is sent to the panels. Panels are initialized from the Floor Plan view or from the Control Map.

To initialize a panel from floor plan:

1. Choose **Operations > Floor Plan** and open the Floor Plan view that contains the panel to be initialized.

---

**Table 12-2  ADV Control Functions from Floor Plan**

<table>
<thead>
<tr>
<th>ADV</th>
<th>Control Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vista Partition</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td></td>
<td><strong>Arm Away</strong> - The panel completely arms the perimeter and interior burglary partition by sensing the intruder’s movements.</td>
</tr>
<tr>
<td></td>
<td><strong>Arm Stay</strong> - Arms only the perimeter burglary protection, guarding protected doors, windows, and other perimeter protection points in the partition. This enables automatic bypassing of certain areas that allows movement on those areas without causing an alarm.</td>
</tr>
<tr>
<td></td>
<td><strong>Disarm</strong> - The panel disarms the selected burglary partition, silences alarms and audible trouble indicators.</td>
</tr>
<tr>
<td>Vista Zone</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td></td>
<td><strong>Bypass Zone</strong> - The panel bypasses alarms from the zone. This allows movement on the bypassed area without causing an alarm.</td>
</tr>
<tr>
<td></td>
<td><strong>Unbypass Zone</strong> - The panel stops bypassing alarms from the selected zone.</td>
</tr>
<tr>
<td>Vista Panel</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td></td>
<td><strong>Arm Away</strong> - The panel completely arms the selected perimeter and interior burglary partitions by sensing the intruder’s movements. This option enables you to select multiple partitions of the panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Arm Stay</strong> - Arms only the perimeter burglary protection, guarding protected doors, windows, and other perimeter protection points in the selected partitions. This enables automatic bypassing of certain areas that allows movement on those areas without causing an alarm.</td>
</tr>
<tr>
<td></td>
<td><strong>Disarm</strong> - The panel disarms the selected burglary partitions, silences alarms and audible trouble indicators. This option enables you to select multiple burglary partitions in the panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Panel Reset</strong> - Resets the panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Refresh</strong> - Refreshes the latest status of the vista panel.</td>
</tr>
<tr>
<td>Vista Output</td>
<td>Acknowledge All Alarms, Clear All Alarms</td>
</tr>
<tr>
<td></td>
<td><strong>Activate</strong> - Activates the output.</td>
</tr>
<tr>
<td></td>
<td><strong>Deactivate</strong> - Deactivates the output.</td>
</tr>
<tr>
<td></td>
<td><strong>Refresh</strong> - Refreshes the latest status of an output.</td>
</tr>
</tbody>
</table>
2. Right-click the panel, and select Initialize from the subsequent menu. The **Panel Initialization Options** dialog box appears.

![Panel Initialization Options](image)

**Figure 12-18  Panel Initialization Options**

See the *Panel Initialization Options* section in this chapter to know the description for initialization options.

3. To update all information in the panel, click **Select All**.

OR

To update only the selected information, select the corresponding check boxes.

4. Click **OK** to update the panel details.

See the *Initializing Status* section in this chapter for details on status of the initialization.
Panel Initialization Options

Table 12-3 Describing panel initialization options

<table>
<thead>
<tr>
<th>Panel Initialization Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Configuration Options</td>
<td>Sends all panel configuration information. This resets your panel programming. It is recommended that you use the “Select All” feature (button) when the Panel Configuration Options are to be sent.</td>
</tr>
<tr>
<td>Time &amp; Date</td>
<td>Updates panel time and date with the network time and date. You may notice a pause for up to 50 seconds when the time and date are sent because the time is sent at the top of the computer minute up to + 10 seconds. Closed circuit acts as a NC circuit.</td>
</tr>
<tr>
<td>Cards</td>
<td>Sends card information to the panel. When sending cards, it is recommended that you re-initialize the panel by choosing Select All. This ensures that old card information is removed when the new card information is added. When cards with an Active or Trace status are added, edited, or deleted from the card or card holder database, this information is automatically sent to the panels. All other card information changes are sent using this command.</td>
</tr>
</tbody>
</table>

Additionally, new or updated information on the following features, functions, and panel elements are sent to the panel:

- Access Levels
- Access Control Areas
- Card Formats
- Command File
- Conversion Tables
- Groups
- Holidays
- Inputs
- IC Configuration
- Input Groups
- Input Scan
- Outputs
- Procedures/Actions
- SIO Boards
- Triggers
- Reader LED/Buzzer specs
- Time Zones

Initializing Status

As the panel initializes, a status window indicates the status of sending the information. If an error occurs, the status window indicates which command caused the error.
Figure 12-19  Showing the status of initialization

Table 12-4  Describing fields in the Status dialog box

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steps</td>
<td>Indicates what information is sent.</td>
</tr>
<tr>
<td>Message Count</td>
<td>Indicates the progress of messages sent.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates whether the proceeding initialization is successful or has failed.</td>
</tr>
<tr>
<td>Cmd Status</td>
<td>Indicates if a command has timed out.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Indicates if any errors occurred while transmitting information to the panel.</td>
</tr>
</tbody>
</table>

Command File

In this chapter...

- Command File Configuration 13-2
- Adding a Command File 13-2
- Editing a Command File 13-4
- List of Commands 13-6
- Running a Command File 13-10
Command File Configuration

A Command file contains a set of commands that can be executed manually or automatically when an event or alarm occurs on an ADV. Commands to be performed on different ADVs can be included in the same command file. When a command file is run, all the commands in the file are carried out at the same time.

For example, when fire is detected in a building, the doors must be automatically unlocked. A command file can be defined containing the commands to Unlock and Pulse the two ADVs, Doors and Outputs.

Adding a Command File

To add a command:


![Command File window](image)

2. Click Add. The Command File Record dialog box appears.
3. Type the name of the command file in the **Name** box.

4. Type a **Description** for the command file.

5. To add commands to the command file, click **Add**.

   See the *Adding Commands to the Command File* section in this chapter for more information on adding commands to the command file.

**Adding Commands to the Command File**

To add commands to the command file:

1. In the **Command File Record** dialog box, click **Add**. The **Command File - Command** dialog box appears.

2. Select an **ADV Category** for the command file. The ADVs belonging to the selected category are retrieved in the **ADV** list.
3. Select the ADV on which the command must be run. The commands that can be run on the ADV are retrieved in the Command list.

4. Select the required command from the Command list.

   See Table 13-1 for the commands available for the ADV controls.

5. To define custom commands for the ADV, select Custom Command from the Command list and enter the action parameters in the fields provided under Parameters.

   See the Running a Command File section in this chapter for more information on adding a custom command.

   See Table 13-1 for the parameters fields displayed for the ADV controls.

6. Click OK to add the command to the command file and to return to the Command File Record dialog box. The newly added command is appended to the command list in the Command File Record dialog box.

7. To move a command in the command list, click any of the following buttons provided next to Move Command:
   - Select a command in the list and click to move the selected command on top of the previous one.
   - Select a command in the list and click to move the selected command to the bottom of the list.

8. To delete a command from the command file, click Delete.

9. Click OK to save the command file and return to the Command File window.

Adding a Custom Command

You can add customized commands for ADVs such as CCTVs, Panels, and RS232 Connections.

To add custom commands:

   1. Select an ADV Category for the command file. The ADVs belonging to the selected category are retrieved in the ADV list.
   2. Select the ADV on which the custom command must be run. The commands that can be run on the ADV are retrieved in the Command list.
   3. Select Custom Command in the Command list.
   4. Under Parameters, define the custom command.

      See Table 13-1 for the parameters fields displayed for the ADV controls.

   5. Click OK to save the changes.

Editing a Command in the Command File

   1. In the Command File Record dialog box, click Edit. The Command File - Command dialog box appears.
   2. Edit the required details of the command and click OK.

Editing a Command File

2. Click Edit. The Command File Record dialog box appears.

3. To edit the command file name, type the name of the command file in the Name box.

4. Type a Description for the command file.

5. Click Apply to save the changes to the command file or click OK to save the changes and to close the Command File Record dialog box.

See the Adding Commands to the Command File and Editing a Command in the Command File sections in this chapter to add or edit commands to the command file.
List of Commands

The following list shows standard commands available when defining Command Files:

**Table 13-1 Command and Parameter list for ADVs**

<table>
<thead>
<tr>
<th>ADV</th>
<th>Commands</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCTV</td>
<td>Camera</td>
<td>Go Home</td>
</tr>
<tr>
<td></td>
<td>Go to Preset</td>
<td>Preset #</td>
</tr>
<tr>
<td></td>
<td>Iris Open</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Iris close</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pan Left</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pan Right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Refresh</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tilt Down</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tilt Up</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom In</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom Out</td>
<td></td>
</tr>
<tr>
<td>CCTV Switcher</td>
<td>Custom Command</td>
<td>Custom Command</td>
</tr>
<tr>
<td></td>
<td>Switch Camera to Monitor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Camera ID</td>
<td>Camera ADV</td>
</tr>
<tr>
<td></td>
<td>Monitor ID</td>
<td>Monitor ADV</td>
</tr>
<tr>
<td>CCTV Monitor</td>
<td>Refresh</td>
<td>DoorLock</td>
</tr>
<tr>
<td></td>
<td>Switch Camera ID</td>
<td>Camera ADV</td>
</tr>
<tr>
<td>Door</td>
<td>Lock</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pulse</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Timed Pulse</td>
<td>0 - 65, 335 sec.</td>
</tr>
<tr>
<td></td>
<td>Unlock</td>
<td></td>
</tr>
<tr>
<td>DVR Input</td>
<td>Shunt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unshunt</td>
<td></td>
</tr>
</tbody>
</table>
### Table 13-1 Command and Parameter list for ADVs

<table>
<thead>
<tr>
<th>ADV</th>
<th>Commands</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVR Output</td>
<td>De-Energize</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Energize</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Timed Pulse</td>
<td>Pulse time in sec</td>
</tr>
<tr>
<td>Galaxy Group</td>
<td>Part Set</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Timed Set</td>
<td>Set Time (in Sec) = 0 to 180 sec.</td>
</tr>
<tr>
<td></td>
<td>Unset</td>
<td></td>
</tr>
<tr>
<td>Entrance</td>
<td>Lock</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pulse</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Timed Pulse</td>
<td>Pulse (Sec)</td>
</tr>
<tr>
<td></td>
<td>Unlock</td>
<td></td>
</tr>
<tr>
<td>Galaxy Output</td>
<td>Activate</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deactivate</td>
<td></td>
</tr>
<tr>
<td>Galaxy Panel</td>
<td>Reset</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set Panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unset Panel</td>
<td></td>
</tr>
<tr>
<td>Galaxy Zone</td>
<td>Bypass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Force Bypass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unbypass</td>
<td></td>
</tr>
<tr>
<td>Loop</td>
<td>Buffer All Panels</td>
<td>0 = Soft, 1=Hard</td>
</tr>
<tr>
<td></td>
<td>Unbuffer All Panels</td>
<td>0 = Soft, 1=Hard</td>
</tr>
<tr>
<td>Output &amp; Group</td>
<td>De-energize</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Energize</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pulse</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Switch to TimeZone Control</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Timed Pulse</td>
<td>0 - 65, 335 sec.</td>
</tr>
</tbody>
</table>
### Table 13-1 Command and Parameter list for ADVs

<table>
<thead>
<tr>
<th>ADV</th>
<th>Commands</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel</td>
<td>Buffer Panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unbuffer Panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Anti Passback - Set all cards to Unused</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Anti Passback - Set card number to Unused</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lock Web Mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unlock Web Mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom Command</td>
<td></td>
</tr>
<tr>
<td>PTZ Camera</td>
<td>Goto Home Preset</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Goto Preset</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Duration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Intensive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Normal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Normal Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Quality</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Resolution</td>
<td></td>
</tr>
<tr>
<td>Server (All)</td>
<td>Refresh</td>
<td></td>
</tr>
<tr>
<td>RS232 Connection</td>
<td>Custom Command</td>
<td></td>
</tr>
<tr>
<td>Stationary Camera</td>
<td>Record Duration</td>
<td>Duration (sec)</td>
</tr>
<tr>
<td></td>
<td>Record Intensive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Normal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Normal Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Quality</td>
<td>Quality</td>
</tr>
<tr>
<td></td>
<td>Record Rate</td>
<td>Frame/Images Per Seconds</td>
</tr>
</tbody>
</table>
### Table 13-1 Command and Parameter list for ADVs

<table>
<thead>
<tr>
<th>ADV</th>
<th>Commands</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Record Resolution</td>
<td>Resolution</td>
</tr>
<tr>
<td>Vista Output</td>
<td>Activate</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deactivate</td>
<td></td>
</tr>
<tr>
<td>Vista Panel</td>
<td>ArmAway Partitions</td>
<td>In the Partition list, select the partitions to be armed.</td>
</tr>
<tr>
<td></td>
<td>ArmStay Partitions</td>
<td>In the Partition list, select the partitions to be armed.</td>
</tr>
<tr>
<td></td>
<td>DisArm Partitions</td>
<td>In the Partition list, select the partitions to be disarmed.</td>
</tr>
<tr>
<td></td>
<td>Reset Panel</td>
<td></td>
</tr>
<tr>
<td>Vista Partition</td>
<td>ArmAway</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ArmStay</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DisArm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Send Keypress</td>
<td>Key entries - 0 to 9, A to D, *, #</td>
</tr>
<tr>
<td>Vista Zone</td>
<td>Bypass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unbypass</td>
<td></td>
</tr>
</tbody>
</table>

The Hard and Soft buffer options are explained in the following table as scenarios:

### Table 13-2 Scenario 1

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Buffer</strong></td>
<td>Command at 1 P.M. Events buffered in the panel from 1 P.M.</td>
</tr>
<tr>
<td><strong>Buffer</strong></td>
<td>Command at 2 P.M. Events continue to be buffered in the panel even after 2 P.M.</td>
</tr>
<tr>
<td>Mode</td>
<td>Soft</td>
</tr>
<tr>
<td><strong>Unbuffer</strong></td>
<td>Command at 3 P.M. Events buffered after the last buffer command are sent to WIN-PAK. Therefore, the events buffered only between 2 to 3 P.M. are sent to WIN-PAK.</td>
</tr>
</tbody>
</table>
### Command File Configuration

#### Running a Command File

Commands that are configured in a command file can be run for performing actions on ADVs.

To run a command file:


2. Select the command file to be run from the drop-down list.

3. Click **Run** to start running the command file. The commands in the command file are run on the ADVs.

---

**Table 13-2 Scenario 1**

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second <strong>Unbuffer</strong> Command at 3 P.M.</td>
<td>Events buffered between the first and the second buffer commands are sent to WIN-PAK. Therefore, the events buffered between 1 to 2 P.M. are sent to WIN-PAK.</td>
</tr>
</tbody>
</table>

**Table 13-3 Scenario 2**

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Buffer</strong> Command at 1 P.M.</td>
<td>Events buffered in the panel from 1 P.M.</td>
</tr>
<tr>
<td><strong>Buffer</strong> Command at 2 P.M.</td>
<td>Events continue to be buffered in the panel even after 2 P.M.</td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td>Hard</td>
</tr>
<tr>
<td><strong>Single Unbuffer</strong> Command at 3 P.M.</td>
<td>All the buffered events (from 1 P.M. to 3 P.M.) are sent to WIN-PAK.</td>
</tr>
</tbody>
</table>
Guard Tour

In this chapter...

- Introduction 14-2
- Configuring Guard Tours 14-3
- Running Guard Tours 14-9
Introduction

A Guard Tour is defined as a series of check points a guard must activate within a given time. The check points are either readers, at which the guard presents the card, or input points, such as egress buttons.

The check points can be sequenced (to be activated in the specified order) or Unsequenced (can be activated in any order.) A sequenced check point is defined with the time at which the guard must access the check point and the grace period allowed for early arrival and late arrival of the guard at the check point. An unsequenced check point can be accessed by the guard at any order.

In addition, the validity of cards that can be accessed at the reader check points is specified (sequenced and unsequenced.)

Alarms for the various check point states are defined by associating an action group to each check point and by specifying the action priority. Based on the priority, an event is displayed or an alarm is triggered for the specific action. For example, if an alarm must be triggered when a guard misses a check point, it can be configured by setting the priority for the Missed action state for the check point. When the guard tour is run and if the guard misses the check point, an alarm is triggered based on the action priority.

After a guard tour is configured, it can be run to monitor the guard’s movements at the various check points. As the guard tour progresses, alarms and events are displayed in the Alarm or the Event window for the various action states of a check point.
Configuring Guard Tours

Configuring guard tours involves:
- Adding a guard tour.
- Defining readers and input points as a part of sequenced and unsequenced check points.
- Associating action groups to check points and specifying priority for each state together with the command file to be executed when the action occurs.

Adding a Guard Tour

Adding a guard tour involves defining a name for the guard tour and specifying at least one check point for the guard tour.

To add a guard tour:

1. Choose Configuration > Guard Tour. The Guard Tour window appears.

2. Click Add. The Guard Tour Record dialog box appears.
Guard Tour
Configuring Guard Tours

Figure 14-2 Guard Tour Record

3. Type a **Name** for the guard tour.
4. Click the **Sequenced Check Point** and the **Unsequenced Check Point** tabs to enter the checkpoint details for the guard tour.

   See the *Adding Unsequenced Check Points* and *Adding Sequenced Check Points* sections in this chapter, for information on defining sequenced and unsequenced check points for the guard tour.

5. Click **Apply** to create the guard tour.
6. Click **OK** to create the guard tour and to close the **Guard Tour Record** dialog box.

**Adding Check Points**

Readers and Input points can be added as sequenced and unsequenced check points to the guard tour.

**Adding Sequenced Check Points**

To add sequenced check points:

1. In the **Guard Tour Record** dialog box, click the **Sequenced Check Point** tab.
2. Under Select, click Inputs to assign input points or click Readers to assign readers as checkpoints to the guard tour. The Select dialog box appears.

3. Type the first few letters of the reader or the input point name in Find What.

4. Click Find. A list of readers or input points with similar names, are retrieved in the Name list.

5. In the Name list, select the input point or reader to be added to the guard tour, and click OK.

The selected input point or reader is displayed in Selected Check Points list in the Guard Tour Record dialog box.

6. Under the Valid Only column in the Selected Check Points list, specify the validity requirement of cards that must be accessed at readers.
   • Type Y if only a valid card must be accessed at a reader.
Guard Tour  
Configuring Guard Tours

- Type N if a valid and an invalid card can be accessed at a reader. (Invalid cards do not have access rights on a specific reader.)

7. Type the **Time(hh:mm)** at which the guard must present the card at the checkpoints (in hours and minutes.)

8. In **(+) (hh:mm)**, type the grace period in hours and minutes allowed for presenting the card, later than the time specified in **Time(hh:mm)**.

9. In **(-) (hh:mm)**, type the grace period in hours and minutes allowed for presenting the card, earlier than the time specified in **Time(hh:mm)**.

10. To add check point alarms to the reader or the input point, select the reader or input device and click **Update** under **Alarms**.  
    See the **Setting Check Point Alarms** section in this chapter for information on setting check point alarms.

11. To view the check point alarms that are already set for the input point or reader, select the **Visible** check box under **Alarms**. The alarms set for the check point is displayed in the **Abstract Device Record** dialog box.

12. To change the display order of the checkpoints:
    - Select a reader or input point in the **Selected Check Points** list, and click to shift it to the top of the list.
    - Select a reader or input point in the **Selected Check Points** list, and click to shift it to the bottom of the list.

13. To remove a reader or an input point from the list of check points, select the reader or input point in **Selected Check Points** and click .

**Adding Unsequenced Check Points**

To add unsequenced check points:

1. In the **Guard Tour Record** dialog box, click the **Unsequenced Check Point** tab.

![Figure 14-5 Adding Unsequenced Check Points](image)

2. Under **Select**, click **Inputs** to assign inputs points or click **Readers** to assign readers as checkpoints to the guard tour. The **Select** dialog box appears.

Guard Tour
Configuring Guard Tours

3. Type the first few letters of the reader or the input point name in Find What.
4. Click Find. A list of readers or input points with similar names, are retrieved in the Name list.
5. In the Name list, select the input point or reader to be added to the guard tour, and click OK.
   The selected input point or reader is displayed in Selected Check Points list in the Guard Tour Record dialog box.
6. Under the Valid Only column in the Selected Check Points list, specify the validity requirement of cards that must be accessed at readers.
   - Type Y if only a valid card must be accessed at a reader.
   - Type N if a valid or an invalid card can be accessed at a reader. (Invalid cards are cards that do not have access rights on a specific reader.)
7. To add check point alarms to the reader or the input point, select the reader or input device and click Update under Alarms.
   See the Setting Check Point Alarms section in this chapter for information on setting check point alarms.
8. To view the check point alarms that are already set for the input point or reader, select the Visible check box under Alarms. The alarms set for the check point is displayed in the Abstract Device Record dialog box.
9. To remove a reader or an input point from the list of check points, select the reader or input point in Selected Check Points and click.

Setting Check Point Alarms

You can track the movements of a guard by setting check point alarms.
For example, alarms can be configured to track the various actions of the guard, such as missing a check point, visiting a check point at a time earlier than the stipulated time, or visiting the check point at a time later than the stipulated time.
Alarms can be set for the following four states of a Sequenced checkpoint: Early Arrival, Late Arrival, Missed, and Out of Sequence. Alarms can be set only for the Checked state of Unsequenced check points.
Check point alarms are defined in the following manner:
Guard Tour
Configuring Guard Tours

a. An action group is associated to a sequenced or unsequenced check point.
b. Priority for triggering off an event or an alarm is specified for each action in the action group.
c. The Command files to be executed for each action are selected.

To set check point alarms:

1. In the Guard Tour Record dialog box, click the Sequenced Check Point or the Unsequenced Check Point tab.
2. Click Update under Alarms. The Abstract Device Record dialog box appears.

![Abstract Device Record]

See the “Configuring an Abstract Device” in Chapter 10 section for information on configuring action groups.

3. Click OK to save the details of check point alarms and return to the Guard Tour Record dialog box.
Running Guard Tours

Guard tours are run to monitor and track the movements of guards. You need to configure the guard tour server for running guard tours.

See the “Adding a Guard Tour” in Chapter 14 section for information on configuring a guard tour.

Running a guard tour involves:
- Selecting the guard tour you want to run.
- Specifying the card that is used by the guard for accessing various check points.
- Starting the guard tour.
- Viewing the status of the sequenced and unsequenced check points that the guard accesses while the guard tour progresses.
- Viewing the alarms and events generated for the actions configured for the various check point states in the guard tour.

Starting a Guard Tour

To start the guard tour:

1. Choose Operations > Guard Tour. The Guard Tour window appears.

2. Click Start. The Guard Tour - Available Tours dialog box appears with the list of configured guard tours.

3. Select the guard tour to be started and click OK. The Select window appears.
Guard Tour
Running Guard Tours

4. Select the card that is being used to validate the reader check points.
   a. In the Find Key list, select Card Number to search for cards based on card numbers, or select Description to search for cards based on the card description.
   b. In the Find What list, enter all or a part of the card number or description.
   c. Click Find. The cards matching the search criteria are retrieved in the list.
   d. Select a card number from the list and click OK to associate the card to the guard tour and to close the Select dialog box.

The details of the selected guard tour are displayed in the Guard Tour window.

5. Select a guard tour and select the Record View Visible check box to view the sequenced and unsequenced checkpoints for the guard tour. The Guard Tour Check Points dialog box appears.

6. To start the guard tour, click Start. The guard tour starts and the Next Check Point, Last Check Point, Time Left for Next Check Point, Total Tour Time Left details are updated as the guard tour proceeds.

7. To view the status of the checkpoints as the guard tour proceeds, select the Record View Visible check box. The Guard Tour Check Points dialog box appears.
Figure 14-12   Guard Tour Check Points

a. To view the status of sequenced checkpoints, click the **Sequenced CheckPoints** tab.

b. To view the status of unsequenced checkpoints, click the **Unsequenced CheckPoints** tab. The checkpoints the guard has visited is displayed in Red color.

c. To close the **Guard Tour Check Points** dialog box, clear the **Record View Visible** check box in the **Guard Tour** window.

8. To pause the guard tour, click **Pause**. The button name changes to **Resume**.

9. Click **Resume** to restart the tour.

10. Click **Cancel** to stop the guard tour.
Monitoring Actions

In this chapter...

- Introduction 15-2
- Locate Card Holder 15-2
- System Events 15-3
- Event View 15-4
- Alarm View 15-7
- Autocard Lookup 15-12
- Live Monitor View 15-14
- Digital Video 15-17
- System Viewer Real Time 15-28
Introduction

In the WIN-PAK system, the actions of card holders, guards, devices can be monitored and controlled with various methods. An action might be a card read, change in the state of input, server trouble, or even an attempt made to open a door without using a card. These actions are categorized into Events, which are regular occurrences and Alarms that require special attention.

Actions to be performed on servers, devices, and digital video are specified while defining ADVs to represent them in WIN-PAK.

Different ways of monitoring the actions:
- **Locate Card Holder**
  - Displays the card holder details such as card number, account, time and location where the card is read by the card holder, and so on.

- **System Events**
  - Displays summary of the WIN-PAK system activities such as successful and unsuccessful server connections, log on details and server disconnections.

- **Event View**
  - Displays list of currently occurring events.

- **Alarm View**
  - Pops up on the User Interface with a beep sound as soon as an alarm occurs. Continues beeping till the alarm is acknowledged.

- **Autocard Lookup**
  - The Autocard Lookup window displays the card holder details of all the card transactions. However, the option is provided to filter the devices or cards.

- **Live Monitor**
  - The Live Monitor window displays the live video from the CCTV camera.

- **Digital Video**
  - The Digital Video Display window displays the live video or the recorded video from the DVR/NVRs.

**Locate Card Holder**

The Locate Card Holder option reports the card holder details, time and location of the cards that are used by the card holder.

To locate a card holder by a card number or a card holder name:

1. Choose **Operations > Locate** or click on the toolbar. The Locate Card Holder dialog box appears.

2. Under **Locate by**, click **Card Number** or card holder **Name**.
3. Click the ellipsis button to search for the card holder. The Select dialog box appears.

![Select dialog box](image)

*(Figure 15-2  Selecting the Card Holder)*

4. Select an item in Find Key and enter the keyword in the Find What box.
5. Click Find. The card holders that match the criteria are listed.
6. Select the card holder and click OK. The dialog box is closed and the selected card holder name is displayed in the Locate Card Holder dialog box.
7. Click View to view the card holder details. The Locate Result dialog box appears.

![Locate Result dialog box](image)

*(Figure 15-3  Locate Result)*

8. Click Close to close the Locate Result dialog box.
9. Click Close to close the Locate Card Holder dialog box.

### System Events

The System Event window displays the details of WIN-PAK system activities, such as successful and unsuccessful server connections, log on details, and server disconnections. Details such as the name, time, and date of the activity are displayed. This enables easier identification of the problem sources during server communications.
Monitoring Actions

Event View

Viewing System Events

The WIN-PAK system provides an option to the user to view the history of WIN-PAK system activities.

To view the system events:

1. Choose **Operations > System Events**. The **System Event** window appears.

![System Event window](image)

**Figure 15-4  System Event window**

2. Click ✕ to close the window. You can also keep the window open always.

Event View

An event is an access control activity such as a card read, change in the state of input, and so on. The Event View window displays the details of access control activities as and when they occur. The number of events displayed in the Event View depends on the setting made for the maximum number of events in the System Defaults option. When the number of events exceeds this number, the oldest entries are replaced by the new entries.

In addition, you can filter the areas or devices to show the events that occur only in the filtered areas or devices. When the window is closed, the displayed events are lost in the Event View window. However, the history of events is maintained in the WIN-PAK system.

Opening an Event View window

To open the Event View window:

1. Click **Operations > Events** or click the View Events icon on the tool bar. The **Event View** window appears showing the list of events.
Monitoring Actions

Event View

2. Click Close to close the Event View window.

Filtering Event Views

The WIN-PAK system is provided with an option to filter the events that must be displayed in the Event View window. These filter selections are cleared, after you close the Event View window.

To filter the events:
1. Click Operations > Events or click the View Events icon on the tool bar. The Event View window is displayed.
2. Select one of the following options under On:
   - Alarm - To display only alarms in the Event View window.
   - Card Read - To display only card read events in the Event View window.
   - Both - To display all alarm and card read events in the Event View window.
3. To filter the events that occur in the specific areas and devices, click Control under Filter. The Filter Devices window appears.
4. Expand the tree by clicking the plus [+] symbol.

5. Select a branch or an individual device to be filtered for monitoring.

6. To filter a branch, right-click the branch and select **Configure**. The **Set Device Selection for a Control Area** dialog box appears.

7. Select one of the following options:
   - **Leave Selection for all devices in this area as it currently is**: To retain the existing filters set for the devices in this branch.
   - **Un-Select (Filter out) all devices in this area**: To clear the selection of all the devices in this branch. The devices in this branch are not monitored.
   - **Select (Include) all devices in this area**: To select all the devices in this branch. All the devices in this branch are monitored.

8. To filter a device, right-click the device and select **Invert Selection Status** to select the device or clear the selection.

9. Click **OK** to return to the **Filter Devices** dialog box.

**Tip:**

- To search for a branch or device:
  a. Right-click the branch or device and select **Find**. The **Find** dialog box appears.
  b. Type the item to be searched and click **Find**. The first item in the tree that matches the criteria is highlighted.

- To refresh the tree, right-click the branch or device and select **Refresh**.

10. Click **OK** to save the filter selection. Only the events that occur in the selected area and device are displayed in the **Event View** window.
Alarm View

An alarm is an event or an access control activity that must be acted upon as soon as it has occurred. The Alarm View window displays alarms when they occur and continuous to beep the sound until it is acknowledged. The Alarm View window is divided into two horizontal panes. Incoming alarms are displayed in the upper pane according to priority and time. The color of an alarm indicates the state of an alarm.

Various states of alarms are:

<table>
<thead>
<tr>
<th>Alarm State</th>
<th>Description</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert State</td>
<td>The initial state of an alarm is Alert state. When an alarm is in this state, the immediate action must be taken. Example: A person tries to open the door forcefully. This is an alarm in the Alert state.</td>
<td>Red</td>
</tr>
<tr>
<td>Normal State</td>
<td>When the access control activity becomes normal, the alarm in Alert state goes to Normal state. Example: When the forced open door is closed.</td>
<td>Green</td>
</tr>
<tr>
<td>Trouble State</td>
<td>Any problem that occurs in the device is reported as an alarm in Trouble state. Example: A reader is tampered.</td>
<td>Yellow</td>
</tr>
</tbody>
</table>

The Cnt (Count) column on the Alarm View window shows the number of state changes in a point. After the message is acknowledged, the new messages of Normal state are displayed in green.

The Details check box enables you to open the Alarm Details dialog box. In the Alarm Details dialog box, you can view the details of the state changes indicated by Cnt (Count) and write a note for an alarm in Operator Messages.

Opening an Alarm View Window

The Alarm View window automatically opens when an alarm is triggered at a reader, door, input point, or output point. You can also manually open the Alarm View window.

To open the Alarm View window:

Monitoring Actions

Alarm View

The details of an alarm is displayed in the Alarm View window such as date and time, alarm status, the reader or point from where the alarm is raised, and so on.

The \texttt{Cnt} (Count) column on the \textbf{Alarm View} window shows the number of state changes in a point.

2. Click \textbf{Close} to close the Alarm View window.

\textbf{Handling Alarms using the right-click menu options}

When you right-click the alarm, it enables the list of options to handle the alarm tasks. Based on the selected alarm type, the list of menu options differs.

\textbf{Control Functions}

The control functions pop-up on right-click menu options differ based on the alarm type:

- \textbf{Input} alarms: Acknowledge, Clear, Open Default Floor Plan, Add Note, Shunt, Unshunt, and Restore to Time Zone.
- \textbf{Door} alarms: Acknowledge, Clear, Open Default Floor Plan, Add Note, Unlock, Lock, Pulse, Timed Pulse, and Restore to Time Zone.
- \textbf{Reader} alarms: Acknowledge, Clear, Open Default Floor Plan, and Add Note.
- \textbf{Reader or Point} alarm which is attached to a camera: Acknowledge, Clear, Open Default Floor Plan, Add Note, Digital Video Live, and Digital Video Retrieval.
Monitoring Actions

Panel System alarms: Acknowledge, Clear, Open Default Floor Plan, Add Note, Buffer, and Unbuffer.

Table 15-2 Describing the basic right-click menu options for handling alarms

<table>
<thead>
<tr>
<th>Menu options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge</td>
<td>This is to acknowledge an alarm. When an alarm is acknowledged, it is moved to the lower pane of the Alarm View window. The message remains in the lower-pane, until it is cleared. <strong>Note:</strong></td>
</tr>
<tr>
<td>Open Default Floor Plan</td>
<td>This enables you to open the default floor plan associated to the device from where the alarm is triggered. &quot;Configuring an Abstract Device&quot; in Chapter 10 for defining the default floor plan for an ADV.</td>
</tr>
<tr>
<td>Add Note</td>
<td>This enables you to provide comments on acknowledging the alarm. When you click this option, the Add Operator Note dialog box is opened.</td>
</tr>
</tbody>
</table>

Handling Alarms using the Command buttons

A set of buttons on the Alarm View window enables you to easily handle basic, routine alarm tasks.

Table 15-3 Describing command buttons in the Alarm View window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge (Ack)</td>
<td>To acknowledge an alarm, select it from the list of incoming alarms and click Ack. When the alarm is acknowledged, it moves to the list in the lower pane of the Alarm View window. However, if the Automatically Clear Acknowledged Alarms option is selected in System Defaults, the alarm is cleared as soon as it is acknowledged. The background color of the acknowledged alarm changes to grey and the text color changes to green (normal), yellow (trouble) and red (alert) depending on the state of the device. It remains in the lower pane of the window until it is cleared.</td>
</tr>
<tr>
<td>Silence</td>
<td>This enables you to silence the alarm for 60 seconds without actually acknowledging it. This feature is enabled in the Alarms Handling section of the System Default Configuration.</td>
</tr>
<tr>
<td>Clear</td>
<td>To clear one or more transactions, select them from the list and click Clear.</td>
</tr>
</tbody>
</table>
Monitoring Actions

Alarm View

Table 15-3 Describing command buttons in the Alarm View window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeze</td>
<td>To temporarily stop the display of incoming messages, click Freeze. When you click Freeze, the button toggles to Release. Freezing stops the screen from scrolling as new information appears. Click Release to return the Alarm View to its normal functions.</td>
</tr>
<tr>
<td>Close</td>
<td>To quit Alarm View, click Close.</td>
</tr>
</tbody>
</table>

– In sequence: Press and hold the SHIFT key and click the first and last alarms in the range.
– At random: Press and hold the CTRL key and click each alarm.

Filtering Alarm Views

The Alarm View is provided with an option to filter areas and devices for monitoring card reads or alarms on a particular area or device. Filtering could be very useful for instances, such as, a particular guard station needs to monitor the loading dock. An Alarm View can be defined to receive messages only from the loading dock doors.

To filter the alarms:

1. Click Operations > Alarms or click the Dynamic Alarm View icon on the tool bar. The Alarm View window is displayed.
2. Under On, click Alarm, Card Read or Both to view only the alarms, card reads or both respectively.
3. To filter the branches and devices, click Control under Filter. The Filter Devices window appears.
4. Expand the tree by clicking the plus [+] symbol.
5. Select a branch or an individual device to be filtered for monitoring.

Table 15-3 Describing command buttons in the Alarm View window

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeze</td>
<td>To temporarily stop the display of incoming messages, click Freeze. When you click Freeze, the button toggles to Release. Freezing stops the screen from scrolling as new information appears. Click Release to return the Alarm View to its normal functions.</td>
</tr>
<tr>
<td>Close</td>
<td>To quit Alarm View, click Close.</td>
</tr>
</tbody>
</table>

Filtering Alarm Views

Figure 15-10 Filtering Alarm Views

Figure 15-11 Filtering Branches and Devices
6. To filter an branch, right-click the branch and select **Configure**. The **Set Device Selection for a Control Area** dialog box appears.

![Set Device Selection for a Control Area](image)

**Figure 15-12 Set Device Selection for a Control Area**

7. Select one of the following options:
   - **Leave Selection for all devices in this area as it currently is**: To leave the devices in this branch as it is - selected or cleared.
   - **Un-Select (Filter out) all devices in this area**: To clear the selection of all the devices in this branch. The devices in this branch are not monitored.
   - **Select (Include) all devices in this area**: To select all the devices in this branch. All the devices in this branch are monitored.

8. To filter a device, right-click the device and select **Invert Selection Status** to select the device or clear the selection.

9. Click **OK** to return to the **Filter Devices** dialog box.

10. Click **OK** to save the filter selection. Only the alarms that occur in the selected area and device are displayed in the **Alarm View** window.

   See the "Adding Alarm View and Event View links to the Floor Plan" in Chapter 12 for information on creating an Alarm View in the Floor Plan.

### Viewing Alarm Details

To view the details of an alarm:

1. Choose **Operations > Alarms** or double-click an alarm to open an **Alarm View** dialog box.

2. Select the **Details** check box. The **Alarm Details** window appears.
Monitoring Actions

Autocard Lookup

The Alarm Details window displays the following information:

- Name of the reader, input or output point from where the alarm is triggered
- The date and time of the alarm and the state of the reader or point
- Indication of whether the alarm has been acknowledged or cleared
- The name of the operator who has acknowledged or cleared the alarm.
- The message box to display the note added by the operator while acknowledging or clearing the alarm.

3. To acknowledge the alarm, select the alarm and click Ack.
4. To clear the alarm, select the alarm and click Clear.
5. To add a note to an alarm while acknowledging or clearing, click Add Note. The Add Operator Note dialog box appears.

6. Type a message in the Operator Note and click OK.

Autocard Lookup

The Autocard Lookup feature enables you to view the card holders details from the designated readers or card reads that have a status priority higher than a designated threshold. If the...
Autocard Lookup window is minimized and a card read is received, the window will pop-up automatically.

The Autocard Lookup window displays the card holder picture (if available), name of the card holder, card number, time, date, reader name, and the status of the card read.

**Activating Autocard Lookup**

To activate an Autocard Lookup window:


![Figure 15-15 AutoCard Lookup - Waiting for card read...](image)

2. Set the **Priority** of card read. The card holder details of all card reads having a higher priority (lower number) than this priority is displayed in Autocard lookup. The priority of a given card read event is set in the reader's Action Group.

   See the "Configuring an Abstract Device" in Chapter 10 for information on setting the priority for an action.

3. To specify the areas and panels of card reads, click **Control**. The **Filter Devices** window appears.

![Figure 15-16 Filter Devices](image)

4. Expand the panel by clicking on the plus signs [+].

5. Right-click the readers that you want to monitor through Autocard Lookup and select **Invert Selection Status**.

6. Click **OK** to return to the **AutoCard Lookup - Waiting for Card Read...** window. When a card from the filtered area and device is presented to the reader, the card information is displayed.
Monitoring Actions  
Live Monitor View

Figure 15-17 Card Information

7. Select the Buffer check box to freeze the current card information on the lookup screen, while saving any subsequent card reads in the panel memory.

8. Click Next to display the next card read results, while remaining in the buffer mode.

9. Clear the Buffer check box to remove all stored information and continue with the next card presented.

10. Click the Show Note Fields check box to display the additional information of the card holder defined in the note fields.

Live Monitor View

The Live Monitor view displays information from a selected CCTV camera in real-time. You can adjust the video display using the Iris, Zoom, Focus, Pan and Tilt controls that are located to the right of the viewing screen. In addition, you can capture and save individual frames.

For Live Monitor view, you must:

- Equip your computer with a video capture card.
- Connect the CCTV Switcher to the video capture card.
- Define cameras and monitors on the Device Map.
- Select the CCTV Switcher monitor for Live Monitor view while setting the Workstation Defaults.

Opening a Live Monitor View

To open the Live Monitor view:

Monitoring Actions
Live Monitor View

2. To enlarge the size of the Live Monitor view, click and drag the corners of the dialog box.
3. To view a different area from a different camera, select the camera in the drop-down list.

Capturing a Frame from the Live Monitor View
To capture a frame from the Live Monitor view, freeze the live view and then save the frame.

1. To freeze a view, right-click anywhere in the live area and select Live.
2. To save the frame, right-click the frozen video and select Save.
3. Select a path, enter a filename and click Save to save the image as a.jpg file.
4. Click OK.

Controlling the Camera
You can control the focus, aperture adjustment, zoom, pan and tilt, and homing presets of switchers and cameras remotely through WIN-PAK.

1. To view the title of the camera that is monitored, right-click in the live view area and select Send Camera Titles.
2. To view the time and date, right-click in the live view area and select Send Time and Date.

Refer to the CCTV equipment manual to ensure that title, time and date features are supported.

<table>
<thead>
<tr>
<th>Button</th>
<th>Control Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Adjusting Focus</td>
<td>Click and hold the upper half of Focus In/Focus Out to slowly focus on closer objects. Click and hold the lower half of the button to slowly focus on distant objects.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Adjusting Iris</td>
<td>Click and hold the top half of Iris In/Iris Out to slowly increase the aperture (opening) of the camera iris, allowing more light in. Click and hold the bottom half of the button to slowly decrease the aperture of the camera iris, letting in less light.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Adjusting Zoom</td>
<td>Click and hold the upper half of Zoom In/Zoom Out to slowly zoom the camera in. Click and hold the lower half of the button to slowly zoom the camera out.</td>
</tr>
</tbody>
</table>
Monitoring Actions
Live Monitor View

Table 15-4 Describing control buttons on the Live Monitor window

<table>
<thead>
<tr>
<th>Button</th>
<th>Control Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Adjusting Pan/Tilt</td>
<td>The control arrows on the Live Monitor window pan the camera left and right, and tilt it up and down. Click and hold the camera control arrows to move the camera. The left arrow pans to the left. The right arrow pans to the right. The up arrow tilts the camera up, while the down arrow tilts the camera down. If the cursor is moved over the live viewing area, arrows appear. Clicking these cursor arrows has the same effect as the control arrow buttons.</td>
</tr>
</tbody>
</table>

Setting Pan and Tilt Limits

Panning and tilting limits are set for each camera to ensure that the camera does not pan or tilt to a point that is stressful on the camera.

Perform the following steps to set the upward tilt limit for a camera. Repeat these steps for downward tilt, left pan, and right pan on each camera.

1. Using the upward and downward arrows, tilt the camera to the highest required point.
2. Right-click the upward arrow and select **Set Limit** from the control menu displayed.

Clearing Limits

To clear the pan and tilt limits:

1. Right-click the arrow for which you want to clear limits, and select **Clear Limit** from the control menu.

Setting Home Position

Home Position is the camera view set for each camera to bring back its home position with the current focus, aperture, and zoom settings. This is the most utilized camera view.

To set the home position:

- On the Live Monitor window, click the square button, located among the pan/tilt arrows.

The following steps outline setting a home position:

1. Adjust the pan, tilt, and aperture settings for the view that you want to make your home position.
2. Right-click **Home** and click **Set Home**.

   The camera returns to this view anytime you click **Home**.
WIN-PAK CCTV Options

<table>
<thead>
<tr>
<th>Brand</th>
<th>Switch</th>
<th>Camera Title</th>
<th>Time Date</th>
<th>Pan Tilt</th>
<th>Zoom</th>
<th>Pan Tilt Limit</th>
<th>Zoom Limit</th>
<th>Focus Limit</th>
<th>Iris Limit</th>
<th>Seek Home</th>
<th>Set Home</th>
<th>Select Monitor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burle</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Dedicated Micros</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td>Geutebruk</td>
<td>x</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td>Javelin</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>NCI CCTV</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td>Panasonic</td>
<td>x</td>
<td>o</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td>Pelco</td>
<td>x</td>
<td>o</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Vicon</td>
<td>x</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

X = option is available and usable through WIN-PAK
O = option either not available or not supported by WIN-PAK

Digital Video

The Digital Video Display shows the live video or the recorded video from the selected DVRs. At the maximum, it can display video from 16 cameras.

**Note:** The Video Management functionality is NOT applicable to WIN-PAK XE.

Opening the Digital Video Display

The Digital Video Display window opens automatically, when an action triggers this window to open. However, you can open the video display window manually.

To open the digital video display:

1. Choose **Operations > Digital Video**. The **Digital Video** window appears.
2. Select the cameras in the **Cameras** list. For multiple selections, use the **SHIFT** or **CTRL** key.
3. To view live video, click **Live**.
   
   OR
   
   To view the recorded clip, click **Clip From** and enter the date and time from when you want to view the clip.
4. If you want to filter the events to be displayed in the Digital Video display, click **Filter**.
   
   See the **Filtering Events** section for more information on filtering the events.
5. Click **Show** to view the live video or the recorded video. The **Viewer Salvo Layout** window appears.
### Monitoring Actions

#### Digital Video

**Figure 15-19** Viewer Salvo Layout

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Salvo View Icon" /></td>
<td>Salvo View.</td>
</tr>
<tr>
<td><img src="image" alt="Color Correction Icon" /></td>
<td>Color Correction.</td>
</tr>
<tr>
<td><img src="image" alt="Flip the video display Icon" /></td>
<td>Flip the video display.</td>
</tr>
<tr>
<td><img src="image" alt="Mirror image of the video Icon" /></td>
<td>Mirror image of the video.</td>
</tr>
<tr>
<td><img src="image" alt="Remove text overlay Icon" /></td>
<td>Remove text overlay</td>
</tr>
<tr>
<td><img src="image" alt="Clip export Icon" /></td>
<td>Clip export.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Salvo snapshot icon" /></td>
<td>Salvo snapshot.</td>
</tr>
<tr>
<td><img src="image" alt="Snapshot icon" /></td>
<td>Snapshot.</td>
</tr>
<tr>
<td><img src="image" alt="Synch playback icon" /></td>
<td>Synch playback.</td>
</tr>
<tr>
<td><img src="image" alt="Full screen icon" /></td>
<td>Full screen.</td>
</tr>
<tr>
<td><img src="image" alt="Close All icon" /></td>
<td>Close All.</td>
</tr>
<tr>
<td><img src="image" alt="Sync icon" /></td>
<td>Sync.</td>
</tr>
<tr>
<td><img src="image" alt="Volume control icon" /></td>
<td>Volume control.</td>
</tr>
<tr>
<td><img src="image" alt="Change playing speed icon" /></td>
<td>Change playing speed.</td>
</tr>
<tr>
<td><img src="image" alt="Reverse play video icon" /></td>
<td>Reverse play video.</td>
</tr>
<tr>
<td><img src="image" alt="Reverse frames icon" /></td>
<td>Reverse frames.</td>
</tr>
<tr>
<td><img src="image" alt="Pause video icon" /></td>
<td>Pause video.</td>
</tr>
</tbody>
</table>
Monitoring Actions
Digital Video

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Forward frames.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Forward play video.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Live video.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Time jump.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Calendar.</td>
</tr>
</tbody>
</table>

6. Use the camera controls in the **Viewer Salvo Layout** window to adjust the camera as required.

**Video control options in panel toolbars**

The panel toolbars appear when you hover the mouse over the video displayed in a panel. The toolbar that appears on top of a panel enables you to view the name of the video source and close the video display. The toolbar that appears on the bottom and on the right of a panel consists of icons that enable you to perform the following actions.
### Table 15-5  Video Control Options in Panel Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Zoom in to the video.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Zoom out of the video.</td>
</tr>
<tr>
<td><img src="image" alt="Flip" /></td>
<td>Flips the video display. Alternatively, you can click this icon in the toolbar on the top of the salvo layout.</td>
</tr>
<tr>
<td><img src="image" alt="Mirror" /></td>
<td>View the mirror image of the video display. Alternatively, you can click this icon in the toolbar on top of the salvo layout.</td>
</tr>
<tr>
<td><img src="image" alt="Reset" /></td>
<td>Resets the digital PTZ effects on the video display.</td>
</tr>
<tr>
<td><img src="image" alt="Color Correction" /></td>
<td>Displays the color correction window. Move the sliders to set the brightness, contrast, hue, and saturation. You can select the Blur check box to blur the video display and the Sharpness check box to increase the image sharpness or clarity. Alternatively, you can click this icon in the toolbar.</td>
</tr>
<tr>
<td><img src="image" alt="Select" /></td>
<td>Displays a drop down box of presets. You can select a preset for the camera. <strong>Note:</strong> The drop down box is disabled when digital PTZ is enabled. You need to disable the digital PTZ feature to select a preset. See <em>Panning, Tilting, and Zooming</em> for information on enabling and disabling the digital PTZ feature.</td>
</tr>
<tr>
<td><img src="image" alt="Move" /></td>
<td>Moves a preset camera position. To move a preset, select a preset number from the drop down list and then click the icon. The camera position (pan, tilt, and zoom) is moved to the selected preset. <strong>Note:</strong> This icon is disabled when digital PTZ is enabled. You need to disable the digital PTZ feature to move a preset. See <em>Panning, Tilting, and Zooming</em> for information on enabling and disabling the digital PTZ feature.</td>
</tr>
</tbody>
</table>
## Monitoring Actions

### Digital Video

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Preset Camera Position Icon" /></td>
<td>Stores a preset camera position. To store a preset, select a preset number from the drop down list and then click the icon. The camera position (pan, tilt, and zoom) is saved in the selected preset. <strong>Note:</strong> The icon is disabled when digital PTZ is enabled. You need to disable the digital PTZ feature to move a preset. See <em>Panning, Tilting, and Zooming</em> for information on enabling and disabling the digital PTZ feature.</td>
</tr>
<tr>
<td><img src="image" alt="Record Icon" /></td>
<td>Starts user activated recording. This feature is currently not implemented and is reserved for future releases of WIN-PAK.</td>
</tr>
<tr>
<td><img src="image" alt="Surrounding Cameras Icon" /></td>
<td>Surrounding cameras. This feature is currently not implemented and is reserved for future releases of WIN-PAK.</td>
</tr>
<tr>
<td><img src="image" alt="Pan Left Icon" /></td>
<td>Pan left.</td>
</tr>
<tr>
<td><img src="image" alt="Pan Right Icon" /></td>
<td>Pan right.</td>
</tr>
<tr>
<td><img src="image" alt="Tilt Up Icon" /></td>
<td>Tilt up.</td>
</tr>
<tr>
<td><img src="image" alt="Tilt Down Icon" /></td>
<td>Tilt down.</td>
</tr>
<tr>
<td><img src="image" alt="Open Iris Icon" /></td>
<td>Open iris.</td>
</tr>
<tr>
<td><img src="image" alt="Close Iris Icon" /></td>
<td>Close iris.</td>
</tr>
<tr>
<td><img src="image" alt="Focus Far Icon" /></td>
<td>Focus far.</td>
</tr>
</tbody>
</table>
Context menu options

When you right-click on a panel displaying live video, a context menu appears. The following table lists the commands in the context menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Click to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Screen</td>
<td>maximize the salvo layout to full screen. Alternatively, you can click <img src="image" alt="icon" /> in the toolbar on the top of the salvo layout.</td>
</tr>
<tr>
<td>Remove Text Overlay</td>
<td>to remove text overlay displayed on the video. Alternatively, you can click <img src="image" alt="icon" /> in the toolbar on the top of the salvo layout.</td>
</tr>
<tr>
<td>Digital PTZ</td>
<td>enable digital PTZ. See <em>Panning, Tilting, and Zooming</em> for information on digital PTZ.</td>
</tr>
<tr>
<td>Save Image</td>
<td>save the frame displayed in the panel as an image in the BMP format. Alternatively, you can click in the toolbar on the top of the salvo layout to save the image in BMP format. See “Saving Images” on page 24.</td>
</tr>
<tr>
<td>Save Image As</td>
<td>save the frame displayed in the panel in different image formats such as JPG, PNG, and GIF. See “Saving Images” on page 24.</td>
</tr>
</tbody>
</table>

Panning, Tilting, and Zooming

You can pan, tilt, and zoom (PTZ) the video displayed in a panel. You can perform two types of PTZ namely, analog PTZ and Digital PTZ.

Analog PTZ is the panning, tilting, and zooming of PTZ cameras.

Using the digital PTZ feature, you can perform panning and tilting on live and recorded video and clips. The digital PTZ feature when enabled allows you to perform panning and tilting on the video display that is zoomed or enlarged.

**Zooming the video display**

Use the mouse scroll wheel to enlarge (zoom in) or reduce (zoom out) the video display in the panel. Alternatively, hover the mouse over the video display. A toolbar appears in the lower part of the panel. You can click ![icon](image) to zoom in and ![icon](image) to zoom out the video display.
Panning and Tilting
To perform analog PTZ:
1. Click the Viewer tab.
2. Center-click anywhere on the video panel. A point is highlighted.
3. Move the mouse to the preferred location, and then click and hold left mouse button to perform pan and tilt. A arrow appears in the direction where the mouse is being moved.
4. Center-click again to stop panning and tilting.
   **Note:** The digital PTZ must be disabled to use analog PTZ. To disable the digital PTZ feature, click and clear Digital PTZ in the context menu.
5. Click the video display and drag the mouse pointer in the direction to pan or tilt. An arrow appears on the video display indicating the pan or tilt direction.

To perform digital PTZ:
1. Right-click on the video display in a panel. A context menu appears.
2. Select **Digital PTZ**. The digital PTZ feature is enabled for the video display in the panel.
3. Zoom the video display.
4. Center-click anywhere on the video panel. A point along with left, right, up, and down arrows appear.
5. Move the mouse in the required direction to pan and tilt.
6. Center-click again to stop panning and tilting.

Saving Images
While viewing video in the panel, you can save a frame of the video as an image. The image can be saved in Bitmapped Graphics (BMP), Joint Photographic Experts Group (JPG) format, Portable Graphics format (PNG), and Graphics Interchange Format (GIF).

**To save a frame displayed in a panel as an image:****
1. Click the Viewer tab.
2. Right-click the panel to display a context menu.
3. Select Save Image to save the image in .BMP format. Alternatively, you can click on the toolbar on top of the salvo layout. The images are saved in the ImagesAndClips folder at the location in the hard drive in which Video Management Server files are installed. For example, X:\Program Files\WIN-PAK PRO\Honeywell\TrinityFramework\ImagesAndClips. Here, X: is the hard drive.
   **OR**
   Select **Save Image As** to save the image in other formats. The **Save As** dialog box appears when you select the Save Image As command. You can select the format in the **Save As Type** box and type the name for the image in **File Name** box. You can also select a folder to save the image.

**To save the salvo layout as an image:**
- Click **on the toolbar on top of the salvo layout.

  The salvo layout is saved as an image (.BMP format) in the ImagesAndClips folder.

Filtering Events
The filter option in the Digital Video window helps you to view the events for a specific period. Therefore, it enables you to retrieve the digital video that is associated to an ADV, which is
configured for an auto pop-up display. For example, you may want to view the events from March 15, 2005 to April 30, 2005.

To filter the events of the recorded video display:

1. In the Digital Video window, click Filter. The Event Filter dialog box appears.

![Event Filter dialog box](image)

**Figure 15-20 Event Filter**

2. To select the associated camera and recorded video clip based on the specific date and time ranges:
   a. Click the Date and Time Filter tab.
   b. Under Date Range, select the From and To dates using the ellipsis button.
   c. Enter the From and To time (in hours and minutes) in the corresponding boxes.
   d. To display video for events that occurred during a particular period, select the Only list events between these hours each day check box, under Daily Time Range. The From and To text boxes are enabled.
   e. In the From and To boxes, enter the time range (in hours and minutes).
   f. Select the standard time zone in the Time Zone list.

3. To select the associated camera and recorded video clip based on the type of card events:
   a. Click the Transaction Filter tab.
b. To filter the video display based on the transaction types, select the following options under **Transaction Types**:

**Table 15-6 Describing the transaction types for filtering video display**

<table>
<thead>
<tr>
<th>Card Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Includes alarms in Alert and Normal states.</td>
</tr>
<tr>
<td>System Alarm</td>
<td>Includes events of system type alarms (not wired points) such as Poll Response alarms.</td>
</tr>
<tr>
<td>Operator</td>
<td>Includes events of operator activities, such as log on and log off.</td>
</tr>
<tr>
<td>Database</td>
<td>Includes events of basic database activities, such as time, date, operator, update, delete or add action to a particular database.</td>
</tr>
<tr>
<td>Card</td>
<td>Includes all card events.</td>
</tr>
<tr>
<td>Guard</td>
<td>Includes all guard tour events.</td>
</tr>
</tbody>
</table>
c. To select the camera display based on the alarm and card behaviors, select the following options under **Alarm & Card**:

**Table 15-7 Describing the alarm and card options for filtering video display**

<table>
<thead>
<tr>
<th>Card Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions</td>
<td>Includes card events of all transactions such as normal, alarm, or host grant.</td>
</tr>
<tr>
<td>Clears</td>
<td>Includes the card alarm events that were cleared by the operator.</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>Includes the card alarm events that were acknowledged by the operator.</td>
</tr>
<tr>
<td>Operator Messages</td>
<td>Includes the card alarm events that were provided with the operator messages.</td>
</tr>
</tbody>
</table>

d. To filter the transactions performed on specific ADVs (devices), click **Filter ADVs**. The **Filter Devices** dialog box appears.

e. Double-click the branch (folder) to select all the devices in the branch
   OR
   Expand the branch (folder) and double-click a device to select the particular device.

f. Click **OK** to return to the **Event Filter** dialog box.

4. To filter the card holders:
   a. Click the **Card Holder Filter** tab.

   ![Figure 15-22 Card Holder Filter tab](image)

   b. Type the **First Name** and **Last Name** of the card holder, or select them by clicking the ellipsis button.

   c. Type the **Card Number** of the card holder or select it by clicking the ellipsis button.
Monitoring Actions
System Viewer Real Time

d. To display the video of the card holders accessing a specific area, select an area in the Tracking Area list that is configured in Tracking and Musterin Area.

e. Select one or more Card Codes which define the card transaction.

f. Select the Note Fields to be displayed. You can also specify the range if you select the numerical note field.

5. To filter further on alarm events:

a. Click the Alarm Filter tab.

b. Enter the alarm point name or use the ellipsis button to find an alarm point.

c. Select the Alarm States that must be included in the report.

6. Click OK to save the filtering settings and return to Digital Video window.

Events associated with a digital camera are displayed with either a fixed camera icon or a PTZ (Pan Tilt Zoom) camera icon, represented with a zoom lens.

System Viewer Real Time

The System Viewer is available only to the operators with “Administrator” permissions, and displays data coming in and out of the communication port. This data can be generated as a report and exported to a file. A viewer freeze button is provided to freeze the scrolling information and allows you to scroll up and down the available list. The quantity of lines that can be viewed in real-time can be selected between 10 and 32,000 with a default setting of 1000.

Opening the System Viewer Real Time window

To open the System Viewer Real Time window:

1. Choose Operations > System Viewer Real Time. The System Viewer Real Time window appears displaying the communication port data.
Figure 15-24  System View Real Time

2. Click any of the following to customize the port data.
   - **Clear All** - clears the data.
   - **Freeze** - Freezes the scrolling information.
   - **Export File** - exports the data to Microsoft Excel.
   - **Close** - closes the system viewer real time window.
Translation

In this chapter...

Introduction 16-2
Language Configuration 16-3
Translation
Introduction

Introduction

WIN-PAK allows you to translate the language of its user interface to languages other than English. The User Interface is translated based on the entries in language text files. A language text file contains entries in English and the corresponding entries in the language to be translated for the captions in the dialog boxes, menus, and other text in the WIN-PAK user interface. The text files for French, German, Dutch, Italian, English, Simplified Chinese, and Traditional Chinese languages are available by default in the WINPAKPRO\Language Files folder of WIN-PAK.

Translating WIN-PAK User Interface involves:

1. Adding a new language with its text and help files into the WINPAKPRO\Language Files folder.
2. Selecting the language for translation.
3. Modifying the translated text (if required) for the dialog box captions, menus, and the other text in the User Interface.

By default, WIN-PAK is designed to work with U.S. English operating systems. Therefore, a special version of WIN-PAK is required to work with the operating systems of other languages. Contact the technical support of Honeywell Access Systems for support on international operating systems.
Language Configuration

Configuring language details involves:

1. Adding a new language with its text and help files.
   OR
   Editing existing language information.

2. Selecting a language for translation.

If a language text file is present, the user interface is translated based on the information present in the text file. In case of a new language, the text file would initially be empty. You are provided with the option of entering the translated text for the captions in the dialog boxes, menus, and the other text present in the user interface. These entries are updated in the language text file and are used for translation.
Translation
Language Configuration

Adding or Editing Language Information

You can add a new language for translation by providing the following information:

- the language name
- the language text file
- the language help file

Adding a new Language

1. Choose Configuration > Translate > Available Languages.

![Figure 16-1 Adding a new Language](image)

The Edit List of Available Languages dialog box appears with a list of existing language files.

![Figure 16-2 Full list of available Languages](image)

2. Click Add. The Configure Language dialog box appears.

![Figure 16-3 Configure Language](image)
3. Type the **Language Name**.
4. Type a name for the text file in **File**.
5. Type the name of the **Help File** for this language. By default, the American English help file is used.
6. Click **OK** to save the language information, and return to the **Edit List of Available Languages** dialog box. The details of the newly added language are listed.
7. Click **OK** to close the window.

**Editing a Language**

1. Choose **Configuration > Translate > Available Languages**. The **Edit List of Available Languages** dialog box appears.
2. Select the language you want to edit and then click **Edit**. The **Configure Language** dialog box appears.
3. Edit the **Language Name**, **File**, and **Help File**.
4. Click **OK** to save the changes and return to the **Edit List of Available Languages** dialog box.

**Deleting a Language**

1. Choose **Configuration > Translate > Available Languages**. The **Edit List of Available Languages** dialog box appears.
2. Select the language you want to delete and then click **Delete**. A message asking for confirmation appears.
3. Click **Yes** to confirm the deletion.
Translation
Language Configuration

Selecting a language for translation

You can select a language for translating the WIN-PAK user interface. When a language is selected, the WIN-PAK user interface is translated based on the entries in the language text file.

In addition, you can set the language for operators using the Operator option in the System menu. The WIN-PAK user interface is translated to the language of the operator who logs on to WIN-PAK.

To select a language:

1. Choose Configuration > Select Language.

![Figure 16-4 Selecting a Language]

The Select Language dialog box appears.

![Figure 16-5 Select Language dialog box]

2. Select a language for translation from the list.
3. Click OK.
Adding or editing entries for translating Dialogs, Menus, and Other Text

On selecting a language, the WIN-PAK user interface is translated based on the entries in the language text file. In case of a new language, the text file would initially be empty. In such a case, you can translate the captions for all the dialogs, menus, and other text present in the user interface. The translated captions are entered in the language text file. In addition, you can edit the translated captions for all dialogs, menu, and the other text in the user interface. The language text file is updated with the modified entries.

See the Selecting a language for translation section in this chapter, for more details on selecting a language for translation.

Adding or Editing entries for dialog boxes


![Edit Dialog Text](image)

Table 16-1 Edit Dialog Text - Elements and Descriptions

<table>
<thead>
<tr>
<th>Field/Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total # Dialogs</td>
<td>The total number of dialog boxes for translation.</td>
</tr>
<tr>
<td>Translated</td>
<td>The total number of fields in the dialog box that has been translated.</td>
</tr>
<tr>
<td>Out of Date</td>
<td>The number of dialog boxes that were translated in the previous version of WIN-PAK (applies only to a WIN-PAK upgrade.)</td>
</tr>
<tr>
<td>Dialog Caption</td>
<td>The caption of the dialog box.</td>
</tr>
<tr>
<td>Total</td>
<td>The total number of fields in the dialog box.</td>
</tr>
<tr>
<td>Done</td>
<td>The number of fields that has been translated in the dialog box.</td>
</tr>
</tbody>
</table>
Translation
Language Configuration

Table 16-1 Edit Dialog Text - Elements and Descriptions

<table>
<thead>
<tr>
<th>Field/Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Out of Date</td>
<td>The number of fields that were translated in this dialog box in the previous version of WIN-PAK (applies only to a WIN-PAK upgrade.)</td>
</tr>
<tr>
<td>ID</td>
<td>The dialog ID used in the application resource file.</td>
</tr>
</tbody>
</table>

2. Select a dialog caption from the Dialog Caption list and click Edit. The dialog box of the selected dialog caption appears.

![Figure 16-7 Selecting a dialog caption](image)

3. Click the field you want to edit. The field name is highlighted.

![Figure 16-8 Editing the field](image)

4. Type the text in the highlighted area.
Figure 16-9  Typing the text

5. Press **ENTER** to save the change.

6. Repeat steps 3 to 5 of the procedure to edit the remaining field names in the dialog box.

7. Click the **Close (X)** icon in the dialog box to save the changes and to close the dialog box.

   The changes are updated in the language text file. The values in **Total Line of Text**, **Translated**, **Out of Date**, **Total**, **Done**, and **Out of date** columns in the **Edit Dialog Text** are updated with the number of fields that are translated.
Translation
Language Configuration

Adding or editing entries for menus

1. Choose **Configuration > Translate > Menus**. The **Translate Menu Text** window appears.

   ![Figure 16-10 Translate Menu Text](image)

   **Table 16-2 Translate Menu Text - Elements and Description**

<table>
<thead>
<tr>
<th>Field/Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Line of Text</td>
<td>The total text lines to be translated.</td>
</tr>
<tr>
<td>Translated</td>
<td>The total number of text lines that have been translated.</td>
</tr>
<tr>
<td>Out of Date</td>
<td>The number of menus that were translated in the previous version of WIN-PAK (applies only to a WIN-PAK upgrade.)</td>
</tr>
<tr>
<td>English, United States</td>
<td>The menu captions in the original language of WIN-PAK</td>
</tr>
<tr>
<td>Language (the language selected for translation is displayed as the column name.)</td>
<td>The menu text in the translated language.</td>
</tr>
</tbody>
</table>

2. Double-click the menu item that must be translated from the list, or right-click the menu item and then click **Edit**. The **Translate Text** dialog box appears.

   a. Type a part or the whole text in the **Search** box.
   b. Select the **Match Case** check box to match case while searching.
   c. Select the **Show only untranslated items** check box to search only for menu items that are not translated.
   d. Click **Find**. The first instance of the menu item is highlighted in the list. Clicking **Find** repeatedly highlights the remaining instances of the text in the list.
The current menu caption is displayed under Original text.

3. Type the translated caption for the menu under Translation.

4. Select the Apply to all identical originals check box to apply the translation for all instances of Original text in the User Interface.

5. Click OK to save the entry and return to the Translate Menu Text window.

   The changes are updated in the language text file. The values in Total Line of Text, Translated, and Out of Date columns in the Edit Dialog Text are updated with the number of fields that are translated.

Adding or Entering Entries for other Text

Other text refers to the text other than the dialog box or menu captions, such as examples, warnings, prompts, messages, and so on.

1. Choose Configuration > Translate > Other Text. The Translate Other Text window appears.
Translation
Language Configuration

Table 16-3 Translate Other Text Options

<table>
<thead>
<tr>
<th>Field/Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Line of Text</td>
<td>The total number of lines of text to be translated.</td>
</tr>
<tr>
<td>Translated</td>
<td>The total number of lines of a text that have been translated.</td>
</tr>
<tr>
<td>Out of Date</td>
<td>The number of miscellaneous text entries that were translated in the previous version of WIN-PAK (applies only to a WIN-PAK upgrade.)</td>
</tr>
<tr>
<td>English, United States</td>
<td>The text in the original language of WIN-PAK</td>
</tr>
<tr>
<td>Language (the language selected for translation is displayed as the column name.)</td>
<td>The text in the translated language.</td>
</tr>
<tr>
<td>Notes</td>
<td>The instructions used for performing the translation. This is included in the text file.</td>
</tr>
<tr>
<td>In File</td>
<td>This is significant only for the maintenance people.</td>
</tr>
</tbody>
</table>

2. Double-click the text that must be translated from the list, or right-click the text and then click Edit. The Translate Text dialog box appears.
   a. Type a part or the whole text in the Search box.
   b. Select the Match Case check box to match case while searching.
   c. Select the Show only untranslated items check box to search only for text items that are not translated.
   d. Click Find. The first instance of the text item is highlighted in the list. Clicking Find repeatedly highlights the remaining instances of the text in the list.

![Figure 16-12 Translate Text](image)

The current line of text is displayed under Original text.
3. Type the translated text under Translation.

4. Select the Apply to all identical originals check box to apply the translation to all instances of the Original text in the user interface.

5. Click OK to save the entry and return to the Translate Other Text window. The changes are updated in the language text file. The values in Total Line of Text, Translated, and Out of Date columns in the Edit Dialog Text are updated with the number of field names that are translated.
Translation
Language Configuration
Reports

In this chapter...

Introduction 17-2
Report Templates 17-2
Generating and Printing a Report 17-7
Introduction

You can generate a number of reports using WIN-PAK. These reports can be generated based on the filter criteria. Reports can be sorted in an ascending or descending order and can be previewed and printed.

The following is the list of reports that can be generated in WIN-PAK:

- Access Area
- Access Level
- Account
- ADV Actions
- Attendance
- Card
- Card Frequency
- Card History
- Card Holder
- Card Holder Tab Layout
- Command File
- Control Area
- Device Map
- Floor Plan
- Galaxy Panel Log
- Guard Tour
- History
- Holiday Group
- Note Field Template
- Operator
- Operator Actions
- Operator Level
- Schedule
- Time Zone
- Tracking and Muster Area

In addition, WIN-PAK provides an option to define the templates for the Card Holder report and the History report.

Report Templates

In WIN-PAK, you can define the report templates for the frequently-generated reports; Card Holder report and History report.

Defining Card Holder Report Templates

Adding a Card Holder Report Template

To define the Card Holder report template:

2. Expand the Report Templates folder to view the Card Holder and History folders.

![Figure 17-2  Report - Card Holder dialog box](image)

See the Card Holder Report section for more on defining the filter options for the card holder report.

4. Type the name of the Card Holder Report template in the text box on the right.

5. Click Save Template to save the template.

6. To create a copy of the template, click Save As. The Save As/Copy - Report Template dialog box appears.
7. Type a new name for the template and click OK to create a copy of template and return to the Report - Card Holder dialog box.

8. Click Close to close the dialog box.

**Editing a Card Holder Report Template**

To edit the Card Holder Report template:

2. Expand the Report Templates folder and the Card Holder folder.

   See the Adding a Card Holder Report Template section for information on editing the template.

**Searching a Card Holder Report Template**

To search a Card Holder Report template:

2. Expand the Report Templates folder and the Card Holder folder.
3. Right-click the report template and click Find. The Find Item dialog box appears.

   4. Type the name of the template to be searched and click OK. The template starts with the specified name is highlighted.

**Deleting a Card Holder Report Template**

To delete a Card Holder Report template:

2. Expand the Report Templates folder and the Card Holder folder.
3. Right-click the report template and click Delete. A message asking for confirmation appears.
Figure 17-5  Deleting Card Holder Report Template-confirmation message

4. Click Yes to confirm the deletion. The selected report template is deleted.

To delete all the card holder report templates:

2. Expand the Report Templates folder and
3. Right-click the Card Holder folder and click Delete All. A message asking for confirmation appears.
4. Click Yes to confirm the deletion.

Defining History Report Templates

Adding a History Report Template

To define the History report template:

2. Expand the Report Templates folder to view the Card Holder and History folders.

Figure 17-6  Adding a History Report Template

Reports
Report Templates

Figure 17-7 Report History dialog box

See the History Report section in this chapter for more on defining the filter options for the generating history report.

4. Type the name of the History Report template in the text box on the right.
5. Click Save Template to save the template.
6. To create a copy of the template, click Save As. The Save As/Copy - Report Template dialog box appears.

Figure 17-8 Save As/Copy - Report Template dialog box

7. Type a new name for the template and click OK to create a copy of template and return to Report - History dialog box.
8. Click Close to close the dialog box.

Editing a History Report Template

To edit the History Report template:
2. Expand the Report Templates folder and the History folder.

   See the Adding a History Report Template section in this chapter for details on editing the template.

### Searching a History Report Template

To search a History Report template:

2. Expand the Report Templates folder and the History folder.
3. Right-click the report template and click Find. The Find Item dialog box appears.

   ![Find Item dialog box](image)

   Figure 17-9   Find Item dialog box
4. Type the name of the template to be searched and click OK. The template starts with the specified name is highlighted.

### Deleting a History Report Template

To delete a History Report template:

2. Expand the Report Templates folder and the History folder.
3. Right-click the report template and click Delete. A message asking for confirmation appears.
4. Click Yes to confirm the deletion. The selected report template is deleted.

To delete all the History Report templates:

2. Expand the Report Templates folder and
3. Right-click the History folder and click Delete All. A message asking for confirmation appears.
4. Click Yes to confirm the deletion.

### Generating and Printing a Report

To generate a report:

1. Choose Reports > Reports or click the Reports icon on the toolbar. The Reports window appears.
Reports
Generating and Printing a Report

2. To generate a report based on the filtering parameters, select and double-click a report from the list.

   OR

   Select a report from the list and click Report Options. The corresponding Report dialog box appears.

3. Set the filtering parameters for generating the report.

   See the corresponding report section in this chapter for setting the filter parameters.

Previewing a report

To see the preview of a report, before printing the report:

1. In the Report dialog box, click Print Preview. The preview of the corresponding report is displayed.
Figure 17-11  Preview of a report

If you place the cursor on the preview area, the pointer changes to a magnifier icon.

2. To enlarge the preview size:
   a. Click **Zoom In**.

   OR

   Click anywhere on the preview area using the magnifier icon. Ensure that the **Zoom In** button is enabled before clicking.

3. To reduce the preview size,
   a. Click **Zoom Out**.

   OR

   Click anywhere on the preview area using the magnifier icon. Ensure that the **Zoom Out** button is enabled before clicking.

4. If the report runs to more than a page, click **Next Page** or **Prev Page** to move to the next and previous pages of the report.

5. If you want to preview the report on two pages, click **Two Page**.
Generating and Printing a Report

6. To close the preview window and print the report:
   a. Click Print. The Print dialog box appears.

   ![Print dialog box](image)

   **Figure 17-13  Print dialog box**

   b. Select the printer in the Name list and set the print properties.
   c. Click OK. The report is printed to the selected printer.

7. To close the preview window without printing the report, click Close.

*Printing the report*

To print the report:
1. Click **Print** in the **Report** dialog box. The **Print Progress** dialog box appears showing the formatting status.

![Print Progress](image1)

*Figure 17-14  Print Progress*

Then, the **Print** dialog box appears.

![Print dialog box](image2)

*Figure 17-15  Print dialog box*

2. Select the printer in the **Name** list. The corresponding printer details are displayed.
3. Click **Properties** to set the printer properties.
4. Select the **Print to File** check box to save the report as a file.
5. Under **Print Range**, select **All** to print all the pages.
6. Click **OK**. The report is printed to the selected printer.

**Exporting the report to a file**

You can export the reports to a file. The available file formats are. txt and. csv.

To export a report into a file:

1. In the **Report** dialog box, click **Export File**. The **Export File** dialog box appears.
Reports
Generating and Printing a Report

Figure 17-16  Export File dialog box

2. Under Delimiter, select the separator to separate columns of the report in the report file.
   
   **Tip:** If you want to set your own delimiter, click Other and type the separator in the provided text box.

3. To set or change the default path of the report file, click the ellipsis button next to Directory to save File to and browse through the folder. The selected path is displayed in the Directory to save File to box.

4. To set the parameters for the file name:
   a. In Default File Name, type the name of the file and the file format. For example, Report.txt.
   b. Select the Include Report name in File name check box to include the name of the report in the file name mentioned in the Default File Name box.
   c. Select the Include Date and Time in File name check box to include the current date and time of the report generation in the file name mentioned in Default File Name.

   After setting these parameters the name of the file is displayed in File Name.

   **Example:** When you generate a card report, if you type Sample.txt in Default File Name and select the Include Report name in File name check box, the name of the file would be SampleCard.txt. The name of the report file is Report.txt, if you do not set any of these parameters.

5. To set the default parameters, click Set as Default.

6. Click OK to export the report to a file at the specified location.

   **Tip:** To open and view the report file, browse through the specified location and open it.

**Estimating the number of pages in the report**

To estimate the number of pages in the report:

1. In the Report dialog box, click Estim. Pages. The Print Progress dialog box appears showing the formatting status.
2. Click **OK** to return to the **Report** dialog box.

**Clearing the filter options**

To clear all the filter options set for generating the report:

1. Click **Clear All**. The user-defined filter options are cleared in the **Report** dialog box.

**Reporting from Archive Database**

When you restore a backup file, you can either overwrite the information in the current database or you can restore to the Archive Database.

To view the reports from the Archive Database:

1. Select the **Run from Archive Database** check box in the report window. You can view the report from the archived database.

**Closing the dialog box**

To close the Report dialog box:

1. Click **Close**. The dialog box is closed.

**Access Area Report**

The Access Area report displays the branches and entrances or readers that are configured in Access Area.

To generate an access area report:

1. In the **Reports** window, select the **Access Area** report and click **Report Options**. The **Report - Access Area** dialog box appears.
Reports
Generating and Printing a Report

Figure 17-19 Report-Access Area dialog box

No filter or sorting options are provided for the access area report.

2. Click Print Preview to view the Access Area Report prior to printing.

3. Click Print to send the report to your printer.

4. Click Close to return to the Reports window.

Access Level Report

The Access Level report contains the available access levels and the corresponding branches or readers that are configured in Access Level.

To generate the access level report:


Figure 17-20 Report-Access Level dialog box

2. To generate reports for the specific access levels and account:

   a. Click the Access Level Filter tab.

   b. Under Access Level, select one of the following options:

   Table 17-1 Describing the filter options for Access Level report

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report for all the access levels.</td>
</tr>
</tbody>
</table>
Table 17-1 Describing the filter options for Access Level report

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>Generates the report for only one access level. When you select this option, the From field is enabled. Enter the name of the access level to generate the report. You can use the ellipsis button to find the access level.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of access levels. When you select this option the From and To fields are enabled. To specify the range, enter the starting access level name in From and the ending access level name in To. You can use the ellipsis button to find the access level.</td>
</tr>
</tbody>
</table>

3. To sort the report by access level name:
   a. In the Report - Access Level dialog box, click the Sort tab.

   b. Under Sort Order, select the field (Name) by which the list must be sorted. If you select Not Sorted, the list is sorted in any order.

   c. Click Ascending or Descending to sort the list in the ascending or descending order.

4. Click Print Preview to view the Access Level Report prior to printing.
5. Click Print to send the report to your printer.
6. Click Close to return to the Report window.

Account Report

The Account report contains the available accounts that are configured in Account.

To generate the account report:
1. In the Reports window, select the Account report and click Report Options. The Report - Account dialog box appears.
Generating and Printing a Report

2. To filter the accounts:
   a. Click the **Account Filter** tab.
   b. Under **Accounts**, select one of the following options

   **Table 17-2 Describing the filter options for Account report**

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report for all the accounts.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single account. When you select this option, the <strong>From</strong> field is enabled. Enter the name of the account to generate the report. You can use the ellipsis button to find the access level.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of accounts. When you select this option, the <strong>From</strong> and <strong>To</strong> fields are enabled. Enter the name of the accounts to generate the report. You can use the ellipsis button to find the access level.</td>
</tr>
</tbody>
</table>

c. Under **Print Data Fields**, click **None** to exclude the data fields or click **All** to include all the data fields of the account in the report.

3. To sort the account list in the report:
   a. In the **Report - Account** dialog box, click the **Sort** tab.
Generating and Printing a Report

Figure 17-23  Sort tab

b. Under **Sort Order**, select the field on which the report must be sorted.

c. Click **Ascending** or **Descending** to sort the accounts in the ascending or descending order.

4. Click **Print Preview** to view the Account Report prior to printing.

5. Click **Print** to send the report to your printer.

6. Click **Close** to return to the **Reports** window.

**ADV Actions**

The ADV Actions report contains the ADV actions for all the available devices.

To generate the ADV Actions report:
1. In the **Reports** window, select the **ADV Actions** report and click **Report Options**. The **ADV Actions** dialog box appears.

![ADV Actions Dialog Box](image)

**Figure 17-24  ADV Actions**

2. Under **ADV**

   - The **ADV Description** check box is selected by default. Click to clear the **ADV Description** check box if you do not want to include this filter.
   - The **Device Name** check box is selected by default. Select a device name from the drop-down list. Click to clear the **Device Name** check box if you do not want to include this filter.
   - The **ADV Type** check box is selected by default. Select an ADV from the drop-down list. Click to clear the **ADV Type** check box if you do not want to include this filter.
   - The **Action Group Name** check box is selected by default. Select an Action group from the drop-down list. Click to clear the **Action Group Name** check box if you do not want to include this filter.

3. The **Action Name** check box is selected by default. Click to clear the **Action Name** check box if you do want to include this filter.
4. The following filters under Actions are enabled only if you select the Action Name check box. Click the check boxes corresponding to each of these filters to include them in the report.
   - Priority
   - Time Zone
   - Print on alarm printer
   - Command File on Receive
   - Command File on Acknowledge
   - Command File On Clear
   - Sound File
   - Alarm Detail View Message

5. Select the Configured Camera check box and then select a camera from the drop-down list.

6. The following filters under Advanced ADV Actions are enabled only if you select the Configured Camera check box.
   - Preset
   - Return Home
   - Recording Settings
   - Home Delay
   - Allow manual PTZ

7. Click Print Preview to view the Account Report prior to printing.

8. Click Print to send the report to your printer.

9. Click Close to return to the Reports window.

**Attendance Report**

The Attendance Report helps you to know the entry and exit details of the card holders who have presented their card in the reader of the tracking area. The Administrator required this report for audit.

To generate the attendance report:

1. In the Reports window, select the Attendance report and click Report Options. The Report - Attendance dialog box appears.
Generating and Printing a Report

2. To filter the tracking area, card holder, and date:
   a. Click the Attendance Filter tab.
   b. Select an area in the Tracking Area list. The areas or branches configured in Tracking Area are listed.
   Tip: To include all the areas, select Tracking and Mustering Areas in the Tracking list.
   c. Select one of the following options for filtering the card holders under Card Holders:

   **Table 17-3 Describing the card holder filter options for Attendance report**

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report for all the card holders in the specified area.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single card holder. When you select this option, the Card Number and Name fields are enabled. Enter the card number or name of the card holder to generate the report. You can use the ellipsis button to find the card holder.</td>
</tr>
<tr>
<td>Group</td>
<td>Generates the report for a particular group. When you select this option, the Access Level and Note Field fields are enabled. Enter the access level and select the note field to generate the report. If you select a note field, the text box appears next to it and enables you to enter the value for the note field. You can use the ellipsis button to find the access level.</td>
</tr>
</tbody>
</table>

   d. To filter the report for a specific period, under Date Range, click the ellipsis button next to the From or To fields and select the date in the calendar.
e. To specify the time range, enter the time in hours and minutes for the From and To fields.

3. To sort the attendance report:
   a. Click the Sort tab.
   b. Under Sort Order 1, select the field by which the report must be sorted.
   c. Click Ascending or Descending to sort the list in the ascending or descending order of the selected field.
   d. Under Sort Order 2, select the field by which the report must be sorted in the second level.
   e. Click Ascending or Descending to sort the list in the ascending or descending order of the selected field.

4. Click Print Preview to view the report prior to printing it.
5. Click Print to send a copy of the report to your printer.
6. Click Close to return to the Reports window.

Card Report

The Card Report is generated based on the selected account or on the all the accounts that are available for the operator. This report enables you to obtain the details of card holders holding a card, the card status and access level.

To generate the attendance report:

1. In the Reports window, select the Card report and click Report Options. The Report - Card dialog box appears.

2. To filter the card details:
   a. Click the Card Filter tab.
b. Select one of the following options for filtering the cards, under **Card Number:**

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates a report for all cards.</td>
</tr>
<tr>
<td>One</td>
<td>Generates a report for a single card. When you select this option, the <em>From</em> field is enabled. Enter the card number to generate the report. You can use the ellipsis button to find the card number.</td>
</tr>
<tr>
<td>Group</td>
<td>Generates the report for a range of cards. When you select this option, the <em>From</em> and <em>To</em> fields are enabled. Enter the first card number of the range in <em>From</em> and last card number of the range in <em>To</em>. You can use the ellipses button to find the card number.</td>
</tr>
</tbody>
</table>

c. Select any of the following options, to filter the cards further based on the selected option:

d. Under **No. of columns to print,**

3. To sort the card report:
   a. Click the **Sort** tab.

   ![Figure 17-27 Report - Card Holder Sort tab](image)

   b. Under **Sort Order 1,** select the field by which the report must be sorted in the first level.
   c. Click **Ascending** or **Descending** to sort the list in the ascending or descending order of the selected field.
d. Under **Sort Order 2**, select the field by which the report must be sorted in the second level. If you select **Not Sorted** the report is sorted on the basis of the field selected in Sort Order 1.

e. Click **Ascending** or **Descending** to sort the list in the ascending or descending order of the selected field.

f. Under **Sort Order 3**, select the field by which the report must be sorted in the third level. If you select **Not Sorted**, the report is sorted on the basis of the field selected in Sort Order 1 and/or Sort Order 2.

g. Click **Ascending** or **Descending** to sort the list in the ascending or descending order of the selected field.

4. To filter cards based on card holder categories, click the **Advanced Card Holder Filter** tab.

![Advanced Card Holder Filter tab](Figure 17-28)

The Card Report is filtered according to the status of:

- **Card Holder** - Attached (to the card), Unattached, or Both.
- **PIN #1** (number) - Assigned (to the card), Unassigned, or Both.
- **Badge Front** and/or **Badge Back** - Assigned (to the card), Unassigned, or Both.
- **Badge Print Status** - Printed, Not Printed, or Both.

5. Select the **Custom Access Level** check box to include all cards that have custom access levels assigned to them.

6. Click **Print Preview** to view the report prior to printing it.

7. Click **Print** to send a copy of the report to your printer.

8. Click **Close** to return to the **Reports** window.

**Card Frequency Report**

The Card Frequency Report enables you to generate a report to know the number of times a card holder has accessed a particular reader using the card. This report also helps the user to obtain the details of the unused cards and to prevent any misuse of the card.
To generate a card frequency report:

1. In the **Reports** window, select the **Card Frequency** report and click **Report Options**. The **Report - Card Frequency** dialog box appears.

![Figure 17-29 Report-Card Frequency](image)

2. To filter the records based on the specific date and time ranges:
   a. Click the **Date and Time Filter** tab.
   b. Under **Date Range**, select the **From** and **To** dates using the ellipsis button.
   c. Enter the **From** and **To** time (in hours and minutes) in the corresponding boxes.
   d. To generate reports for events that occurred during the specified period, select the **Only list events between these hours each day** check box, under **Daily Time Range**. The **From** and **To** text boxes are enabled.
   e. In the **From** and **To** boxes, enter the time range (in hours and minutes).
   f. Select the standard time zone in the **Time Zone** list.

3. To set the card frequency limits:
   a. Click the **Frequency Filter** tab.
b. Under Frequency, type the **Lower Frequency Limit** and **Higher Frequency Limit** to filter cards between these limits.

c. To generate the card frequency reports by filtering the readers, type the **Reader** name under **Location** or select the reader by clicking the ellipsis button.

d. To generate the frequency filter reports for access areas, type the **Access Area** name under **Location** or select the access area by clicking the ellipsis button.

e. To include only certain devices, click **Filter ADVs** to select the ADVs. In the **Filter Devices** dialog box, select the appropriate ADV or ADV type from the tree and click **OK**.

f. Under **Disposition**, select one of the following actions that must be performed on the cards that are filtered for frequency report:

4. To generate card frequency report based on the card holders:
   a. Click the **Card Holder Filter** tab.
Generating and Printing a Report

**Figure 17-31  Card Holder Filter tab**

b. Type the First Name and Last Name of the card holder, or select them by clicking the ellipsis button.

c. Type the Card Number of the card holder or select it by clicking the ellipses button.

d. To generate the card frequency reports of the card holders accessing a specific area, select an area in the Tracking Area list that are configured in Tracking and Mustering Area.

e. Select one or more Card Codes which define the card transaction.

f. Select the Note Fields to be displayed in the report. You can also specify the range if you select the numerical note field.

5. Click Print Preview to view the report prior to printing.

6. Click Print to print the card frequency report.

7. Click Close to return to the Reports window.

**Card History Report**

The Card History report contains the history of card transactions and events.

To generate a card history report:

1. In the Reports window, select the Card History report and click Report Options. The Report - Card History dialog box appears.
2. To filter records based on the specific date and time ranges:
   a. Click the **Date and Time Filter** tab.
   b. Under **Date Range**, select the **From** and **To** dates using the ellipsis button.
   c. Enter the **From** and **To** time (in hours and minutes) in the corresponding boxes.
   d. To generate reports for events occurring during a particular period, select the **Only list events between these hours each day** check box, under **Daily Time Range**. The From and To text boxes are enabled.
   e. In the **From** and **To** boxes, enter the time range (in hours and minutes).
   f. Select the standard time zone in the **Time Zone** list.

3. To filter the report based on the type of card events:
   a. Click the **Transaction Filter** tab.

---

**Figure 17-32**  Report-Card History

**Figure 17-33**  Transaction Filter tab
b. Select an account in the **Account** list.

c. To filter the report based on the card behaviors, select the following options, under **Card**:

<table>
<thead>
<tr>
<th>Card Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions</td>
<td>Reports card events of all transactions such as normal, alarm, or host grant.</td>
</tr>
<tr>
<td>Clears</td>
<td>Reports the card alarm events that were cleared by the operator.</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>Reports the card alarm events that were acknowledged by the operator.</td>
</tr>
<tr>
<td>Operator Messages</td>
<td>Reports the card alarm events that were provided with an operator message.</td>
</tr>
</tbody>
</table>

d. To filter the transactions performed on specific ADVs (devices), click **Filter ADVs**. The **Filter Devices** dialog box appears.

e. Double-click the branch (folder) to select all the devices in the branch.

**OR**

Expand the branch and double-click a device to select the particular device of the branch.

<table>
<thead>
<tr>
<th>Card Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgements</td>
<td>Reports the card alarm events that were acknowledged by the operator.</td>
</tr>
<tr>
<td>Operator Messages</td>
<td>Reports the card alarm events that were provided with an operator message.</td>
</tr>
</tbody>
</table>

g. Click **OK** to return to the **Report - History** dialog box.

When a new event is identified, it is given a sequence ID and any change in the event carries a new sequence ID.

When a report is sorted by the Sequence ID, the events of the specific ID are grouped together in a chronological order. This makes it easier to view relative to other system-wide events.

4. To filter card events based on the card holders:

<table>
<thead>
<tr>
<th>Card Holder Filter tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgements</td>
<td>Reports the card alarm events that were acknowledged by the operator.</td>
</tr>
<tr>
<td>Operator Messages</td>
<td>Reports the card alarm events that were provided with an operator message.</td>
</tr>
</tbody>
</table>

**Caution:** Do not select too many options for selection criteria, as it may result in not finding records meeting the selected criteria.
b. Type the First Name and Last Name of the card holder, or select them by clicking the ellipsis button.

c. Type the Card Number of the card holder or select it by clicking the ellipsis button.

d. To generate the card history reports of the card holders accessing a specific area, select an area in the Tracking Area list that are configured in Tracking and Mustering Area.

e. Select one or more Card Codes which define the card transaction.

f. Select the Note Fields to be displayed in the report. You can also specify the range if you select the numerical note field.

5. Click Print Preview to view the report prior to printing.

6. Click Print to print the card history report.

7. Click Close to return to the Reports window.

Card Holder Report

The Card Holder report displays the list of card holder details.

To generate a card holder report:

1. In the Reports window, select the Card History report and click Report Options. The Report - Card Holder dialog box appears.
Generating and Printing a Report

Figure 17-35 Report-Card Holder

2. To filter the card holders based on card holder name, access level:
   a. Click the Card Holder Filter tab.
   b. Under Card Holder, select the following options to filter card holders based on last name:

   Table 17-6 Describing the options for filtering card holders

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report that includes all the card holders.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single card holder detail. When you select this option, the First (Last Name) is enabled. Enter the last name of the card holder in First (Last Name) to generate a report for this card holder.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for a range of card holders. When you select this option, the First (Last Name) and Last (Last Name) are enabled. To specify the range, enter the starting last name of the card holder in First (Last Name) and ending last name in the Last (Last Name).</td>
</tr>
</tbody>
</table>

c. To filter the report based on the card holders’ access level, select it in the Access Level list.

d. To filter the report based on the card holders’ account, select it in the Account list. To include all the accounts, select Available Accounts.

e. To include the note fields in the report, select the following options under Note Fields.

Table 17-7 Describing the options for filtering note fields

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>To include NO note fields in the report.</td>
</tr>
</tbody>
</table>
### Generating and Printing a Report

To sort the report in the ascending or descending order of a specific field:

1. Click the ellipsis button to display the *Select Note Fields* dialog box.
2. Select the note fields that must be included in the report.
3. Click OK to return to the Report - Card Holder dialog box.

#### Table 17-7 Describing the options for filtering note fields

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>To include all the note fields in the report.</td>
</tr>
</tbody>
</table>
| Select | To select a specific note field that must be included in the report. When you select this option, the ellipsis button beneath the Select option is enabled.  

1. Click the ellipsis button to display the *Select Note Fields* dialog box.  

2. Select the note fields that must be included in the report.  

3. Click OK to return to the Report - Card Holder dialog box.  

Field | To filter the note fields information that must be displayed in the report. The number of drop-down lists depend on the number of available note fields.  
When you select a note field, the From and To fields are enabled.  

1. Enter the corresponding information in the From and To fields. These fields are case-sensitive, if the note field template is defined for a note field.  

**Example:** If you select **Color** in **Field** and you select **Blue** in From and **Red** in To, the card holder details that contain **Blue** through **Red** colors are included in the report.  

3. To sort the report in the ascending or descending order of a specific field:
Generating and Printing a Report

Reports

a. Click the Sort tab.

![Figure 17-36 Sort tab]

b. Under Sort Order 1, select the field by which the report must be sorted in the first level.

c. Click Ascending or Descending to sort the list in the ascending or descending order of the selected field.

d. Under Sort Order 2, select the field by which the report must be sorted in the second level. If you select Not Sorted the report is sorted on the basis of the field selected in Sort Order 1.

e. Click Ascending or Descending to sort the list in the ascending or descending order of the selected field.

f. Under Sort Order 3, select the field by which the report must be sorted in the third level. If you select Not Sorted the report is sorted based on the field selected in Sort Order 1 and/or Sort Order 2.

g. Click Ascending or Descending to sort the list in the ascending or descending order of the selected field.

4. To filter the cards based on the card details, click the Advanced Card Filter tab.
The Card Holder report is filtered according to the status of:

- **Card** - Attached (to the card holder), Unattached, or Both.
- Number of **Photos** or **Signatures** - Assigned (to the card), Unassigned, or Both.

5. Select the following check boxes to set global parameters for information to be included in the report:

- **Print all cards** (assigned to the card holder)
- **Print no. of photos assigned**
- **Print no. of signatures assigned**

6. Click **Print Preview** to view the report prior to printing it.

7. Click **Print** to send a copy of the report to your printer.

8. Click **Close** to return to the **Reports** window.

### Card Holder Tab Layout Report

To generate the card holder tab layout report:

1. In the **Reports** window, select the **Card Holder Tab Layout** report and click **Report Options**. The **Report - Card Holder Tab Layout** dialog box appears.
Generating and Printing a Report

![Figure 17-38 Report-Card Holder tab layout](image)

2. To filter the card holder tab layout by an account, select it in the Account list. If you want to include card holder tab layouts of all the account, select Available Accounts in the Account list.

3. Click Print Preview to view the report prior to printing it.

4. Click Print to send a copy of the report to your printer.

5. Click Close to return to the Reports window.

Command File Report

To generate a command file report:


![Figure 17-39 Report-Command File](image)

2. To filter command files to be included in the report,
   a. Click the Command File Filter tab.
   b. Under Command File, select one of the following options:

   ![Table 17-8 Describing the options for filtering card holders](image)
Table 17-8 Describing the options for filtering card holders

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>Generates the report for a single command file. When you select this option, the From field is enabled. Enter the name of the command file to generate the report. You can use the ellipsis button to find the access level.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of command files. When you select this option, the From and To fields are enabled. To specify the range, enter the starting command file name in From and the ending command file name in To. You can use the ellipsis button to find the command files.</td>
</tr>
</tbody>
</table>

3. To sort the list in the report in the ascending or descending order:
   a. Click the Sort tab.
   b. Under Sort Order, select the field by which the list in the report must be sorted.
   c. Click Ascending or Descending to sort the list in chronological order or reverse order.

4. Click Print Preview to view the report prior to printing it.
5. Click Print to send a copy of the report to your printer.
6. Click Close to return to the Reports window.

Control Area Report

The Control Area report displays the branches or devices that are configured in Control Area. To generate a control area report:

1. In the Reports window, select the Control Area report and click Report Options. The Report - Control Area dialog box appears.
Generating and Printing a Report

No filter or sort options are provided for the control area report.

2. Click **Print Preview** to view the Access Area Report prior to printing.
3. Click **Print** to send the report to your printer.
4. Click **Close** to return to the **Reports** window.

**Device Map Report**

To generate a device map report:

1. In the **Reports** window, select the **Device Map** report and click **Report Options**. The **Report - Device Map** dialog box appears.

   2. Under **Device Filter**, select the **Print ADV Name** check box to include the abstract device names in the report.

   3. To filter the devices to be included in the report, select a device in the **Device** list.
A corresponding tab with additional filter options is added to the dialog box.

**Servers:**
- The **Device Map Report** can include communication servers or all other servers. You are also provided with an option to display all or a range of servers.

- To select the type of server:
  a. Click the **Server Filter** tab. It is displayed by default when you select the device as **Servers**.
  b. Under **Print**, select the type of server; **Communication Servers** or **All Other Servers**.

- To select the range of servers:
  a. Under **Servers to Print**, select one of the following options:
     * **All** - to include all the servers.
     * **One** - to include a single server that you select in the **From** field.
     * **Range** - to include a range of servers that you select in the **From** and **To** fields.
     * You can use the ellipsis button to select a server.

**Loops:**
- The **Device Map Report** displays the details of a single loop like C-100, 485/PCI of all or the selected communication server. You are also provided with an option to display the details of all or a range of loops.
Reports
Generating and Printing a Report

- To select the type of loop:
  a. Click the Loop Filter tab. It is displayed by default when you select the device as Loops.
  b. Under Type, select the type of loop; C100, 485/PCI, P-Series or RS-232 Port.
  c. Enter the name of the Communication Server to include only the loops that are available in the selected communication server. You can use the ellipsis button to select the communication server.

- To select the range of loops:
  a. Under Loops to Print, select one of the following options:
     * All - to include all the loops.
     * One - to include a single loop that you select in the From field.
     * Range - to include a range of loops that you select in the From and To fields.
     * You can use the ellipsis button to select a loop.

Panels:
- The Device Map Report can display the details of a single panel like P-Series, NS2+ of all or the selected loop. You are also provided with an option to display the details of all or a range of loops.
To select the type of loop:

a. Click the Panel Filter tab. It is displayed by default when you select the device as Panels.

b. Under Type, select the type of panel: P-Series, Direct P-Series, Remote P-Series, N-1000/PW-2000, NS2+ or Galaxy, NetAXS, NetAXS Gateway.

c. Enter the name of the Loop to include the panel of this loop. You can use the ellipsis button to select the communication server.
   * The Loop option is disabled, if the Galaxy, Vista, or Direct P-Series panel type is selected.
   * The Loop option changes to Modem Pool, if the Remote P-Series panel type is selected.

To select the range of panels:

a. Under Panels to Print, select one of the following options:
   * All - to include all the panels.
   * One - to include a single panel that you select in the From field.
   * Range - to include a range of panels that you select in the From and To fields.
   * You can use the ellipsis button to select a panel.

To include the advanced option details of a panel, select the Print Advanced Options. This option is enabled only for the N-1000/PW-2000 panel type.

CCTV Switcher:

- The Device Map Report can display the details of a CCTV Switcher of all or the selected communication server. You are also provided with an option to display the details of all or a range of CCTV switchers.
Generating and Printing a Report

To select the communication server:
  a. Enter the name of the Communication Server to include the CCTV Switcher of this loop. You can use the ellipsis button to select the communication server.

To select the range of switchers:
  a. Under Devices to Print, select one of the following options:
     * All - to include all the CCTV switchers.
     * One - to include a single CCTV switchers that you select in the From field.
     * Range - to include a range of CCTV switchers that you select in the From and To fields.
     * You can use the ellipsis button to select a CCTV switcher.

Modem Pools:
  - The Device Map Report can display the details of a single loop like C-100, 485/PCI of all or the selected communication server in the modem pool. You are also provided with an option to display the details of all or a range of loops.
Generating and Printing a Report

Figure 17-47  Modem Pools

- To select the type of loop:
  a. Click the Loop Filter tab. It is displayed by default when you select the device as Modem Pools.
  b. Under Type, select the type of loop; C100, 485/PCI, or P-Series.
  c. Enter the name of the Communication Server to include the loop of this server. You can use the ellipsis button to select the communication server.

- To select the range of loops:
  a. Under Loops to Print, select one of the following options:
     * All - to include all the loops.
     * One - to include a single loop that you select in the From field.
     * Range - to include a range of loops that you select in the From and To fields.
     * You can use the ellipsis button to select a loop.

Recorder:

The Device Map Report can display the details all or a range of recorders.
Reports
Generating and Printing a Report

To select the range of recorders:

- Click the **Recorder** tab. It is displayed by default when you select the device as **Recorder**.
- Under **Devices to Print**, select one of the following options:
  - **All** - to include all the recorders.
  - **One** - to include a single recorder that you select in the **From** field.
  - **Range** - to include a range of recorders that you select in the **From** and **To** fields.
  - You can use the ellipsis button to select an access DVPRO server.

4. Click **Print Preview** to view the report prior to printing it.
5. Click **Print** to send a copy of the report to your printer.
6. Click **Close** to return to the **Reports** window.

**Floor Plan Report**

To generate a floor plan report:

1. In the **Reports** window, select the **Floor Plan** report and click **Report Options**. The **Report - Floor Plan** dialog box appears.
2. To filter floor plans to be included in the report,
   a. Click the **Floor Plan Filter** tab.
   b. Select one of the following options under **Floor Plans to Print**:

   **Table 17-9 Describing the options for filtering floor plans**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report that includes all the floor plans.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single floor plan. When you select this option, the <strong>From</strong> field is enabled. Enter the name of the floor plan to generate the report. You can use the ellipsis button to find the floor plan.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of floor plans. When you select this option, the <strong>From</strong> and <strong>To</strong> fields are enabled. To specify the range, enter the starting floor plan name in <strong>From</strong> and the ending floor plan in <strong>To</strong>. You can use the ellipsis button to find the floor plan.</td>
</tr>
</tbody>
</table>

3. To filter floor plans based on metafiles, select the **Metafile Name** in the list.
4. To filter a specific **ADV**, select an **ADV Type** in the list and enter the name of the **ADV**. Use the ellipsis button to find an **ADV**.
5. To sort the list in the report in the ascending or descending order:
   a. Click the **Sort** tab.
   b. Under **Sort Order**, select the field by which the list in the report must be sorted.
   c. Click **Ascending** or **Descending** to sort the list in chronological order or reverse order.
6. Click **Print Preview** to view the report prior to printing it.
7. Click **Print** to send a copy of the report to your printer.
8. Click **Close** to return to the **Reports** window.
Galaxy Panel Log Report

Galaxy Panel Log report is used for tracking the events happening at the Galaxy panel. This report can be generated if you procured license for the Galaxy feature in WIN-PAK.

To generate a Galaxy Panel Log report:


2. To filter date and time of the log events to be included in the report:
   a. Click the Date and Time Filter tab.
   b. Under Date Range, select the From and To dates using the ellipsis button.
   c. Enter the From and To time (in hours and minutes) in the corresponding boxes.
   d. To generate reports for messages sent and received during a particular period, select the Only list events between these hours each day check box, under Daily Time Range. The From and To text boxes are enabled.
   e. In the From and To boxes, enter the time range (in hours and minutes).
   f. Select the standard time zone in the Time Zone list.

3. To filter log type of the log events to be included in the report:
   a. Click the Log Filter tab.
Generating and Printing a Report

17-45

WIN-PAK User’s Guide

Guard Tour Report

To generate a guard tour report:

1. In the Reports window, select the Floor Plan report and click Report Options. The Report - Guard Tour dialog box appears.

2. To filter guard tours that must be included in the report,
   a. Click the Guard Tour Filter tab.
Reports
Generating and Printing a Report

b. Under **Guard Tours to Print**, select one of the following options:

   **Table 17-10 Describing the options for filtering guard tours**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report that includes all the guard tours.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single guard tour. When you select this option, the <strong>From</strong> field is enabled. Enter the name of the guard tour to generate the report. You can use the ellipsis button to find a guard tour.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of guard tours. When you select this option, the <strong>From</strong> and <strong>To</strong> fields are enabled. To specify the range, enter the starting guard tour name in <strong>From</strong> and the ending guard tour in <strong>To</strong>. You can use the ellipsis button to find a guard tour.</td>
</tr>
</tbody>
</table>

3. To filter the check point types, select one of the **Check Point Type to Include** options.
4. To sort the list in the report in the ascending or descending order:
   a. Click the **Sort** tab.
   b. Under **Sort Order**, select the field by which the list in the report must be sorted.
   c. Click **Ascending** or **Descending** to sort the list in chronological order or reverse order.
5. Click **Print Preview** to view the report prior to printing it.
6. Click **Print** to send a copy of the report to your printer.
7. Click **Close** to return to the **Reports** window.

**History Report**
To generate a history report:

1. In the **Reports** window, select the **History** report and click **Report Options**. The **Report - History** dialog box appears.
2. To filter the records based on the specific date and time ranges:
   a. Click the **Date and Time Filter** tab.
   b. Under **Date Range**, select the **From** and **To** dates using the ellipsis button.
   c. Enter the **From** and **To** time (in hours and minutes) in the corresponding boxes.
   d. To generate reports for events occurring during a particular period, select the **Only list events between these hours each day** check box, under **Daily Time Range**. The From and To text boxes are enabled.
   e. In the **From** and **To** boxes, enter the time range (in hours and minutes).
   f. Select the standard time zone in the **Time Zone** list.

3. To filter the report based on the type of card events:
   a. Click the **Transaction Filter** tab.
b. To filter the report based on the transaction types, select the following options, under **Transaction Types**:

<table>
<thead>
<tr>
<th>Card Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Reports transactions of type alarms.</td>
</tr>
<tr>
<td>System Alarm</td>
<td>Reports system type alarms (not wired points) such as Poll Response alarms.</td>
</tr>
<tr>
<td>Operator</td>
<td>Reports operator activities, such as log on and log off.</td>
</tr>
<tr>
<td>Database</td>
<td>Reports basic database activities, such as update, delete or add action to a particular database.</td>
</tr>
<tr>
<td>Card</td>
<td>Reports all card events.</td>
</tr>
<tr>
<td>Guard</td>
<td>Reports all guard tour events.</td>
</tr>
</tbody>
</table>

Table 17-11 Describing the transaction types for filtering history details

Table 17-12 Describing the Alarm & Card options for filtering history details

<table>
<thead>
<tr>
<th>Card Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions</td>
<td>Reports card events of all transactions such as normal, alarm, or host grant.</td>
</tr>
</tbody>
</table>
d. To filter the transactions performed on specific ADVs (devices), click **Filter ADVs**. The **Filter Devices** dialog box appears.

e. To select a device, expand the corresponding folder and double-click a device.

f. To select all the devices in a folder:

g. After selecting the required devices, click **OK** in the **Filter Devices** dialog box to return to the **Report - History** dialog box.

h. Click the **Sort on Sequence ID** check box, if you want the report to be sorted by the sequence number given to each action in the data base.

When a new event is identified, it is given a sequence ID and any change carries a new sequence ID.

When a report is sorted by the Sequence ID, the ID number groups the events together in chronological order. This makes it easier to view information relative to other system-wide events.

4. To filter the card events based on the card holders:

   a. Click the **Card Holder Filter** tab.

   b. Type the **First Name** and **Last Name** of the card holder, or select them by clicking the ellipsis button.

<table>
<thead>
<tr>
<th>Card Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clears</td>
<td>Reports the card alarm events that were cleared by the operator.</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>Reports the card alarm events that were acknowledged by the operator.</td>
</tr>
<tr>
<td>Operator Messages</td>
<td>Reports the card alarm events that were provided with an operator message.</td>
</tr>
</tbody>
</table>
c. Type the **Card Number** of the card holder or select it by clicking the ellipsis button.

d. To generate the card history reports of the card holders accessing a specific area, select an area in the **Tracking Area** list that are configured in Tracking and Mustering Area.

e. Select one or more **Card Codes** which define the card transaction.

f. Select the **Note Fields** to be displayed in the report. You can also specify the range if you select the numerical note field.

5. To filter further on alarm events:

   a. Click the **Alarm Filter** tab.

   ![Figure 17-56 Alarm Filter tab](image)

   b. In the **Alarm Point** text box, enter the device or point name. You can also use the ellipsis button to find the device or point on which the alarms to be viewed.

   c. Select the **Alarm States** that must be included in the report.

6. Click **Print Preview** to view the report prior to printing.

7. Click **Print** to print the card history report.

8. Click **Close** to return to the **Reports** window.

---

**Holiday Group Report**

To generate a holiday group report:

1. In the **Reports** window, select the **Holiday Group** report and click **Report Options**. The **Report - Holiday Group** dialog box appears.
2. To filter the holiday groups to be included in the report,
   a. Click the Holiday Group Filter tab.
   b. Under Holiday Group, select one of the following options:

   **Table 17-13 Describing the options for filtering holiday groups**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report that includes all the holiday groups.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single holiday group. When you select this option, the From field is enabled. Enter the name of the holiday group to generate the report. You can use the ellipsis button to find the holiday group.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of holiday groups. When you select this option, the From and To fields are enabled. To specify the range, enter the starting holiday group name in From and the ending holiday group in To. You can use the ellipsis button to find the holiday group.</td>
</tr>
</tbody>
</table>

3. To sort the list in the report in the ascending or descending order:
   a. Click the Sort tab.
   b. Under Sort Order, select the field by which the list in the report must be sorted.
   c. Click Ascending or Descending to sort the list in chronological order or reverse order.

4. Click Print Preview to view the report prior to printing it.
5. Click Print to send a copy of the report to your printer.
6. Click Close to return to the Reports window.

**Note Field Template Report**

To generate an access area report:

1. In the Reports window, select the Access Area report and click Report Options. The Report - Note Field Template dialog box appears.
Reports
Generating and Printing a Report

2. To filter the note field templates based on an account, select an Account under Account Filter.
3. Click Print Preview to view the report prior to printing.
4. Click Print to send the report to your printer.
5. Click Close to return to the Reports window.

Operator Report
To generate a report on operators:

1. In the Reports window, select the Operator report and click Report Options. The Report - Operator dialog box appears.

2. To filter the operators to be included in the report,
   a. Click the Operator Filter tab.
   b. Under Operator, select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report that includes all the operators.</td>
</tr>
</tbody>
</table>
3. To sort the list in the report in the ascending or descending order:
   a. Click the **Sort** tab.
   b. Under **Sort Order**, select the field by which the list in the report must be sorted.
   c. Click **Ascending** or **Descending** to sort the list in chronological order or reverse order.
4. Click **Print Preview** to view the report prior to printing it.
5. Click **Print** to send a copy of the report to your printer.
6. Click **Close** to return to the **Reports** window.

### Operator Actions Report

The Operator Actions report is an Audit Report for the Administrator to monitor the actions performed by the operator using WIN-PAK User Interface. This report can be generated based on the operator levels, devices, and operator actions.

To generate an operator actions report:

1. In the **Reports** window, select the **Operator Actions** report and click **Report Options**. The **Operator Actions Report** dialog box appears.
2. To filter the operator actions based on the date and time range:
   a. Click the **Date and Time** tab.

---

**Table 17-14 Describing the options for filtering operators**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>Generates the report for a single operator. When you select this option, the From field is enabled. Enter the name of the operator to generate the report. You can use the ellipsis button to find an operator.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of operators. When you select this option, the From and To fields are enabled. To specify the range, enter the first operator name in From and the last operator name in To. You can use the ellipsis button to find an operator.</td>
</tr>
</tbody>
</table>
Generating and Printing a Report

3. To filter only the specific operator actions:
   a. Click the Operator Actions tab.
   b. Under Operator Actions, select or clear the operator actions to be included or excluded. By default all the actions are selected.

   **Tip:** Click Select All to select all the actions or click Deselect All to clear all the actions.

4. To filter the list of operators to monitor their actions:
   a. Click the Operators tab.
   b. Under Operators, select or clear the operators to be included or excluded. By default all the operators are selected.

   **Tip:** Click Select All to select all the operators or click Deselect All to clear all the operators.

5. To filter the devices on which the actions are performed:
   a. Click the Devices tab.
   b. Under Devices, select or clear the devices to be included or excluded. By default all the devices are selected.

   **Tip:** Click Select All to select all the devices or click Deselect All to clear all the devices.

6. To sort the report based on report columns:
   a. Click the Sort Order tab.
   b. Under Sort Field, in First Sort, select the field in the list by which the report must be sorted.
c. In the adjacent list, select the sort order; **Ascending** or **Descending**.

d. Repeat steps b and c for defining Second Sort, Third Sort and Fourth Sort.

7. To set the default filter criteria, click **Default Filters**.

8. Click **Run Report** to generate the report. The **Operator Actions Report** window is displayed in a separate window.

![Operator Actions Report](image)

**Figure 17-61 Operator Actions report**

**Toolbar buttons on the report**

You can perform additional operations on this report using the toolbar available on the top of the Operator Actions Report window.

The following image illustrates the toolbar buttons:

![Toolbar Buttons](image)

**Table 17-15 Defining toolbar buttons**

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Sends the report to the printer.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the content of the report and it can be pasted in any of the text applications like Word, Excel, Notepad.</td>
</tr>
<tr>
<td>Find</td>
<td>Searches for a particular text in the report. When you click this button, the <strong>Find</strong> dialog box appears. Enter the text and click <strong>Find Next</strong>.</td>
</tr>
<tr>
<td>Single Page</td>
<td>Changes the view of the report to a single page. This button is enabled, only when you view the report in multiple pages.</td>
</tr>
</tbody>
</table>
Reports
Generating and Printing a Report

Table 17-15  Defining toolbar buttons

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗ Multiple Pages</td>
<td>Changes the view of the report to multiple pages. To view multiple pages, click and select the number of pages in the drop-down list box.</td>
</tr>
<tr>
<td>✗ Zoom Out</td>
<td>Reduces the size of the page display. This button is disabled, when the page size is less than or equal to the window size.</td>
</tr>
<tr>
<td>✗ Zoom In</td>
<td>Enlarges the size of the page display.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Reduces or enlarges the size of the page display based on the selected percentage.</td>
</tr>
<tr>
<td>✗ Previous Page</td>
<td>Displays the previous page of the report. This button is disabled, if you are in the first page.</td>
</tr>
<tr>
<td>✗ Next Page</td>
<td>Displays the next page of the report. This button is enabled, if you are in the last page.</td>
</tr>
<tr>
<td>Page No./Total no. of pages</td>
<td>Displays the “page number of the current page/total number of pages”. To move to the desired page, type the page number in the text box and press ENTER.</td>
</tr>
<tr>
<td>✗ Move Backward</td>
<td>Displays the previously viewed page. Note that it is not the previous page.</td>
</tr>
<tr>
<td>✗ Move Forward</td>
<td>Functions reverse to the Move Backward button.</td>
</tr>
</tbody>
</table>

Export Buttons

<table>
<thead>
<tr>
<th>Export button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗ Excel</td>
<td>Exports the report to the excel sheet.</td>
</tr>
<tr>
<td>✗ HTML</td>
<td>Exports the report to the html page.</td>
</tr>
<tr>
<td>✗ ASCII Text</td>
<td>Exports the report to the text file.</td>
</tr>
<tr>
<td>✗ PDF</td>
<td>Exports the report to the PDF file.</td>
</tr>
<tr>
<td>✗ TIFF</td>
<td>Exports the report to the image file in TIFF format.</td>
</tr>
</tbody>
</table>

Note:

9. Click Close to close Operator Actions Report dialog box.

Operator Level Report

To generate a report on operator levels:

1. In the Reports window, select the Operator Levels report and click Report Options. The Report - Operator Level dialog box appears.
Generating and Printing a Report

2. To filter the operator levels to be included in the report:
   a. Click the Operator Level Filter tab.
   b. Under Operator Level, select one of the following options:

   Table 17-16 Describing the options for filtering operator levels

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report that includes all the operator levels.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single operator level. When you select this option, the From field is enabled. Enter the name of the operator level to generate the report. You can use the ellipsis button to find an operator level.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of operator levels. When you select this option, the From and To fields are enabled. To specify the range, enter the first operator level name in From and the last operator level name in To. You can use the ellipsis button to find an operator level.</td>
</tr>
</tbody>
</table>

3. To sort the list in the report in the ascending or descending order:
   a. Click the Sort tab.
   b. Under Sort Order, select the field by which the list in the report must be sorted.
   c. Click Ascending or Descending to sort the list in chronological order or reverse order.

4. Click Print Preview to view the report prior to printing it.
5. Click Print to send a copy of the report to your printer.
6. Click Close to return to the Reports window.

Schedule Report

To generate a schedule report:

1. In the Reports window, select the Schedule report and click Report Options. The Report - Schedule dialog box appears.
Reports
Generating and Printing a Report

2. To filter the schedules to be included in the report,
   a. Click the Schedule Filter tab.
   b. Under Schedule, select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report that includes all the schedules.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single schedule. When you select this option, the From field is enabled. Enter the name of the schedule to generate the report. You can use the ellipsis button to find a schedule.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of schedules. When you select this option, the From and To fields are enabled. To specify the range, enter the first schedule name in From and the last schedule name in To. You can use the ellipsis button to find a schedule.</td>
</tr>
</tbody>
</table>

3. To sort the list in the report in the ascending or descending order:
   a. Click the Sort tab.
   b. Under Sort Order, select the field by which the list in the report must be sorted.
   c. Click Ascending or Descending to sort the list in chronological order or reverse order.

4. Click Print Preview to view the report prior to printing it.
5. Click Print to send a copy of the report to your printer.
6. Click Close to return to the Reports window.

Time Zone Report

To generate a time zone report:

1. In the Reports window, select the Time Zone report and click Report Options. The Report - Time Zone dialog box appears.
2. To filter the time zones to be included in the report,
   a. Click the Time Zone Filter tab.
   b. Under Time Zone, select one of the following options:

   **Table 17-18 Describing the options for filtering time zones**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Generates the report that includes all the time zones.</td>
</tr>
<tr>
<td>One</td>
<td>Generates the report for a single time zone. When you select this option, the From field is enabled. Enter the name of the time zone to generate the report. You can use the ellipsis button to find a time zone.</td>
</tr>
<tr>
<td>Range</td>
<td>Generates the report for the range of time zones. When you select this option the From and To fields are enabled. To specify the range, enter the first time zone name in From and the last time zone name in To. You can use the ellipsis button to find a time zone.</td>
</tr>
</tbody>
</table>

3. To sort the list in the report in the ascending or descending order:
   a. Click the Sort tab.
   b. Under Sort Order, select the field by which the list in the report must be sorted.
   c. Click Ascending or Descending to sort the list in chronological order or reverse order.

4. To perform advanced filter on time zones:
   a. Click the Advanced Time Zone Filter tab.
Generating and Printing a Report

b. Under Time Zone, select one of the following options:

Table 17-19 Describing the time zone options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used</td>
<td>Generates the report only on the used time zones.</td>
</tr>
<tr>
<td>Unused</td>
<td>Generates the report only on the unused time zones.</td>
</tr>
<tr>
<td>Both</td>
<td>Generates the report on the used and unused time zones.</td>
</tr>
</tbody>
</table>

5. Click Print Preview to view the report prior to printing it.
6. Click Print to send a copy of the report to your printer.

Note: Click Close to return to the Reports window.

Tracking and Mustering Area Report

To generate a tracking and mustering area report:

1. In the Reports window, select the Tracking and Mustering Area report and click Report Options. The Report - Tracking and Mustering Area dialog box appears.

No filter or sorting options are provided for the access area report.

2. Click Print Preview to view the Access Area Report prior to printing.
3. Click Print to send the report to your printer.
4. Click Close to return to the Reports window.
Import Utility

In this chapter...

- **Introduction** 18-2
- **Defining Note Fields and Card Holder Tabs** 18-2
- **Defining Sequence of Fields** 18-2
- **Creating the Excel Sheet** 18-3
- **Assigning Default Values** 18-4
- **Importing Card and Card Holder Information** 18-4
Introduction

The WIN-PAK Import Utility is used for importing the card and card holder details into WIN-PAK. When you import these details into WIN-PAK, cards are assigned to the card holders as applicable.

Importing card and card holder details to WIN-PAK includes the following:

1. Defining note fields and card holder tabs in WIN-PAK for including card holders’ additional information.
2. Defining the sequence of the fields.
3. Entering card and card holder details in the excel sheet.
4. Assigning default values to certain fields.
5. Importing the excel sheet into WIN-PAK.

Defining Note Fields and Card Holder Tabs

Note Field is the user-defined field for entering the additional information of the card holder in WIN-PAK. The user-defined fields are grouped under various categories called card holder tabs.

Defining Sequence of Fields

After you define the note fields and card holder tabs, you must define the sequence of the card holder fields.

To define the sequence of the card holder fields:

1. Click Start > Programs > Honeywell Access Systems > WIN-PAK Import Utility. The Login Information dialog box appears.

![Login Information](image)

**Figure 18-1   Login Information**

2. Type the Name of the user and the Password. Note: Only the Administrator can log on to WIN-PAK Import Utility.
3. Click Connect. The system fetches the data from database and displays the WIN-PAK ImportUtility window.
4. Select the **Account** to which the sequence has to be defined. The card holder fields for the selected account are listed in **Columns Order**.

5. To change the order of a row, select the row in the list and click the up \(\uparrow\) button and/or down \(\downarrow\) button.

**Note:** You must follow the **Order** of the fields, when you enter the card holder information in the excel sheet. For example, Row 0 in the Columns Order becomes Column 1 in the excel sheet and Row 1 in the Columns Order becomes Column 2 in the excel sheet.

### Creating the Excel Sheet

Before you create the excel sheet, make a note of the column order in which the fields must be entered.

To create the excel sheet:

1. Open the Microsoft Excel application.
2. Enter the card and card holder information as in the sequence you defined in the WIN-PAK Import Utility.
3. Save the excel sheet in the .xls or .csv format.

### Tips on entering card and card holder details in the excel sheet

- Do not enter the field names in the first row. If you enter the field names to identify the field of the column, delete it before you use the excel sheet for importing data into WIN-PAK.
- For the Status field, type 1, 2, or 4 to indicate the card status as Active, Inactive, or Trace.

  **Note:** Leave the Activation Date and Expiration Date fields empty, if you specify the card status as Active or Trace.
- Ensure that access levels are configured in WIN-PAK for the respective account, before you enter the name of the access levels.
- Avoid duplication of card numbers.
• To assign default value for the fields, leave the fields empty. You can assign default value to the Issue Number, Status, Access Level, Activation Date, and Expiry Date fields and the user-defined fields.

• Ensure to use the format of note field templates for the user-defined fields.

• In the Photo column, enter the name of the image file to assign the photo of the card holder.

Assigning Default Values

You can assign the default values to certain fields like Issue Number, Status, Access Level, Activation Date, and Expiration Date. You can also assign default values for user-defined fields.

To assign the default values to certain fields:

1. Log on to WIN-PAK Import Utility. The WIN-PAK Import Utility window appears.

2. Select the Account for assigning the default values. The corresponding fields are displayed in Columns Order.

3. Under Columns Order, select the field to which the default value to be assigned. The Default Value box appears on the right.

4. Type or select the default value to be assigned to all the card holders.

   **Tip:** For Activation Date or Expiration Date, select the check box to select the current date. To change the date, click the drop-down list and select the required date in the calendar.

   **Note:** The expiration date must be greater than the activation date.

Importing Card and Card Holder Information

You can import the card and card holder information, after you create the excel sheet and assign the default values.

**Note:** Honeywell recommends you to take a backup of the current WIN-PAK database, before importing the data to WIN-PAK.

To import the excel sheet:
1. Log on to WIN-PAK Import Utility. The **WIN-PAK Import Utility** window appears.

![WIN-PAK Import Utility Window]

2. Select the **Account** to which the card and card holder information must be imported. The corresponding fields are displayed in **Columns Order**.

3. In **CVS File Path**, specify the path of the excel sheet or click the ellipsis button and select the path.

4. In **Images Folder**, specify the path of the folder where the photo images are stored.

5. Click **OK**. A message appears asking for confirmation.

6. Click **OK** to proceed with importing the data. A message appears indicating that import is successful.

**Correcting Errors in Excel Sheet**

If any error occurs while importing the data, you cannot successfully import the card and card holder information to WIN-PAK until you correct the errors.

To view and correct the errors:

1. In case of unsuccessful import, the following error message appears asking whether to open the list of errors occurred.
2. Click **Yes** to view the errors. The **ErrorLog.xls** file is opened.

3. View the errors in **ErrorLog.xls** file and correct them in the source file.
Appendix

Cold Restart on Power-surge

**Warning:** A cold restart of the access control panel sometimes occurs if there is a serious power surge on the power or communication lines. This causes corruption of the panel’s database and time functions.

- The PW-2000 panels address the time problem by generating a system alarm 99 (Panel Database, System Alarms, Panel Reset Alarm) when the panel experiences a cold restart.
- WIN-PAK then sends the current Time and Date to the panel within 60 seconds of receiving this alarm. The default time and date after a cold restart is January 1st, Monday at 12:00 AM. This time stamp appears on activities in the Event view and History report.
- Panel Time is critical to the proper operation of the muster function as the most recent event is used to determine the tracking or muster status of a card holder.
- If a card is presented to the Muster reader and the time and date stamp is earlier than the stamp from another reader location, there is no change of status to the Muster (safe) location.
- In the event that the card database is lost or corrupted at the muster reader, WIN-PAK recognizes all read-types (Not Found, Time Zone, Normal, Trace, PIN Violation, and Expired) as valid muster reads, provided that the time is later than the previous card read as described above.

This function eliminates the need to reload cards or to have host grant enabled to a muster panel during a muster event. Only Valid and Trace card reads count at a Tracking reader.
Appendix

Cold Restart on Power-surge
Index

A

ABA 7-16, 7-17
About this Guide iii-1
About WIN-PAK Pro 3-12
Abstract Device 10-169
  Action Group 10-170
  Adding 10-169
  Command File 10-171
  Default Floor Plan 10-170
  Deleting 10-174
  Editing 10-174
  Priority for the action 10-170
Abstract Devices 1-4
Access Area Report 17-13
Access Areas
  Define 11-3
Access Level Report 17-14
  sort the report 17-15
Account 6-2
Account Report 17-15
  filter 17-16
  sort 17-16
Accounts 5-2
  Adding 5-2
  Deleting 5-5
  Editing 5-5
  Selecting 5-4
action 15-2
Action Group 10-175
  Copying 10-178
  Deleting 10-178
  Editing 10-176
  Viewing 10-175
Adding a Loop to a Site 6-5
Adding a New Site 6-4
Adding a Panel 6-8
Adding a Recorder 10-39
Adding a Vista Panel 10-163
  Fire Burglary Panels 10-163
  PANEL VISTA 128FBP 10-163
  PANEL VISTA 250FBP 10-163
  partitions 10-163
  zones 10-164
Adding or Editing Language Information 16-4
Adding Readers to a P-Series Panel 6-9
Administrators 5-5
ADV Action Groups 10-178
ADV Control Functions 12-18
  Arm Away 12-21
  Bypass Zone 12-21
  Galaxy Communication 12-19
  Galaxy Group 12-20
  Galaxy Keypad 12-20
  Galaxy MAX 12-20
  Galaxy Output 12-20
  Galaxy Panel 12-20
  Galaxy RIOs 12-20
  Galaxy Zone 12-20
  Panel Reset 12-21
  Part Set 12-20
  Reset Panel 12-20
  Set Group 12-20
  Unbypass Zone 12-21
  Unset Group 12-20
  Vista Output 12-21
  Vista Panel 12-21
  Vista Partition 12-21
  Vista Zone 12-21
Alarm View 11-26, 15-7
  Acknowledge 15-9
  Add Note 15-9
  Alert State 15-7
  Cnt 15-7
  Command buttons 15-9
  Control Functions 15-8
  Filter Devices 15-10
  Filtering 15-10
  Normal State 15-7
  Open Default Floor Plan 15-9
  Opening 15-7
  right-click menu options 15-8
  Trouble State 15-7
  Viewing 15-11
Archive Database Server 10-3
Areas
  Add Branch 11-3
  Add Entrance 11-4
  Introduction 11-2
  Move entrance 11-5
  Remove Branch 11-5
  Remove Entrance 11-5
  Rename Branch 11-5
Aspect Ratio 7-13, 7-19, 7-21
Assigning Time zones and Holiday groups to the NetAXS panel 10-132
Associating Cards to an Account 6-4
Associating Time Zones to Accounts 6-3
Attendance Report 17-18
  Card Report 17-21
  filter 17-20
  sort 17-21
AutoCard Lookup 15-12
  Activating 15-13
  Buffer 15-14
  Priority 15-13
  Show Note Fields 15-14

B

Background Image 7-11
Badge Background 7-10
Badge Definition window 7-6
Badge Designs 7-6
Badge DLLs 7-26
Badge Elements
  Bar Code 7-22
  Bar code 7-18
  Barcode Options 7-23
  Bitmap 7-18, 7-21
  Item layering order 7-25
  Photo 7-18, 7-19
  Properties 7-24
  Shape 7-18, 7-20
  Signature 7-18, 7-20
  Text 7-18
Badge Layout 7-2
  Add New 7-2
  Configure 7-2
  Configuring 7-2
  Copying 7-5
  Deleting 7-5
  Editing 7-5
Index

Isolating 7-5
Placing Elements 7-18
Search 7-2
Searching 7-4
Selecting the Account 7-2
Sorting 7-4
Viewing 7-5
Badge printable size 7-7
Badge Printers 7-27
Configure 7-27
Badging Printers 2-4
Blockouts 7-9
Buffer Command 13-9

C

C-100 Local Connection 11-26
C-100 or 485 (non-ACK/NAK)
  Adding 10-56
  Editing 10-58
  Isolating and Deleting 10-58
C-100 Panel Loop 10-21
  Adding 10-21
  Editing 10-23
  Isolating and Deleting 10-24
  Loop Verification Interval 10-22
  Panel Defaults 10-22
  port 10-23
  TCP/IP Connection 10-23
  TCP/IP Encrypted Connection 10-23
C-100 Remote Connection 11-26
Capture Image 7-11
Card 8-2
  Privileged card 8-26
  privileged card 8-2
  P-Series Trigger Control 8-26
Card Frequency Report 17-23
  card frequency limits 17-24
  Card Holder Filter 17-25
  Disposition 9-12, 17-25
  Frequency Filter 9-12, 17-25
  Zero Frequency 9-12, 17-25
Card History Report 17-26
  Daily Time Range 17-27
  Sort on Sequence ID 17-28
Card Holder
  user code 8-17
Card Holder Report 17-29
  Advanced Card Filter 17-32
  filter the note fields 17-31
  Select Note Fields 17-31
  sort the report 17-31
Card Holder Report Templates
  Adding 17-2
  Deleting 17-4
  Editing 17-4
  Searching 17-4
Card Holder Tab Layout Report 17-33
Card Holders 8-2
  user codes 8-2
Card Report
  Advanced Card Holder Filter 17-23
  Badge Back 17-23
  Badge Front 17-23
  Badge Print Status 17-23
  filter 17-21
  PIN #1 17-23
  sort 17-22
CCTV Monitor 11-27
CCTV Switcher 10-63, 11-26
  Adding 10-63
  Camera Title 10-65
  Editing 10-66
  Isolating and Deleting 10-66
  Parity 10-64
CD Key 2-5, 2-16
Check Point Alarms 14-7
Check Points 14-4
Comm Server 11-26
Command Buttons
  Acknowledge 15-9
  Clear 15-9
  Close 15-10
  Freeze 15-10
Command buttons
  Silence 15-9
Command File 13-1
  Add 13-2
  Add Custom Command 13-4
  Adding Commands 13-3
  Configuration 13-2
  Edit 13-4
  Parameters 13-4
  Run 13-10
Command File Report 17-34
Index

Command File Server 10-3, 11-26
   Adding 10-8
   Editing 10-9
   Isolating and Deleting 10-10
   Present in Control Area 10-11

Command list 13-6

Communication Loops 10-21

Communication Server 10-3, 10-4
   Adding 10-4
   Alarm Priority for notification 10-5
   Alarm Priority for required acknowledgement 10-6
   Editing 10-6
   Isolating and Deleting 10-7
   Protocol end point 10-5

Communication Type 6-6
   Dial Up 6-6
   TCP/IP 6-6

Comparison 4-11

Compress 7-13

Configuring a reader
   galaxy groups 10-85, 10-86, 10-97, 10-116
   privileged card 10-85, 10-97
   vista partitions 10-85, 10-97

Configuring default settings 5-26

Configuring default workstation settings 5-19

Configuring Groups to the NetAXS panel 10-141

Configuring Inputs Points to the NetAXS panel 10-136

Configuring Readers to the NetAXS panel 10-143

Configuring rights for an entire branch 5-9

Configuring rights for an individual device 5-9

Configuring rights for databases 5-10

Configuring rights for reports 5-10

Configuring rights summary chart 5-12

Configuring the Output Points to the NetAXS panel 10-138

Control Area Report 17-35

Control Areas 11-20
   Add Device 11-22

   device type 11-22

   Galaxy devices 11-25

   Add Site 11-20

   Move Device 11-22

   Remove Branch 11-23

   Remove Device 11-23

   Remove Site 11-23

   Rename Site or Branch 11-21

Control areas 11-2

Control Maps 11-20, 11-24

   Controlling Devices 11-24
CrypKey Licensing Drivers 2-20
Custom Command 13-4

D

Database Server 10-3
Daylight Saving Group 9-24
  Adding 9-24
  Deleting 9-25
  Editing 9-25
Default Settings 5-2, 5-19
Defaults Option 5-20
Defining Areas 11-1
Defining Operators 5-14
  Adding 5-14
    Operator Level 5-16
  Deleting 5-18
  Editing 5-17
  Searching 5-17
  Sorting 5-17
  Tips on Password 5-16
De-fragmenting 2-23
Deleting a Recorder 10-42
Device Map Report 17-36
  additional filter options 17-37
  CCTV Switcher 17-39
  Fusion 17-42
  Loops 17-37
  Modem Pool 17-40
  Panels 17-38
  RapidEye 17-41
  Servers 17-37
Device Map tree 10-2
Digital Video 15-17
  camera controls 15-20
  Clip 15-17
  Filtering 15-22, 15-26
  Live 15-17
Direct point 10-117
Domain Environment 4-2
  Adding 4-2
  Log On Property 4-3
  Power Users 4-2
  Setting 4-5
Door Interlocks 10-117
  Control Mode 10-118
  Direct Point 10-117
Index

Disable Egress for Time Zone 10-118
Free Egress Input 10-118
Held Open Time 10-119
Pre Alarm Time 10-119
Status Input 10-118
Strike off 10-118
Strike Time 10-118
Doors 11-26

E

Editing a Recorder 10-41
Enabling Ports 4-9
Ethernet Module 10-70
  Adding 10-70, 10-73
  Connection Password 10-72
  Default Polling 10-71
  Encryption 10-72
  Galaxy Gold Port Number 10-72
  Galaxy Gold User Interface 10-70
  Panel Defaults 10-71
  Poll Once 10-71
  Polling Interval 10-71
  Remote PIN 10-72
  Zones 10-70
Event View 11-27, 15-4
  Alarm 15-5
  Both 15-5
  Card Read 15-5
  Filter Devices 15-5
  Filtering 15-5
  Opening 15-4
Exit Areas 11-7
External Components 2-20

F

Features 1-3
Firewall Exception Settings 4-5
  Disabling Firewall 4-9
  Unblocking WIN-PAK Services 4-6
Firmware Version 10-128
Floor Plan 12-1
  Adding 12-3
  Adjusting the size 12-13
  Alarm View Links 12-2, 12-11, 12-18
Controlling System Devices 12-18
Deleting 12-15
Editing 12-15
Event View Links 12-2, 12-11, 12-18
Other Floor Plan Links 12-18
Previewing 12-14
Text Blocks 12-12
Text blocks 12-2
Floor Plan Control
  Removing 12-14
Floor Plan Controls 12-14
  Copying 12-14
  Pasting 12-14
  Resizing, Rotating, and Re-arranging 12-14
Floor Plan Definition 12-3
Floor Plan Design 12-4
  Adding ADV 12-5
  Other Floor Plan Links 12-10
Floor Plan Operations 12-16
Floor Plan Report 17-42
Floor Plan Views 12-16
  Opening 12-16
  Previewing 12-17, 12-18
  Resizing 12-17
Foreign Language Installation 2-20
Free egress input 10-118

G

Galaxy devices
  Activated 11-26
  Bypassed 11-25
  Deactivated 11-26
  Tamper 11-25
  Unbypassed 11-25
Galaxy Panel 10-150
  Add 10-150
  Alarm report Timezones 10-152
  Chime 10-153
  keypad 10-156
  MAX 10-156
  Omit 10-153
  Output Function 10-154
  Output Mode 10-154
  panel groups 10-151
  panel outputs 10-154
  panel zones 10-152
Index

Part Set 10-153
Resp. Time 10-153
Right-Click 10-157
  Download 10-157, 10-159
  Synchronize 10-157
  Upload Date and Time 10-157, 10-160
  Upload User Code 10-157, 10-159
  Virtual Keypad 10-157, 10-160
RIO board 10-155
SIA 10-153
user codes 10-155
Zone Type 10-153
Galaxy Panel Log Report 17-44
Generating and Printing a Report 17-7
  Clear 17-13
  Close 17-13
  Estimate 17-12
  Export 17-11
  Preview 17-8
  Print 17-10
  Report from Archive Database 17-13
Getting Started 4-1
Ghosting 7-19
Grab settings 7-12
Grid Settings 7-9
Groups 11-27
Guard Tour 14-1
  Adding 14-3
  Configure 14-3
Guard Tour Report 17-45
  check point types 17-46
  filter 17-45
Guard Tour Server 10-3
  Adding 10-12
  Editing 10-13
  Isolating and Deleting 10-13

H

Hardware Requirements 2-3
Help on Web 3-12
history of events 15-4
History Report 17-46
  Sort on Sequence ID 17-49
  Transaction Filter 17-47
History Report Templates
  Adding 17-5
Index

Deleting 17-7
Editing 17-6
Searching 17-7
Holiday Group 9-20
  Adding 9-20
  Editing 9-21
  Holiday 1 9-21
  Holiday 2 9-21
  Isolating and Deleting 9-22
Holiday Group Report 17-50
Holiday group report
  filter 17-51
Home Automation Mode 10-72
Hue 7-12, 7-15

I

IATA 7-16, 7-17
Import image 7-11
Import Utility 8-32
  Columns Order 8-36
  Correcting Errors 8-36
  Default Values 8-34
  Defining Order 8-33
  errors 8-37
  Excel Sheet 8-33
  Importing 8-35
  log on 8-32
  Importing 8-13
Input Points 11-27
Install Automatically 2-13
Installation Components 2-19
Installing Communication Server 2-19
Installing Complete WIN-PAK 2-11
Installing Database Server 2-16
Installing User Interface 2-17
Installing User Interface and Communication Server 2-18
Interacting with Cameras 10-4
Interlocking 10-100
Interlocking Points on SIO Board 10-116
Introduction 9-2, 12-2
  Daylight Saving Group 9-2
  Holiday Group 9-2
  Schedule 9-2
  Time Zone 9-2
  User Interface 3-2
Intrusion Panel 10-3
Index

Intrusion Panels 1-4
   Galaxy panel 1-4
   Vista panel 1-4

L

Language
   Add New 16-4
   Deleting 16-5
   Editing 16-5
   Select for translation 16-6
Language Configuration 16-3
Licensing 2-22
Links 11-27
Live Monitor View 15-14
   Capturing a Frame 15-15
   CCTV Options 15-17
   Clearing Limits 15-16
   control buttons 15-15
   Controlling the Camera 15-15
   Setting Home 15-16
   Setting Pan and Tilt 15-16
LobbyWorks 8-38
Locate Card Holder 15-2
Logging Off 4-15
Logging On 4-14
Logging on to WIN-PAK 3-2
Login using current Windows user at startup 5-30
Loop 6-5
Luminosity 7-15

M

Magnetic Stripe Encoding 7-16
   Enter Data 7-16
Main Window 3-3
Maintenance Window 3-6
   Add, Edit, and Delete records 3-9
   Isolating Record 3-9
   Opening 3-7
   Printing Details 3-10
   Searching and Sorting 3-8
   Toggle 3-10
   Viewing Information 3-7
MDAC 2-20
Menu Bar 3-5
Micro Cobox 10-73
Micro Cobox converter 10-74
Modem Pool 11-27
Modem Pools 10-53
  Adding 10-53
  C-100 or 485 (non-ACK/NAK) 10-56
  Editing 10-55
  Isolating and Deleting 10-55
  Local Phone Number 10-54
monitoring the actions 15-2
  Alarm View 15-2
  Autocard Lookup 15-2
  Digital Video 15-2
  Event View 15-2
  Live Monitor 15-2
  System Events 15-2
Multiple 5-31
Muster System Precautions 11-8
Mustering Areas 11-7, 11-12
  Add Branch 11-12
  Add Entrance 11-13
  Find Item 11-15
  Move Entrance 11-14
  Rename Branch 11-15
Mustering areas 11-2

N

N-1000/PW-2000 Panel 10-75
  Adding 10-75
  Anti-passback 10-78
  Assigning time zones and holiday group 10-77
  Configuring a reader 10-85
  Configuring groups 10-84
  Configuring input points 10-82
  Configuring output points 10-83
  Continuous Card Reads 10-79
  Debounce Time 10-83, 10-87
  Egress Input 10-87
  Forgiveness 10-79
  Groups 10-79
  Hardware Options 10-79
  Host Grant 10-79
  Interlocking 10-83
  Keypads 10-79
  OD (Duress Option) 10-81
  Outputs for duress 10-82
Index

- PFR (Power Fail Reroute 10-81
- PIN and Time Zone for PIN 10-79
- Pulse Time 10-84, 10-87
- Report Alarms 10-83
- Reverse Read LEDs 10-79
- Setting the card format 10-76
- Setting the panel options 10-78
- Shunt Time 10-83, 10-87
- Site Codes 10-79
- Status of the panel 10-76
- Supervised 10-83
- N-485 Local Connection 11-27
- N-485 Remote Dialup 11-27
- Nested Areas 11-7
  - Example 11-8
- NetAXS-123 panel 10-127
- NetAXS-4 panel 10-127
- Network cards 2-5
- network environment 2-9
- Note Field Template Report 17-51
- NS2+ Panel 10-88
  - Adding 10-88
  - Advanced Options 10-94
  - Anti-Passback 10-97
  - Assigning time zones and holiday group 10-90
  - Card+PIN Time Zone 10-98
  - Configuring a reader 10-97
  - Configuring input points 10-94
  - Configuring output points 10-96
  - Continuous Card Reads 10-92
  - Debounce Time 10-95
  - Direct Point 10-99
  - Duress Option 10-94
  - First Valid Read Activates Time Zone 10-96
  - Forgiveness 10-91
  - Free Egress 10-98
  - Global Anti-passback 10-91
  - Host Grant 10-92, 10-93
  - Initialization Command 10-94
  - Interlocking 10-96
  - Keypads 10-92
  - Outputs for duress 10-94
  - PIN 10-92
  - PIN Only Time Zone 10-98
  - Report ON/OFF 10-96
  - Reverse Read LEDs 10-92
  - Setting the card format 10-90
  - Setting the panel options 10-91
Index

Shunt Time 10-95
Site Codes 10-92
Supervised 10-95

O

Online Help 3-12
Operator Actions Report 17-53
  Toolbar buttons 17-55
Operator Level Report 17-56
Operator Levels 5-7
  Adding 5-8
  Configuring 5-8
  Copying 5-12
  Editing 5-13
  Isolating and Deleting 5-13
Operator Report 17-52
Operators 5-7
Orientation 7-8
Output Points 11-27

P

Pan / Tilt Camera 11-27
Panel 11-27
Panel Configuration 10-74
Parameters 13-4
PCI3 10-127
Physical devices 10-2
Pop-up menus 3-6
Precision 5-31
Prerequisites 2-5
Print
  Tracking and Muster details 11-17
Printing Tracking and Muster details 11-17
P-Series Intelligent Controller 10-34
P-Series Panel 10-101
  Access Configuration 10-114
  Adding 10-101
  Adding P-Series Panel in Modem Pool 10-124
  Adding SIO boards 10-107
  Anti-Passback 10-115
  Assigning time zones and holiday groups 10-106
  Basic tab 10-108
  Configuring ABA card format 10-105
  Configuring card formats 10-105
Quitting WIN-PAK 4-15

R

Readers 11-27
Recorder Configuration 10-40
Registering WIN-PAK 2-22
Registering WIN-PAK Online 2-22
   License Key 2-23
Remove Branch 11-12, 11-15
Remove Entrance 11-12, 11-15
Report Templates 17-2
   Card Holder Report Templates 17-2
   History Report Templates 17-5
RPC connection 4-11
RS-232 Connection 10-68
   Adding 10-68
   Editing 10-69
   Isolating and Deletin 10-69
   Port Settings 10-68
RS-232 Panel Loop 10-30
   Adding 10-30
   Editing 10-32
   Isolating and Deleting 10-32
   Loop Verification Interval 10-30
   Panel Defaults 10-31
   Port 10-31
Ruler Measurement 7-7
Run Report 5-10
   Report Type 9-16

S

Saturation 7-12, 7-15
Schedule 9-8
   a task 9-8
   Activate and Deactivate Cards 9-10
   Card Frequency Report 9-10
   Deleting 9-19
   Dial Remote Area 9-13
   Editing 9-18
   Guard Tour Configuration 9-15
   Run Command File 9-14
   Run Guard Tour 9-15
   Run Report 9-15
   Send Date and Time 9-17
Index

Task Type 9-10
Task types 9-9
Update cards every day 9-8
Update Custom Access Level 9-18
Update Custom AL every day 9-8
Update date and time every day 9-8
Schedule Report 17-57
Schedule Server 10-3
   Adding 10-15
   Editing 10-16
   Isolating and Deleting 10-16
Search 3-8
Sentinel Hardware Lock Drivers 2-20
Sequenced check point 14-2
Sequenced check points 14-4
Server Configuration 10-4
   Command File Server 10-8
   Communication Server 10-4
   Guard Tour Server 10-12
   Schedule Server 10-15
   Tracking and Muster Server 10-18
Setting background color 7-13
Setting the Card Formats 10-130
Setting the NetAXS Panel Options 10-133
Shortcut Keys 3-5
Signature Index 7-21
SIO Boards 11-27
Site 6-4
   Add Branch 11-21
Snap to Grid 7-9
Software Requirements 2-4
Sort 3-8
sound files 5-19
Stat Camera 11-27
Status Bar 3-6
Status input 10-118
Sub-menus 3-6
Summary Report 6-11
Synchronize Event Types 10-39
System Defaults 5-25
   access levels for cards 5-30
   alarm handling 5-27
   automatic log on and log off 5-30
   e-mail IDs for reporting alarms 5-28
System Events 15-3
   Viewing 15-4
System Manager 4-11
   Setting RPC Endpoints 4-11
Setting User Interface Workstation 4-12
System Triggers and Procedures 10-119

T

Time Zone 9-3
  Adding 9-3
  Always On 9-5
  Editing 9-5
  Never On 9-5
  reassign a time zone 9-6
  Snap Time 9-3
  Time slots 9-4
  time slots for holidays 9-5
  time zone 6-3
  Time Zone Report 17-58
  Time zone report
    Advanced Time Zone Filter 17-59
  Tool Bar 3-4
  Toolbar 3-4
  Tracking and Muster Areas 11-7
  Tracking and Muster Server 10-3
    Adding 10-18
    Editing 10-19
    Hours of History to Prime on startup 10-19
    Isolating andDeleting 10-19
  Tracking and Muster View 11-15
    Deleting Card Holder 11-17
  Tracking and Mustering Area Report 17-60
  Tracking and Mustering tree 11-7
  Tracking Areas 11-2, 11-7
    Add Branch 11-9
    Add Entrance 11-10
    Configure 11-9
    Find Item 11-12
    Move Entrance 11-11
    Rename Branch 11-11
  Translation 16-1
    dialog boxes 16-7
    Dialogs, Menus, and Other Text 16-7
    Introduction 16-2
    menus 16-10
    Other Text Options 16-12
    Select language 16-6
    text 16-11
  Tree Window 3-11
  Triggers and Procedures 10-119
Index

Adding a new procedure 10-120
Adding a New Trigger 10-122
Delay 10-121
Do Output Action 10-121
Procedure Actions 10-122
TTS 7-16, 7-17
Typical ADVs and Control Functions 11-26
  Arm Away 11-29
  Arm Stay 11-29
  Bypass Zone 11-29
  Disarm 11-29
  Galaxy Group 11-28
  Galaxy Keypad 11-28
  Galaxy MAX 11-28
  Galaxy Output 11-28
  Galaxy Panel 11-28
  Galaxy RIOs 11-28
  Galaxy Zone 11-28
  Panel Reset 11-29
  Set All Groups 11-28
  Unbypass Zone 11-29
  Vista Output 11-29
  Vista Panel 11-29
  Vista Partition 11-29
  Vista Zone 11-29

U

Unbuffer Command 13-9
Unsequenced check point 14-2
Unsequenced check points 14-6
Upgrades 2-6
Upgrading WIN-PAK 2-20
  backup copies 2-20
User Interface 3-1, 3-3
  Elements 3-2
  Introduction 3-2
  Menu Bar 3-5
  Pop-up menus 3-6
  Status Bar 3-6
  Sub-menus 3-6
  Tool Bar 3-4

V

Variable Length 7-17, 7-23
Index

Video Capture Card 2-3
Video Management System 10-38
Visitor 8-38
Visitor Management 8-38
  access cards 8-38
  Integrating 8-38
Vista Panel Port 10-72
  Zones 10-72

W

Watchdog Timer 3-3
WIN-PAK Architecture 2-2
WIN-PAK Client 1-2
  User Interface 1-2
WIN-PAK Help 3-11
WIN-PAK PRO Central Station Users 5-5
WIN-PAK Servers 1-2
  Communication Server 1-2
  Database Server 1-2
WIN-PAK Services 4-14
  Logging Off 4-15
  Logging On 4-14
WIN-PAK User Information 2-16
WIN-PAK Users 5-2
WIN-PAK Windows 3-3
WorkGroup Environment 4-10
Workstation Defaults 5-19
  alarm printers 5-20
  Restore options 5-24
  sound and language files 5-22
  sound settings 5-21
  wallpaper 5-23

Z

Zoom factor 7-8